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INTRODUCTION

Hij,

After years of development and anticipation, Windows Vista was released
on January 30 2007 amidst a great deal of hype and confusion, as well as
liberal amounts of misleading information across the Internet. With its
predecessor Windows XP having been the dominant operating system for
over five years, most people are unfamiliar with, wary of, even hostile
towards Vista. The vague and often incorrect advice on Vista's features that
is proliferating around the Internet only makes things worse.

Having written computer guides since 2002, and running a site well known
for providing comprehensive guides like the original TweakGuides Tweaking
Companion, 1 realized that it would be expected of me to provide at the very
least a basic guide or article that discusses how to optimize and customize
Vista. But I wanted to do more than that, so early this year I set about the
task of writing a totally comprehensive Vista guide. Initially I, like many
others, underestimated the sheer number of changes and new features in
Vista. However after several hundred hours of research, experimentation and editing, the TweakGuides
Tweaking Companion for Windows Vista has been completed and sits before you.

At over 250 pages in length, the guide will no doubt frustrate people who are looking for a handful of
tweaks or quick fixes to 'make Vista faster'. Clearly that is not the sole aim of this guide. The main purpose of
the guide - indeed my entire site - is to try to explain how things work in simple but sufficient detail so that
readers can customize and optimize their machines appropriately while learning more about them. As
computers become integral to almost every aspect of our way of life, it is no longer possible to simply ignore
them or pretend that it's not important to know how they work. Now more than ever it has become
extremely important that you begin to understand how your PC and Windows are working. Thus the guide is
long because I make sure that whether novice or advanced, you are given enough details to actually see
what is going on, and understand the logic behind my recommendations, rather than being treated like a
small child who is simply told to change settings without a second thought.

I promise you that if you patiently work your way through this guide over the course of a few days, that you
will come out at the other end with not only a better performing, more stable and better customized PC; you
will also be much more comfortable with using Vista on a daily basis; the mystery will disappear. More
importantly, you will also be able to better diagnose, indeed prevent, any problems on your PC in the future.

In any case use the guide as you see fit. If you find the guide useful, please consider providing constructive
feedback, making a donation, or purchasing the professionally printed version at www.TweakGuides.com.

This will allow me to work on further refining and maintaining this guide over time, and also to continue to
create a range of new guides in the future.

Cheers,

Koroush

Koroush Ghazi i
Owner/Author In honor of 2,500 years of Persian Culture
TweakGuides.com Dedicated to the noble ideals of Cyrus the Great
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BEFORE USING THIS GUIDE

Please read the following information before attempting to make any changes using this guide.

BASIC REQUIREMENTS

There are three key requirements you must meet before being able to use this guide successfully:

*  You should prepare backups of all your important information prior to undertaking any of the changes
detailed in this guide. Follow the instructions in the Backup & Recovery chapter.

*  You should have an original Windows Vista installation DVD. Do not undertake the tweaks in this
guide if you don't have a Vista DVD as you may not be able to reverse certain changes or fix any
problems which may occur.

*  You will need access to an Administrator level User Account to make the majority of the changes in this
guide. See User Accounts under the Control Panel chapter for more details.

I do not recommend proceeding with the guide unless you meet all three requirements above, because if you
experience any problems you will not be able to fix them. At the very least you must have Administrator
level access to the system.

DIFFERENT VERSIONS OF WINDOWS

This guide is only designed to suit Windows Vista. The main differences between the various editions of
Vista are covered in this Microsoft Article. There are no content differences between the OEM, Academic,
Upgrade and Retail editions of Vista - these are all identical in terms of performance and content. The actual
difference is that certain purchasing and usage conditions apply to each of them - see the Windows Product
Activation & Validation chapter for details. Note that there is a separate TweakGuides Tweaking
Companion for Windows XP which XP users should use.

WHY IS THE GUIDE SO LONG?

This guide is intended as a reference source. It is not intended for people seeking quick fixes. I provide
detailed explanations for a wide range of features and procedures so that you understand what you're doing,
rather than just taking my word for it. To find information on any topic in the guide at any time, use the
Table of Contents, the Bookmarks tab to the left, or press CTRL+F to bring up the PDF search functionality. I
will not be releasing a cut-down version of this guide; there will be no '10 best tweaks' or handful of changes
which 'fix' or speed up Vista, it is a complex interrelationship of hardware and software settings which
determines how fast and how stable your PC runs. I firmly believe in the old saying "Give a man a fish and he
will eat for a day; Teach a man to fish and he will eat for a lifetime". For those who find that the guide does not
have enough detail about a particular aspect of Windows I encourage you to follow the link(s) provided and
also undertake additional research to find out more.

RECOMMENDED SOFTWARE

Listed throughout this guide is a range of software which I recommend you download to enable you to carry
out some of the procedures in the guide or to provide additional functionality. At no point do you have to
purchase any software. I am not paid or sponsored by any software or hardware company, hence my
recommendations are based only on two criteria: functionality and price. Specifically it must be the best free
software available to do the job. In a few cases the software may require purchase, but usually the trial
version of the software retains enough functionality to complete the job for which I have recommended it. Of
course if you do find any of the software useful I encourage you to purchase it or donate to the software's
author. Not everything on the Internet is free, nor should it be.
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PICTURES AND DIAGRAMS

There is a distinct lack of pictures, diagrams and graphics in this guide. This has been done to keep the guide
as short as possible. The Deluxe Edition of this guide does contain screenshots and illustrative images, as
well as higher quality image and text resolution. If you want a guide with these features, and more
importantly want to show your support for the site, please consider purchasing a Deluxe Edition.

PROBLEMS WITH THE GUIDE

While I have made every effort to ensure this guide is as accurate and detailed as it can be, I hope you
appreciate that I cannot possibly test the information and recommendations in this guide on every potential
type of PC hardware and software. I stress that [ can't provide technical support to readers. Unfortunately I
just don't have the time, so under no circumstances will I provide personalized tweaking advice, purchasing
advice or tech support. The whole reason for writing this guide is to give each and every reader a thorough
rundown on all the steps necessary to optimize your system. There are sufficient resources and links in this
guide to help people solve most any problem when combined with genuine research.

However if there is anything you believe is genuinely inaccurate, or which needs fixing in the guide such as
broken links please don't hesitate to Email Me with specific details.

YOUR RESPONSIBILITIES

The basic theme throughout this guide is that as long as you read and consider the advice given carefully
and use common sense when applying any changes you will remain problem-free. In all respects the guide is
safe to use if followed correctly. However for legal reasons, I cannot take any responsibility for any damage
or loss incurred through the use of this guide. It is a condition of use for this guide that you agree to take
full responsibility for your own actions. If you do not wish to take full responsibility for using this guide
and any resulting impacts, then do not proceed any further - close the guide immediately.
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VISTA USAGE NOTES

Window Vista is a relatively new Operating System, but for the most part its usage is similar to that of
previous Windows versions. However there are a range of changes which impact on the way you will go
about using Vista and this guide. This section briefly highlights the most important of these changes. Do not
skip this chapter - read through it quickly now, then refer back here as you go through the guide.

SEARCH BOX

Throughout this guide you will see me refer to Start>Search Box as a place to input particular text, often to
launch a program or Windows feature. This Search Box is actually an Instant Search box which appears
(among other places) at the bottom of the Start Menu when you click the Start button. Strictly speaking it is
not a command line interface like the Windows Run box - which you can access by pressing WINDOWS+R
or using the Run item on the Start Menu (when configured appropriately). However it is much quicker to
use than going through menus to find a shortcut, or typing an exact executable or command name in the
Run box, so I refer to it constantly in the guide.

More details of this Search Box and how the search functionality works in Vista are under the Windows
Search chapter.

USER ACCOUNT CONTROL

Vista has changed the way users are allowed to make major changes to the system. To start with you will
need to be using (or have access to) an Administrator-level user account if you want to implement most of
the changes in this guide. The default account that you create when first installing Vista is one such
Administrator-level account, so start by logging into that account when using this guide.

When User Account Control (UAC) is enabled, you will be prompted to Continue prior to making any
system-level changes; this is normal. Click the Details button on the UAC prompt to ensure you will be
running the program you expect to be running. In some cases programs not designed specifically for Vista
may not launch properly or have full functionality when UAC is enabled, because they don't ask for
Administrative access to the system even when it is required. So to start with, launch any programs by right-
clicking on their executable or launch icon and select 'Run as Administrator' to ensure they have full
functionality.

Importantly: Do not disable UAC to start with because aside from security issues, if you choose to enable it
again in the future, due to file and registry virtualization your settings for any currently-installed programs
may be lost. The reason for this is explained more clearly in the PC Security chapter. Keep UAC enabled
initially both for security and consistency purposes, and once you've finished using this guide you will have
enough information to properly consider whether to keep it enabled or not and the impact that this choice
will have.

These changes are all detailed under the User Account Control section of the PC Security chapter, and the
User Accounts section of the Control Panel chapter.

ADMINISTRATOR COMMAND PROMPT

Related to UAC is the fact that if using an MS-DOS Command Prompt to make command-line based
changes, you will often require what is known as an 'Administrator Command Prompt' to successfully use
certain system commands. There are several ways to access an Administrator Command Prompt.

* Go to Start>Search Box and type "ecmd" (without quotes), then right-click on the 'cmd.exe' option which
appears at the top of the Start Menu and select Run as Administrator'.
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*  Go to Start>Search Box and type "ecmd" (without quotes), then press CTRL+SHIFT+ENTER.

* Go to Start>Search Box and type "cmd" (without quotes), then right-click on the 'cmd.exe' option, select
Pin to Start Menu' or 'Send To>Desktop' to create a shortcut. Right-click on this shortcut, select
Properties, click the Advanced button and tick 'Run as Administrator'. You can now use this shortcut to
always launch an Administrator Command Prompt as required.

If ever a particular command line option is not executing properly or appears to have no impact, it is most
likely because you need to use it in an Administrator Command Prompt. Note that you can also run any
program or Vista feature from an Administrator Command Prompt without requiring a re-confirmation
through UAC, because it already has elevated privileges.

WINDOWS EXPLORER

Most users will need to start using the Windows Explorer and Explorer-based windows and features
relatively early in their experience with Vista, typically to manipulate files, so the Windows Explorer chapter
has been moved closer to the start of this guide. I encourage you to refer to that chapter as early as possible
(even directly after reading this if you wish), and as often as necessary to understand how the new Vista
Explorer interface works since it is a key tool for all users.

The Windows Explorer chapter also contains a list of keyboard shortcuts which may come in handy as you
use this guide, so again it may be worth perhaps skipping to early on to see the changes and new features.

NOTIFICATION AREA

This is a relatively insignificant change, but it should be noted that Microsoft now refers to the area at the
bottom right of the screen in the Taskbar (next to the clock) as the Notification Area, not the System Tray
area. All references in this guide to the Notification Area refer to that location.

WINDOWS AERO INTERFACE

An obvious feature new to Vista is the Windows Aero glass-like interface. The Windows Desktop is no
longer simply a 2D environment, under Vista the Desktop now always runs in Direct3D mode, so it can have
both 2D and 3D elements at the same time. To see if you are running Aero, and to demonstrate its 3D
capabilities, press WINDOWS+TAB to trigger Vista's 'Windows Flip 3D' task switching interface.

For details of how to enable and use the new interface features see the Graphics & Interface chapter.

PROGRAM COMPATIBILITY

Like any newly released operating system, Vista faces a range of potential compatibility issues from some
programs which were not designed with Vista in mind. While Vista is not the same as Windows XP or
Windows 2000, for the most part any 32-bit Windows-based program which ran under those platforms will
run on Vista without problems. However this does not include extremely system-intrusive programs such as
virus scanners or firewalls not designed for Vista. | have made sure the software listed throughout this guide
is compatible with Vista.

If you are having problems with a program, right-click on the program executable or launch icon, select
Properties and under the Compatibility tab tick the 'Run this program in compatibility mode" and select the
appropriate OS (Windows XP Service Pack 2 if in doubt). Also make sure to try running the program as an
Administrator (see User Account Control further above), as some programs do not inform Vista that they
need full Admin access to the system, and hence will abort during launch or give errors during installation
or usage unless you right-click on them and select 'Run as Administrator'.

Also check this Windows Vista Software Compatibility List to see if your program has any known issues.
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DRIVER COMPATIBILITY

Driver compatibility is perhaps the most significant issue facing Vista at the moment, and also the one whih
users can do least about. Vista employs a new driver model which is designed to make the system more
stable, but this means that older drivers will not work in Vista; drivers specifically designed for Vista must
be used. Some hardware manufacturers are struggling to provide adequate, stable drivers which are fully
functional, but this will improve over time. While some older hardware may never receive proper drivers,
most recent hardware should have good drivers soon. Hardware manufacturers ATI, Nvidia and Creative
Labs have all indicated they are working towards releasing better drivers over the coming months.

Vista 64-bit users should note that you cannot run drivers which are unsigned under Vista 64-bit, nor can it
use drivers designed for 32-bit Windows. See the Windows Drivers chapter for more details of drivers under
Vista, as well as the Sound section under the Control Panel chapter, and the start of the Graphics & Interface
chapter for important details on audio and video driver-related changes.

These are just some of the more important areas which may confuse new users of Vista. Vista has a vast
range of changes, some large and some small, for which you must steadily read through this entire guide to
learn more about and understand the rationale behind them. The one thing I can guarantee you is that
Windows Vista is not just Windows XP with a new interface, a few annoying prompts and driver problems.
It really has had a great deal of changes both above and beneath the hood, and contains greatly improved
built-in utilities and features which are all covered in this guide.
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BASIC PC TERMINOLOGY

If you're not totally familiar with the various components of a modern PC, then this chapter will help you
understand some of the common terminology used throughout the guide and what each hardware
component does in layman's terms. Note that I use a human body analogy to describe the function of PC
hardware components to hopefully clarify their functionality. Experienced PC users can skip this chapter.

BITS & BYTES

You will often see the terms Bits, Bytes, Kilobytes, Megabytes and Gigabytes (or their abbreviations) being
thrown around in guides such as this one. A Bit is the lowest form of computer information and can take the
value 0 or 1 (i.e. Off or On). All computer functionality is derived from the behavior of Bits. For our
purposes, the main conversion factors you need to know are:

8 bits (b) = 1 Byte (B)

1,024 Bytes = 1 Kilobyte (KB)

1,024 Kilobytes (KB) = 1 Megabyte (MB)
1,024 Megabytes (MB) = 1 Gigabyte (GB)

Note in particular that the general convention is that bits are shown as a small 'b, and Bytes are shown as a
capital B. E.g.: 512kbps is 512 kilobits per second, which translates to 64KB/s (KiloBytes per second).

PC

A PC (Personal Computer), often referred to as a System, Machine, Rig or Box, is a collection of hardware
(electronic components) which function as a unified system through the use of software (programmed
instructions). This is similar to the way a human body has a range of organs, connective tissue and structures
designed to work together to achieve an outcome.

CPU

The CPU (Central Processing Unit) is the single most important component of a PC. It is typically a thin
square chip which is seated firmly on your Motherboard, usually covered by a large metal heatsink and fan
to cool it. The CPU controls and co-ordinates the actions of the entire PC under instruction from software. It
has the role of determining which hardware component does what, assigning tasks and undertaking
complex calculations which are then fed through the various relevant components and back. In human body
terms, the CPU is the brain.

MOTHERBOARD

The Motherboard, also called the Mainboard, or Mobo for short, is the large rectangular plastic Printed
Circuit Board (PCB) into which a large range of electronic components are connected in a PC. The
motherboard provides a network of pathways (or Buses) for the CPU to communicate to the various
hardware components, and a range of ports for standard peripherals and devices to plug into the PC. The
major pathway for information flow in the motherboard is the main Bus (Front Side Bus or HyperTransport).
In human body terms, the motherboard is the nervous system and arterial system combined.

MEMORY

RAM (Random Access Memory), also called System RAM or just Memory, is the most common form of
computer memory hardware used by a PC. RAM usually comes in long thin 'sticks' of set sizes that plug into
the motherboard and through it provide a place for the CPU and other components to temporarily store
information. RAM only holds information while the PC is on; if a PC is rebooted or switched off, any
information in RAM is instantly cleared. Aside from System RAM, the graphics card usually has its own
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RAM called Video RAM, and the CPU and other hardware often have small memory chips called Caches to
hold information temporarily. In all cases, memory is used to speed up data transfers because information
can be written to and read from memory much faster than any other form of storage (such as the Hard Drive
or CD ROM). This is primarily because such memory chips have no moving parts.

ROM (Read Only Memory) is a permanent form of memory, and works similar to RAM, however unlike
RAM it can only be read from and not written to under normal circumstances, and it will not clear when the
system is rebooted or switched off. ROM is primarily used to hold small amounts of important information,
such as the BIOS (Basic Input Output System) - the program which tells the computer how to function when
it is first switched on - stored on the ROM chip in the motherboard. Certain ROMs can be written to by use
of a process called Flashing, such as when the BIOS is flashed with a new version. In human body terms,
Memory is like our own memory with RAM being short term memory and ROM being long term memory.

HARD DRIVE

The Hard Drive is a semi-permanent storage area that acts like Memory, except it is slower and far larger.
The hard drive is a rectangular metallic box inside which is a stack of round platters and a read/write head.
The hard drive plugs into the motherboard's IDE (Integrated Drive Electronics) Controller, SATA (Serial
Advanced Technology Attachment) Controller or SCSI (Small Computer System Interface) Controller
depending on the drive type and the motherboard type. Whenever the PC requires information, it must first
be read from the hard drive, usually into RAM, from where it is then accessed by the CPU and other devices.
Data such as installed software will remain on the hard drive regardless of whether the system is rebooted or
switched off. Because the hard drive involves moving physical components, such as the read/write head and
a spinning disk, it can never be as fast as RAM/ROM - which have no moving parts - in providing
information. Often a system may slow down or stutter while waiting for more information to be loaded up
or written to the hard drive. The amount of information on the hard drive itself usually has no significant
impact on its performance. In human body terms, the hard drive and the information it holds is like a library
of books, or a notepad that can be read from and written to.

CD/DVD DRIVE

Much like the Hard Drive, a CD, DVD, CDRW or DVD-R drive (broadly called an Optical Drive) is a storage
device that reads from and sometimes writes information onto CDs or DVDs that permanently hold this
information until overwritten or deleted. Such drives usually come in plastic rectangular boxes with a
loading slot or extendable tray in the front. They usually plug into the motherboard's IDE Controller or
SATA Controller depending on the drive and motherboard type. Specifically, CD and DVD ROM drives can
read information from CDs or CDs & DVDs respectively, but cannot write anything onto them. CDRW and
DVD-R drives can both read from and write information to writeable CDs and DVDs respectively. All these
drives are slower than a hard drive in reading and writing information due to physical limitations once
again and also the way in which they are connected to the main system Bus. In human body terms, these
drives are again much like an external library and the CDs and DVDs themselves are like books or notepads.

FLOPPY DRIVE

Much like a Hard Drive or CD/DVD Drive, a Floppy Drive stores information on a recording medium,
usually a thin plastic 3.5" Floppy Disk. The floppy drive comes in a rectangular plastic box with a loading
slot at the front and a large ejection button, and plugs into the floppy controller on the motherboard. Floppy
drives can read from and write information to floppy disks, but are incredibly slow compared to any other
form of drive, and also hold very little information (1.44MB) and hence are not commonly used anymore.
Most PCs retain a floppy drive for emergency use when Windows won't load up for example, or to flash the
BIOS, though even this is no longer necessary under Vista. Again, in human body terms a floppy drive is like
a library, with the floppy disks a document or notepad for reading from and writing to.
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GRAPHICS CARD

The Graphics Card, also called the Video Card, Graphics Adapter or VGA Adapter, is a miniature computer
of its own dedicated solely to graphics-related functions on the PC. It is a thin rectangular plastic PCB with a
GPU (Graphics Processing Unit, or 'Core') - similar to a CPU - and Video RAM (or VRAM) - similar to
System RAM - as well as Pipelines for transferring information internally, similar to the Buses on a
motherboard. It plugs into the motherboard through the AGP (Accelerated Graphics Port) Port, a PCI
(Peripheral Component Interconnect) slot, or a PCI-E (Peripheral Component Interconnect Express) slot.
Most graphics cards have one or more heatsinks on the GPU and the VRAM, and often have a fan on the
GPU or covering the entire card. The graphics card undertakes the majority of 2D and 3D graphics
calculations and also sends information directly to the Display Device, which is usually a monitor. Some
motherboards have built-in graphics functionality that works in much the same way as a graphics card, but
is referred to as Onboard Graphics or Integrated Graphics. PCs with such graphics functionality typically
process graphics-related information far less quickly than those with plug-in graphics cards. In human body
terms, the graphics card is like the portion of the Brain that relates to visual or artistic expression.

DISPLAY DEVICE

A Display Device, or more commonly referred to as the Monitor, is the device through which the PC's
information is displayed graphically. This graphical information comes from the graphics card, and a
display device must usually be plugged directly into the graphics card through the back of a PC to facilitate
this. While many computers still have a CRT (Cathode Ray Tube) monitor as their primary display device,
modern PCs can utilize LCD displays, Plasma Televisions and sometimes multiple types of displays at once
to output the graphics information. Display devices have the ability to display graphics at various
resolutions, typically expressed in number of Pixels wide by number of Pixels high (e.g. a resolution of 1024
x 768). A Pixel is the smallest component of graphics, and the higher the resolution, the more pixels are
displayed on the display device and hence the clearer the image. At each resolution a display device can also
redraw the image a number of times per second, referred to as the Refresh Rate. The higher the refresh rate
the smoother your graphics will appear and the less flickering you will notice. In human body terms the
display device is like a piece of paper or a canvas used by a person to convey thoughts as images and text.

SOUND CARD

The Sound Card, also called the Audio Card or Audio Device, is a thin plastic PCB or sometimes an external
attachment that acts as a dedicated CPU for calculation of audio information. A sound card typically plugs
into the motherboard through a PCI slot, or in some cases as an external peripheral, and usually has no
heatsink or fan, as it does not require the same level of cooling as other major components. Some
motherboards have built-in audio functionality that works in much the same way as a sound card, but is
referred to as Onboard Audio or Integrated Sound. PCs with such audio functionality typically process
audio-related information less quickly or less faithfully than those using proper sound cards. In human body
terms, the sound card is much like the portion of the Brain that relates to audio interpretation.

SPEAKERS OR HEADPHONES

A PC speaker system (or headphones) is designed to output the audio signals of the PC, which usually come
from the sound card, and hence they typically plugged directly into the sound card. Even if a PC has no
attached speakers/headphones, all PCs have a small built-in speaker that provides important system status
information usually as beeps. In human body terms the speakers or headphones are like the voice of the PC.

POWER SUPPLY UNIT

The Power Supply Unit (PSU) is a square metal box, usually with a fan at the back, which is cabled to all the
major components of a PC, particularly the motherboard, and provides the power for the PC to function. The
power cord from the wall usually plugs straight into the back of the PSU directly, as it draws the appropriate
power and regulates the precise voltages that certain devices need to function correctly. The PSU usually has
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a wattage rating which indicates the maximum power output of the PSU under load, with the more devices
connected to a PC the higher the wattage required to maintain ample smooth power to each and hence keep
the system stable under stress. In human body terms, the PSU is like the heart which pumps blood through
the arteries and organs.

HEATSINKS AND FANS

A Heatsink is a square or rectangular solid metal object typically with a perfectly flat surface on one side,
and many long square 'spines’ on the opposite surface. The role of a heatsink is to sit on top of a chip like the
CPU or GPU, or even RAM - any component which gets quite hot - and draw out the heat these components
are producing through conduction. This heat then travels along the length of the heatsink to the top of the
individual metal spines where cooler air and a large surface area help in accelerating the dissipation of the
heat. Typically a fan is bolted on top of the heatsink to aid in blowing more cool air over the heatsink's
spines and hence dissipate the heat more quickly. In some cases where just a heatsink is sufficient for the job,
no fan is used - such as the heatsinks on the motherboard or heatsinks placed onto VRAM.

Often Fans are placed inside and around a PC case by themselves to draw in cool air and blow out hot air
from the enclosed space around the hardware components on the motherboard. Given the way heatsinks
work, the air around components will heat up quickly as heatsink(s) radiate the heat drawn from hardware
components. Fans of varying sizes and speeds aid in cooling the air in the entire case.

Other forms of PC Cooling such as refrigerator-like Peltiers, Heatpipes and Watercooling blocks can assist or
replace heatsinks and fans in the role of cooling system components, but are less common due to their cost
and complexity. In human body terms all these devices are like the respiratory and perspiration functions.

CASE

The PC case is a hardened structure, usually made of thin but strong metal and/or plastic, which encloses all
the PC components and onto which the motherboard is firmly attached. The case usually provides the basic
framework required for affixing additional components such as hard drives, floppy drives and the PSU.
Often the case will also have a range of openings small and large to allow fans to draw and expel air for
better circulation. In human body terms the case is like the skeleton combined with the skin.

PERIPHERAL

A Peripheral generally refers to any external device attached to a PC, such as a mouse, keyboard, printer or
digital camera for example. The term 'peripheral’ is used specifically to indicate that the device lies outside
the periphery of the PC case. The only thing peripherals have in common with each other is that they
provide additional input to the PC, and often capture some of the PC's output too. In human body terms
peripherals are like the eyes, ears, nose, hands and feet of the PC.

OPERATING SYSTEM AND SOFTWARE

The Operating System (or OS) such as Windows Vista, is a vital piece of software - a compilation of
instructions that tell all the hardware components in a PC how to function to achieve particular outcomes.
This information is interpreted and coordinated by the CPU, but is not confined to CPU functionality. An OS
is a necessity on all modern PCs since without an overarching program to provide core functionality, all the
computer components would not be able to function as a single machine. Additional installed software is
like modular functionality which slots under the OS to perform specific functions or tasks, such as word
processing or gaming. In human body terms the Operating System/software is like a combination of our

basic education, instincts and emotions - the driving force behind our behavior that tells us how to act.

Hopefully this information has helped you understand the roles of the various hardware components a little
better. Ultimately a PC is an incredibly complex machine and as such the simplifications in this chapter don't
do justice to the intricate and multi-faceted ways in which hardware and software components interact.
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SYSTEM SPECIFICATIONS

The first step in optimizing your PC is to find out precisely what hardware components you have, and what
their various capabilities are. This is known as your System Specifications, and to find out the specific details
of your hardware you require an appropriate set of tools. Information about your system specifications is
vital both for using this guide, and for general PC usage and maintenance. For example you must know the
model and chipset type of your motherboard before you can upgrade your BIOS, or install the correct
motherboard drivers; you must know the full capabilities of your graphics card if you want to know if it can
run Vista Aero or again to update its drivers; or you may have a complex problem which you wish to resolve
yourself or provide details of to a Technical Support person. This chapter covers the tools you need and the
methods you can use to obtain all the relevant system information.

B SYSTEM INFORMATION TOOLS

There are several good free system information utilities to choose from, including some comprehensive ones
built into Windows Vista. A combination of these programs will tell you everything you need to know about
your system specifications and capabilities, and I recommend you download and install as many of these
programs as possible:

WINDOWS SYSTEM INFORMATION TOOL

You can access the Windows System Information Tool by going to Start>All Programs>Accessories>System
Tools>System Information, or go to Start>Search Box and type "msinfo32" (without quotes) and hit Enter.
The Windows System Information Tool presents a range of basic information about your system.
Unfortunately much of it can be a little difficult to comprehend or may not be quite what you're looking for.
Some of the more useful pieces of information include the IRQ allocations under Hardware Resources>IRQs;
the listing of your hardware components by type under the Components section; a listing of all the system
drivers loaded up and their status under Software Environment>System Drivers; or recent Windows errors
under Software Environment>Windows Error Reporting. In general the System Information Tool is best
used by medium to advanced users who can comprehend the interface and the information much easier than
a beginning user. Its major advantage is that it is a free and built-in utility that anyone can easily access.

PERFORMANCE & INFORMATION TOOLS

Windows Vista contains several tools which provide performance and diagnostic information about your
system. These can be found under Control Panel>Performance Information and Tools>Advanced Tools and
include the Task Manager, the Reliability and Performance Monitor, the Windows Memory Diagnostics and
the Generate System Health Report items. These tools are very useful in both providing more detailed
information about your system, and more importantly for allowing you to undertake
troubleshooting/diagnostics. They are covered in detail under the Performance Measurement & Diagnostics
chapter.

DEVICE MANAGER

You can access the Windows Device Manager under the Control Panel, or by going to Start>Search Box and
typing "device manager" (without quotes) and then pressing Enter. As a built-in Windows utility you can
gain a great deal of useful information about your hardware from this tool. Your major devices are displayed
under various categories, and you can even choose to update individual device drivers or uninstall a device
altogether should you wish. The Device Manager has several important roles and is covered in more detail
under the BIOS & Hardware Management chapter.
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DIRECTX DIAGNOSTICS

You can access the DirectX Diagnostic Utility (DXDiag) by going to Start>Search Box and typing "dxdiag"
(without quotes) and pressing Enter. DXDiag is another built-in Windows Diagnostic/System Information
tool that is part of the DirectX 10 API (See the Graphics & Interface chapter). The main tab of DXDiag, called
System, displays basic information about your system such as your Processor (CPU) type and speed, amount
of Memory (physical RAM) and the Pagefile (Virtual Memory) usage among other things. Under the
Display, Sound and Input tabs you can find more information about the particular hardware you are
running for each of these functions. In particular you should ensure that all the DirectX Features listed are
Enabled. If they are not, they can't be changed here however this indicates that there may be an issue with
your hardware or drivers - see the Windows Drivers chapter for more details.

The most useful function for DXDiag is its ability to create a detailed text file with all your major system
information, including your main hardware specifications, driver files, and environmental settings. To
generate this text file click the 'Save All Information' button found at the bottom of the main DXDiag screen.
You will be prompted to save this report somewhere, and the default of the Windows Desktop is just fine.
This DXDiag.txt file can now be attached to an email you can send to a Technical Support person, or its
contents can be posted on an online forum to allow others to help you with any problems you may be
experiencing. Don't worry - it doesn't contain any private information such as serial numbers or passwords.

3DMARK

You can download the latest version of 3DMark from the Futuremark Website, and you can read more about
its main functionality under the Performance Measurement & Diagnostics chapter. 3DMark is primarily
designed as a graphics benchmarking utility, however it has a nice system information section that gives you
a brief snapshot of major system information. Start 3DMark and on the main screen click the Details button
under the System section. A browser window will open with a range of information about your system.

SANDRA

You can download Sandra from the SiSoftware Website. Once installed, run Sandra and you will see a wide
selection of information and benchmarking modules to choose from. Under the free version of Sandra, many
of these modules are inactive, however the main ones we need have sufficient functionality for our purposes.
For example, if you want to know more about your system, go to the Hardware tab and open the Computer
Overview module. It will display a range of basic but important information about your system, such as the
CPU speed and type, and your graphics card model. If you want to know more about your motherboard in
particular for example, open the Mainboard module, and it will display the motherboard chipset type, and
information related to your motherboard and the types of devices on its various ports. Sandra has several
very useful benchmarking and stress testing features that are covered in more detail in the Performance
Measurement & Diagnostics chapter. Note that Sandra installs two new Services for itself, called the
'SiSoftware Sandra Agent Service' - which you can set to Manual; and the 'SiSoftware Database Agent
Service' - which you can Disable.

CPU-Z

You can download CPU-Z from the CPU-Z Website. Run CPU-Z.exe and it will provide you with everything
you need to know about your CPU, such as its precise speed, voltage, packaging type, cache sizes etc. It will
also tell you about your system's current Bus speed under the CPU tab, your full motherboard details under
the Motherboard tab, and your RAM's complete details under the Memory and SPD tabs. Note that for
information to appear under the SPD tab you will have to first select the slot(s) on the motherboard that your
RAM stick(s) occupy, otherwise the box will be empty.

There are many other system information tools which are available, some of which are not free. However a
combination of the tools above can give you all the details you need to see precisely what hardware is in
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your PC. I strongly encourage you to make sure that you are fully aware of your hardware specifications
and capabilities, as incorrect knowledge can cause major problems when you try to install drivers or make
system or BIOS changes for example. Make a list of your relevant system specifications now using the above
tools and keep them handy - see the format below for further help.

B PROVIDING SYSTEM SPECIFICATIONS

At some point while you are seeking help for a computer-related problem you will have to provide your
system specifications. Whether a qualified Technical Support person or simply a computer enthusiast on an
online forum asks, you should provide your specifications in an appropriate format. Simply copying the
entire contents of a DXDiag dump for example is far too large for most people to have the patience to wade
through, so I recommend that you use the format shown below.

Use the system information tools covered above to fill in the appropriate details. The more detail you can
provide, the better - the bare minimum is the brand and model number of your major components. Add in
details like whether any of the components are overclocked, whether there is any additional or modified
cooling, and indeed whether any other modifications have been made to the system since purchased. I have
filled in some sample information in italics to demonstrate how it should look:

CPU: AMD Athlon 64 X2 4400+ Dual-core CPU, stock speed, XP-90 cooling
Motherboard: DFI NForce4 SLI-DR
Graphics card: Nvidia GeForce 7800GTX at Stock speed
Sound Card: Creative SoundBlaster Audigy 225
RAM: 2x1GB OCZ PC3200 at 400MHz, 2-3-2-5 (CAS 2)

Hard Drive(s): 2 x 74GB Western Digital Raptor SATA RAID 0
CD/DVD Drive(s): Pioneer DVR-109 DVD-R

Power Supply: Silverstone 650W
Operating System: Windows Vista Ultimate including all updates

Driver Versions, Other Details: 2.08.0002 Audigy 2 drivers, 100.65 Forceware, 6.70 NForce drivers

You can also provide details of your monitor, keyboard, mouse, speakers/headphones, however these are
usually not critical to solving a PC problem, unless of course your problem is with mouse input, display
output, or audio output for example.

If you are still at a total loss as to how to provide full details of your system, use DirectX Diagnostics (see
above) to generate a report and attach it to an email or post its contents on a forum, but bear in mind that
noone can magically solve a problem simply by looking at your system specifications, no matter how
detailed they are, so despite the length of a DXDiag text dump, it is not a substitute for you becoming
familiar with your own system and therefore troubleshooting your own problems, or actively being able to
contribute and assist someone else who is trying to do so. You should also become familiar with the
Performance Measurement & Diagnostics chapter of this guide, as it provides important details on how you
can go about resolving many problems on your own PC.
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BACKUP & RECOVERY

Computers can store a great deal of information, and over time your PC may hold a lot of important, private,
irreplaceable data such as digital photographs and movies, financial documents, emails, passwords and
login details. It is of critical importance that you establish an appropriate method for regularly backing up
this information, so that if your PC is stolen, damaged, or its data is corrupted or accidentally overwritten,
that you do not lose all this valuable data permanently. Hence backing up is a vital and unavoidable part of
sensible computing. In fact once you are sure that your system is completely free of malicious software, you
should make at least one backup copy of all your important and irreplaceable documents before proceeding
any further with this guide.

This chapter not only covers various backup strategies and tools, it also covers a range of useful data
recovery methods you can use to regain valuable information which has been lost through forgetting
passwords, accidental deletion of files, data corruption or damage to your Windows installation.

B BACKUP AND RESTORE CENTER

Windows Vista's Backup and Restore Center allows you to either create backups of particular files, or create
a complete backup image of your hard drive(s), as well as a means of restoring these backups at a later date.
To access the Backup and Restore Center, go to Start>All Programs>Accessories>System Tools, or to
Start>Search Box and type "backup restore" (without quotes) and press Enter. The Backup and Restore
Center dialog box will open, giving you two main options for backing up (or restoring) your data: either as a
range of files, or as an entire image of your hard drive(s). Each option is covered below:

BACKING UP FILES

This option backs up only particular files from your system. This takes up far less space than the Back Up
Computer' option, and also allows you to selectively back up and restore certain file types. However it is
still much less precise than a manual backup, typically including a lot of files you don't wish to back up. This
is because Vista does not allow you to select the specific files and folders you want to back up, only files of a
certain type. For example, if you want to back up all Pictures and Music and select these categories, then
aside from any pictures and music you've created, saved or downloaded, it will also back up all image and
music files from other folders such as those under the \ Program Files directory (e.g. game music and image
files). This can obviously take up a great deal of additional space to backup, so I only recommend using this
option if you prefer its automated nature and don't mind its lack of control. A manual backup is the
preferred method of backing up specific files/folders in a more efficient manner (see further below).

When you select the 'Back Up Files' button, Vista first asks you where you wish to backup the files to, either
a CD, DVD or hard drive. I recommend that you back up your files to a CD or DVD regularly, even if you
also backup to another hard drive as well. I don't recommend only backing up the files to another partition
on your main Vista drive for example, unless you also keep backups of the data elsewhere. This is because if
your main Vista drive fails, all partitions on it will also be lost. So on balance another hard drive and/or
CD/DVDs are recommended.

Once you've made your selection, you will be prompted as to which hard drive(s) you wish to backup files
from. Your current Vista drive will be selected automatically and cannot be unselected; select other drives if
you wish. The next screen shows the specific types of files you may want to back up. As noted, a major
drawback is that Vista does not allow you to select specific directories or files to back up, merely the
category of files. By clicking on the name of each file type here you can see the kinds of files which will be
backed up from your chosen drive(s). Files which will not be backed up regardless of the categories you
choose include:
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* System files - The files that Windows needs to run.

* Program files - Mainly .EXE and .DLL files; other portions of program files will be backed up depending
on their type.

* Files stored on hard disks that are formatted using the FAT file system.

*  Web-based e-mail that is not stored on your hard disk.

* Files that are in the Recycle Bin.

* Temporary files.

= User profile settings.

* Files that have been encrypted using the Encrypting File System (EFS).

Once you've selected the file types you want to back up, Vista will assume you want to automatically do this
on a regular basis, and asks you to schedule a regular time for automatic backups each day, week or month.
Note that scheduling automatic backups is not possible in Vista Home Basic, though it will periodically
remind you to back up manually. To turn off automatic backups, or indeed alter any backup files settings,
open the Backup and Restore Center, click the 'Change settings' link below the 'Back up files' button. Then
you can click the 'Turn Off' button at the bottom of the next screen to disable automatic backups, and/or if
you want to change the backup settings you can click the 'Change Backup Settings' option. Note, to get back
to this configuration screen quickly at any time, you can type "backup status" (without quotes) in the
Start>Search Box and press Enter. If you want to permanently disable scheduled backups altogether, see
Task Scheduler under the Administrative Tools section of the Control Panel chapter.

Once done with the configuration, the 'Create a new, full backup' option should be ticked, now click the
'Save settings and start backup' button. You will be prompted to insert/format any disks required until the
backup is completed. If you need to manually format a CD, DVD or hard drive at this point, open Windows
Explorer, right click on the relevant optical drive letter or hard disk letter, select Format or 'Erase this Disk'".
If you attempt to create a backup which requires more disk space than you have available on your target
drive (e.g. the backup requires 5 DVDs and you only have 4), then you can resume the backup process at a
later date by running the '‘Back up files' option and it will continue from where it left off. If an automatic
backup fails due to lack of disk(s), it too can be resumed the same way.

The first time the Backup Files function runs, it automatically creates a full backup of all your selected file
categories, this may time quite some time. Vista then starts keeping track of which of your selected file types
across your chosen drive(s) have been modified or newly created, and in future when you return to the 'Back
up files' option you will be given the option of creating another full backup, or simply creating an
incremental backup of new/modified files only. You can also choose this by clicking on the 'Change settings'
link, and either selecting '‘Back Up Now' to find new/updated files to add to your backup, or 'Change backup
settings' to alter the settings and/or create a new full backup. Using the incremental method makes backing
up much faster and easier, so it is recommended.

When using Windows backup features, backup files are saved in a special format on your target drive/disk,
in the form Drive Letter:\<computer name>\ Backup Set <year-month-day> <time>\Backup Files <year-month-day>
<time>. The actual files themselves are stored in a set of archived .ZIP files, which you can open and
view/extract the contents of with an archival utility like WinZip. However to properly view and restore these
backed up files you should use the option below.

RESTORING FILES

If at any time you want to restore or simply view any files and folders backed up via the 'Back up files'
option, then you should go to the Backup and Restore Center and click the 'Restore Files' button. You can
then select to restore the file(s) from the latest backup you made, or from an older backup. I recommend
clicking the 'Advanced restore' link instead as this provides additional options, including the ability to
restore a backup of files made on another PC. On the next screen, click the 'Advanced Restore' option. If your
backups were made on another PC, select the Files from a backup made on a different computer' item; if
you've made several backups of the files on this PC but you want to restore an older version of a file, select
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the 'Files from an older backup..." option. Finally the most common option is to restore the latest version of
the files which you've backed up by selecting the 'Files from the latest backup...' item. Click Next when done.

On the next screen, if you chose to restore an older backup you can select the date of the backup made and
insert the appropriate disk if required before proceeding. If the files were backed up on a different computer,
connect or insert the disk(s) required and then continue. If you're using the latest backup, make sure you
insert the appropriate disk(s) if required.

To restore particular files or folders, select the 'Add Files' or 'Add Folders' option as appropriate and browse
to the '‘Backup' folder in the file browser on the left side of the dialog box. You should see the backed up
drive letter shown with a listing of the files and folders which have been backed up onto this particular hard
drive/CD/DVD. Highlight each of the particular files/folders you want to restore and click the Add button at
the bottom of the box. If you want to restore the entire backup, tick the 'Restore everything in this backup'
box at the top of the screen instead. Once done, click the Next button and nominate a location to restore the
file to. You can either have the backed up version of the file overwrite the current version on your Vista
drive (not recommended), or you can restore it to another location to prevent it overwriting the existing
version - this is the option I recommend just to play it safe, in case you restore the wrong backup or the
backup itself is somehow corrupt or infected. Restore it to another location, delete your current versions to
the Recycle Bin, then move the newly restored files to their original location and see if they are fine.

BACKING UP THE ENTIRE COMPUTER

Backing up specific file types is a useful but not foolproof way of making sure you don't lose valuable
documents in case of a hard drive failure or severe malware infestation. It prevents total data loss but it is
still time consuming to have to reinstall Windows and reconfigure everything back to the way you want it
after a major problem. Therefore Vista allows you to make a backup image of your entire computer, backing
up every file and detail such that you can restore your PC to the exact same state at any time. Unfortunately
this method does not allow you to selectively choose particular files or folders to backup or restore - you will
be backing up/restoring your entire PC in every way. If you have a dual boot arrangement, this also includes
the other version of Windows you're using as well, which can take up quite a bit of space. Note that this
function is not available in Vista Home Basic or Vista Home Premium.

To start the process click the 'Back up Computer' button in the Backup and Restore Center, and as
recommended, select another hard drive/partition to back up to. If you don't have any other hard drives, you
can select DVDs though this can obviously require quite a number of them. Regardless of where you choose,
on the next screen you will be given a rough estimate of the amount of space required, the drive(s) to be
backed up, and you can then commence the process by clicking 'Start Backup'. Depending on the size of your
current Window installation(s) and all programs installed, this could take quite a while.

This method is only recommended in conjunction with other automatic or manual backups of your specific
valuable files. This is because if you wish to restore your computer backup, it will completely overwrite your
current Vista install, and if you have a dual boot, it will also completely overwrite your other version of
Windows as well, with the version you backed up earlier. Clearly this is overkill just to restore a single lost
file, and also may mean you lose other data which was created or modified after your previous entire
computer backup. So on balance this method is recommended more for recovering from a catastrophic
failure like a total drive failure/corruption, or a severe malware infestation, and also requires that you
regularly maintain the entire computer backup to keep it up to date.

For details of how to recover using this backup, and also for alternatives to Vista's drive imaging method,
see further below.
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RESTORING THE ENTIRE COMPUTER

If you want to restore an entire computer backup image, click the Restore Computer' button and you will be
given the instructions on how to do this. Basically restoring a computer image cannot be done while you are
already running Vista or another version of Windows, so it needs to be done prior to the OS starting up. It
requires that you reboot and get into the recovery options and select the 'Windows Complete PC Restore'
option. For full details of how to get to your recovery options and how to use them, see the System Recovery
section further below.

Remember, you cannot restore particular files or folders using this type of a backup, it only allows you to
restore your entire computer setup to the state it was in when you last backed it up using the 'Back up
computer' option. All the hard drives you made a backup of will be completely reformatted, losing all
existing data on them, and the backups are then restored over them. If you had a dual boot arrangement, this
will be restored, however once again that means that any other operating system you were using along with
Vista will also be deleted and returned to the state it was in when you last backed up your entire computer.

Clearly this method is only recommended if you either have no other backups of important information, you
have suffered a catastrophic failure such as hardware failure or total drive corruption, or a severe malware
infestation which has compromised a great deal of your current data. If this not the case then I recommend
attempting other forms of system repair or recovery first, as covered further below.

B SYSTEM PROTECTION

Windows Vista attempts to ensure that you don't accidentally delete your files or have them unintentionally
altered without some form of backup. To that end, Vista's System Protection features, enabled by default,
automatically back up previous versions of your files regularly. These backups are known as Shadow
Copies, and they are automatically created on a daily basis for files which have been altered, as well as being
created whenever you use the System Restore feature to create restore points, or when you use the
automated Backup features of the Backup and Restore Center. To access the System Protection settings, go to
Control Panel>System and click the System Protection link in the left pane, or go to Start>Search Box and

type "systempropertiesprotection” (without quotes) and press Enter.

I recommend that all of these functions be enabled initially until you can get a better idea of the types of
backup strategies you wish to use for your system. The use of these features primarily impacts on hard drive
space, and does not have a major performance impact. Given it may help prevent the loss of important
documents and/or get you out of trouble if your have system issues, I believe on balance this makes them
worth keeping enabled. There is some scope to customize these features, and we look at the various specific
features of System Protection below.

SYSTEM RESTORE

System Restore is not a general backup and restore utility, and should not be mistaken as one. It does not
back up or maintain any copies of your personal files, such as your emails, pictures, documents or music.
Instead it tries to track and save information specifically on system-level changes, such as Windows system
files which are changed due to driver installations and alterations made to the Windows Registry by
programs. It is thus most useful as a general system state backup and recovery tool. Enabled by default,
System Restore relies on 'Restore Points' which are a snapshot of your system state at a point in time. Restore
points can be created manually by you, as well as being created automatically on a daily basis, and also just
prior to major system events like the installation of drivers or Windows Update patches.

To open System Restore, go to System Protection and click the 'System Restore' button, or go to Start>Search
Box and type "rstrui" (without quotes) and press Enter. On the main dialog box for the utility, you will be
presented with an option to go to the System Protection screen if you want to manually create a restore
point. I strongly recommend manually creating at least one restore point after you have installed Vista and
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prior to conducting any detailed tweaking. Go to System Protection and click the Create button, then give
the restore point a suitable name and click Create.

To use a restore point to return your system state to the way it was when that point was created, follow these
steps:

1. Open System Restore, and if any restore points exist, you will be able to click the Next button and view a
list of the restore points, and the date they were created.

2. Highlight the restore point and click Next. You will be shown the drive(s) to which the restore point
applies, and you can then click Next, and on the next screen confirm that you wish to use that restore
point.

3. Your system will restart and your system files will revert to the way they were at the time of the restore
point. You will be notified if the restore was successful.

4. If you find that using the restore point was no help at all, or made things even worse, you can undo the
use of the restore point by opening System Restore again, clicking Next to view the list of restore points,
and selecting the 'Undo: Restore Operation' item, click Next and follow the prompts. Note that this
option is not available if you use System Restore in safe mode.

If you wish to turn off System Restore, go to the System Protection screen and untick all the available
drive(s) you wish to disable this functionality for, then click Apply. Note however that this also removes all
existing restore points and turns off the general System Protection functionality. This is not recommended
unless you are genuinely a very advanced user who does not experience system issues very often and you
also regularly create backups of important files.

System Restore uses up to 15% of hard drive space on each hard drive it is enabled for, and requires a
minimum of 300MB of free space to work properly. Over time System Restore will delete older restore points
automatically so as not to exceed its size limit. However if you want to save disk space, you can manually
delete all older restore points except the very latest one at any time by using the Disk Cleanup utility - see
the Cleaning Windows chapter for details.

PREVIOUS VERSIONS

Although System Restore does not restore copies of your personal files as part of a restore point, the System
Protection feature ensures that Shadow Copies, also known as Previous Versions' are automatically created
for most non-system files during the creation of restore points. As long as you keep System Protection
enabled on a particular drive, then shadow copies will also be made of relevant files whenever they are
altered. While shadow copies are not a substitute for taking proper backups of your important files, this is
one of the added safety features in Vista to help prevent accidental deletion or alteration of important files,
which is why it is again recommended that you do not disable System Protection on your main Vista drive.

Just to be clear: the main difference between System Restore and Previous Versions is that System Restore is
used for backing up and restoring system-related files, while Previous Versions is for backing up and
restoring personal and other non-system files. Previous Versions of Windows system files (e.g. those under
the \ Windows directories) are not kept.

To view and/or restore the existing Previous Versions of any file, do the following:

1. Open Windows Explorer and browse to the selected file.

Right-click on the file and select 'Restore previous versions', or alternatively right-click on the file, select
Properties and click on the 'Previous Versions' tab - both have the same effect.

3. Under the Previous Versions tab you will see all available previous versions listed in order of the date
upon which the file was last modified, not the date it was saved. Note the Location field - if the file has
been saved as part of a Shadow Copy on your drive, it will be listed as such; if it was backed up using
the Backup and Restore Center, it will be listed as a Backup.
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4. To restore a previous version, highlight the version you wish to restore and click the Restore button.
Shadow copies are stored on your main Vista drive and will be restored immediately, whereas Backup
copies will be stored on another medium such as CDs/DVDs or another hard drive and require you to
have that particular medium connected or inserted in the drive before the restore can be completed.

5. If restoration is possible you will be asked to confirm the task, and if you agree, the file will be
overwritten with the earlier version.

Again, while this is a very useful function, it is not a substitute for taking proper backups regularly of your
irreplaceable personal files. Depending on the amount of drive space you have available and the number of
files on your system, over time you will lose older previous versions.

RESIZING SYSTEM PROTECTION'S RESERVED DRIVE SPACE

As noted previously, the System Protection functionality requires at least 300MB of drive space, and can use
up to 15% of your total drive space on your main Vista drive. If you wish to manually alter the amount of
drive space used by System Protection and its associated features including System Restore and Previous
Versions, you can do so as follows, though this is only recommended for advanced users:

1. Open an Administrator Command Prompt - see the Vista Usage Notes chapter.
In the command prompt that opens, type the following command, changing the main parameters to suit
your specific needs:

vssadmin Resize ShadowStorage /For=C: /On=E: /MaxSize=900MB

Where:

/For=Is the drive letter for the drive for which system protection is enabled;

/On=Is the drive letter for your main Vista drive;

/MaxSize= specifies the maximum amount (preferably in MegaBytes (MB)) allowed to be allocated to
System Protection, with the minimum allowable value being 300MB.

3. Once you've used the appropriate parameters for your own system and typed up the command, press
Enter and the amount of space used will be immediately resized as requested.

Note that by reducing the maximum amount of space usable by System Protection, you may lose older
restore points and shadow copies, and if set too low this may make System Protection effectively useless by
not being able to protect all your important system files and provide sufficient previous versions of all your
files. I would recommend you set at least 2GB of drive space, preferably more if you have more files on the
drive and/or you've nominated more than one drive to be protected. If in doubt, do not alter this setting. In
the end if you really resent the space taken up by System Protection features, or just don't have the space to
spare on your drive, then it may be best to simply disable System Protection for that drive altogether. This is
not recommended of course, but if you do decide to do this then you must make sure to regularly back up all
your files often.

B OTHER AUTOMATED BACKUP METHODS
Aside from the automated backup methods built into Windows Vista, there are a couple of other ways you
can create and maintain backups in a relatively automated manner.

NORTON GHOST

A popular package for backing up quickly and easily is Norton Ghost, though unfortunately it isn't free.
However if you genuinely can't be bothered with manual backups and/or you have some very important
information and want to make sure it's backed up completely and properly and/or you often install risky
software, play around with system settings and overclock heavily on a regular basis, then Norton Ghost can
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save you a lot of grief. Since Ghost isn't free, and is not essential, it won't be covered in detail here, but I refer
you to this Norton Ghost Guide for full details.

You can also try Acronis Truelmage, which some users prefer over Norton Ghost. Once again this is not a
free utility, so refer to the Truelmage User Guide for more details.

The main benefit of third party imaging utilities over Vista's built-in ‘Back up Computer' imaging option is
that firstly the Vista utility not available on Vista Home Basic or Vista Home Premium, and secondly
because Vista's built-in drive imaging program does not allow selective backup and restoration - it backs up
and restores everything. Therefore you may consider one of the utilities above as a valuable investment, as
they allow greater flexibility in choosing what to backup and restore.

ONLINE BACKUP

Most ISPs provide their customers with a basic webspace, or if not, then free email services such as Yahoo
and GMail provide large amounts of storage in the order of several Gigabytes. While I do not recommend
uploading/emailing any sensitive data to these locations, they do serve as good holding spots for backups of
digital photos and other important but non-secretive documents. That way if you lose all your local backup
copies through fire for example, there are still copies online which you can download and restore.

If you really want to be secure and not worry about losing your backups - especially if you have extremely
valuable information - then consider an online backup service, like Backup.com. This ensures that your data
is encrypted and stored safely, but this not free use, so is only recommended for people who genuinely need
that level of protection against data loss or theft.

B MANUAL BACKUP

The following is a list of tips for creating a manual backup of your data and settings in Windows Vista.
There are methods that can be used to create automated backups of your system which are covered above,
however I personally use the manual method regularly to ensure I have a 'clean' backup copy of all my
important files, especially if I am going to do a reinstallation of Windows. Any automated backup utility you
use may inevitably backup the problematic or sub-optimal settings you were trying to escape in the first
place, or back up a range of additional files you don't need, so a manual backup is strongly recommended
especially if you are experiencing problems. You can combine this with an automatic backup as well if
required, especially since Vista has a good built-in backup utility.

How precisely you do a manual backup is up to you; below are my personal methods for preparing data and
manually backing up your important files regularly:

Logical Directory Structure: Windows Vista has a much cleaner and more logical directory structure than
Windows XP by default, with a set of personal folders named after each user account, found under your
\Users\ directory. Under here are several clearly-named subdirectories: Contacts, Documents, Downloads,
Favorites, Music, Pictures, Saved Games, Search and Videos. You are strongly encouraged to take advantage of
this structure for a range of reasons as covered later in this guide. Make sure you get in the habit of placing
all your relevant files in the appropriate folders, creating sub-folders under them as necessary. I also
recommend keeping archived (zipped) copies of any major files you've downloaded, such as game patches,
the latest drivers etc. Then any time you want to make a manual backup, all you need to do is backup your
entire personal folder and all its subfolders. If you wish, you can create or use another partition or even a
separate hard drive to store your files, or even move your personal folders there (see the Windows Explorer
chapter), however again this still doesn't negate the need to back them up to another medium in case of
drive failure.

Internet  Bookmarks: Your Internet Explorer bookmarks are automatically saved wunder the
\ Users\[username]\ Favorites directory, and as long as you back this directory up as part of your manual
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backup strategy, they will be backed up as well. If at any time you want to export your IE7 bookmarks, you
can do so by opening IE, going to File menu>Import and Export>Export Favorites and select the appropriate
folders - usually the top folder is best. Follow the prompts to export your Favorites to a suitable location
under the default name Bookmark.htm. To import the Favorites back into Internet Explorer at any time go
back to the Import and Export function and choose 'Import Favorites'. If you use a browser like Mozilla
Firefox, you can backup your bookmarks by going to the Bookmarks menu, selecting Organize Bookmarks',
then selecting File>Export and choosing where to save the Bookmarks.html file.

Saved Games: If you want to backup any saved games or game configuration files, these are typically held
under the game's main directory in one of the subdirectories name Saves, Savegames or Profilename, and/or
under your \Users\[username]\ Documents directory, often under a directory with the name of the game. If
you are having problems with a game, I don't recommend backing up the game's configuration files as it
may just pass the problem onto your new install of Windows. Also, don't attempt to backup an entire game
program directory, as you cannot restore games (or most other programs) in this manner - these will not run
properly if they are copied back onto another installation of Vista due to the lack of appropriate registry
entries and files spread throughout various other directories. You must use the original installation
files/disks to reinstall a game or program correctly.

Usernames/Passwords: You can store all your usernames and passwords securely electronically - see the
Backing Up & Restoring System Passwords section further below. If you have no faith in electronic storage
systems then compile a written list/printout of the major usernames and passwords on your system.
However you must then store this list safely in a physically secure place like a safe or lockable drawer.

Backup to Disk or Hard Drive: Once you have determined the files to backup, you should regularly backup
your important files/programs to another medium, such as another hard drive, or ideally to CDs or DVDs. I
certainly don't recommend backing up your files to another partition on your main drive. I recommend CDs
or DVDs simply because it is easier to transfer information between PCs via CD/DVD rather than having to
plug in a hard drive, but the choice is yours. When selecting which files to regularly back up, give top
priority to files that are genuinely irreplaceable, such as digital photos and financial documents. Anything
that has a high sentimental or monetary value should be backed up often, ideally to more than one location.
Information which changes regularly should be backed up more often.

Remember that the Previous Versions option does provide some level of protection against accidental
deletion or modification of your personal files, and System Restore also allows you to undo the general
system damage caused by other mishaps, but neither of these should be relied upon solely as your only
backup procedure because they provide no protection against drive failure. Furthermore Vista's 'Back up
files' option is quite imprecise in backing up your personal files and folders, so I recommend manually
backing up the specific files which are important to you on a regular basis. Ideally you should use both
Vista's automated backup features and manual backing up together, not just one or the other, but manual
backups should be your first priority.

B BACKING UP THE WINDOWS REGISTRY

The Windows Registry is a critical component of Windows Vista, and any problems you experience with it
can make Windows unbootable, or result in a variety of errors or strange behavior - see the Windows
Registry chapter. For this reason it is important to have a backup of the Registry before undertaking any
system changes. Specifically, prior to editing the registry manually at any time, you should make a backup
of that portion of the registry - this is covered under the Windows Registry chapter. However you should
also make full backups of the registry regularly to allow you to undo any recent changes which can cause
problems with Windows. By default System Restore already maintains a snapshot of your registry at each
restore point, and this is one of the main reasons why you should keep System Protection enabled on your
main Vista drive and create a restore point before editing the registry for example. However this is not a
foolproof way of preventing registry corruption or unintended alteration.
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To provide a layer of added protection, ideally you should regularly back up your entire registry manually
as well. You cannot do this using the Export function in Registry Editor as that method is only handy for
saving individual branches of the Registry; unfortunately full Registry backups made by Registry Editor will
not restore correctly if your registry becomes corrupted.

Instead, I recommend you use a free utility called Erunt (Emergency Recovery Utility for NT). Download
this program and install it, but note that during the installation of Erunt you should answer 'No' when asked
if you want Erunt to be placed in the startup folder, as this is unnecessary. To make a backup of the
Windows Registry using Erunt, launch the program. You will be prompted to backup your registry to a
folder, which you should accept by clicking Ok until the backup has been made. If you want to restore this
backup at any point, simply go to the directory where the backup was made, typically
\ Windows\ ERDNT\[Date of backup]\, and launch the ERDNT.exe file there to restore that backup.

B BACKING UP & RESTORING PASSWORDS

One of the biggest headaches when running Windows would be losing your main login password,
particularly if you're the Administrator on your machine. With the NTFS file system it is quite difficult to
access the data on your hard drive without the correct login password (there is a method to reset this
password - see further below). Clearly the best thing to do is back up your password now before anything
happens, so that if necessary you can restore it without any difficulties. The recommended way to back it up
is as follows, though note you will require a floppy drive or USB flash drive for this to work:

BACKING UP LOGIN PASSWORD

1. Go to Control Panel>User Accounts and click on your User Account.

Click on 'Create a Password Reset Disk' in the left pane. The Forgotten Password Wizard will open up.
Click Next.

3. Insert a blank formatted 3.5" floppy disk into your A:\ drive or attack a USB stick and click Next. If you
need to format a blank floppy first, insert the disk into your floppy drive, open Windows Explorer,
right-click on A:\ and select Format. Click Next.

4. Type in your current User Password in the box and click Next. Once the disk has been created, click
Next and select Finish. Store this disk/stick somewhere safe, as anyone can use it to access your account.

Note that most people will use any old 3.5" floppy they find to backup their password and typically these
disks are quite old. A floppy disk has an error-free life of about 10 years on average, so I urge you to obtain
relatively fresh 3.5" floppies. If you don't have a floppy drive consider buying a small USB flash drive just for
this purpose.

RESTORING LOGIN PASSWORD

If you ever need to restore your password from the disk created above, follow these steps:

1. Boot your PC as normal, and on the Windows Login screen select your User Name.
Try entering your password (or just press Enter), and if it's incorrect you'll get a message saying the
Username or Password is incorrect. Click OK and then select 'Reset Password', inserting your password
reset disk or flash drive you created earlier.

3. Follow the Password Reset Wizard to set a new password and log back into your system.

Note that the password reset disk needs to be write-enabled so that Windows can update your disk with the
new password automatically during this procedure. When done, you should once again put it away in a
physically secure place. Note further that if you have another user who is an Administrator on your PC, they
can log in and change the password for your account. However this method will prevent you from accessing
any existing encrypted files or folders for your account, so it is strongly recommended you use the password
reset disk method above instead. It is the best precaution against a lost account password.
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RECOVERING LOGIN PASSWORD

If you've completely lost your login password, you don't have a password reset disk, and you don't have any
other Administrator who can reset it for you then generally you're in a lot of trouble. Usually you will have
to simply reformat and reinstall Vista. Windows Vista has increased its file system security over Windows
XP such that many earlier methods of unlocking/cracking user accounts are no longer possible.

However if you really are desperate to regain access to your user account and you have the time, you can try
the instructions and methods detailed here or here for cracking your account password. I am providing this
information in good faith for users who want to restore their own account, not to attempt to hack other
accounts. If you are alarmed at the existence of cracking tools and methods for getting account passwords in
Vista then I strongly recommend that you set your user account password to something very strong such as

a 12 character long base64 or base95 random password - use this online Password Generator to generate one.
These are very difficult if not impossible to crack, especially the more characters you use.

STORING PASSWORDS

If you want to hold all your usernames and passwords in a central database which is protected by high level
encryption, use the free KeePass Password Safe utility. To use it, run the program and select 'New Database'
under the File menu, then enter a Master Password and/or select a 'Key Disk' - this is used to unlock the
password list so make sure the password has a high bit-rate (e.g. 128 bit). Once created, you can populate the
database with Group entries for home banking, Internet - any groups you require. Then in the right pane for
each group you can right-click and select 'Add Entry' to create a new Username/Password entry to store.
Make sure to read the help file under the '?' menu>Open Help File as there are many options in this utility.
You can backup this password database to another location, and if needed access it using the master
password or key disk as required. Because it is encrypted it is next to impossible to access the database
without the right password/key disk.

There is also a built-in Vista Key Manager which you can access by going to Start>Search Box and typing
"control userpasswords2" (without quotes) then press Enter. This opens the User Accounts Advanced screen
(See User Accounts under the Control Panel chapter). Under the Advanced tab click the 'Manage Passwords'
button and you can then add login and password details for particular programs, websites or servers here,
and they will be saved and used whenever you launch the relevant program, site or server. You can even
backup and restore these credentials to another location. The Vista Key Manager is less secure though
because unlike KeePass above there is no master password which blocks access to this utility.

RECOVERING OTHER PASSWORDS

If you haven't stored your various passwords and you've managed to forget or lose a username/password,
there are utilities you can use to recover various passwords stored on your system. The process is not
necessarily easy since Vista is still new and many older password viewing utilities no longer work. Free tools
which work in Vista include Ophcrack and Cain & Abel, while a non-free tool is Elcomsoft System Recovery.
I cannot provide detailed usage instructions for these tools, and indeed none of them is simple to use. Once
again the presence of these tools should hopefully let you see though that nothing is completely safe on your
machine, so it is important to always restrict physical access to your machine only to trusted individuals,
and always follow the tips in the PC Security chapter and the User Accounts section of the Control Panel

chapter.

B FILE DELETION AND RECOVERY

Accidental deletion of files is one of the most common ways in which files are lost. By default Windows
Vista has some protection against this with its built-in backup features (see further above), and also not
being able to easily delete a file for which you are not the owner (See the PC Security chapter). Furthermore,
it's obviously wise to not only backup often but to also leave System Protection enabled, so that you have
several different Previous Versions of a file to choose from in case the file is damaged (again see further
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above). You should also leave the Recycle Bin enabled and make sure that files are moved to the Recycle Bin
when deleted - see the Cleaning Windows chapter for the details.

However in the end for one reason or another you may still wind up deleting a file permanently.
Fortunately, when you delete a file from your system the file is removed from view and you regain the space
on your hard drive, however it is not actually permanently deleted from your hard drive. In fact, nothing on
your drive is permanently removed when you delete it. Whenever you delete a file Windows simply marks it
for deletion by changing one character in the file table. The entire file is still sitting on your hard drive, but is
not visible. Windows then allows other files to write over the space where it resides if required, but the file is
not gone from your hard drive until it is completely overwritten at some point. This means that you can
recover files that have been 'permanently’ deleted, but you will require special software to do so.

RECOVERING DELETED FILES

The best free utility I have found to restore deleted files is a small tool called Restoration. To use Restoration
first download the file and run it to extract the contents to an empty directory on your hard drive, or to a
blank 3.5" floppy disk or USB drive. Then run the Restoration.exe file and either enter a filename in the search
box, or a file extension (e.g. JPG, DOC, TXT), or leave the box blank (to find all recoverable deleted files) and
click the 'Search Deleted Files' button. Restoration will scan your hard drive for files which can be restored
and list them. Once done, you can highlight a file and click 'Restore by Copying' to recover it - however note
that the file may not be complete since portions of it may have already been overwritten, so there is no
guarantee you can recover an entire file this way.

The more hard disk activity there is after you have deleted a file, the less chance you can fully recover it,
since portions of it may have been overwritten by new data. If you have accidentally deleted an important
file, try and minimize any further disk activity before running Restoration; if you can't run Restoration
straight away it is best to shut down Vista immediately to prevent a background task from commencing as
these will potentially overwrite the area where the file is sitting. Run an undelete program like Restoration
immediately.

If you want to recover deleted or damaged files on a CD or DVD disk, you will have to use a utility like
IsoBuster. This utility is available for free, however it requires paid registration for full functionality. You can
however use it to see if there is any recoverable data on your particular CD or DVD. Check the program's
help file for detailed instructions. However just like hard drive data recovery, there is no guarantee that any
usable data can be recovered from a damaged or deleted disk - particularly if it has been overwritten.

PERMANENTLY DELETING FILES

If you ever want to permanently delete a file so that others can't undelete it, you can also use the Restoration
program to do this. First delete the files you want to permanently delete the normal way - i.e. highlight them
and press Delete, then empty the Recycle Bin. Then launch Restoration and enter the name of the file in the
search box and click 'Search Deleted Files'. When Restoration finds the file and lists it, highlight the file and
go to the 'Others' file menu in Restoration and select 'Delete Completely'. This will permanently delete the
file so it is unrecoverable by virtually any program or method. Note that the file may still be recoverable by
law enforcement agencies using specialized methods, although it is highly unlikely that anyone could
recover the bulk of this data regardless of the methods used.

LOW LEVEL FORMAT AND ZERO FILL

People might suggest that you 'Low Level Format' your drive to permanently remove data or fix a drive
problem. This is not recommended unless you are experiencing severe hard drive problems, and even then
only as a last resort. Modern hard drives are low-level formatted at the factory to create tracks and sectors
and do not need to have it done again. The correct course of action is to Zero Fill your drive, which people
often confuse for a low-level format. This method overwrites the entire hard drive with blank data, ensuring
that everything is deleted permanently for most intents and purposes, but it is not as intensive or potentially
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disk-damaging as a low-level format. A note for the extremely paranoid - nothing short of physically
destroying the drive (by burning it for example) can guarantee that data cannot be recovered from a hard
drive by law enforcement agencies. So essentially a zero fill is your best bet in getting back to a 'good as new'
hard drive. To zero fill a drive, check your hard drive make and model, then consult your manufacturer's
website for an appropriate format/installation utility: Seagate DiskWizard, Western Digital Data LifeGuard,
Maxtor PowerMax or Hitachi Drive Fitness.

If you still believe you have to low level format your drive - for example if it seems heavily damaged with
bad sectors and is unresponsive to a zero fill - then you will have to look for a specific utility available from
your hard disk manufacturers' website to undertake this. I would only recommend this as a final step and
even then it may not save your hard drive.

B SYSTEM RECOVERY

This section covers all the main methods of recovering data and/or control of Windows after a major system
error or crash. Also refer to the Performance Measurement & Diagnostics chapter for more details of ways to
troubleshoot the potential source of such problems. If after any changes you make to Windows Vista your
system starts crashing or behaving oddly, or you are having major problems booting into Windows, it may
be because the Windows Registry or Window's system files have been corrupted or perhaps contains
conflicting or bad data of some kind. The most common reasons for system file issues or data corruption:

*  Opverheating and/or Overclocking - See the Overclocking and BIOS & Hardware Management chapters
for details. An overheating or overclocked component can malfunction, often in subtle ways, leading to
data corruption over time or within a short space of time.

* Faulty hardware - If a component is faulty, such as your RAM or CPU, it can corrupt data and cause a
range of problems.

* A bad shutdown - Can occur if your system suddenly reboots or Blue Screens, or if the power is lost to
your PC while it is on. This prevents Windows from properly closing down.

* Bad driver or faulty program installation - A faulty driver or program, including possible malware
infestation, can cause data corruption.

The very first thing is to try and undo what you last did which you suspect caused this problem, such as
uninstalling any recently installed drivers or programs. However if this is not possible or does not work,
then try one of the following:

If you can boot into Windows:

* You should run a range of malware scanners to make sure your system is free of any malware which
may be causing the corruption or crashes/odd behavior - see the PC Security chapter.

* You should run System Restore and revert to the most recent Restore Point available - see System
Restore earlier in this chapter. This is the easiest and safest method for undoing harmful changes to
system files. Remember, System Restore doesn't overwrite or alter your personal files, it only undoes
program and system changes.

= If System Restore doesn't work or you don't have any recent Restore Points, you should then try to
restore an Erunt Registry backup and reboot to see if this resolves your problem.

* If you don't have a Registry backup, try using the System File Checker as detailed further below.

If none of these options work or are not available to you, then try the options in the Windows Recovery
Environment section further below.

If you can’t boot into Windows:

If you simply can't boot into Windows, then you will have to use the Advanced Boot Options at Windows
startup to attempt to fix the issue or attempt further system recovery procedures, such as running System
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Restore in Safe Mode. If these don't work or you don't have the expertise to troubleshoot the problem then
you will need to use the automated Startup Repair tool in Vista - see the Windows Recovery Environment
section further below.

If you can’t switch on your PC or the problem occurs immediately after the PC is switched on:

If your problem is with a PC that won't turn on properly, or which crashes or shows screen corruption
immediately after you switch the PC on and during the POST sequence, prior to Windows startup screen,
then the issue is with your hardware, not Windows or your software settings. This can include problems like
a bad BIOS setting, overheating, bad connections or a faulty piece of hardware - see the BIOS & Hardware
Management chapter for details of things to try.

SYSTEM FILE CHECKER

The System File Checker is a built-in function of Windows that allows the system to go through and check all
the major protected Windows system files against the original versions stored on a valid Microsoft Windows
Vista DVD. This is extremely handy if you suspect corrupted/tampered system files that are leading to
unusual Windows behavior.

To access the System File Checker follow this procedure:

1. Open an Administrator Command Prompt - see the Vista Usage Notes chapter.

Type "sfc /scannow" (without quotes) then press Enter to start an immediate scan of your system files.

3. The System File Checker will go through all your important system files and make sure they have not
been altered in any way. Where major system files are corrupted or shown to be different from original,
they will be replaced with cached originals and/or your Windows Vista DVD.

4. If prompted reboot your PC as required.

Full usage options for the System File Checker can found in this Microsoft Article. The System File Checker

does not repair general system issues such as Registry corruption or bad drivers or startup programs, so it
may not resolve your problems. In which case check the options below.

ADVANCED BOOT OPTIONS

To access a range of more advanced startup options for Windows Vista, reboot your PC and keep pressing
F8 during startup - you will come to a screen with the heading Advanced Boot Options, providing a range of
options, the most useful of which are covered further below in more detail. Importantly, these options are
listed in the order in which you should use them when trying to resolve a problem.

Last Known Good Configuration: This mode is the first thing you should select if trying to resolve problems
with Windows not booting up or acting strangely. This mode uses the most recent system and registry
settings which were effect the last time you successfully booted up Windows. It will not alter or revert your
personal files to an earlier state, only relevant system files/settings and the Windows Registry.

Safe Mode: Safe Mode is an important Windows mode which only loads up the bare essentials required for
Windows to function. Third party drivers, graphical enhancements, startup programs, unnecessary
processes etc. are all skipped and only the minimum required to display and use Windows and access your
drives is provided. Safe Mode is provided precisely for troubleshooting purposes and not for general usage.
The idea is that by reducing the number of software variables involved in the Windows environment, it
becomes easier to identify the cause of a problem. You can read the details of the specific devices, drivers
and services which are loaded up in Safe Mode in this Microsoft Article.

There are three types of Safe Mode you can launch:
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* Safe Mode - This is the basic Safe Mode and is usually the option you should select.

* Safe Mode with Networking - Loads up Safe Mode with network drivers, allowing Internet access. You
should not select this mode to start with if your issue is potentially connected with network drivers or a
malware infestation.

* Safe Mode with Command Prompt - Loads up Safe Mode with a DOS command prompt interface
instead of a graphical user interface - use this if you have problems entering normal Safe Mode.

When you enter Safe Mode you will see the Windows Desktop, typically shown at lower resolution, and
with no graphical enhancements such as Vista Aero or even the background wallpaper. The words 'Safe
Mode' appear around the edges of the screen to inform you that you are running a cut-down version of
Windows Vista. The main use for Safe Mode is to determine whether your device drivers or recently
installed software are the source of a problem you are currently experiencing, and allow you to uninstall
them or alter your system as necessary to be able to restart normally. Because Safe Mode does not load any
of your installed third party device drivers - instead using the default versions built into Windows - and
because Safe Mode does not load up any startup programs or non-essential services into the background,
this gives you the opportunity to determine whether your software or one (or more) of your startup
programs is causing problems.

If you couldn't boot into Windows normally, but you can in Safe Mode for example, that is a clear sign that
one of your recently installed drivers or programs is the likely cause of the problem. You can choose to
permanently remove/roll back or temporarily disable the relevant programs or drivers by using Device
Manager, Software Explorer or MSConfig. Furthermore if you made a change to a system setting or the
Windows Registry that may have caused the problem, you can undo the setting in Safe Mode, or use System
Restore to revert to an earlier Restore Point, or restore a Registry backup here.

Finally, a major use for Safe Mode is the removal of malicious software such as viruses or spyware. Many of
these will load into the memory areas of Windows that cannot be unloaded during normal Windows
operation. However in Safe Mode there are no such protected memory areas, and no startup programs or
services are loaded with Windows, so this is the best way of removing such troublesome software. Enter Safe
Mode and find and delete the troublesome file(s), edit your startup items or Services to remove unusual or
harmful entries (See the Startup Programs and Services chapters), or run a suitable scanner in Safe Mode to
find and remove any malicious software (See the PC Security chapter).

If you find that you cannot boot into Safe Mode, or are having similar problems in Safe Mode as you are in
normal Windows - for example your graphics are garbled or show glitches - then the problem is likely
hardware-based such as overclocking, excess heat, permanent damage to a component/faulty component(s),
or a bad BIOS setting or incompatibility.

B WINDOWS RECOVERY ENVIRONMENT

Windows Recovery Environment is Vista's replacement for Windows XP's Recovery Console. It attempts as
much as possible to automate the process of recovering from any major system issues preventing you from
booting up successfully into Windows. If all of the methods above have failed to work, or you simply don't
feel you have the expertise to apply the above methods, then you should use these options to try to fix your
issue. There are two main ways to access the Recovery Environment options:

= Booting Off the Windows Vista DVD -All Vista Installation DVDs come with the Windows Recovery
Environment tools. To access these tools, insert your original Vista DVD and restart your PC. Your
computer should boot from the Vista DVD, but if it doesn't, go into your BIOS and set your DVD drive
as the first boot device then reboot again, and if prompted, press any key to boot from the DVD. Once
you reach the main Vista installation screen, select your language and keyboard layout, then click Next.
On the next screen click the Repair your computer' link at the bottom of the box.

* Recovery Partition - If pre-built, your PC may already come with a Recovery Partition which contains
the information required by the Recovery Environment tools. To see if this is the case, as you're booting
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up your PC keep pressing the F8 key to reach the Advanced Boot Options. If you see a Repair your
computer' option in the list of advanced boot options, then you should highlight it and press Enter to
launch the Windows Recovery Environment. Note, if you want to install the Recovery Environment on
your hard drive at any time, use these instructions.

Once you've launched the Recovery Environment using one of the methods above, you will be presented
with the list of detected Windows Vista installation(s) on your drive(s). Select the one you want to fix and
click Next. If you don't see any or all of your hard drives containing Windows, then you will need to insert a
driver disk containing your SATA/RAID/SCSI drivers, click the Load drivers' button and browse to the
driver disk and load up the relevant driver files.

The main Recovery Environment options are covered below:

STARTUP REPAIR

Startup Repair is quite possibly the most important feature of Windows Vista's Recovery Environment. It is
the primary tool you can use to diagnose and automatically fix any issues which are preventing you from
booting up properly into Windows Vista. Click this option and allow it to scan your system for any potential
problems. If it can resolve the issues, it will do so automatically, rebooting as often as required, and will
provide links at the end of the process which you can click to see precisely what issues have been found and
resolved. Note that Startup Repair cannot recover your Windows under certain circumstances, including
problems due to hardware failure, or certain types of virus attacks, or if your drive(s) are not being correctly
detected. If Startup Repair cannot detect or repair the problem, you can try using the manual legacy
commands which are listed further below under the Command Prompt option.

SYSTEM RESTORE

This utility has been covered in detail under the System Restore section further above. This option allows
you to launch System Restore and use a previous Restore Point in case you can't access System Restore from
within Windows or Safe Mode. Obviously this requires that a suitable Restore Point be present and able to
be used. This is yet another reason why I recommend that you keep System Restore enabled.

WINDOWS COMPLETE PC RESTORE

This utility has been covered in detail under the Backup and Restore Center section further above. If your PC
is not recoverable, this option allows you to restore a full backup you made earlier with the 'Back up
Computer' option in the Backup and Restore Center. It requires that you insert or attach the relevant
CDs/DVDs/Hard Disks which contain the backup. If you haven't made any such backup then this option will
not work, it cannot operate on partial backups of files for example.

WINDOWS MEMORY DIAGNOSTIC TOOL

The Windows Memory Diagnostic Tool is covered in further detail in the Performance Measurement &
Diagnostics chapter. This option allows you to run the tool immediately by clicking the 'Restart now and
check for problems' link, or 'Check for problems the next time I start my computer'. The first option should
be fine unless you have other things you still wish to finalize in the Recovery Environment, in which case
choose the second option.

COMMAND PROMPT

This option allows you to open a DOS Command Prompt window to enter a range of commands. This is
useful if you want to access specific DOS commands or attempt to browse for particular files or directories
on the stricken hard drive(s) and try to copy them to another drive.

Furthermore even though the Windows Recovery Environment replaces the XP Recovery Console, most of
the Recovery Console commands have been kept and can still be used if required. Here is the full list of
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legacy Recovery Console Commands, and a list of those which have changed or no longer work in Vista. For
example, the following commands may be of some use:

* Use the CHKDSK /R command to do a drive check and fix any errors if possible. If CHKDSK says the
drive is unreadable or there are too many errors, make sure that if you have a SATA/RAID setup, you
loaded the appropriate SATA/RAID drivers on the Recovery Environment main screen.

*=  Use the BOOTREC /FIXBOOT command to repair the boot sector of the drive.

= Use the BOOTREC /FIXMBR command to repair the Master Boot Record of the drive.

If none of the options above work in repairing or restoring your Windows installation, then it is highly likely
that your hard drive has experienced too much corruption and/or your hard drive or other hardware has
actual physical faults which prevent proper startup. In the first instance you should make sure your system
is not overclocked, and then try to run some diagnostics on it using the tools covered under the Low Level
Format and Zero Fill section further above. If the drive appears sound you should consider doing a clean
reformat and reinstall of Windows on it After that you should run a range of performance and diagnostic
tools to ensure that the system is working correctly and that no other hardware components - particularly
your motherboard, CPU and RAM - are faulty in any way, as otherwise you may experience data corruption
and the same problems all over again.
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BIOS & HARDWARE MANAGEMENT

Before delving into any specific Windows or software configuration, it is very important to ensure that your
hardware is correctly configured for optimal operation. Regardless of any changes you want to make in
Vista, if your hardware is not configured properly its capabilities will not be correctly utilised, indeed
serious problems may occur. While this chapter does not go into the complexities of how to build a PC, once
you've built a PC or purchased a pre-built machine, you should firstly make sure that the hardware settings
in the machine's BIOS are correct, and that the hardware is properly cooled. These topics are covered below.

B THE BIOS

The BIOS (Basic Input/Output System) is a program held on a small ROM chip on your motherboard. It
provides the instructions for what your PC should do as soon as it turns on. Your BIOS is independent of
your Operating System, which means it is not directly affected by the operating system you use, or which
driver version you've installed, or what your settings are in Windows for example. The BIOS supersedes all
of that, and your drivers and operating system will load after the BIOS has loaded up. The BIOS controls a
range of hardware-related features and is the middle-man between your CPU and other devices.

If there is an incorrect setting in your BIOS - that is a setting which is not optimal or correct for your
hardware configuration - then you will have problems regardless of what you change in Windows, or which
driver versions you install. Importantly, the BIOS is best configured correctly before installing Windows, as
this reduces the number of unnecessary services and drivers which Windows may install, and helps reduce
the potential for IRQ conflicts which is discussed further below.

POST SCREEN

As your BIOS starts to load, the first thing it does is the Power-On Self Test (POST), a diagnostic program
which quickly checks your components and makes sure everything is present and working OK. The POST
sequence is usually extremely fast; you will only really notice it if it stops when encountering an error. POST
error messages can be a bit obscure, but usually give you a lead as to where to look in your BIOS settings. A
quick general guide to what the startup error beeps mean is this POST Error Codes, but a more accurate
description specific to your hardware is usually found in your motherboard's manual.

If you have no POST errors you will then see your PC's startup screen, which shows such information as
your BIOS type (e.g. Award BIOS), the key to press to access your BIOS settings (e.g. DEL or ESC), the type
of processor and its speed, RAM amount and RAM test results, drive information, etc. Note that if any of this
information is incorrect, it may be that your hardware is extremely new and hence not recognized correctly
by the BIOS, you've overclocked your PC too far, or you have bad hardware or incorrect BIOS settings.

BIOS SETTINGS

To access the detailed settings in your BIOS, you typically need to press a particular key (the Delete key for
example) repeatedly as your system is booting up. If your BIOS has a password then you'll need to enter it
first to access your BIOS settings; if you've forgotten the password, then try this BIOS Password Site. Once in
your BIOS screen you will see a multitude of settings. The layout of the BIOS, and the names of the various
settings vary greatly depending on the particular motherboard brand and model you own, so I cannot cover

them here. It would simply take too much space to cover properly. The best reference source is this
Definitive BIOS Optimization Guide - scroll down that page to find the Free Access' link to the guide. It
covers all the common BIOS settings in detail, and combined with your motherboard's manual it allows you
to undertake the very important task of optimizing your BIOS settings before doing any Windows tweaking.
I cannot stress the importance of making sure all the major settings in your BIOS are correct for your

particular hardware setup and that you've disabled unnecessary devices and options. It may take some time
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and some research, but it ensures maximum performance and stability, and no amount of software tweaking
can overcome a badly set up BIOS or resolve BIOS-related problems.

BIOS UPDATES

The BIOS is actually written on a rewriteable ROM chip, which means that it can be updated (or 'flashed')
with new information. Motherboard manufacturers often release new BIOS versions that can improve
performance, stability and compatibility, add new features or modify existing features, and fix known bugs.
These new BIOS versions are available for download on the manufacturer's website. I can't list all the
manufacturer websites here, as there are far too many however if you have a look through your
motherboard manual you should see a relevant link to the appropriate website. Download the latest BIOS
for your exact motherboard brand and model number and follow the instructions on the site to Flash
(reprogram) the BIOS chip on your motherboard with this new BIOS version. A word of warning: flashing
the BIOS is not to be taken lightly. If something does go wrong then your PC may not boot up and you may
have to take your motherboard to a dealer to have the memory chip replaced. While this is rare, when
updating your BIOS make sure you follow the instructions provided to the letter.

FIRMWARE UPDATES

Your motherboard is not the only device which has a BIOS. Many components, indeed most major electronic
equipment like TVs and DVD players have their own inbuilt BIOS chips. The software on these chips is
typically referred to as Firmware, and all firmware can be updated using the correct equipment and
software. For consumer electronic equipment this is usually done by a qualified technician, but for PC
components, it can be upgraded in much the same way as flashing your BIOS. You will need to check your
manufacturer's website for more recent versions of the BIOS/firmware you require, and any specific
instructions or software necessary. The most common firmware updates are for CD/DVD drives. If you want
to find out more about these updates, see this Firmware Page. A firmware upgrade can help resolve
problems like difficulties reading from a particular disk type, 'disk not detected' errors, and other issues. Just
like BIOS flashing it involves an element of risk, so please read any instructions carefully before proceeding.

The BIOS is a critical component of the PC which is often overlooked, so I urge you to take the time to
become more familiar with your own BIOS, and to configure it correctly. Of course if you are not sure what a
setting in the BIOS does, do not change it from its default.

B HARDWARE MAINTENANCE

It is important to properly maintain your hardware, to ensure it remains in good operation. The information
below will help you understand how to handle, clean and keep your components operating smoothly.

HARDWARE HANDLING TIPS

If you have to physically handle the hardware components in your system at any time, such as removing or
installing a component, checking component connections, or cleaning the components, you should make
sure you follow these tips to prevent any permanent damage to the components through mishandling:

* Before opening your case and/or handling any of your components, always shut down your PC and turn
off the power directly at the wall socket - the electricity in your PC can kill or injure you, especially the
dangerous voltages contained in your Power Supply. Even when switched off at the wall, the PSU can
retain a lethal charge for quite some time, so on no account should you ever open your PSU or insert any
metal objects into its casing.

= Once you've turned off your system at the wall, press and hold the PC power button for several seconds
to discharge any residual energy in the motherboard's capacitors.

*  While handling computer components, make sure you regularly diskharge any static electricity in your
body by touching any 'earthed’ object - that is any object that can harmlessly dissipate static electricity.
Typically if you leave your Power Supply Unit plugged into the wall socket (but switched off) then
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periodically touching the side of the metal PSU case will harmlessly diskharge any static electricity. You
can also purchase an anti-static wrist strap if you handle components regularly. If you are going to
handle components try to minimize how much artificial fabrics and materials you are wearing as these
can help to build up a significant electrostatic charge in your body. An electrostatic diskharge from your
body can damage or kill an electronic component, so do not take this lightly as it can actually happen.

* Do not use a vacuum cleaner to clean the inside of your computer and its components, precisely because
vacuum cleaner nozzles can discharge static electricity and zap your components. Use a clean barely

damp lint-free cloth to wipe dust from most surfaces, making sure you don't rub or scrape the Printed
Circuit Board (PCB). Don't use any detergents on the cloth and most certainly don't spray any onto the
components. Ideally if it is available to you, use a can of compressed air (or an air compressor) to blow
dust from hard-to-reach or sensitive surfaces as this is much safer and far more effective.

* Do not force any plugs, cables or components into sockets that do not appear to be accepting them. Even
if the two ends appear to be matched, the pin arrangements may be slightly different or out of alignment
and hence forcing a fit may actually bend some of the pins and make the connection useless or
permanently damaged. Computer hardware interfaces are designed to fit together with firm but not
excessive force. This includes components like the CPU chip which fits into the appropriate socket on the
motherboard - align all the pins perfectly and press evenly but not too hard and they will mate safely.
Force the fit and you may just end up permanently ruining your CPU.

* Most devices in your PC require a source of power, however the voltage they require is very specific. If
you connect the wrong plug to the component (which is hard to do), or forget to attach a power
connector then the component will appear to be dead or may malfunction. You will have to check your
component documentation and especially the motherboard manual to ensure that all components are
plugged in correctly and firmly to receive sufficient power.

* Most hardware components are sensitive to physical impact and strong vibrations. Avoid situations
which result in the bumping or banging of these components, or for example mounting heavy fans onto
them insecurely which can pass vibrations to these components or warp them under the weight.

* Do not handle liquids around electronic components. Any spillage can result in disastrous short-
circuiting. This also includes any thermal or adhesive compounds which can conduct electricity and
hence cause a short-circuit - apply them cautiously and don't just assume that any excess will dry up and
disappear; remove all excess thermal compounds thoroughly with a cloth.

* Do not place excessive weights on PCBs as this can crack or warp them such that they will be
permanently damaged. Don't even rest a large object temporarily on the motherboard or a component
for example, put them on another surface until you need to use them.

Most importantly, make sure you are using a good quality Surge Protector for your PC and all your other
sensitive electronic devices. Aside from letting you plug in multiple devices into one outlet, surge protectors
serve an important function: they prevent spikes in voltage which can occur for a range of reasons from
harming your components. Voltage surges needn't be sudden or catastrophic; even minor increases in
voltage can reduce your component's lifespan over a period of time. Note that most surge protectors will not
protect your equipment from the surge generated by a direct lightning strike on or near your house, so
during thunderstorms it is strongly recommended that you turn off your PC and any other expensive
electronic products and disconnect their power plugs from the walls. This also includes any phone lines used
for ADSL for example.

Electronic components these days are quite hardy, and can withstand some abuse, but given how valuable
they are I suggest that you don't take any risks when handling them and in their general usage, so the tips
above are best observed if you want to maintain your PC and your electronic components in good condition.

COOLING

One of the most common reasons for problems in Windows is actually the hardware-related phenomenon of
overheating. Overheating hardware can cause all sorts of strange errors and problems, and is often
misdiagnosed as being a software problem. Most computer hardware generates heat due to the power they
consume, and this heat needs to be dissipated somewhere. A typical computer case is designed such that it
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traps heat, and hence as heat builds up in a PC, it will cause components to malfunction and even become
permanently damaged over time. Overheating can occur in both stock systems and overclocked systems; it
all depends on a range of factors we look at below.

Your CPU and motherboard both have built-in diodes that measure the temperature for these components.
The CPU temperature monitor is a reasonably accurate measure of the temperature at or near the core of the
CPU, while the motherboard temperature monitor is a good measure of the general system (or case)
temperature - the ambient temperature of the air in the immediate vicinity of the motherboard. Most recent
graphics cards also come with built-in temperature diodes as well, allowing measurement of the
temperature near the core of the graphics card. Many other components do not come with temperature
measurement devices, and so you can only tell their heat by touching them, or by using specialized
equipment such as an electronic thermometer.

To actually see the temperature readings from your components, you can check them in your BIOS typically
under a 'Hardware Monitor' section or similar. This gives you the CPU and motherboard temperatures,
perhaps also the PSU temperatures as well. Clearly you need an additional method of checking temperatures
under Windows, especially when running system intensive applications or games. Most motherboards
already come with such a software utility, so you should check your motherboard manual and driver CD, or
the motherboard manufacturer's website for an appropriate monitoring utility. If you still cannot find one,
you can use one of these generic utilities which read the sensors on your motherboard and CPU:

SpeedFan
HMonitor

Sandra

Monitoring your graphics card's temperature is possible through your graphics card control panel, generally
accessed via Control Panel>Personalization>Display Settings>Advanced Settings. You can also use third
party tools to view your graphics card temperatures - see my ATI Catalyst Tweak Guide, or my Nvidia
Forceware Tweak Guide. Remember however that only if your graphics card is equipped with a temperature
sensor can you monitor its temperatures in this way. If it is not so equipped, the only possible course of

action is to buy an electronic thermometer and attempt to measure the temperatures near the GPU of the
card. Also remember that the GPU temperature shown is not the same as the Video RAM temperature which
may be much higher.

Once you have the appropriate utility, monitor both your idle temperatures and your temperatures when
your system is under load. If particular components reach high or excessive temperatures when under load,
then it is likely that those components will malfunction while undertaking more strenuous activities on your
PC, such as playing games. However even when idle, your PC may begin to malfunction if heat steadily
builds up in your PC case and is not cleared fast enough. Most people will want to know what the 'safe’
temperature is for particular components on their system. The answer is different based on different
hardware architectures, as some are designed to run hotter than others, but you can ascertain what a safe
temperature under full load is by searching on Google using the specific brand and model of component to
see if any user feedback or reviews of your hardware states what temperature ranges are normal.

If you are experiencing problems with heat in your system, or if you just want to ensure that you remain
problem-free, the following basic cooling tips should be observed. This applies equally to overclocked and
non-overclocked systems:

* Remove any obstructions from around your case. For example don't obscure any of your case grills/air
holes, such as having them pressed against a wall, blocked by dust etc. Insufficient flow of air into and
out of the case is the number one cause of heat buildup and heat-related problems. No matter how much
cooling you have inside a case, if air can't easily get into and out of the case then your system will
overheat.
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= If you have few or no major case fans drawing in cool air and expelling hot air, remove the sides of your
case so that the fans on the CPU, graphics card and Power Supply can get a fresh supply of cooler air,
and can expel hot air outside the case.

* If you do have several case fans, arrange them so that some are to the front and low in the case, sucking
air into the case (as the air near the floor is cooler) and some are to the rear and/or the top of the case,
blowing hot air out of the case (where the hot air expelled will rise away from the case). In this situation
make sure to keep the sides of your case closed so that the fans have more pressure to suck/blow air
through the case's contents like a wind tunnel.

*= Don't position a sucking and a blowing fan(s) too close together as they will 'short circuit' each other -
that is they will pass air through the shortest line between the two, bypassing your components and
hence not cooling them as efficiently. As mentioned above, fans sucking air into your case should be low
and on the furthest side of the case from the blowing fans that expel heat from the case.

* If one component is shedding a lot of heat, pay attention to perhaps providing greater cooling to the
components immediately around it. Often the excess heat from one component can actually cause
another nearby component to overheat.

= Tidy the internal components of your case. This means all ribbon cables, power cables, etc. should be
clipped or twisty-tied to be as neatly arranged as possible, primarily to avoid blocking the flow of free
air around components, especially the CPU and graphics card which are the two hottest components in
most cases. Secured cabling and snug plug connections also means you can be sure nothing becomes
accidentally unplugged or short-circuited over time and hence causes hardware-based errors that will
confuse you in the future.

» If using additional internal cooling like larger heatsinks or fans, make sure they are not too heavy for the
surface they are mounted on. For example, using extremely large heatsinks on a graphics card can result
in the card actually bending under the weight and hence becoming permanently damaged. Even a large
heatsink mounted on a motherboard can cause it to warp or crack, once again damaging the
motherboard PCB beyond repair. If you feel you require such hefty cooling you should consider instead
buying a larger case that has better airflow properties.

* Make sure your hard drive(s) are not smothered by cabling or crammed into a stuffy area of the case
with no nearby cooling or fresh air. Higher speed hard drives in particular (i.e. 7,200RPM or 10,000 RPM
drives) can heat up quite a bit - one touch of their metal casing will tell you just how hot. Hard drives are
often overlooked in cooling, and yet they are a vital system component, and as such you should make
sure they receive plenty of fresh cool air.

= Make sure that any heatsinks on the motherboard itself are not covered or blocked by other components
or cables, or covered in dust. There is a reason why these heatsinks are there: because motherboard
memory controller chips for example require cooling otherwise they can malfunction due to excessive
heat just like any other major component. Don't assume a heatsink without a fan implies the component
requires minimal cooling, as sometimes manufacturers skimp on putting a fan on these heatsinks, which
simply means the heatsinks have to do more work, so keep them well exposed to cool air. You may even
consider installing a small fan on them if you wish, and this can aid in system stability.

The most simple of all of these tips which anyone can undertake is to provide greater access to fresh cool air
for the case's contents and regularly clean the case to remove dust buildup. Dust in particular can reduce
airflow significantly, so keep your case dust-free by using a damp cloth or compressed air. The next time you
go to upgrade your PC, consider buying a larger case with greater ventilation as the single best investment
in general cooling.

B DEVICE MANAGER

Once you have set up your hardware and BIOS correctly, the Device Manager in Windows is the central
location for viewing and configuring connected hardware on your system. To access Device Manager, you
can find it under the Control Panel, or go to Start>Search Box and type "device manager" (without quotes)
and press Enter. The main Device Manager window lists all your detected hardware grouped by category,
and you can expand particular categories to see individual devices. Double-click on any particular device to
see more details of it.
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Devices with a question mark or exclamation mark next to them will need further troubleshooting to
correctly identify and install, as by default Windows is unable to use the Plug and Play system to identify
what they are. Until Windows can identify a device properly, it cannot be used even if it is correctly
connected to your system and identified by your BIOS for example. You can use the Add Hardware
component of the Control Panel to add older devices which don't support Plug and Play (See the Add
Hardware section of the Control Panel chapter) and/or you may have to install the appropriate device
drivers for Windows to use the device properly - see the Windows Drivers chapter.

ACPI RESOURCE ALLOCATION

ACPI is the Advanced Configuration and Power Interface standard, and is an important part of the way
Windows Vista and drivers communicate with your hardware. In previous versions of Windows you could
run hardware which didn't support ACPI, or even disable ACPI if you wanted to attempt manual resource
allocation. However this is no longer possible in Windows Vista - Vista requires ACPI for it to function. That
means that you cannot disable ACPI, and older hardware which is not properly ACPI-Compliant will not
run Vista. In fact Vista only supports systems based on motherboards whose BIOS is ACPI Compliant and
dated 1 January 1999 or newer. If you're running older hardware that means you should update to the latest
available BIOS for your motherboard and also ensure that any ACPI options are enabled for Vista to install
and run without problems.

Windows Vista does not fundamentally change the way resources are handled compared to Windows XP.
Since Vista only accepts ACPI-compliant systems, and because most recent hardware supports Plug and
Play functionality, resource allocation is handled quite efficiently and should not be a major issue. While
ACPI is automated and does not require any intervention or alteration, one practical aspects of ACPI is
covered below.

INTERRUPT REQUESTS (IRQS)

Interrupt Requests (IRQs) are the way in which all of your major system devices get the CPU's attention for
instructions/interaction as often as necessary. There are usually 16 - 24 main hardware IRQs in a modern PC.

To view your current IRQ allocation go to Control Panel>Device Manager and under the View menu select
‘View Resources by Type', then expand the 'Interrupt Request (IRQ)' item. You will see all the devices
currently active on your PC arranged by IRQ number, starting at 0 [System Timer]. Under Vista you may see
IRQs numbered up to 190 or more, but all of the IRQ numbers above 24 appear to be for legacy Industry
Standard Architecture (ISA) or non-Plug and Play devices, not for your main system hardware.

Window Vista allows several devices to share an IRQ without any major issues, and in general this is fine. In
any case you can't alter the IRQ allocations from within Windows, as they are automatically handled by
ACPI Only legacy devices will have the option to attempt manual alteration of their resources under the
Resource tab of the relevant device Properties; most other devices do not allow the 'Use automatic settings'
option to be unticked. However you may have problems or reduced performance if two or more major
devices (such as the sound card and graphics card) share the same IRQ, so you should try to minimize IRQ
sharing.

To first check to see if any of your major hardware is sharing IRQs, you can go to each hardware device in
Device Manager, and see if any yellow exclamation marks appear for the device, indicating problems. Open
the Device Properties box (double-click the device or right-click and select Properties), then click the
Resources tab and see if any conflicts are listed under the 'Conflicting device list' box. You can also check
your IRQ listing and a summary of conflicting devices using the built-in System Information tool (see the
System Specifications chapter). To access it go to Start>Search Box and type "system information" (without
quotes) and press Enter. Expand the 'Hardware Resources' item in the left pane, and click the IRQ item to see
IRQs listed in order from 0 upwards. Click the 'Conflicts/Sharing' item to see a summary of sharing conflicts.
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Don't panic if you see conflicts, this doesn't mean your system is unstable or is going to run into major
problems. In many cases some hardware will be sharing a single IRQ and there's not much you can do to
prevent or alter this, it is normal behavior. However to minimize sharing, try the tips below.

Disable Unused Devices: IRQs and other system resources are typically assigned by your BIOS and set by
Windows Vista during the installation process. Usually they are next to impossible to alter in any significant
way, so the best way to ensure that you are less likely to end up with shared IRQs (and potential problems)
is to disable any unused devices in the BIOS before installing Windows Vista. However it is still useful to
disable these devices even after Vista is installed. Some examples of common devices that can be disabled - if
you're not going to use them - are:

»  Serial Portl (COM1)

= Serial Port2 (COM2)

» Parallel Port (LPT1)

= Game Port

=  Midi Port

*  Unused IDE Channels
= Unused SATA Channel
= RAID options

Disabling unused devices not only frees up unreserved IRQs and reduces the chances of sharing, it can also
speed up bootup time noticeably because Windows won't load up drivers for these devices. Clearly if you
already have, or plan to have, a piece of hardware connected to any of these Ports, or need to use a particular
device, then you should not disable them. For example if you have a printer which connects to the Parallel
Port (LPT1) then disabling the Parallel Port in the BIOS will simply mean your printer will not function. If
you have one or more IDE-based drives which connect to an IDE channel, then you cannot disable that IDE
channel and expect the drives to work. You can always re-enable these devices in the BIOS at any time, so
this is by no means a permanent disabling of particular devices. However you should only disable devices in
the BIOS that you are certain will not be used during your normal Windows usage.

Move Conflicting Devices: If you are using an existing installation of Windows Vista you can attempt to reduce
IRQ sharing by physically moving a device. Note however that on certain motherboards particular IRQs are
shared by default and cannot be changed. For example on many systems the USB Host Controller (for USB
peripherals) is often on an IRQ shared by another fixed system device, such as your Serial ATA Controller -
this is unavoidable and usually does not result in any problems. In such cases where you feel there may be a
conflict or reduced performance, your only course of action is to physically move one of the items to another
location on your system if possible. For example, if your sound card is sharing an IRQ with your graphics
card, physically shift the sound card from one PCI slot to another free one; if the USB Host Controller is
sharing with another device, avoid using the particular USB hub that controller relates to. If neither of the
shared devices can be physically moved then you will have to accept the situation. Remember that Windows
can share IRQs without major problems in most cases, and Vista is quite refined in this respect.

If after the above procedures you still have major difficulties which you feel are attributable to IRQ sharing,
the final option is to reformat and reinstall Windows Vista, making sure of course to first correctly configure
your BIOS and disable all unnecessary devices. Even then there is no guarantee that major devices won't
wind up being shared again. Unlike previous versions of Windows, you cannot disable ACPI to force
manual IRQ allocation, as Vista must have ACPI enabled to work.

DEVICE POWER MANAGEMENT

Aside from the global Power Options available under Control Panel and covered under the relevant section
of the Control Panel chapter, you can access individual device-specific power management settings in
Device Manager for certain types of devices (e.g. Keyboards, Mice and USB devices). To do so, open the
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Properties of any specific device and if there is a Power Management tab, click on it and you will typically
see two options, one or both of which are available:

Allow the computer to turn off this device to save power: This option lets Windows power management disable a
device if it considers it idle. However unfortunately USB devices in particular seem to have performance
issues if this option is ticked, so I recommend unticking it. If you're having problems unticking this option,
see this Microsoft Article.

Allow this device to wake up the computer: If selected, this allow the device to wake the computer up from Sleep
mode. It should be only enabled if you want that to occur, otherwise untick it. Note that if you are having
problems with a device waking the computer, see this Microsoft Article.

In most cases both boxes should be unticked for the least problems with a device, particularly USB devices.

REMOVE UNUSED DEVICES

For each device that has ever been connected to your system, Device Manager will retain a range of entries in
the Windows Registry relating to the device type, and the drivers and settings it used. That way if it is ever
reconnected it can be quickly recognized again. However there are times when you have permanently
discontinued the use of a device, or want the device to re-initialize, and you want to clean out the Device
Manager of any traces of it. To firstly view unused devices in Device Manager, do the following:

1. Open an Administrative Command Prompt - see Vista Usage Notes chapter.
Type the following lines exactly as shown, pressing Enter after each one:

Set devigr_show_nonpresent_devices=1
Devmgmt.msc

3. In the Device Manager window that opens go to the View menu and select 'Show Hidden Devices'. Now
expand all the categories and start looking through all the devices. Devices in gray are usually
old/unused and safe to remove by right clicking on each one and selecting 'Uninstall".

4. In particular, you might find several entries under the Monitors section from previous graphics driver
installations. You can typically delete all the greyed out entries but at least one un-greyed entry should
remain. You may also find old entries for previous graphics cards under the Display Adapters section
that again can be removed.

5. You should not remove any Microsoft devices such as those under the 'Sound, video and game
controllers' section, or devices that you are unclear about such as those listed under 'Storage volume
shadow copies'.

6. Once done, you can close Device Manager the usual way and the next time you open it up it will not
shown unused devices until you again use this method to do so.

Use this method with caution, making sure to create a new System Restore point beforehand. If you do
accidentally uninstall a hardware device which is currently connected to your system, in many cases you can
simply disconnect and reconnect the device, or reboot Windows, and it will be redetected by Windows and
the appropriate drivers installed again - so this method doesn't permanently remove any device such that it
prevents it from being detected or used again in the future usage.

In general I recommend making sure that your hardware and BIOS is correctly configured, clean and well
maintained otherwise no amount of software tweaking will resolve odd problems in Windows if they are
hardware based. The single most common reason for Windows problems is lack of adequate cooling, so if
you only do one thing, it should be to ensure your components are clean and cooled properly.
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WINDOWS INSTALLATION

The methodology behind the installation of Windows Vista has changed from previous versions of
Windows. Vista now uses an image-based installation method which is covered in this Microsoft Article.
Your Windows Vista installation DVD contains all the different Vista editions, and at the start of installation,
the Product Key you enter identifies which edition you've purchased and will be installing. Then as
installation begins, instead of selectively copying across a large number of individual files as XP did, a
complete compressed 'hardware neutral' image of a Vista installation is copied across to the target hard
drive, uncompressed and overwrites the drive contents. As the installation continues, Vista then identifies
your hardware and configures itself accordingly. This change in the underlying installation method has a

range of practical impacts which are discussed further below, and also in Microsoft Article.

This chapter covers a series of important things you should consider prior to installation, as well as all the
steps involved during the actual installation of Vista and immediately afterwards.

B PRIOR TO INSTALLATION

Before we move onto the Windows installation process, we first look at the various preparations you should
make and the issues you should consider prior to starting installation. Even if you've already installed Vista
some of the information in the chapter is still applicable and worth reading through.

CHECK YOUR HARDWARE FOR COMPATIBILITY

Just to be safe, before purchasing and installing Windows Vista, you should make sure that all your
hardware components are compatible with Vista and will run it reasonably well. To do so, check the Vista
Minimum Requirements and also use the Windows Vista Upgrade Advisor if you believe your system to be
borderline compatible. The Advisor scans your PC and will tell you if you will have any issues, and can also
help choose the version of Vista which suits you best. Also check this Vista Hardware Compatibility List to
see if your hardware is listed as having any issues or being incompatible with Vista.

DISABLE UNUSED RESOURCES IN THE BIOS

As covered in the BIOS & Hardware Management chapter, it is important to turn off any options and
resources in the BIOS which you will not be using prior to installing Windows Vista. This will ensure that
you minimize any shared resources in Vista, prevent the installation of unnecessary drivers, and help
minimize potential problems. Remember, you cannot manually reallocate IRQs and other system resources
to your hardware once Vista is installed, so don't skip this step.

SCAN FOR MALWARE AND PREPARE BACKUPS

If you are going to transfer any data or personal files from an existing installation of Windows to Vista, it is
strongly recommended that you do a complete malware scan of your existing Windows installation. This
ensures that you don't wind up copying across infected files which ruin your new installation of Windows
Vista. See the PC Security chapter of this guide or the TweakGuides Tweaking Companion for XP as relevant
for full details. Importantly, if you plan to run the Vista installation from your current install of Windows,
make sure to completely disable all background functionality of any antivirus programs after your scan, as
they may interfere with proper installation of Vista.

Once you've scanned and are sure that your files are clear of any malware, the next step is to prepare
complete backups of all your important information. This is covered under the Backup and Recovery chapter
of this guide. Regardless of which type of install you're going to undertake, even if you choose an Upgrade
install for example, I still strongly recommend having backups on disk or a separate hard drive prior to
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installation of Windows just in case anything goes wrong and you lose all the existing data on your drives. It
is genuinely much better to be safe than sorry.

MIGRATING FILES AND SETTINGS OR UPGRADE INSTALL

If you just want to move user accounts, data and settings from a Windows XP or Windows 2000 machine to
your current Windows Vista installation in an automated manner, you can use the Windows Easy Transfer
utility. To access Windows Easy Transfer, go to Start>All Programs>Accessories>System Tools, or go to your
Start>Search Box and type "windows easy" (without quotes) and hit Enter. You will enter a migration wizard
which will take you through the steps required to carry out the migration. For full details of how to handle
the migration, see this Microsoft Article. To successfully migrate between two machines you will need either
a removable hard drive, a USB 'Easy Transfer' Cable, be connected to the same network (not counting the
Internet), or use CDs/DVDs. The categories of things you can migrate are:

* Files and folders

* E-mail settings, contacts, and messages
* Program settings

= User accounts and settings

* Internet settings and favorites

* Music

*  Pictures and video

If you don't want to transfer settings and files between two different machines, and instead you want to
install Windows Vista over the top of an existing installation of Windows while maintaining all your files
and settings, you will need to commence installation of Vista from within your current version of Windows
as detailed under the Installing Windows section further below. Then when you reach Step 5 below select
the Upgrade option and continue from there.

For home users I don't recommend migrating or doing an upgrade install and transferring user accounts,
files and settings in this manner. Vista's new image-based installation method is quite sound compared to
prior versions of Windows, and hence an upgrade install is not likely to cause problems. However to ensure
that you have a clean slate to begin with, I still recommend on balance that you start with a full clean install
of Vista, and then manually copy across only the files you need. If you insist on using the transfer tool or
doing an upgrade install, I strongly recommend only transferring personal files, not any settings or user
accounts.

MODIFYING THE WINDOWS INSTALLATION DISK

Vista's image-based installation system allows easier creation of a modified installation disk. The tools you
need to do this are in the Windows Automated Installation Kit and combined with these ImageX commands
you can generate and alter a new Windows Vista disk image which may incorporate the latest drivers or
other updated components, or remove unnecessary components, for use in future installations.

The easiest method to alter your Vista installation image is to use vLite. vLite is a free automated utility for
creating a custom Windows Vista disk image for use in installation, a method also referred to as
Slipstreaming. It allows you to select the components you wish to remove from Windows, as well as things
you would like to add, such as Windows Updates, the latest drivers and so on. Once you have integrated the
relevant components and removed the components you don't need, vLite generates an ISO file which you
can burn onto CD or DVD and use as your Windows Vista installation disk.

I encourage you to experiment with vLite, however I strongly recommend that you research what you are
doing before using this tool. Don't simply remove something from the Vista installation disk because you
think that it somehow 'speeds up' your PC. Removing most components simply reduces disk space, it
doesn't increase speed in the majority of cases. Removing Internet Explorer 7 for example is more likely to
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cause problems and doesn't speed up your PC in any way at all. Removing certain other features may
appear intuitive at first, but also have unintended results. For example removing the TabletPC features of
Vista also winds up removing the very useful Snipping Tool (see the Control Panel chapter); removing
Windows Defender also removes access to Software Explorer (see the Startup Programs chapter). Don't fall
into the trap of thinking that it is cool to strip out virtually every component of Windows and replace it with
a third-party alternative - you are more likely to cripple desired functionality in Vista inadvertently or cause
other problems for yourself down the track.

I recommend instead that you install Vista as normal, or use vLite to add useful components to the Vista
installation disk, then later you can remove particular Windows components using the built-in Programs
and Features utility (See the Control Panel chapter) or disable them as required. That way if you want any
component back at any time, you can reinstall or re-enable it again very easily, whereas removing them
permanently during installation can make things difficult. In any case if you need further help with vLite
check the vLite Forums.

Importantly: Be aware that Vista's image-based installation system means that you face greater exposure to
malware if you use a downloaded Vista installation image which you yourself have not created. Do not
download or use any untrusted installation images as you could be installing serious malware on your
system in the process, bypassing all security measures.

B PREPARING THE HARD DRIVE(S)

Before you can install Windows, you need to think about how best to configure your hard drive(s) for
optimal performance and the functionality to properly meet your needs. This includes considering whether
you want to (re)format or partition any of the hard drives, whether you want to use a RAID configuration,
and whether you want to dual boot Vista with another OS. It is also much easier to partition and format hard
drives prior to Windows installation, though you can still do it after you install Vista. Make absolutely
certain to read the following information before proceeding with Windows installation.

DUAL BOOT OR MULTIBOOTING

Windows Vista is a relatively recent OS and is known to have some compatibility and driver issues, so you
may wish to consider a dual boot configuration of Vista along with your existing version of Windows such
as XP or 2000. This will allow you to use both operating systems on one machine, with a Boot Menu letting
you select which to boot into each time your PC starts up. Such a configuration does not provide any
performance benefits, it is simply designed to allow two or more different operating systems to reside on the
same machine, totally isolated from each other. If you only want Windows Vista on your PC, you can skip
this procedure.

The instructions for creating a dual boot/multiboot system in Vista are in this Microsoft Article, and more
specific details and tips are in this Dual Boot Configuration article. Essentially, you need to have at least two
or more partitions on your current hard drive and/or have two or more hard drives (See further below for
partitioning information). You should then boot up into your existing version of Windows and insert the
Windows Vista DVD and run Vista setup from there. This ensures that Vista will 'see’ your existing
Windows installation and configure the boot menu properly to give you the choice of booting into either OS
- see the Boot Configuration chapter. Importantly, if you run SATA or RAID hard drives, for Vista to
correctly identify all of your hard drives prior to installation and correctly configure the dual boot, you must
have appropriate SATA/RAID drivers on a floppy disk or CD/DVD and insert them during the hard drive
identification stage of Windows Setup.

In general I recommend having Vista and an older version of Windows on completely separate hard drives,
as this causes the least number of problems, particularly if you want to remove the older version of
Windows eventually. Performance is also improved if each OS resides on the first primary partition of a
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different hard drive, so for optimal performance in Vista, do not install it on a secondary partition of any
hard drive - see below for more details. Some important things to note about dual boot setups:

* It is strongly recommended that you install the older version of Windows first (or it must already exist)
before installing Vista. It is possible to install Vista first and then install an older version of Windows
afterwards, but this requires more risky boot configuration editing - see the Boot Configuration chapter.

= If your older version of Windows is the active partition on the first boot drive (the drive or partition
which is first booted up by your BIOS), then it will be altered to include Vista's boot manager files. If you
delete or damage these boot files, or you remove the older OS, then you will need to boot from the Vista
DVD and run Startup Repair to fix Vista's boot configuration, otherwise it will not bootup properly - see
the Backup and Recovery and Boot Configuration chapters.

= If you want to remove Vista from a dual boot arrangement and return the boot record of your earlier
version of Windows to its normal state, see the Boot Configuration chapter for details.

PARTITIONING

During the formatting of your hard drive, you have the option of also partitioning your hard drive.
Partitions are simply fenced-off portions of a hard drive. By partitioning a drive you can effectively divide a
single hard drive into several smaller logical drives of varying size, each with their own drive letter. For
details on the potential advantages, disadvantages and optimal methods for partitioning, see this Partition
Strategy Guide. If you're still not certain and you just want to install Vista on a single hard drive, I strongly
recommend having a single partition (the default setup) as this keeps things simple and performance will be
optimal.

On any hard drive the first Primary partition is always the fastest, and performance is still limited by how
fast the single hard drive head can seek (move around to read or write) information. It can't be in two places
at once, whereas with two physically separate hard drives, each hard drive's head can seek information
independently, such as one drive reading game information while the other concurrently reads/writes
virtual memory information in the pagefile. Therefore partitioning is not a true substitute for having two or
more drives, it is most useful as an organizational tool. For example one of the major reasons you may wish
to create multiple partitions is to allow you to dual boot with Windows XP and Windows Vista, as discussed
under the Dual Boot or Multibooting section above. This allows you to run Vista along with XP on the same
hard drive for example, but completely separated from each other.

It is ideal to format and partition a hard drive prior to starting Windows installation, and you can do this
either using a third party tool as covered further below, or you can use the built-in formatting and
partitioning functionality of XP or Vista under the Administrative Tools>Computer Management>Disk
Management utility. The instructions for Windows XP are in this Microsoft Article, and the instructions for
Vista can be found below and under the Computer Management section of the Control Panel chapter in this
guide. You can also access these features by booting from the Vista setup disk and following the installation
process covered further below up to Step 6.

Furthermore in Windows Vista, you can not only create partitions during the normal formatting process (see
further below), you can also repartition a hard disk on an existing installation of Vista. To add partitions in
Vista follow these instructions:

1. Go to Control Panel>Administrative Tools>Computer Management or go to Start>Search Box and type
"computer management" then press Enter.

2. In the Computer Management box, click the 'Disk Management' item in the left pane.

3. Select the hard drive for which you want to alter a partition from the list at the top of the screen.

4. Right-click on the drive and select 'Shrink Volume' - this will "shrink" the existing partition, freeing up
space for a new partition(s) to be made.

5. In the next dialog box enter the amount in MB you want to use for the new partition; the maximum
amount available is the amount of free space left on the hard drive.
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6. When done, click the Shrink button and the existing partition will be reduced by the amount you chose
above.

You can now create a new partition in this freed up space. There are a range of other functions possible
under Disk Management, but these are covered in more detail under the Control Panel Chapter.

If you use multiple partitions across a range of hard drives and you are after a utility that will make partition
management easier, the most reputable one is Norton Partition Magic. It is not free, and I will not be

covering it in detail here, however if you wish to undertake complex partitioning of your hard drive(s) it is a
worthwhile investment. Note that Vista uses a newer version of the NTFS File System (see below), so you
may have issues if you partition your hard drive using an older partitioning tool like Partition Magic. It
would be best to stick to using Windows partitioning tools wherever possible as detailed above.

Finally, keep in mind that using multiple partitions on the same drive for backup purposes is not a good
substitute for having backups of your important data on CD/DVD or another hard drive. Hard drives can
and do become physically corrupted and this affects data on all partitions of a drive, so backing up from one
partition to another on the same hard drive as your main backup strategy is not appropriate. However
partitioning a single drive to create a recovery partition for Startup Repair for example can provide useful
additional protection. See the Backup and Recovery chapter for more details on these topics.

RAID CONFIGURATION

RAID (Redundant Array of Independent Disks) is a common method of configuring multiple hard drives to
perform better and/or provide better protection against data loss than a single hard drive. The various RAID
levels are best demonstrated in this RAID Article - click the numbers at the top right of the article to see the
various RAID levels demonstrated graphically, including RAID 0, RAID 1, RAID 5 and RAID 0+1.

To set up a RAID array you need two or more hard drives, preferably of the same size and speed, and a
motherboard with RAID support. You will then need to connect the drives and configure the appropriate
RAID options in your motherboard's BIOS (include any 'RAID BIOS' options) - see your motherboard
manual for instructions. If your motherboard supports RAID, there is no additional hardware required, it is
all driven by Windows and the motherboard. Once configured correctly, the RAID configuration of multiple
drives will be seen as a single large hard drive by Windows, and treated as such.

To determine which RAID configuration best suits your needs, you will need to read the articles linked
above and consider your most common PC tasks. The most commonly used RAID array is a pair of similar
drives in RAID 0 formation, which provides the best all-round performance at minimal cost. RAID 0 usually
beats any single hard drive configuration in terms of speed, particularly for gaming or large file movements,
due to there being two independent drive heads constantly seeking data in place of one. However RAID 0
also provides absolutely no fault tolerance at all, meaning if one of the drives suffers a serious error or is
damaged, you lose all the data on both drives since the data is split evenly ('striped’) across both drives.
Therefore if you require stronger protection against data loss, you might want to consider a RAID 5
configuration which is more costly, but far safer and still provides good performance for desktop PC usage.

While setting up striped RAID arrays - that is, RAID arrays which split data evenly across two or more hard
drives (such as RAID 0 or RAID 5), you will need to determine a Stripe Size to be used in your RAID BIOS.
In general, if you are uncertain of the size to choose, use the Auto setting (if available) or a 64kb stripe. If you
use the drives primarily for gaming I suggest a smaller stripe size of 16kb, as in my experience this can assist
in reducing stuttering in games.

In any case once you have connected your drives and set up your RAID array using the options in the
motherboard's BIOS, you will need to have a floppy disk, CD or DVD handy with the correct RAID drivers
prior to starting the Windows Vista installation procedure. Then during Windows Vista installation, on the
screen where you select which drive to install Vista onto, if your RAID hard drives are not detected and
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shown as a single logical drive with the correct size and volume name, you will need to click the 'Load
driver' link, insert the appropriate SATA/RAID driver disk, load up the relevant drivers, then click Refresh
on the drive selection screen. If you miss this step, the RAID hard drives may not be correctly detected by
Windows Vista as one large hard drive, and you will not be able to install Windows on them properly or you
will break the RAID array and lose the benefits of RAID.

Once Vista is installed on your RAID drives, from that point onwards there are no special considerations as
such; the drives are treated as one large normal hard drive for all intents and purposes in Windows.

FILE SYSTEMS

During the formatting of your hard drive and/or its partitions, you can choose to format using the NTES (NT
File System) or FAT32 (File Allocation Table) File System. The file system used on a hard drive determines
how the drive will store and organize data, so it is an important choice. You can see a comparison of the two
file systems in this Microsoft Article. Windows Vista actually uses an enhanced version of NTES called
Transactional NTFS which allows Vista to perform single and multiple file operations more securely and
with greater data integrity. This new version of NTFS also allows other changes, such as Directory Junctions
and improved searching - see the Windows Explorer and Windows Search chapters for details.

In general your hard drive(s) should be formatted in NTES only. The only possible reason for using the
earlier FAT32 file system on a hard drive or partition would be for compatibility purposes if considering
installing an older version of Windows, such as Windows98. If you want to convert an existing FAT32 drive
or partition to NTES, it is strongly recommended that you reformat the drive in NTFS. However if that is not
possible or not desirable, you can convert the FAT32 drive to NTFS using the instructions in this Microsoft
Article.

32-BIT VS. 64-BIT

The final choice to make is whether you install Windows Vista 32-bit (also called x86) or 64-bit (also called
x64). The following things should be considered when deciding whether to install 32-bit or 64-bit Vista:

= Vista 64-bit only runs on 64-bit Processors. Most recent CPUs are 64-bit, but specifically all Intel Pentium
D, Xeon, Core 2 and Extreme Edition CPUs or newer, and all AMD Turion, Opteron, and Athlon64 or
newer support 64-bit computing. Refer to this CPU List for more details. If your CPU is not 64-bit
capable then you cannot install or use Vista 64-bit.

=  Vista 64-bit requires that all device drivers be designed specifically for 64-bit and that they be signed.
Vista 64-bit cannot use 32-bit drivers, and can only use unsigned drivers with a tedious workaround at
each bootup. This can mean that some older or less popular hardware may never receive 64-bit signed
drivers, because of the extra costs to the hardware manufacturer of development and having them
signed. See the Windows Drivers chapter for more details.

*  Vista 64-bit can use more than 4GB of RAM efficiently, as the 4GB RAM limit is a technical limitation of
the 32-bit architecture. See the Boot Configuration chapter for more details.

* Vista 64-bit does not support 16-bit programs, and while it can use all 32-bit programs, there are usually
no performance benefits when doing so. Only programs designed specifically for 64-bit computing will
have improved performance under Vista 64-bit, and right now there are not that many such programs.

As you can see, it appears the drawbacks of Vista 64-bit tend to outweigh the benefits, mainly due to the
smaller user base for 64-bit operating systems, and hence the less software and drivers are developed
specifically to take advantage of it. For more details of 64-bit computing see this Wikipedia Article, and also
see this Microsoft Article. I recommend that most users install Vista 32-bit for maximum compatibility and
performance under a variety of conditions. There are few practical benefits from installing Vista 64-bit, and if
anything there is far more potential for problems, especially driver-related problems which are next to
impossible to resolve without obtaining newer or better drivers.
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Importantly, most editions of Vista do not come with a 64-bit Vista DVD; only Vista Ultimate contains the
64-bit DVD along with the regular 32-bit DVD. You will need to either specifically purchase the 64-bit
version of a particular edition of Vista, or order a 64-bit installation DVD as detailed in this Microsoft Article.

B INSTALLING WINDOWS

At this point you are ready to begin the actual format and installation process for Windows Vista. This
section details the procedures required to install Vista, but it also assumes you have read all of the sections
above and considered which options suit you best. It is strongly recommended that you take the time to
research and consider factors such as whether you want a dual boot configuration, the number of partitions
and/or whether you wish to use a RAID configuration prior to starting the installation process. There is no
point rushing the installation, only to have to go through it again because you overlooked something.

The official Vista installation options are covered in this Microsoft Article. You can also see more detailed

instructions of how to install Windows complete with screenshots using one of these guides:

Vista Upgrade Install Guide
Vista Clean Install Guide
Vista Dual Boot Install Guide

I will still run through the installation procedures step by step below, noting the various options available
depending on what particular type of installation you wish to do, and include any recommendations I have:

STEP 1 - START THE INSTALL

There are two main ways to start Windows Vista installation depending on the type of install you want:
Upgrade Install or Dual Boot

An Upgrade Install or Dual Boot installation of Vista will require that you first load up your existing version
of Windows and then insert your Vista DVD and run setup.exe on the disk if Setup doesn't run automatically.
This is necessary for Vista to correctly identify your existing version of Windows. If you are going to do an
Upgrade Install of Vista over an existing installation of Windows XP or Windows 2000 (not recommended -
see further above for details), first check this table of qualifying versions as some editions of XP/2000 cannot
be upgraded to certain editions of Vista in this manner.

Clean Install

A Clean Install of Windows Vista will erase all data on the target hard drive or partition - it will not transfer
any existing files or settings on that drive. Make sure you have backed up all your data appropriately. To
start a Clean Install, go into your BIOS and set your DVD drive as the first boot device, and make sure all
your hard drives are correctly connected, configured and detected in the BIOS. Then insert your Vista DVD
in the DVD drive and reboot your system, pressing any key when prompted on the screen to boot up via the
DVD drive.

Note: If you are using an Upgrade Edition DVD of Vista, normally you can only do a clean install of Vista by
first booting into an existing qualifying version of Windows, then selecting either an Upgrade Install or a
Clean Install as above. However there is a method which allows you to do a clean install by booting up from
your Vista DVD on a newly formatted hard drive. Refer to this article for details and note that it is legal only
if you actually qualify to install an Upgrade Edition by owning the correct previous version of Windows.
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STEP 2 - INSTALL NOW

On the first Vista Installation screen, if you booted from the Vista DVD you will be asked to select your
Language, Time & Currency Format and Keyboard method. Set these correctly and click Next.

Once you've done this, or if you started Vista installation from within an existing version of Windows, the
next screen you will see should have a large 'Install Now' button. Click this to start installation.

Note: If you aren't certain of your hardware compatibility with Vista or you want to migrate your settings
from your current install of Windows to Vista (See Migrating Files and Settings further above), then click the
relevant link. The migration link only appears if you launch the Vista setup from within an existing install of
Windows. Alternatively if you booted up from the Vista DVD, the 'Repair your computer' link will be shown
instead, and its functionality is covered under the Backup and Recovery chapter.

STEP 3 - GET IMPORTANT UPDATES

You will be prompted to check for important updates prior to installation. If you are connected to the
Internet, it is recommended that you get the latest updates now, but this can be done later manually so it is
not critical.

STEP 4 - ENTER PRODUCT KEY

You will be prompted to enter your 25 character Vista Product Key. This Product Key identifies the edition
of Vista you purchased. If you don't enter your key, you will be able to choose any version of Vista to install,
and there is also a method for extending your Activation grace period to 120 days from within Vista such
that you can test these other editions - see the Windows Product Activation & Validation chapter. Unless
you want to undertake such a trial, or you still expect to make changes to your hardware configuration, I
recommend entering your key now and ticking the 'Automatically activate Windows when I'm online' box.

STEP 5 - UPGRADE OR CUSTOM INSTALL

You will then be prompted to accept the End User License Agreement (EULA), which you should read and
accept if you wish to continue installation. More details of the EULA conditions are in the Windows Product
Activation & Validation chapter.

At this point, you will get the choice to do an Upgrade install or a Custom (Advanced) install which
translates to a clean installation. The Upgrade installation option should only be chosen if you want to do an
Upgrade install; all other configurations including dual boot should choose the Custom option.

If you do choose an Upgrade install, you will be given a Compatibility Report indicating which of your
currently installed programs and drivers may be problematic under Vista, and you can stop installation at
this point without any problems or changes to your existing Windows install if you feel there are too many
issues identified. If you choose to proceed with the Upgrade installation, the procedure will be similar to that
outlined in the steps below, but not exactly the same, since for starters the target drive has to be the one on
which your current install of Windows is sitting. Once again, an Upgrade installation is not recommended,
however it should usually not be problematic given Vista's new installation method.

STEP 6 - SET TARGET DRIVE

The next screen is an important one, as it allows you to choose the logical drive where Vista will be installed.
You should see a list of all the existing drive(s) correctly displayed in the format: Disk [No.] Partition [No.]
[volumename] [driveletter]. If the drive(s) are not correctly identified, or are unformatted, then you will see
something like 'Disk 0 Unallocated Space' as the title.
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If you have SATA or RAID configured hard drives, to ensure that they are correctly identified, you will need
to click the 'Load driver' link at the bottom of this box, and then insert an appropriate Floppy Disk, CD or
DVD containing your SATA/RAID drivers and load all the relevant controller drivers needed. Once done,
click the Refresh link at the bottom of the screen and your drives should be shown correctly. If they still
aren't then you may have to abort installation (click the red X button at the top right of the screen) and either
get more appropriate drivers from your motherboard manufacturer's website and/or check your BIOS to see
if the drives are configured correctly. If Vista does not detect your drives properly at this stage you will
either be unable to install Windows, or the installation will not work as intended especially if you are
attempting a dual boot configuration or using a RAID configuration.

If you booted up with the Vista DVD you can choose to format or partition any hard drives here by
highlighting the relevant drive and clicking the 'Drive options (advanced)' link at the bottom right of the
screen. Note that this option is not available if you started setup from within Windows, so if necessary abort
installation and follow the steps under the Partitioning section further above if you want to partition your
drives for a dual boot configuration.

If your drives are partitioned and formatted the way you want them and are detected correctly, highlight the
relevant drive or partition to which you want to install Windows Vista. Remember that if you want to create
a dual boot configuration, your existing version of Windows and Vista must be on separate partitions or hard
drives, so select the drive/partition on which your current install of Windows is not resident otherwise you
will simply wind up overwriting (deleting) your existing Windows install.

Once the suitable logical drive is selected, and you are certain you want the installation to proceed, click the
Next button. Any existing contents of the target drive or partition will be lost as Vista installs over it. Note
that Vista does allow resizing and repartitioning from within Windows, so you can alter your partitions to
some extent in the future without having to reinstall - see the Computer Management section of the Control
Panel chapter.

STEP 7 - AUTOMATED INSTALLATION

From this point on, no user interaction is required for some time as Vista begins to copy across the
compressed image of itself to your target drive, expands it and configures the required features and updates.
Your PC will then restart and will complete installation before rebooting again.

STEP 8 - BASIC USER SETUP

Vista will then commence on the final phase of the installation which requires your input. Each section is
covered below:

User Account details: This is quite important. You will be asked to enter your preferred Username and
Password for the first User Account on this system. This User Account will have Administrator privileges -
see the User Accounts section of the Control Panel chapter and the User Account Control section of the PC
Security chapter for details. The User Account Username will also be used to label the root directory of your
personal folder, so choose something relatively simple but descriptive. If you share this PC with others, want
to have multiple user accounts, if the PC is physically accessible by others you don't trust, or you simply
have security concerns, then enter a password. If this is not the case for convenience's sake I recommend not
entering a password (leave the Password fields blank and click Next) for the moment. You can always
change these settings later. Select a user picture, and note that this too can be easily customized to any image
of your own choice later. These details are covered under the User Account section of the Control Panel
chapter.

Computer Name & Wallpaper: The computer name is primarily for identifying the PC in a network of
computers. As such you should not need to change this, the default of [Username]-PC should be fine for a
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home PC. You can also select a background wallpaper for your Windows Desktop here. Once again this can
be easily customized to any image of your choice later as covered under the Graphics & Interface chapter.

Important Updates: You will be asked to configure Vista's basic security and online update settings. To
maintain good security during the initial startup period I recommend clicking the 'Use recommended
settings' option at the top, as we will modify all these options later in the guide anyway.

Time and Date: Set your correct time zone, time and date, and also I recommend ticking the 'Automatically
adjust clock for Daylight Saving Time'.

Computer’s Current Location: This screen asks you to set your location for networking/Internet connectivity
purposes. The options are Home, Work or Public Location. However ironically, for the average standalone
home PC connected to the Internet the best choice is actually 'Public Location' not Home, as this allows you
to connect to the Internet with full functionality but maintains tighter security. You can customize these
settings later as covered under the Network & Sharing Center section of the Control Panel chapter.

STEP 9 - WINDOWS EXPERIENCE INDEX & STARTUP

Vista then launches into its final setup phase, which may take a while, during which your system
performance is measured by the Windows System Assessment Tool to determine your hardware's Windows
Experience Index, and hence whether certain features will be enabled or not - see the Performance
Measurement & Diagnostics chapter for details. You will eventually reach the Welcome Center, which you
can browse or close immediately as it is not a particularly necessary feature. You will be able to disable the
Welcome Center from running at startup each time by unticking the small 'Run at startup' box at the bottom
left of the Welcome. If the box is unavailable it should be there upon the next bootup.

At this point you can continue with the rest of the guide, but a few things to keep in mind:

* Make sure to go into your BIOS and reset your hard drive(s) as the first boot device if you had set your
DVD drive as the first boot device for installation purposes.

=  Make sure to remove the Vista DVD and any floppy disks from your drives before rebooting.

* Limit any Internet browsing or other online activities until you've gone through the PC Security chapter.

* Don't Activate your PC straight away if you plan to make any major physical changes to the hardware
configuration of your PC, or if you believe you'll be reinstalling Vista again within the next 30+ days;
wait until you've bedded down your configuration before activating. This is because multiple activations
within a short period of time are viewed as suspicious by Microsoft - see the Windows Product
Activation & Validation chapter for details.

Since this guide has been designed to cater to both those who are doing a new installation of Vista, and those
who are using an existing installation of Vista, it follows a roughly sequential order as to the types of things I
would recommend configuring after doing a new installation, but any chapter can also be read by itself if
you want to focus on a particular topic first. I would however strongly recommend becoming familiar with
the contents of the Windows Explorer and PC Security chapters as soon as possible, along with (re)reading
the Vista Usage Notes chapter at the start of this guide.
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BOOT CONFIGURATION

Windows Vista has a different bootup configuration than earlier versions of Windows. Instead of using a
simple Boot.ini file as in Windows XP, Vista has a special Boot Configuration Data (BCD) database to hold all
the relevant bootup parameters, and to allow compatibility with new bootup methods. However this change
also makes boot configuration and editing much more tricky. Editing the boot configuration is particularly
important if you've installed a dual boot setup of Vista as covered in the previous chapter. For the most part,
you should not need to edit or alter the Vista boot configuration unless you're troubleshooting a system
problem, attempting to use more than 4GB of RAM, or you want to alter specific parameters or repair a dual
boot or multiboot setup. There are several ways you can view and modify your Vista boot configuration, and
each is covered in more detail below.

B BCDEDIT

BCDEdit is a built-in command line tool for altering the boot configuration in Vista. To use it, open an
Administrator Command Prompt (see the Vista Usage Notes chapter). The full list of BCDEdit command
line options is in this Microsoft Article. Given it is a more complex tool to use, it is not recommended that
you edit the boot configuration this way - I recommend using the tools below at least to start with.

B STARTUP AND RECOVERY

The easiest method to alter your basic bootup options is to go to Control Panel>System>Advanced System
Settings, or go to Start>Search Box and type "systempropertiesadvanced" (without quotes) and press Enter.
Then click the Settings button under 'Startup and Recovery'.

In the Startup and Recovery box, under System Startup if you want a Boot Menu to be shown when your PC
first loads with a list of all installed Operating Systems, tick the "Time to display list of operating systems'
box and in the box next to it choose how many seconds you want the Boot Menu to remain on screen before
it automatically loads up the default OS. If on the other hand you don't want a boot menu to be shown at all,
and want the default OS to load up straight away, untick the box.

The 'Time to display recovery options when needed' box should be ticked, and a reasonable amount of time
entered, such as 15 seconds or more. The recovery options menu will only appear if you run into problems
with Vista, and its features (such as Safe Mode) are covered under the Backup & Recovery chapter.

B MSCONFIG

Another way to alter boot configuration is to use the Microsoft Configuration utility (MSConfig). Go to
Start>Search Box and type "msconfig" (without quotes) then press Enter. Go to the Boot tab of MSConfig and
you will see under the '‘Boot Options' section there are several options for altering the way your PC boots up.
These are primarily used for troubleshooting purposes. Highlight the install of Windows Vista you wish to
alter then you can select one of these options to apply to it:

Safe Boot: If selected, the next boot will be into Safe Mode, as covered under the Backup & Recovery chapter.
Default Safe Mode is called Minimal; 'Alternate Shell' is Safe Mode with Command Prompt instead of GUL;
'Active Directory repair' is Safe Mode with GUI and Active Directory; Network is Safe Mode with GUI and
Networking features enabled.

No GUI boot: Removes the default Windows Vista 'scrolling bars' startup screen when booting up, replaces it
with the Aurora image. See the Graphics & Interface chapter for more details on how to customize the boot
screen.

uoneindyuo)) j00g

Copyright © 2007 Koroush Ghazi 5 9


http://technet2.microsoft.com/WindowsVista/en/library/85cd5efe-c349-427c-b035-c2719d4af7781033.mspx?mfr=true
http://technet2.microsoft.com/WindowsVista/en/library/08d64d13-4f45-4a05-bd86-c99211a93dd91033.mspx?mfr=true

e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

Boot log: Records all bootup information in a logfile stored under your \ Windows directory as Ntbtlog.txt.

Base video: Boots up Vista using the standard Windows graphics drivers rather than the specific video driver
for your graphics hardware.

OS boot information: Shows the names of all the drivers as they're being loaded during bootup.

The Timeout value in the box on the right is the same as the 'Time to display a list of operating systems'
setting covered under 'Startup and Recovery' further above - it controls how long the boot menu for
multiboot systems is shown.

If you click the 'Advanced Options' button you will see more advanced bootup options for troubleshooting;:

Number of processors: If you have a multi-core CPU, you can tick this option and manually force all, some or
only one of the processors (cores) on the CPU be detected and used by Windows.

Maximum Memory: Allows you to manually force Windows to only use a certain amount of RAM on your
system, up to and including your full physical RAM amount. Amount entered is in KiloBytes (KB).

PCI Lock: Stops Windows from dynamically assigning system resources to PCI devices. The devices will use
the BIOS configuration instead.

Detect HAL: Forces Windows to redetect the Hardware Abstraction Layer (HAL) in case your hardware is
incorrectly being detected/reported.

Debug: Starts Windows in debugging mode.

Once done selecting which bootup options you wish to apply to the boot configuration, click the Apply
button then OK, and these option(s) will come into effect on next boot. Should you wish to apply any
permanently, I recommend using BCDEdit or VistaBoot Pro rather than leaving them enabled in MSConfig.

B THIRD PARTY TOOLS

Aside from the built-in tools above, there are a range of third party tools you can use to do what is covered
above more easily.

VISTABOOT PRO

VistaBoot Pro is a tool for editing the boot configuration in Vista using a graphical interface and does not
require detailed knowledge of how the BCD works. Upon installation you will be prompted to make a
backup of your BCD database, which is strongly recommended before you do anything else. Should
anything go wrong with the BCD, you can go to the Backup/Restore Center button and restore your backed
up BCD files.

VistaBoot Pro has a wide range of functions, but we'll cover only the major ones here. On the main 'View
Settings' screen in VistaBoot Pro you can see a summary of the data held in the BCD. If you have a dual or
multiboot setup, you should see all the operating systems listed with the correct drives shown. You can
expand this display by clicking the Detailed or All options at the top of the screen. This is useful for
troubleshooting, and also gives you some idea of the kind of data held in the BCD.

If you want to alter these entries, click the 'Manage OS Entries'. Here you can set the default OS and the
timeout, though these are best altered using the normal Vista Startup and Recovery options as covered
further above. Most interestingly, you can rename the OS entries which show up in the Boot Menu. By
default, Vista insists on calling your older operating system 'Earlier version of Windows' in the Boot Menu,

uoneindyuo)) j00g

Copyright © 2007 Koroush Ghazi 6 0



http://www.vistabootpro.org/

e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

and it calls Vista simply 'Microsoft Windows'. To help prevent confusion and make things neater, click on
each OS listed and tick the 'Rename selected operating system' checkbox - new options will appear allowing
you to provide a new name and also change the drive letter if necessary. For example I've renamed my listed
OSes so that one says 'Windows XP' and the other says "'Windows Vista'. You can also add a new (Windows)
OS listing here by ticking the 'Add new operating system entry' option and filling in the details. Finally, you
can change the order in which the OSes are listed by highlighting the relevant OS and using the up or down
arrows to the right.

The 'Advanced Settings' include various advanced features which the MSConfig utility can also accomplish,
and these are covered further above. Some useful features you can use VistaBoot Pro for are:

Allow use of Unsigned drivers: By default the 64-bit version of Vista only allows signed drivers to be installed.
Ticking this option attempts to override that limitation - has no impact on 32-bit Vista editions.

PAE Enabled: If ticked enables Physical Address Extension (PAE) in Vista. This is necessary for correct
memory detection if you have more than 4GB of RAM in the 32-bit version of Vista.

DEP On: Data Execution Prevention (DEP) is on by default, but can be turned off here. DEP is covered in
more detail in the PC Security chapter and generally should not be disabled.

Finally, the Bootloader section of VistaBoot Pro allows you to attempt to fix any problems with the Vista
bootloader, or to uninstall it if you've removed Vista from your system and you had a dual boot
configuration. By default, simply deleting/reformatting/removing the Vista drive or partition in a dual boot
configuration may cause problems since Vista's bootloader is still resident on the older version of Windows.
This option lets you to remove the bootloader so you can boot into your older OS as normal.

VistaBoot Pro is a very useful tool for BCD editing, however if in doubt do not alter any settings, and if you
wind up damaging your BCD or any other Vista boot files, use the Startup Repair functionality of Vista to fix
the problem (See the Backup & Recovery chapter), or see the instructions here.

EASYBCD

EasyBCD is another free automated utility which makes editing the Vista boot configuration much easier.
However it is virtually identical to VistaBoot Pro in terms of its major features and functions, so it will not be
covered in detail here. You can use either utility to achieve much the same results.

B BOOTDISKS

As mentioned in this Microsoft Article, Windows Vista does not use Boot Disks any more; the original Vista
DVD is effectively a boot disk. If you're having problems booting up Windows, you can boot up using the
original Vista DVD then use Startup Repair to automatically detect and repair any issue preventing proper
Windows startup. You can also access the DOS Command Prompt in the Vista Recovery Tools if necessary.
Details of these functions are covered under the Backup & Recovery chapter.

If you still want to create a Vista bootup floppy disk, you can do so according to the details here. If you want
to start up your PC in very basic DOS mode and the Command Prompt mode of the Vista Recovery
Environment is not appropriate for some reason, there are a range of bootdisks you can download here.

Ultimately there really shouldn't be a reason to alter your boot configuration under normal circumstances so
I would approach the use of the tools above with caution, and initially rely on the automated Startup Repair
feature of the Vista DVD itself to troubleshoot any bootup problems before moving on to other methods of
altering the BCD.
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WINDOWS PRODUCT ACTIVATION & VALIDATION

To confirm that you are running a legitimately purchased copy of Windows Vista in accordance with the
terms of the End User License Agreement (EULA), Microsoft relies on Windows Product Activation, a
process which verifies your Product Key and hardware configuration online or over the phone. While
activation has been around since Windows XP was introduced, some of the measures surrounding it have
been tightened as part of the new Microsoft Software Protection Platform. This chapter looks at how
Activation and Validation work, though note that I don't cover any illegal methods of bypassing Activation.

B LICENSING AGREEMENT

The End User License Agreement (EULA) for Windows Vista contains the terms and conditions of
acceptable usage for the OS. You do not actually own Windows Vista outright; Microsoft gives you

permission (a license) to use the software under certain terms and conditions.

OEM VS. UPGRADE VS. RETAIL EDITIONS

While their contents do not differ, there are some notable differences between the license conditions for OEM
(Original Equipment Manufacturer) copies of Vista - sometimes called 'System Builder' editions - versus the
Upgrade editions, vs. the Retail editions:

OEM: An OEM edition of Vista comes pre-installed on, or accompanying, a new PC and is bound specifically
to that PC. If you substantially alter or upgrade the PC on which the OEM copy is installed (e.g. change the
motherboard and CPU), or you attempt to install the OEM copy on another PC you will fail activation since
you have breached the licensing conditions. There are several other limitations of OEM versions, including
limited or no technical support from Microsoft. This is why OEM copies are the cheapest editions.

Upgrade: An Upgrade Edition requires that you already own a qualifying previous full version of Windows.
However in terms of upgrading your PC or transferring Vista to a new PC, there are no specific limitations
on the number of times you can do this.

Retail: The full Retail Edition does not require the ownership of any other version of Windows, and can be
installed on any PC, and allows unlimited upgrades or moves to another PC. This is why it is the most
expensive edition.

However all editions of Vista must adhere to the following general conditions of use.

GENERAL CONDITIONS OF USE

Some important conditions of use you should consider from the EULA for the average home PC user are
spelled out in plain English below:

* The OS is licensed to one specific device at any time, namely the PC on which it is installed. You can't install
the same copy of Vista on multiple PCs unless you have specifically purchased multiple licenses - one
for each PC.

* You can transfer Vista from one PC to another as many times as you want, as long as it is not installed
on more than one machine at a time. However this does not apply to the OEM version which is always
bound to the original PC for which it was bought or first installed on.

* You can upgrade or alter the hardware in the PC on which Vista is installed as often as you wish. This
does not apply to the OEM version, for which any major system upgrades may invalidate the license.

= If the edition includes both the 32-bit and 64-bit version of Vista, you can install one or the other, but not
both at the same time. Even if you order a 64-bit version of your edition, you cannot install and use both
32-bit and 64-bit editions at the same time.
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* You must Activate your copy of Windows within 30 days of installation, and you must allow it to
periodically connect to the Internet to Validate - see further below for details. Some OEM versions of
Vista come pre-installed and already activated, so manual activation is not required. There is a
legitimate workaround to extending Activation, and it is covered below.

*  You are allowed to make one backup copy of the Vista DVD for your own use.

The above has been provided for information purposes only and cannot be the sole basis for any actions you
take - you must read the EULA which accompanies your particular edition of Vista carefully for yourself to
ensure you understand all the licensing terms and conditions as applicable to you.

B ACTIVATION

This section goes through the procedure for activation, and also addresses any common issues you may
experience.

PRODUCT KEY

When you first install Vista, you will be prompted to enter your Product Key, which appears as a series of 25
letters or numbers separated by dashes in the format: xxxx-xx0xX-xxxxXX-xxXXX-XXXXX. This key can be
found on a sticker on your computer if you purchased the PC with Vista pre-installed, on the installation
disk holder of your Vista retail package, or on the Vista manual. The Product Key is very important for two
reasons:

= The Vista installation DVD contains all versions of Windows Vista, from Home Basic through to
Ultimate - it is the Product Key which tells Vista the correct version to install.

*  The Product Key is integral to validating and activating your copy of Windows Vista. If the key is used
by anyone else at the same time as you, or on another one of your PCs, this will invalidate your key.

Make sure you keep your Product Key in a safe place, do not share it with anyone else and if your PC or
copy of Vista did not come with a Product Key then contact your retailer or the person from whom you
purchased the Vista DVD and ask them to give you one as it is absolutely necessary (unless you are in a
corporate or business environment). If you wish at any time to alter your Product Key while using Vista, you
can do so by going to Control Panel>System and clicking the 'Change product key' link at the bottom of the
box. Entering a new key will require you to reactivate. If you want to look at options for purchasing
additional Product Key(s) online from Microsoft see here.

ACTIVATION

Once you have installed Windows Vista, you will have exactly 30 days within which to activate Windows.
During this time you can use Windows Vista as normal, but you will regularly be prompted to activate. To
see how many days you have left before your activation grace period runs out, either click the prompt in the
Notification Area, or go to Control Panel>System and click the link at the bottom of the box, or go to the
Start>Search Box and type "slui" (without quotes) and press Enter.

If you are aware that your PC may undergo some further changes shortly, such as the installation or removal
of key pieces of hardware it is recommended that you do not activate Windows right away. You have 30 days
(or more - see below) within which to bed down your final hardware configuration and I suggest you use it.
Activating before your hardware setup is finalized could see you having to re-activate repeatedly, including
having to call Microsoft to complete Activation or running into other potential complications. Microsoft
generally views multiple activations in a short space of time as quite suspicious.

There is a legal method by which you can extend the grace period before Activation by another 30 days, up
to a maximum of 120 days in total, before you must Activate. Follow these steps to do so:

1. Open an Administrator Command Prompt - see the Vista Usage Notes chapter
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2. In the Command Prompt type "slmgr -rearm" (without quotes) and press Enter.
3. Reboot your PC and you should now have an additional 30 days before Activation.
4. You can repeat Steps 1 - 3 above to give you a total of 120 days maximum before Activation is required.

This is useful if you want to bed down your hardware prior to final activation, or if you want to try out one
of the different editions of Vista, by not entering a Product Key during installation and extending the
Activation period. However at some point you will have to Activate for your copy of Vista to be legal.

Once you are ready to activate, use one of the means further above to access the activation application and
click the 'Activate Windows online now' button. When activation commences, you will automatically
connect to a Microsoft server and send several pieces of information specific to your system including;

* The version of the OS and the version of the activation software

*  Your language

*  Your Product Key

*  The Internet Protocol (IP) address of your PC

= A set of non-unique hardware hashes generated based on your hardware configuration. These hashes
don't have any personal information, nor can they be used to determine the make/model of your PC.

If automatic activation fails or you are not connected to the Internet, you will be given instructions on how to
activate Vista by contacting Microsoft over the phone. If Activation succeeds you will not be required to
reactivate Windows Vista again unless you substantially alter the PC's main hardware components; if your
Product Key is found to be in use by another system and/or turns out to be an illegally obtained one; or if
there are signs of tampering with Windows to circumvent Activation.

REDUCED FUNCTIONALITY MODE

Should you not activate successfully within 30 days, or if you do not reactivate within 3 days after any major
hardware changes, or are found to be running a non-genuine version of Windows, you will enter Reduced
Functionality mode in Vista. This will mean that certain features and capabilities of Vista will be disabled as
detailed in this Microsoft Article. Non-genuine copies of Vista will have a "This copy of Vista is not genuine'
stamp placed at the bottom right hand corner of the screen. You will need to successfully activate your copy
of Vista to get back to normal.

B VALIDATION

Alongside Product Activation, Microsoft has implemented an additional anti-piracy feature into Windows
called Windows Genuine Advantage (WGA) Validation, or just Validation for short. Windows Vista will
periodically connect to Microsoft servers to validate itself, sending similar information to that sent under
Activation (see further above). This validation may also occur when you connect to Windows Update or
download certain Microsoft updates. If Validation fails, the user will not be able to download updates from
Microsoft, and can only download critical security updates through the Microsoft Download Center or
through Windows Update set to automatically update (See the Control Panel chapter). The OS may also go
into Reduced Functionality mode as discussed further above.

If you are having problems with WGA on a legitimate installation of Windows, visit the Windows Genuine

Advantage Diagnostic Site. In particular, if you use Firefox as your main browser, Microsoft has released a
Firefox plugin to allow WGA to work on this popular browser.

If you are still having problems with Activation or Validation, the only correct course of action is to contact
Microsoft Technical Support for your particular country.
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WINDOWS EXPLORER

Windows Vista uses the Explorer interface as the primary means for manipulating files and folders in
Windows. This interface appears in Windows Explorer as well as in many applications which prompt you to
open or save files, and of course in most standard Desktop windows. Windows Explorer can be accessed in
several ways, including by going to Start>All Programs>Accessories, or by going to Start>Search Box and
typing "windows explorer”" (without quotes) and pressing Enter, or by clicking on the Computer link in the
Start Menu, or by pressing WINDOWS+E at any time. The interface is familiar to any Windows user and the
basics have remained the same, however there are important changes and handy new features which are
explained in more detail in this chapter.

B BASIC FEATURES

Instant Search: The Instant Search box is present in all Explorer interfaces, shown at the top right of the
window. This is a very useful feature which allows you to refine what is displayed in the current window by
typing in a search term or even partial characters. This is covered in detail in the Windows Search chapter.

Address Bar: At the top of each Explorer-based window is an Internet Explorer-like Address Bar which has
back and forward arrows at the left, a refresh button at the far right, and the path to the currently displayed
directory in the address box. Useful aspects of the Address Bar include:

* You can view/jump to any subdirectories under each branch of the displayed path by clicking the small
black arrow next to that particular directory branch.

* You can type in a specific directory path by left-clicking on an empty space in the navigation pane.

*  You can click on the small arrow between the box and the arrows on the left and select a recently viewed
directory to go to.

* You can view recently opened directories by clicking the small arrow next to the Refresh button at the
right of the box.

*  You can copy the current directory path by right-clicking in the box and selecting 'Copy address as text'.

Navigation Pane: This is the area to the left of Windows Explorer which lists quick links to your favorite
folders at the top left, and below that is the normal Folders listing of all directories and subdirectories on
your hard drives.

Command Bar: Beneath the navigation pane is the green command bar which contains a range of buttons.
These buttons will change depending on the particular file(s) or folder(s) you are viewing or have
highlighted. For example if you go to a folder and highlight an .MP3 file, the command bar will display a
Play button. You may instead see a Burn, Share, Email, Open, Preview, Print, or Slideshow button
depending on the specific files and folder type.

You will always see Organise and Views buttons on the command bar, which allow you to access a range of
useful functions that let you customize the Explorer interface. Under the Organise button, aside from
common tasks such as Copy, Rename and New Folder are the following features:

=  Under the Layout item you can select whether to display the Menu bar - if selected the Menu Bar will be
enabled permanently in Explorer and Explorer-based interfaces. If you don't wish for it to be
permanently displayed, you can show it temporarily at any time by pressing the ALT key while in an
Explorer-based window.

* Under the Layout item you can select whether to enable or disable the Details, Preview and Navigation
panes. The Navigation Pane is covered above, the Details and Preview panes are covered further below.

* The 'Folder and Search Options' link opens Folder Options, covered in detail under the Folder Options
section below. Importantly, you can set each folder type's view more quickly by using this option.
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You can use the Views button to change the way folder contents are shown. By clicking the button you can
cycle through the various available options, including Tiles, Details, Lists and Icon views. You can also use
these features instead:

*  You can click on the drop arrow next to the button and manually select the view by clicking on it, or
using the slider.
*  You can hold down the CTRL key and use your mouse scrollwheel to cycle through the various views.

Preview Pane: The Preview Pane if enabled sits at the right side of the Explorer window, and is usually blank
if no file is highlighted. Once you highlight a particular file, a preview of the contents will be displayed
where possible. Since this can increase file browsing time, disable it if you don't need this functionality.

Details Pane: The Details Pane if enabled sits at the bottom of the Explorer window, and displays details
about the highlighted file or folder, including information from its Properties tab, as well as any preview of
its contents if possible. Note that you can edit the properties for a file by clicking on customizable fields in
the Details Pane and entering new information (if the file is not write-protected). Again this should be
disabled if you don't need or use this functionality. You can always right-click on a file and select Properties
then look under the Details tab to see the same information.

Live Icons: The contents of some folders are shown as Live Icons, which are icons that show a preview of the
actual current contents of the particular file - e.g. the Pictures folder. You can disable this for specific folders
by switching to Details or List view for example, which helps speed up browsing such folders.

Sort By: The contents of any folder displayed can be sorted by a range of properties. By default the contents
are automatically sorted in Ascending order by Name (file name), and the sorting is dynamic; that is, there is
no need to refresh the screen whenever new files are added, Vista will automatically resort everything
instantly to maintain appropriate order. To sort by something other than file name, right-click in the content
area and select 'Sort By', and you will see the common properties such as Date Modified, Type and Size on
which you can sort the contents, either in Ascending or Descending order. You can click the More option
and select any one of a larger range of properties upon which to sort the current view of contents.

Group By: You can create subcategories within a content view by right-clicking in the content area and
selecting 'Group By', then selecting the particular property by which you wish to group the contents. This
will arrange the contents under headings for each subcategory. Once again you can select the More item to
see additional properties for use in grouping contents. If you wish to remove grouped view, right-click,
select 'Group By' then choose the (none) item.

Stack By: Instead of grouping contents with headings, you can 'stack’ files into smaller folders within the
current folder. These Stacked Folders are clickable, and when opened their contents are displayed. The
folders are also able to be manipulated like a normal folder, such as moving them to other subdirectories.
However they are only virtual folders and their main purpose is to help you organize directory contents.

Filter By: If you only want to view a certain subset of the contents in a folder, aside from using the Instant
Search box (see above), you can click highlight a column header and click on the small black arrow at the
right of the header. Here you will be able to select a check box to filter the contents by a particular category.
If the category you wish to use for filtering isn't available, you can add more column types by right-clicking
on a column header, selecting the More item and selecting which additional columns to add.

To further customize Windows Explorer, you need to use the Folder Options component of the Control
Panel, as covered further below.
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B FOLDER OPTIONS

Folder Options can be found under the Control Panel, or by pressing the Organise button in the Command
Bar of Windows Explorer and selecting 'Folder and Search Options'. As the name suggests, Folder Options
has a range of options which affect the way folders are viewed, but it also has important Search-related
options. Each tab of the Folder Options box is covered separately below:

GENERAL

Tasks: If the 'Show preview and filters' option is chosen, all Windows Explorer-based windows will have a
Details pane at the bottom of the screen, a Preview pane at right hand side, and filter options at the top of the
screen. To turn this added features off select the 'Use Windows classic folders' instead. Choose whichever
one suits your taste. Note that you can manually turn off the Details or Preview panes individually in
Windows Explorer - see further above. In general disabling the Preview pane provides the most responsive
Explorer window.

Browse Folders: If 'Open each folder in the same window' is chosen, then launching an option or utility in one
window will mean that it opens in the existing window. If 'Open each folder in its own window" is chosen, a
new window will open for each utility or option launched from within an existing window. I recommend
the first option, as this reduces the number of open windows which in turn reduces memory usage.

Click items as follows: The 'Double-click to open an item (single-click to select)' is the default behavior most
Windows users are familiar with, and the one which is assumed when providing descriptions in this, and
most other guides. If you prefer a more web-like behavior, you can select the 'Single-click to open an item
(point to select)’, and further choose whether to have selectable items and icons underline all the time, or
only when you hover your mouse over them. In general the double-click method is most familiar and
prevents frequent accidental launching of programs or options, so it is recommended.

VIEW

Folder views: When you change the look and layout of a particular folder in Windows Explorer, such as
column widths, whether files are show in List, Details or Thumbnail view and so forth, to apply your
changes to all folders of that same type, click the 'Apply to Folders' button here. However you must do this
for each type of folder separately; that is, the layout you choose for a music folder will not apply to anything
other than other music folders for example. So you should take the time to set up one of each general type of
folder the way you want it in Windows Explorer, then in each case open Folder Options>View>Apply to
Folders. Usually it is quicker to just click the Organize button in the Command Bar area of Explorer and
select 'Folder and Search Options' and this will open up Folder Options as well.

Most of the options in this section are dependent on your own particular tastes in functionality and
appearance. However certain settings are important and I provide my recommendations for these below.

It is recommended that you tick the following options:

* Display simple folder view in Navigation pane - Removes the dotted lines in the Windows Explorer
folder Navigation Pane, which I believe looks better. The dotted lines can however help in quickly
identifying parent directories if you have complex layers of folder and sub-folders.

* Show hidden files and folders - Shows hidden system files and folders, including Directory Junctions -
see further below. It is important to have this option ticked if you want to see all the files and folders on
your system, especially when using this guide.

* Remember each folder's view settings - Makes sure that Windows remembers your specific folder
settings for each folder. Remember though that different folder types require individual configuration.

*  Show drive letters - Important in knowing which specific drive you're viewing (e.g. C;, E:).
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* Show encrypted or compressed NTFS files in color - Highlights files which have been encrypted or
compressed in a different color.

It is recommended that the following are unticked:

* Display file size information in folder tips - Holding your mouse over a file or folder will show further
information; this can cause small delays while navigating so is best switched off.

* Hide extensions for known file types - Needs to be disabled to correctly see and if necessary change the
file extensions for various files, especially when undertaking tweaking.

* Hide protected operating system files - Needs to be disabled for advanced tweaking purposes.

* Show popup description for folder and desktop items - Switching this off removes the popup
information boxes which appear whenever you hover the mouse over a folder or desktop item. These are
unnecessary and can also cause slight pauses while navigating folders or the desktop.

The options not mentioned above can be ticked or unticked according to your tastes, and their individual
functionality is covered in this Microsoft Article.

SEARCH

These options relate to the Instant Search box found at the top of every folder window in Vista, as well as the
Instant Search box found on the main Start menu. This functionality allows you to find a file within the
current folder, and is covered in detail in the Windows Search chapter. If you use search indexing or just
want the fastest results I recommend that you select the following settings:

= Inindexed locations, search filenames and contents.
* Include subfolders when typing in the Search box.

* Find partial matches.

* Include system directories.

If you start to notice that you're often not finding what you're after, or if you've disabled search indexing, I
recommend the following settings which are slower but more thorough:

= Always search file names and contents.

* Include subfolders when typing in the Search box.
*  Find partial matches.

* Don't use the index when searching the file system.
* Include system directories.

* Include compressed files.

Be careful as the second set of options though thorough may be much slower, and can tie up a great deal of
system resources when searching for a non-indexed file. This may make using the Instant Search box in the
Start menu in particular a pain if you just want to quickly launch common Windows programs from it, so on
balance I recommend the first set of options further above for most everyone. The time difference depends
on how many files and sub-folders are in the particular folder in which you've commenced a search. For a
small folder, it shouldn't make a huge difference; for a system-wide search it may take quite a long time.
Again, more details on optimal searching strategies are in the Windows Search chapter, and remember that
search functionality isn't so much about finding lost files, it makes accessing common files and programs
much quicker.

B PERSONAL FOLDERS

Every User Account has a set of Personal Folders created for that account. They can be found under your
\ Users\ [username] directory, and contain such subfolders as Documents, Pictures, Music and Videos. Note that
you may also see the legacy personal folders from Windows XP (such as My Documents) showing up under
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your personal folder directory, but these are Directory Junctions not actual folders - see further below for
more details on those.

While your first temptation may be to ignore these personal folders and create your own ones, I recommend
against doing so. Aside from already being quite convenient for holding various file types, these folders are
also linked to particular features in Vista, such as the User Account security features, and the Documents,
Pictures and Music items you can enable on your Start Menu. Furthermore by default certain applications
will initially start looking for the appropriate file types in those folders, e.g. Windows Media Player will
initially open its file browser in the Music folder. So while you can place your files wherever you wish, I
would suggest taking advantage of this directory structure and if necessary create subdirectories under the
existing folders if you want to further categorize your material - or you can use Windows Explorer's
Grouping and/or Stacking features (covered further above) to sort things virtually under each folder.

Fortunately the location of these personal folders is not fixed; you can move them around to another place
on the same drive, or even to another drive if you want to. To do so follow these steps:

1.  Go to the relevant folder under your personal folders.
2. Right-click on it and select Properties, then go to the Location tab.
3.  Click the Move button and specify a new folder and/or drive to move the current folder to.

Alternatively you can just type the new path in the Target box. When you're done, Windows will now
recognize the new location as the home of your present folder, and all references to it throughout Vista
should point correctly to this new location automatically.

It is important to note that if you try to alter any files or folders outside your own personal folders, you will
often be faced with a UAC prompt. This is due to Access Control, and the reasons behind this are detailed
under the Access Control and User Account Control sections of the PC Security chapter.

The bottom line is that it would be wise to take advantage of your personal folders, given they are tied in to
several useful features in Vista and also require the least security credentials to alter.

B DIRECTORY JUNCTIONS AND SYMBOLIC LINKS

When you enable the 'Show hidden files and folders' option under the View tab in Folder Options, as
recommended further above, you will notice that a range of new directories become visible among your
personal folders. That is, under the \ Users\[username]\ directory you will see additional sub-directories such
as \ Cookies, \Local Settings, \My Documents, and \Recent. Yet when you click on them, you will get an access
error. This is because they are not actual directories and don't contain anything, they're Directory Junctions -
redirection links which point to another directory, and this is also why they are denoted with a shortcut icon.

Directory Junctions exist for compatibility purposes, so that when an application not specifically designed
for Vista attempts to put files or folders under the \My Documents directory for example (which doesn't exist
in Vista anymore), the \My Documents junction in Vista redirects the program to place its files/folders under
the correct new \ Documents directory. Meanwhile the application's requirements are satisfied, because it sees
the directory junction as though it were a real directory of the same name, so it doesn't report any errors or
problems.

Under Windows Vista the following junctions redirect to the following real directories:
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‘ Windows XP Directory ‘ Corresponding Windows Vista Directory
Application Data \ AppData\Roaming
Cookies \ AppData\Roaming\ Microsoft\ Windows\ Cookies
Local Settings \ AppData\ Local
My Documents \Documents
NetHood \ AppData\Roaming\ Microsoft\ Windows\ Network Shortcuts
PrintHood \ AppData\Roaming\ Microsoft\ Windows\ Printer Shortcuts
Recent \ AppData\Roaming\ Microsoft\ Windows\ Recent
SendTo \ AppData\Roaming\ Microsoft\ Windows\SendTo
Start Menu \ AppData\Roaming\ Microsoft\ Windows\ Start Menu
Templates \ AppData\Roaming\ Microsoft\ Windows\ Templates

Along with Directory Junctions, Vista also supports a similar feature called Symbolic Links. A Symbolic Link
is like a shortcut, except a shortcut is actually a type of file (LNK), whereas a Symbolic Link is not a file; it
exists at the file system level. It can point to anywhere, whether a file, a directory, or even another drive.

If you wish to create a Directory Junction or Symbolic Link of your own, you can do so by opening an
Administrator Command Prompt (see Vista Usage Notes chapter) and then use the MKLink command. For
example to create a link simply called ReadMe in your current directory, linking to the file Text.doc under
E:\Users\ User1\ Documents\, the following command can be used:

MKLink ReadMe E:\ Users\ Userl \ Documents\ Text.doc

The link ReadMe will be created, denoted with a shortcut icon when viewed in Windows Explorer. If you
want to see where this link points to, right-click on it, select Properties and under the Shortcut tab click the
'Open folder location' button. You can use either the /] or /D switches respectively to specify whether you
wish to create a Directory Junction or Symbolic Directory Link (to link to a directory as opposed to the
default Symbolic file link).

These features are not really designed for the average user, they are more for maintaining compatibility for
older applications and games, and generally speaking you should not need to ever create Directory Junctions
or Symbolic Links. If however after upgrading from XP to Vista you have problems with the default Vista
junctions redirecting properly, see this Microsoft Article.

B ADVANCED FEATURES

The following are some slightly more advanced features of Windows Explorer, including tips and tweaks for
making Explorer easier to use.

MANIPULATE MULTIPLE FILES AT ONCE

If you have a range of files you want to manipulate together - e.g. move, copy, rename, change the properties
of all of them - you can do so rapidly in Windows Explorer by doing the following:

1. Highlight the group of files you want to rename in one of two ways:
* Hold down the SHIFT key and click on the first file in the group, then while still holding down shift,
click on the last file in the group and everything in between will also be highlighted.
= Hold down the CTRL key and click on any individual files you want to select until all the files you
want to select are highlighted.
You can also combine the two methods, i.e. SHIFT select a range of files, then use CTRL to remove or
add individual files to the highlighted ones.
2. Without clicking anywhere else, right-click on the first file you want to manipulate and select the
appropriate function, such as Rename, Copy or Properties.
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For example if you choose to rename the files, all the highlighted files will be renamed with the same name
you gave the first file, however they will also have a number in brackets after them. For example, if I rename
the first in a series of files Screen.jpg using this method, the remaining highlighted files will be renamed
Screen (1).jpg, Screen (2).jpg, etc.

Note that you can also enable the 'Use check boxes to select items' option under the View tabs of Folder
Options, and this allows you to use the new Check Box method in Explorer to select multiple individual files
by placing ticks next to the relevant items, or you can select all files at once by ticking the single check box in
a column header. It is a matter of personal taste whether you enable this option or not, as some people don't
like the check boxes, though they are usually hidden unless a file is highlighted.

DIRECTORY SHORTCUTS

If you want to open a Windows Explorer window at a particular folder quickly, there are two main ways to
do this:

*  Go to Start>Run or Start>Search Box and type the path of the folder then press Enter. If you don't specify
the full path, Windows Explorer will open up at the first incidence of that directory. E.g. enter only the
word 'Downloads’ in the Search Box and press Enter, and a Windows Explorer window will open at the
\ User\ [username] \ Downloads directory by default.

* Create a shortcut - right-click on an empty spot in Windows Explorer or your Desktop, select
New>Shortcut, then enter the full directory path to the folder of your choice. When done this shortcut
when launched will open Windows Explorer at the folder you specified.

SET WINDOWS EXPLORER DEFAULT STARTUP FOLDER

If you usually open Windows Explorer from a shortcut, this allows you to set which directory it will start in
by default when launched from that shortcut:

1. Right-click on the shortcut icon you use to launch Windows Explorer and select Properties. Note that by
default there is a shortcut for Windows Explorer under Start>All Programs>Accessories.
2. In the Target box replace the existing text with the following:

%SystemRoot% \ Explorer.exe /e, path

3. In place of path above you should enter the actual path to the directory you want open by default. For
example E:\ User\ User1\ Pictures. The path does not require quote marks around it. Make sure not to
forget the comma after the /e switch and before the path. E.g.:

%SystemRoot% \ Explorer.exe /e, E:\Users\ Userl \ Pictures

4. Click OK, and now using this shortcut will always open a Windows Explorer window in the directory
specified.

EXPANDED CONTEXT MENUS

A context menu is the small menu which pops up when you right-click on a file, folder or icon for example,
whether in Explorer-based views or on your Desktop. If you want to view an 'expanded’ context menu for a
particular file or icon, hold down the SHIFT button while right-clicking on them. You'll see additional
options such as 'Pin to Start Menu', 'Add to Quick Launch' and 'Copy as Path’, or other options depending
on the particular file or icon.

1a10[dXxyg sMopuIpy

Copyright © 2007 Koroush Ghazi 71




O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

EDIT CONTEXT MENUS

Many of the entries in the context menu have been unnecessarily put there by programs you have installed.
The first step in getting rid of any unwanted entries involves opening the programs in question and looking
through their options to see if you can unselect any 'shell integration' or 'context menu' options they have. If
that fails, you can manually remove these entries by opening Registry Editor and following these steps:

1. Create a System Restore Point, then back up the registry keys which you plan on changing - see the
Windows Registry and Backup & Recovery chapters for details.
2. The specific keys you should look under in Registry Editor are:

[HKEY CLASSES ROOT\*\shellex\ContextMenuHandlers]

[HKEY CLASSES ROOT\Directory\shellex\ContextMenuHandlers]
[HKEY CLASSES ROOT\Drive\shell]

[HKEY CLASSES ROOT\Drive\shellex\ContextMenuHandlers]
[HKEY CLASSES ROOT\Folder\shell]

[HKEY CLASSES_ROOT\Folder\shellex\ContextMenuHandlers]

3. Under each, aside from standard Windows items such as Offline Files, you may find keys which
relate to particular third party programs. Right-clicking on the relevant program key and selecting
Delete will remove its context menu entries.

4. Asyou remove unwanted program entries, you can test the effects immediately by checking to see if the
relevant entry was removed from the context menu.

If you make a mistake and remove an important entry, restore the relevant branch of the Registry you
backed up in Step 1 - do not proceed without backups of each branch. If you're not comfortable manually
editing the Registry and want to delete the main context menu entries, you can use the free Context Menu
Editor utility instead, however it may not find all context menu entries.

ADD 'COPY TO' AND 'MOVE TO' CONTEXT MENUS

If you want to add two useful commands to your context menus - namely 'Copy To' and 'Move To', follow
the steps below:

[HKEY CLASSES ROOT\AllFileSystemObjects\shellex\ContextMenuHandlers]

Copy To= {C2FBB630-2971-11d1-A18C-00C04FD75D13
Move To= {C2FBB631-2971-11d1-A18C-00C04FD75D13

Create two new keys under the ContextMenuHandlers folder - that is, right-click on
ContextMenuHandlers and select New>Key twice and name them 'Copy To' and 'Move To' (without
quotes) respectively. Then left-click once on each folder, go to the right pane in Registry Editor and double-
click on the (Default) entry and assign the appropriate values shown above, including the parentheses
around the numbers. This will create two new context menu entries that allow you to right-click on an item,
select either 'Copy To Folder' or 'Move To Folder', and then specify the location to copy or move them to.

ADD 'OPEN WITH NOTEPAD' CONTEXT MENU

If you want to quickly open any file using Notepad, you can add a new 'Open with Notepad' context menu,
by opening Registry Editor and following the steps below:

[HKEY CLASSES ROOT\*\shell\]

Right-click on the key above, select New>Key and create a new key called Open with Notepad then right-
click on this new key, select New>Key again to create a new key under it called command with the final
result looking like this:
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[HKEY CLASSES ROOT\*\shell\Open with Notepad\command]

Highlight the command key and in the right pane, double-click on the (Default) entry and enter the
following text exactly as shown:

notepad.exe %1

Note that there is a single space between notepad.exe and the %1. Now whenever you right-click on a file it
should have a new context menu entry called 'Open with Notepad', which when selected opens that file
instantly in Notepad.

FIX INCORRECT FOLDER VIEWS

If your folder views are constantly being shown incorrectly, even after you have followed the instructions
earlier in this chapter to set individual folder view types, then go to the following Registry key:

[HKEY CURRENT USER\Software\Classes\Local Settings\Software\Microsoft\
Windows\Shell\Bags]

You can then delete the entire Bags Key by right-clicking on it and selecting Delete. This should reset all
your folder views, requiring you to customize them again but this time the settings will stick. Note that if
this happens often it indicates that you may have data corruption issues which you should investigate.

SHOW SUPER HIDDEN FILES

If you've selected 'Show hidden files and folders' in Folder Options as covered above, you will see most
hidden files and folders. However there are a class of system files which still won't show up, and you will
need to change the following setting:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]

SuperHidden=1

Setting the DWORD above to =1 will allow you to view all hidden files after you reboot. Obviously it is not
recommended that you alter these files unless there is a specific need, they're hidden for a reason.

EXPLORER RESTART SUBSTITUTE FOR REBOOT

There is a method of doing a reboot of the Explorer process as a substitute for having to do a full restart of
Windows under certain circumstances. This is done as follows:

1. Open Task Manager - see the Performance Measurement & Diagnostics chapter
Under the Processes tab right-click on the Explorer.exe process and select 'End Process'. Confirm the End
Process prompt which comes up. The Taskbar and parts of the screen will go blank.

3. Still in Task Manager, go to the File menu and select 'New Task (Run)'.

4. Type "explorer" (without quotes) in the box which opens and press Enter. Explorer will be reloaded and
the interface should return to normal.

This method can help resolve problems with the Vista interface showing glitches or being unresponsive, or if
a particular file or program is not responding. Furthermore if you've implemented a Registry change then
restarting Explorer will often implement the change without having to reboot. This method does not replace
the need to reboot in most other circumstances such as during the installation of drivers, or after serious
erTors.
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B KEYBOARD SHORTCUTS

Most people know that you can use the keyboard to speed up access to common commands and functions in
Windows. A range of these are mentioned throughout this guide, however below is a consolidated table of
all the main common keyboard shortcuts you can use to quickly access useful functions in Vista.
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Keyboard Combination Function

CTRL +C Copy selected item(s)

CTRL + X Cut selected item(s)

CTRL+V Paste copied/cut item(s)

CTRL+Z Undo last action

CTRL+Y Redo last action

CTRL+ + Force all columns to be shown in Explorer interfaces

SHIFT + DEL Delete highlighted item bypassing Recycle Bin

WINDOWS Open Start Menu

WINDOWS + D Minimize/Restore all Windows

WINDOWS + E Open Windows Explorer

WINDOWS + F Open Windows Search

WINDOWS + L Lock Workstation

WINDOWS +R Open Start>Run box

WINDOWS + F1 Open Help & Support

WINDOWS + Number Open Quick Bar item - number corresponds to order of item on Quick Bar

WINDOWS + TAB Switches between active programs in 3D Flip mode
CTRL + WINDOWS + TAB opens 3D Flip permanently,
TAB or arrow keys to cycle elements, ESC to exit

ALT + TAB Switch between active programs in 2D Task Switcher
CTRL + ALT + TAB opens Task Switcher permanently,
TAB or arrow keys to cycle elements, ESC to exit

CTRL + SHIFT + ESC Open Task Manager

ALT +F4 Close highlighted program
Show PC Shutdown options if Desktop or Taskbar highlighted

SHIFT + LEFT CLICK Select multiple items within a range

CTRL + LEFT CLICK Select multiple non-sequential items individually

TAB Step forward through screen elements

SHIFT + TAB Step backward through screen elements

F2 Rename/Enter text for item

F5 Update/Refresh active window

SHIFT +F10 Open Context Menu

KEYBOARD AND MOUSE SUBSTITUTES

If you're having problems using your keyboard or mouse, either because one or the other is broken, or you
are differently abled, there are two substitute methods you can use in Windows:

Microsoft Onscreen Keyboard: This utility can be accessed by going to Control Panel>Ease of Access Center and
selecting it, or go to Start>Search Box and type "osk" (without quotes) then press Enter. A virtual keyboard
will be displayed, allowing you to use your mouse to click on virtual keys as though you were using a
keyboard. To make things easier, position it somewhere convenient and then select 'Always on Top' under
the Settings menu so you don't constantly have to switch back and forward between tasks to use it. If you
can't click the left mouse button to select keys, or want a quicker way of selecting keys, under the Settings
menu select 'Typing Mode' and then 'Hover to Select', then set the length of time needed to hover over a key
before it registers as an entry (values in seconds between 0.00 and 1.00 second). Now you can rapidly move
your mouse cursor over keys on the Onscreen Keyboard and it will register as an entry.

Mouse Keys: If instead of your keyboard you're having problems using the mouse, you can enable the
Windows MouseKeys functionality by going to Control Panel>Ease of Access and select ‘Make the mouse
easier to use' and then tick the 'Turn on Mouse Keys' option. MouseKeys allows you to use the Numpad
keys - the numerical keys on the far right of your keyboard - to move the mouse cursor around on screen.
You can configure these keys further by clicking the 'Set up Mouse Keys'.
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WINDOWS DRIVERS

Device drivers are the software that give instructions to your system on how to deal with hardware.
Graphics drivers for example tell your graphics card what to do in various situations, such as during 3D
applications and games, as well as translating information to and from your CPU. While Windows comes
with built-in driver support for virtually any type of common computer hardware, and hence most of your
hardware will operate in Windows even without installing drivers, these built-in drivers are not optimal and
do not guarantee that you will get full efficient functionality out of your hardware. Thus wherever possible
you need to download and install the latest available Vista-specific device drivers for your hardware to
make sure your entire system performs optimally and with stability.

Windows Vista is based on the new Windows Driver Model, which attempts to make the creation,
installation and usage of device drivers much simpler, more secure and less likely to cause critical system-
wide instability. This is because much of the driver is now not involved with the Kernel - the core software
of Vista - and thus if a device or driver malfunction then often the system state can be restored by restarting

the driver rather than rebooting the entire system. This model also allows better sharing of resources, so that
it is easier to genuinely multitask without running into serious problems. However the new driver model
also requires completely new drivers specifically written for Vista, and in turn Vista 32-bit and Vista 64-bit
have different driver requirements. This chapter runs through these issues and details how to install, view,
uninstall and troubleshoot device drivers in Windows.

B DRIVER COMPATIBILITY

Vista is a relatively new OS and as such some hardware manufacturers have not yet released Vista-
compatible drivers, or have not released final version drivers which are completely functional under Vista
without problems. In fact for some hardware devices, particularly much older ones, Vista-compatible drivers
may never be released. Clearly this is a problem since despite the fact that Vista provides default Windows
drivers for a wide range of hardware, without proper drivers provided by the hardware manufacturer, some
devices will not function correctly or with full functionality.

To obtain Vista-compatible drivers for your hardware, do the following;:

1. Check the hardware manufacturer's website for each of your major hardware components and search for
the latest Vista-compatible drivers. More details and links are provided under the Driver Installation
section further below - follow those procedures first.

2. If you cannot find Vista-specific drivers for your particular hardware, you should then run Windows
Update, making sure the 'Include recommended updates' option is enabled first. This will allow Vista to
search for and install any newer drivers for your hardware. See Windows Update under the Control
Panel chapter for more details.

3. If you still cannot find Vista-specific drivers for your hardware, then you will simply have to continue
using the default Windows drivers for the hardware for the moment. Most recent hardware will
eventually have proper Vista-specific drivers released for it.

4. If no drivers are found and you are having major issues with your hardware in Vista, you should also
check to see if your hardware is formally compatible with Vista by using this Vista Hardware
Compatibility List as well as this unofficial Hardware Compatibility List. If your hardware is not on the
list or is listed as Unknown then you may experience some issues with. You can also try the Vista
Hardware Advisor to see further whether your specific hardware is suitable for Vista.

The bottom line is that since Vista is a recent OS, it may take some time for some hardware manufacturers to
release mature stable drivers for their hardware. For security reasons I encourage you not to attempt to
install leaked or heavily modified third party drivers unless you have absolutely no other option. The best
source of Vista-compatible drivers is the manufacturer of the hardware - see below for more details.
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B SIGNED VS. UNSIGNED DRIVERS

When a device driver is installed, it effectively becomes a part of the operating system and has unrestricted
access to much of the computer. This means it's important to only install drivers you are familiar with and
which are from a reputable source, such as directly from the company which manufactured the hardware for
which the driver is intended. To ensure that the drivers you are installing are legitimate and have not been
tampered with to include malware for example, Windows Vista prefers the installation of Signed Drivers. A
signed driver has a digital signature which indicates who created the driver and whether its contents have
been altered in any way. The treatment of unsigned drivers is different under Vista 64-bit as compared to
Vista 32-bit:

VISTA 32-BIT

In Vista 32-bit you can still install unsigned drivers but you must have Administrator access and you will be
warned first:

»  Windows can’t verify the publisher of this driver software: This means the driver is unsigned or signature
cannot be verified. You should only install such drivers if you are obtaining them for a trusted source.
For example they could be a beta driver direct from the hardware manufacturer's site, in which case they
should be fine. If you are unsure, do not install the driver.

»  This driver software has been altered: This means the driver has been altered after being signed. It could be
a 'modded' driver, in which case if you are aware of the risks and are downloading it from a reputable
site, you can proceed. If you downloaded it from an untrusted or unfamiliar source then do not install
the driver as it may contain malware or could be problematic. If you downloaded it from a hardware
manufacturer, it is best to do further research and seek user feedback before installing this driver.

VISTA 64-BIT

In Vista 64-bit if you see either of the warnings above you will not be allowed to install the driver. This is
because it contains a feature called PatchGuard which is designed to protect the system Kernel even further -
see the PC Security chapter for details. This is one of the reasons why Vista 64-bi is not recommended for
most users, because some hardware manufacturers may not be able to afford to release updated signed
drivers on a consistent basis.

However there is a way around this limitation of Vista 64-bit if you absolutely must install an unsigned
driver. It is detailed in this Microsoft Article and involves restarting your PC and during bootup continually
pressing the F8 key. You will come to the Advanced Boot Options screen and can select the 'Disable Driver
Signature Enforcement' option to prevent signature checks throughout the current session. You will need to
do this at every restart otherwise the unsigned driver(s) will not load up.

SIGNATURE VERIFICATION

If your system is suffering from problems and general instability, it might be a good idea to check to see
precisely how many unsigned drivers you have on your system, and perhaps uninstall the ones which are
least trustworthy. The File Signature Verification utility in Vista is a simple tool for quickly checking the
status of drivers. Go to Start>Search Box and type "sigverif" (without quotes) and press Enter. In the dialog
box which opens, click the Start button and it will scan your system and display all the unsigned drivers.
You can click the Advanced button in the utility and also tell it to save the results as a log file, as well as
being able to view the current log file.

There will likely be a fair few unsigned drivers on your system to begin with, but as Vista matures, the
number of these should definitely be minimized to avoid problems. Remember that installing unsigned
drivers in either version of Vista is not recommended unless you are very certain of the trustworthiness and
reputation of the source of the drivers. This usually means they should be direct from the hardware
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manufacturer's website. By installing unsigned drivers you are defeating a major security feature of Vista,
and potentially allowing malicious or problematic software direct access to your machine. It's a question of
system security, not just system stability, so it is not to be taken lightly.

B DRIVER INSTALLATION

All of your major hardware devices require the latest available Vista-compatible drivers to function
correctly, and indeed many problems in Windows and games often result from a lack of the latest drivers. It
is important therefore to check for and install all the relevant drivers as soon as possible after installing
Vista. The instructions below cover the major hardware components for which you should install drivers,
and the major manufacturer driver links.

Note that during installation of these drivers, if you are prompted to reboot at any time, you must do so to
allow proper driver installation. Even though Vista has a new Restart Manager which is designed to
automatically attempt to close down all non-critical processes and hence allow them to be updated without a
full system reboot, most major device drivers still typically need a reboot in order to continue. Hence it is
best not to try to do anything else while a driver is installing.

STEP 1 - WINDOWS UPDATE (IMPORTANT UPDATES)

If you did not choose to allow Vista to check for and install all the important updates during Vista
installation (See the Windows Installation chapter), then it is imperative for security purposes that you first
run Windows Update to check for and install all important updates to the core Vista software. To do this, go
to Control Panel>Windows Update, click 'Change Settings' in the left pane and I recommend selecting
'Check for updates but let me choose whether to download and install them'. To begin with I recommend
unticking the 'Include recommended updates' option as this will prevent Vista from installing any updated
generic Windows device drivers for your hardware components. It is best to enable this option later and
recheck if you have not been able to find and install proper Vista-compatible drivers. Click OK and then
click the 'Check for updates' link and allow Visa to search for and install all relevant updates. See the
Windows Update section of the Control Panel chapter for more details of the Windows Update functionality
and how best to configure it and use it in the future.

STEP 2 - MOTHERBOARD DRIVERS

Install your motherboard chipset drivers. These are very important in achieving optimal, trouble-free
performance for your entire system, as well as providing additional motherboard-specific functionality such
as onboard audio, the onboard Network adapter, etc. The motherboard driver package varies depending on
which particular motherboard chipset type you run:

=  For Intel motherboards, download and install the latest Intel Chipset Software, also known as the 'INF
Update Utility'. If you have a RAID drive setup, also install the Intel Application Accelerator RAID
Edition. Alternatively, install the Intel Matrix Storage Manager for RAID setups on recent Intel chipsets.

=  For Nvidia motherboards, download and install the latest nForce Drivers, and also check the Nvidia
Beta Driver site for Vista-compatible drivers if none exist on the main site.

=  For VIA motherboards, download and install the latest VIA Hyperion Drivers. To find out more about
these drivers read my VIA Hyperion FAQ.

= For SiS motherboards, download and install the latest S5iS Chipset Software. Note that there are several
separate SiS chipset drivers - they don't come in a unified package. First select your OS and then you

should only download and install the relevant drivers that support features on your particular chipset.
For example, the 'SATA & RAID' drivers should only be installed for chipsets that have SATA/RAID
support.

Note that the motherboard chipset type is not the same as the motherboard brand. The chipset type is based
on the company that manufactures the actual chipset architecture used in the motherboard. The
motherboard's brand is based on the company that buys this chipset, packages it with certain features and
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sells it under its own brand name. For example, an ASUS nForce590 based motherboard is manufactured by
a company called ASUS, using Nvidia's nForce 590 chipset. If you're not clear on this, see the System
Specifications chapter for a list of utilities which can help you determine your motherboard's exact chipset
type if in doubt; the important thing for driver purposes is to identify the actual chipset used, not the
necessarily the company that makes the motherboard.

Also note that the motherboard chipset drivers linked above are not the same as a motherboard BIOS. The
motherboard chipset drivers are Windows drivers that control the way the motherboard communicates
through its various components under Windows, the same as graphics drivers or sound card drivers for
example. The BIOS on the other hand is not dependent on Windows at all and operates at the machine level
to control the motherboard's behavior the second your PC starts booting up. You usually update the
motherboard chipset drivers regularly, not the BIOS. See the BIOS & Hardware Management chapter for
more details.

Finally, some motherboards come with built-in 'onboard' audio or video. If you don't have a plug-in (i.e.
separate) sound card and/or graphics card and want to use these onboard features, you may need to install
additional drivers specific to your motherboard chipset, as well as altering the relevant BIOS settings for
these functions to work correctly. Search the chipset manufacturer's websites above, or the motherboard
manufacturer's website (see your motherboard manual for the web address) for these additional drivers and
any additional instructions, and install them as part of this step. If on the other hand you are using a separate
plug-in sound card and/or graphics card on your system you should disable any onboard audio for optimal
performance and minimal conflicts.

STEP 3 - GRAPHICS DRIVERS

Install your graphics card video drivers. These vary depending on the chipset type of your graphics card:

* For ATI graphics cards, download and install the latest ATI Catalyst Drivers. For details on how best to
install and set these up correctly read my ATI Catalyst Tweak Guide.

= For Nvidia graphics cards, download and install the latest Forceware Graphics Drivers. For details on
how to install and set these up correctly, see my Nvidia Forceware Tweak Guide.

*=  For SiS graphics cards, download and install the latest SiS GPU Graphics Drivers.

* For S3 graphics cards, download and install the latest S3 Graphics Drivers.

*  For Matrox graphics cards, download and install the latest Matrox Graphics Drivers.

»  For XGI graphics cards, download and install the XGI Graphics Drivers.

*  For motherboards with onboard graphics, the drivers for these are usually contained with your specific
chipset driver, or available as a separate download from your motherboard manufacturer - see Step 2
above.

Note that as with motherboards, graphics chipsets are usually sold to different manufacturers who then
package them together with certain features and capabilities and market them under their own brand name.
The important thing to know is the manufacturer of the chipset on which your graphics card is based - for
most graphics cards this will be either Nvidia or ATI. For example, an EVGA 8800GTX graphics card uses an
Nvidia 8800 series chipset put together and sold by the company EVGA. The chipset is the determinant of
which driver to use, not the company selling the card.

The drivers found on the CD that comes with your graphics card are typically quite old by the time you get
them, so download and install the latest versions of these drivers from the links above. Note that installing
these 'reference’ chipset drivers will not cause any problems on the majority of graphics cards regardless of
their brand. You don't have to use manufacturer-specific drivers unless your graphics card has special
features that do not appear to be functioning correctly with the reference drivers, or you can't find newer
Vista-compatible drivers. In the first instance install the drivers from above, then if you believe any
functionality has been removed or impaired, consider installing the manufacturer-specific driver instead. In
terms of performance, stability and compatibility the latest Vista-compatible reference drivers are optimal.
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STEP 4 - SOUND DRIVERS

Install your Sound card's audio drivers. These vary depending on the brand of the sound card you are
running. Only the major brands are covered below:

=  For Creative sound cards, download and install the latest Creative Audio Drivers.

=  For Turtle Beach sound cards, download and install the latest Turtle Beach Audio Drivers.

=  For Hercules sound cards, download and install the latest Hercules Audio Drivers.

* For AOpen sound cards, download and install the latest AOpen Audio Drivers.

*  For motherboards with onboard audio (e.g. AC '97 Audio), the drivers for these are usually contained
with your specific chipset driver - again see Step 2 above for more details.

Importantly under Windows Vista there have been major changes to the way sound is handled by the OS -
see the Sound section under the Control Panel chapter for full details. The result is that sound cards no
longer have as much importance or control over the sound functionality in Vista. There are many benefits to
this new sound management method, but one problem it causes is that in games which use the
DirectSound/DirectSound3D API, your sound card's hardware capabilities for enhanced audio effects (such
as EAX) will not be used. Games which use OpenAL (such as those listed here) are not affected. If you have a
game which has an option to use OpenAL mode, I recommend selecting it if you want extra sound features
offered by your sound card. If you own a Creative X-Fi sound card, there is another solution which involves
using the Creative ALchemy Patch as a workaround, and note that while this only works for X-Fi cards,
support for Audigy 2 and 4 sounds cards may be provided later.

If you find you are having strange performance issues in games, or audio problems such as crackling,
distortion or disconnected sound, then I would recommend that pending newer drivers for your sound card,
you consider disabling or removing the card and reverting to the onboard sound functionality which most
recent motherboards have. These are designed for software-driven sound which is essentially what Vista
uses, and hence will have less problems and offer the same audio quality under Vista. The performance
difference should not be significant. Refer to the Sound section of the Control Panel chapter for more details.

STEP 5 - PERIPHERAL DRIVERS

Connect any remaining devices to your system (e.g. Mouse, Printer, Digital Camera) and test their
functionality. If they appear to work fine and all the major functions which you would use are intact, then I
suggest you do not install a new driver for them. For example, if you connect an optical mouse and it
appears to have sufficient functionality, do not then install the drivers that come on the CD with the mouse,
or download and install new drivers from the manufacturer's website. The reason for this is that such drivers
typically need to load into the background at Windows startup and usually add to overall resource usage,
increase boot times, and quite often don't add anything of real value to the device's function. Vista should
already support the important basic functionality of your major peripherals without the need for additional
drivers.

However obviously should your device not function correctly, or a feature that you need to use appears
disabled, you will need to install the latest Vista-compatible driver for that device. In that case I recommend
you go to the device manufacturer's website and download the latest available drivers rather than using the
older drivers that come on the CD with the device. There are far too many device manufacturers to list here,
but the website address is usually prominently listed on the device's box and/or in the manual. Where
possible follow the device installation instructions in the device's manual (or on its website) for the best
method of installation. Typically this involves connecting the devices to your machine one by one, and when
Windows Vista detects them and prompts for drivers, insert the appropriate driver disk or point Windows
to the directory where you have downloaded the latest driver files for the device.
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If you have an older device which is not compatible with Plug and Play, or your device isn't being detected
correctly, see the Add Hardware section under the Control Panel chapter for more details of how to
manually install such a device under Vista.

STEP 6 - WINDOWS UPDATE (DRIVER UPDATES)

Now that you've installed the latest Vista-compatible drivers which are available for your devices, you can
run Windows Update again to see if new drivers can be found for the devices for which you could not find a
suitable Vista driver, as well as seeing if any newer versions of your existing device drivers exist on the
Microsoft site. Go to Control Panel>Windows Update, click 'Change Settings' in the left pane make sure the
'Include recommended updates' option is ticked. Click OK and then click the 'Check for updates' link and
allow Visa to search for and install any new drivers for any of your devices. These drivers should be
completely safe and appropriate to use in Vista, as they've been tested by MS before being included in
Windows Update, and they will only be detected and installed if they are newer than the versions you are
already using.

If you still cannot find Vista-compatible drivers for your hardware, or you are having problems with a
device in Vista, then unfortunately all you can do is wait for appropriate Vista drivers to be released by the
manufacturer. Vista is still relatively new, so driver support for it is not complete as yet, and many hardware
manufacturers have publicly stated that they are struggling to incorporate full trouble-free functionality into
their drivers for Vista.

B VIEWING, UPDATING OR UNINSTALLING DRIVERS

To view the current version of a driver for a particular hardware component, or to update or uninstall them,
you can use Device Manager. To access Device Manager, go to Control Panel>Device Manager or go to
Start>Search Box and type "device" (without quotes) and press Enter. Note that the general hardware
functionality of Device Manager is covered under the BIOS & Hardware Management chapter.

VIEWING DRIVER DETAILS

To view the current version of the drivers installed for particular hardware component in detail follow the
steps below:

1. Open Device Manager and expand the category under which your particular hardware device is placed.
For example to view your monitor drivers, expand the Monitor category and your monitor(s) will be
listed underneath.

2. Double-click on the device or right-click on it and select Properties.

3. Under the Driver tab you will see the specific driver version, date and provider. If the device is using a
default Windows driver the provider will usually be listed as Microsoft.

4. Click the 'Driver Details' button and you will see the specific driver files associated with that device. You
can then click on each individual file shown, and the provider and version of that file will also be
displayed just below it.

MANUALLY UPDATING DRIVERS

Normally, when you wish to update a device driver, the best course of action is to download the new driver
package and run it. It should automatically execute and take you through the steps necessary to update the
device. However in some cases you may need to manually update a driver - for example if a driver does not
come in an executable (.EXE) package, but rather as a set of files, perhaps in archived format. Follow the
steps below to manually search for and update a device driver:

1. Open Device Manager and expand the category under which your particular hardware device is placed,
then double-click on the device or right-click on it and select Properties.
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Under the Driver tab click the 'Update Driver' button.

You will have two options; you can either allow Vista to 'Search automatically for updated driver
software’, or if you know where the driver files are stored click the 'Browse my computer for driver
software’ option. The first option is recommended only if you do not already have the new driver files,
or if you are a novice user - if you choose this option see Steps 4 - 5 below. If you have the relevant
driver files, or if you feel you are more advanced, choose the second option and go directly to Step 6.
You will be presented with three options 'Yes, always search online'; 'Yes, search online this time only’;
and 'Don't search online'. If you have the new driver files already on your system I recommend clicking
the 'Don't search online' option as this should detect and install the local version. If you don't know
whether newer drivers are available and/or you don't have them downloaded on your system, then I
suggest the second option, that is to allow Vista to search online, but not to make this the default
behavior.

Once Vista has searched it will either ask you to install newly found drivers, or tell you that your current
version is the latest. Proceed as appropriate. If you know there are newer drivers on your system and
they're not detected, go back to Step 3 and select 'Browse my computer for driver software' then follow
Step 6 onwards.

Depending on where the newer driver files are held, insert the appropriate disk and/or browse to that
directory/drive - make sure the 'Include subfolders' option is ticked. Click Next and Vista should detect
and ask you to install the newer driver version.

If the above steps fail and you are certain you have newer driver files for the device, then follow Steps 1 -
3, selecting 'Browse my computer for driver software’, then select 'Let me pick from a list of device
drivers on my computer'.

Click the 'Have disk' button and insert or browse to the place where the newer drivers reside. If an
appropriate .INF file is found, click on it and click Open. If your hardware is supported by that driver
file you can select the specific driver to install.

If nothing else works and you wish to install another driver for a device similar to yours, then follow
Steps 1 - 3 above, then Step 7. Then untick the 'Show compatible hardware' box and you will see a much
wider range of drivers. Select one which you believe would be most compatible with your device,
though clearly if you select a driver not meant for your specific device, you may not be allowed to install
it, or it may result in a lack of correct functionality or major problems. This is only a last resort option.

ROLLING BACK TO AN EARLIER VERSION OF DRIVERS

If you have recently installed a driver set which is causing you problems, then you may wish to go back to
the previous drivers you were using. To do this follow these steps:

1.

Open Device Manager and expand the category under which your particular hardware device is placed,
then double-click on the device or right-click on it and select Properties.

Under the Driver tab click the 'Roll Back Driver' button. If it is not available then you do not have any
earlier driver versions installed, or they may not be detected - see the manual instructions further below.
Confirm whether you want to do this, and your current drivers will be replaced with the previously
installed version

This is the quickest way to go back to a previously installed version, however it may not resolve your

problems, or you may wish to go back to a specific driver version, in which case you will have to do things

manually. To manually go back to an earlier driver version which was installed on your system, or if you

wish to revert to the standard Windows driver for a device for some reason (e.g. to troubleshoot a driver-
related issue), then follow these steps:

1.

@

Open Device Manager and expand the category under which your particular hardware device is placed,
then double-click on the device or right-click on it and select Properties.

Under the Driver tab click the 'Update Driver' button.

Click the 'Browse my computer for driver software' option.

Select 'Let me pick from a list of device drivers on my computer'.
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5. Make sure the 'Show compatible hardware' box is ticked, and you will see all the previous versions of
compatible drivers which are available on your system for this device, along with their version number
and date where applicable. Select the earlier version you want and click Next to install it. Note that the
latest version of the drivers may have no date or version number.

6. Alternatively, if you wish to go back to the default Windows driver for this device, select the driver
starting with the name Standard and click Next.

7. If instead of the options above you want to choose the most basic driver for that class of device, you
should look for a driver starting with the name Generic. This provides very limited functionality and
should only be used for troubleshooting or if no other driver works on your system.

If you are having continual problems and you suspect a driver is the cause then I recommend cleaning out
your drivers and installing only the latest version or the version which you know works best on your
system.

UNINSTALLING DRIVERS

In general it is recommended that you do not maintain multiple driver versions on your system, as these
leave various bits and pieces - known as driver residue - on your system. This increases the potential for
driver-related problems, especially if you are going back in driver versions, since driver files with varying
driver versions may be used by Vista and this can cause problems.

To correctly uninstall a driver through Windows you should go to Control Panel>Programs and Features
and on the main screen you should see most if not all the programs, updates and drivers installed on your
system. Look for the driver or relevant device name in the list, and if found highlight the item (or right-click
on it) and select Uninstall. However some drivers are not listed in the Programs and Features list. In that
case there is another way you can uninstall a driver:

1. Open Device Manager and expand the category under which your particular hardware device is placed,
then double-click on the device or right-click on it and select Properties.

2. Under the Driver tab click the Uninstall button.

3. Make sure to tick the 'Delete the driver software for this device' check box. If this option is not available,
it means you are already using the default Windows driver for the device, in which case you should not
continue attempting to uninstall the device unless you want the default driver to reinstall for some
reason.

4. Click OK and the device will be uninstalled from your system, and its currently-used driver will be
removed from your system as well. Restart your PC as prompted. Importantly, uninstalling certain
devices such as your graphics card or monitor can cause your system display to go black. In this case
simply wait a few moments, then press the power or restart button on your PC to tell Vista to shut down
and/or restart the PC.

5. Once your system restarts, your device will be redetected by Vista and the next available drivers will be
installed for it automatically.

DRIVER FILE REPOSITORY

If you are still struggling to find and remove certain drivers, or you want to see the contents of the drivers
Vista is installing, then you should note that Vista holds all the driver packages it has downloaded or uses
for standard installation under the \Windows\ System32\ DriverStore\ FileRepository directory. These are not
the actual driver files actually in use by the system, as those are held under the \Windows\System32
directory. Each separate driver package is a subdirectory with the name of the .INF file for the package. For
example the Nvidia nForce RAID drivers can be found in a subdirectory starting with noraid and ending
with a string of numbers.

You can use this driver repository for three things:

SIDATI(] SMOPUIAA

Copyright © 2007 Koroush Ghazi 8 2




e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

* Remove traces of a faulty or undesirable driver.

* Manually direct Vista to a particular driver package if it does not detect it automatically.

* Find and manually modify the driver package so that when Vista detects your device it uses the
modified contents to install the driver.

In each case you must first identify which folder under the \ Windows\ System32\ DriverStore\ FileRepository
directory relates to the driver package you are seeking. To do this follow these steps:

1. Download the latest version of the driver and manually open the package in an archiving utility like
WinZip to view its contents, even if it is an .EXE file.

2. Open Windows Search and do an Advanced Search for a specific driver file you know to be unique to
that particular driver package (preferably an .INF file), as identified in Step 1.

3. Match the driver filename and date with one under the relevant subdirectory of
\ Windows\ System32\ DriverStore\ FileRepository.

In most cases you will find that these are mainly the default Microsoft drivers built into Vista, and hence you
should not delete them. However if you find the driver package you are looking for then you can delete it
and if you uninstall and reinstall your hardware device in Device Manager, Vista will use the next recent
driver package when it detects the device.

Alternatively you can modify the folder contents with portions of other driver packages, and Vista will
attempt to install them when it redetects your device. Or you can simply point Vista to this folder when
manually updating drivers as detailed further above.

Finally, you can also use the Autoruns utility covered under the Startup Programs chapter to identify and/or
remove driver files which are loading up at startup under the Drivers tab. Obviously these methods are
really only for people who have having serious difficulty with a particular device and/or are not expecting
updated drivers to be available from the hardware manufacturer anytime soon.

B DRIVER VERIFIER

If you believe you're having driver-related problems, you can use an advanced tool which comes with Vista
called the Driver Verifier. To run it, go to Start>Search Box and type "verifier" (without quotes) and press
Enter. It is a complex tool, so read the detailed instructions for its usage in this Microsoft Article. I'll cover its
basic usage details below.

1. Once Verifier starts, after a moment you will see a dialog box open - leave the options at their default
and click Next.

2. On the next screen, you can either let the Verifier test all the drivers it deems fit, or (as I recommend),
select the 'Select driver names from a list' option to pick specific drivers you suspect to be problematic.

3. Place a tick against all the driver files you believe need to be checked. To make things simpler, click the
Provider column header so that the list is sorted by the providing company, that way if you want to
choose your graphics drivers you can tick all the boxes for the files provided by Nvidia or ATI for
example. Once all the relevant boxes are ticked, click Finish.

4. You will have to reboot your system, at which point during or soon after your PC starts up again you
may see a Blue Screen error (BSOD) if the driver file(s) you chose are potentially problematic. If
Windows starts up normally and you see no BSOD after a while then the file(s) have been verified as
being fine.

You will need to disable Verifier once you've finished with it, otherwise it will continue to verify the files at
each loadup. To do this, open Verifier again and select 'Delete existing settings' then click Finish. If you
cannot access the Verifier user interface to turn it off, open an Administrator Command Prompt, or use the
Windows Recovery Environment Command Prompt and type "verifier /reset" (without quotes) and press
Enter. You can also uninstall the driver in Safe Mode - see Backup & Recovery chapter.
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Having an error in Driver Verifier is not indicative that a driver is the primary source of your problems.
However it is one more way of seeing if it is indeed a driver file which may be contributing to a problem or
the source of a problem, or something else altogether. Bear in mind that the majority of system issues are the
result of overheating, overclocking, bad BIOS settings or stressful game settings, not driver files. Just because
an error points to a driver file in the error message, that doesn't meant the file itself is the cause of the
problem - see the Performance Measurement & Diagnostics chapter for more ways of troubleshooting a
system issue, including the use of Event Viewer to see specific errors which may be driver-related.

B GENERAL DRIVER TIPS

The following are my general recommendations with regard to device drivers:

* It is usually fine to install unsigned drivers as long as they are directly from your device manufacturer,
or from a reputable and well established third-party source (e.g. Omegadrivers). This does not guarantee
their stability, but it does help ensure they do not contain malware.

*  Only install beta drivers if they are from your device manufacturer, and only if the release notes (or user
feedback) states that they resolve a specific issue you are currently experiencing. Beta drivers carry the
risk of causing additional system problems.

* Do not install alpha (pre-beta), 'leaked' and/or heavily modded drivers. There is a great deal of risk
involved with doing this, both stability and security wise. Don't be fooled by promises of large
performance gains - be patient and wait for a solid beta or final release version before installing such
drivers, unless you feel you have absolutely no alternative.

= If you play any recent games or use recent applications, always use the latest drivers. While the latest
drivers don't necessarily contain performance improvements, they often contain specific bug fixes for
recent or popular applications and games, resolutions to Vista compatibility issues, and improvements
to the driver interface among other things.

Drivers are a critical component of the way your hardware interacts with Windows, so it is best to make sure
they are secure and up to date. Keep in mind that over time driver support for Vista will improve and hence
so will hardware performance and functionality.
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PC SECURITY

Over the past few years PC security has become a major issue due to the increase in the ways in which the
security of the average home PC user can be compromised. Accordingly, Windows Vista has greatly
increased the number and type of security features integrated into it. At first glance many users will find
these features very annoying and quickly turn them off, however I strongly advise that you do not take the
topic of PC security lightly or ignore it. It is extremely important that you become acquainted with both the
types of threats to the integrity and privacy of your PC, as well as how Vista's security-related features
actually work to counter them.

It is no longer true to say that only the very careless or novice user will succumb to a security-related
problem or malware infestation. Even if you consider yourself an advanced user, you need to bear in mind
that malware threats these days are becoming increasingly dangerous. In the past a malware infestation
would usually result in little to no real harm; you'd have to delete a few files or at worst reformat and
reinstall Windows. Now however, malware is increasingly being coordinated by organized crime groups for
financial gain, and if you use your home PC for any type of financial transactions such as online banking or
shopping, being exposed to malware may see you lose money or your online identity. Even if you're not
concerned about your own security, it needs to be understood that much of the unsolicited junk email (or
Spam) that is sent actually originates from home PCs which have been infected with malware and used as
part of a Botnet. So having a somewhat carefree attitude towards PC security is a thing of the past.

This chapter starts by explaining the types of threats to PC security, then looks at the built-in features and
tools in Windows Vista which deal with these threats, and then at recommended third party tools and
applications to supplement Vista's security measures, as well as general tips for maintaining a secure PC.

B SECURITY THREATS

There are a wide range of security threats which Windows users face, particularly from various types of
malicious software - often broadly referred to as just Malware. Malware can enter your system and cause
problems ranging from the very minor to the very serious. Malware can remain hidden for long periods and
have subtle effects, or its impact can be immediate and blatant. However it is important to understand that
malware does not harm your computer hardware directly, nor does it actually physically 'infect' the
hardware. Malware is software, and its threat is to the integrity of your data, your privacy and your
finances. The major categories of security threats are covered below:

VIRUSES & WORMS

Viruses are small programs that load onto your computer without your permission and without your
knowledge of their real function. They are called viruses because just like a human virus they are designed
to replicate themselves and cause damage, attaching themselves to normal programs and files and spreading
to other host computers. Viruses range from the mischievous to the truly harmful, and while none of them
can cause physical damage to your computer, they can destroy valuable information, cause a range of
system problems, and waste resources.

Worms are a variation of viruses, with the primary difference being that they generally do not attach to other
programs, they can spread independently.

TROJAN HORSES

A Trojan, short for Trojan Horse, is a malicious program that is often installed on your system under the
guise of being another program. Trojans differ from viruses in that they typically attempt to steal
information from your system such as passwords, or control certain aspects of your PC without your
knowledge, all for the benefit of the distributor of the trojan.
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SPYWARE

Spyware is similar to a Trojan, in that it is software that is usually installed on your system purporting to
have different functionality, or as a component of a useful program. Just like a trojan it transmits information
about you, such as your passwords, Internet usage behavior etc. to the distributor of the spyware.

ADWARE

Adware is a form of spyware that is less malicious as it is mainly used to target online advertising or create
popup ads on your machine, however again it is installed without your permission. This software breaches
privacy and security and uses system resources and bandwidth for no useful purpose whatsoever.

ROOTKITS

A Rootkit is similar to a virus or trojan horse, but is specifically designed to mask its presence on your PC to
make it easier for an intruder to access your machine and conduct malicious activity. The problem with a
rootkit is that it is very difficult to detect, and actively works to remove telltale signs of itself so that most
scanners cannot see it.

BROWSER HIJACKERS

A certain category of malicious scripts attempt to alter certain aspects of your Internet browser's behavior,
such as the default home page, the title bar of the window, additional toolbar icons - all without your full
permission. These scripts are appropriately called Browser Hijackers.

PHISHING

While not a form of malicious software, Phishing is fast becoming a common and significant security threat.
Typically it involves fooling unsuspecting users into revealing important information such as credit card
numbers or passwords. For example a phishing attempt may involve getting a user to click a fake
‘confirmation link' in an email which takes the user to a fraudulent copy of the user's bank login page,
whereupon they enter their login details, giving the phisher the details they need to then login to the user's
real bank account and rob them. Phishing is not malware as such, since it does not involve software
infection, it uses social engineering techniques instead to defraud its targets.

As you can see, there are a range of security threats which you and your system are susceptible to during
everyday use of your PC. Unfortunately in the past few years, these types of threats have become ever-more
sophisticated, intrusive and malicious. Even relatively tech-savvy users face the risk of picking up a serious
piece of malware or even accidentally falling prey to phishing. It may not happen often, but it only takes one
serious incident with malware to result in financial loss or data loss and the subsequent hassles which come
getting new credit cards, proving your case to a bank or financial institution, etc. More importantly the
people behind creating these security are making large sums of money from doing this, so they have more
resources to constantly adapt to existing malware defences and innovate new and ever-more-intrusive forms
of malware and phishing scams.

Protecting yourself against these security threats is not as simple as installing lots of malware scanners and
turning them all on. It requires that you use a combination of measures as well as being vigilant and
understanding your own system. Below are the tools and methods you can use to counter these threats,
starting with the ones built into Windows Vista.

B WINDOWS SECURITY CENTER

The Windows Security Center is designed to consolidate the main Windows security-related information in
a central location, issuing alerts to users if it believes any of your security settings are insecure, or if there are
any problems with any of your installed security software. The Vista version of the Security Center is much
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better integrated and has been refined over the XP version. It now allows installed security software such as
third-party antivirus or firewall packages to use the Security Center to both warn users if something is
wrong, as well as provide users with useful steps for how to rectify the problem - this is detailed in this
Microsoft Article.

While all this sounds good in theory, and is certainly useful for more novice users, in practice the Security
Center makes itself an unnecessary annoyance. Once you've established your security settings based on your
own preferences and having read through guides such as this one, unfortunately the Security Center will
continue to sit in the Notification Area and regularly nag you with Windows Security Alerts if your settings
don't match what it considers optimal. If Windows Security Center detects an issue, it will place a small red
'shield' icon with a cross in the middle of it in your Notification Area, at the bottom right corner of the
screen. Just after you start a Windows session it will warn you about any issues, and also when launch the
offending program(s) it will again provide details of the potential problems it's detected. Clicking the shield
or prompt will take you to the Security Center.

By default Security Center has four categories of security features it monitors, and color-codes them as either
Green (good), Yellow (some problems) or Red (bad) light:

Firewall: This area monitors whether the Windows Firewall is turned on or off. Fortunately, the Security
Center can detect some (but not all) third-party firewalls which are installed on your system, and as it
recommends, it is not wise to run both the Windows Firewall as well as another firewall together. It won't
red light as long as a valid firewall is detected and on. See the Windows Firewall section further below for
firewall configuration details - I generally recommend running the Windows Firewall as it is perfectly fine,
unless you have a specific third-party firewall you want to use instead.

Automatic Updating: This area monitors whether you have the Windows Updates feature set to allow
automatic updating. As recommended under the Windows Updates section of the Control Panel chapter,
you do not need to have automatic updates enabled for your system to remain secure; preferably you should
select the 'Check for updates but let me choose whether to download and install them' so that you are still
alerted when an update is available, but you can choose if and when you want to download and install it.
Unfortunately Security Center considers anything other than full automatic updating as insecure and flags it
as a yellow or red light.

Malware Protection: This area monitors your main antivirus scanner, as well as Windows Defender. It does
not necessarily detect all anti-malware programs such as those covered later in this chapter; it seems to
detect the major antivirus packages. If you don't have a recognized malware scanner, click the 'Show me
available options' and select 'T have an antivirus program that I'll monitor myself' though this still throws up
a yellow light. If it detects your antivirus package you can even update it through the Security Center,
however it seems to insist on the background scanning features of the antivirus package being enabled
otherwise it throws up a red light. Of course if Windows Defender is disabled at any time then that too gets a
red light, even if you're using other anti-spyware/trojan/adware scanners which may be more effective. See
the Windows Defender section below for more advice.

Other Security Settings: The last category monitors Internet Explorer's security settings and User Account
Control. If IE7's security-related features, such as Protected Mode, the Phishing Filter and general Security
Level are not enabled or high enough then Vista will warn you and allow you to reset them to secure levels
again - see the Internet Explorer chapter for details of these features. If User Account Control is disabled, this
too raises a red light - see UAC further below.

While the idea behind the Security Center is a noble one, and indeed is useful to more novice or very
forgetful home PC users, unfortunately the Security Center is more of annoyance to medium or advanced
users, particularly those who have decided on a different security strategy than the one the Security Center
considers optimal. Using certain perfectly anti-malware programs such as those later in this chapter will
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protect you extremely well, yet because some of them are not detected by the Security Center or because it
believes that all the features of an anti-malware program need to be enabled, you will constantly get false
warnings. Fortunately you can turn off the Security Center's incessant prompts by clicking the 'Change the
way the Security Center alerts me' link in the left pane of the Security Center. You can select the default of
"Yes, notify me and display the icon' which is only recommended for novice users; 'Don't notify me but
display the icon' which is only recommended if all your security software is totally compliant with the
Security Center; or 'Don't notify me and don't display the icon' which is recommended for everyone else.

If you do disable the Security Center prompts, this will not disable the software the Security Center
monitors, only the prompting behavior. Make sure to go through the rest of this chapter and configure your
security properly.

B USER ACCOUNT CONTROL

The most fundamental layer of improved security in Windows Vista is the restriction of Administrator level
access to the system by default. This is because a user logged in with a full Administrator-level User Account
can do pretty much anything to the system, from altering the Registry to installing any software (good or
bad) to creating or deleting other User Accounts. An Administrator User Account therefore provides the
greatest power and flexibility, and hence is the preferred choice for most users, as opposed to the 'Standard
User' account. For more details of User Accounts, see the section of the same name under the Control Panel
chapter, however for the purposes of this discussion you should keep in mind:

*  Administrator User Accounts can make any type of changes to the system without restriction, including
altering other User Accounts.

»  Standard User User Accounts are restricted to installing most software and making changes as relevant to
their own account such as changing display or power settings. They cannot make a range of system-
wide changes nor changes which affect other users.

Unfortunately malware capitalizes on the fact that most people run Administrator-level User Accounts to its
advantage, tricking users into installing malware, often quietly in the background while the user is unaware
of what's just happened, and hence gaining total access to your system. Obviously running an
Administrator-level User Account as your normal account has a great deal of risk attached to it, but it is also
extremely convenient and often necessary to undertake tweaking and other advanced functionality. So in an
attempt to balance convenience and security, Vista has changed the way it manages User Account access to a
new method called User Account Control (UAC) which is enabled by default.

The process of how User Account Control works is detailed as follows:

1. Regardless of whether you're logged on as a Standard User or Administrator level User Account, you
are restricted to making basic changes to files and folders you own, installing programs and other non-
intrusive functions. Basically you have Standard User privileges even if logged on as an Administrator.

2. Assoon as you try to make a system-level change such as editing the Registry, launching a system tool
or altering or deleting another user's files or system files which you do not own for example, you will be
prompted to confirm your action. Two important things to note here:

*  Your screen will change as you are placed in a sort of 'limbo' called Secure Desktop mode whereby
no other program can execute itself except for important System processes. This Secure Desktop is
an important layer of protection and prevents malware programs from doing things like faking the
file details on a UAC prompt or automatically accepting a UAC prompt.

* You can't just press Enter to continue; by default the UAC prompt's focus is on the Cancel button. so
pressing Enter will abort execution of the program or change. This helps ensure people don't just get
into the habit of quickly pressing Enter whenever they see a UAC prompt without paying attention.

3. If you're running an Administrator level User Account, the prompt simply requires that you click the
Continue button to continue the task; if you're running a Standard User level User Account, you will
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also need to enter the password for an Administrator level account to continue. If you don't have the
password, or you're not familiar with the program being launched then click Cancel.

So in the past, if a Windows user wanted optimal security they would have to run two separate accounts,
one an Administrator and the other a Standard account, and switch between them whenever they wanted to
install any software, or play certain games. The end result was that most people simply did not bother with
this and used their Administrator account all the time, creating an unnecessary security risk. UAC now
combines security with relative convenience: you can use one account all the time, whether a Standard user
or Administrator, and only elevate privileges to Administrator level when you actually need it. UAC
effectively provides a barrier against malware quietly executing itself and/or making any system changes at
any time in the background without your knowledge. With UAC enabled, you will clearly see what program
is about to run if it needs to make intrusive changes to your system. If you did not specifically initiate the
program or procedure, then you should view the UAC prompt with great suspicion, click the Details link,
note the path and filename of the program that wants to execute, Cancel the UAC prompt and investigate
further. At the very least run several malware scanners on the program in question.

FILE SYSTEM AND REGISTRY VIRTUALIZATION

In order to provide compatibility with applications not built with UAC in mind, UAC incorporates File
System and Registry Virtualization. It comes into effect if a program or game is not given full Administrator
privileges while attempting to make changes to the following folders or Registry locations:

*  \ProgramFiles
»  \Windows

*  \Windows\ System32
- [HKEY LOCAL_ MACHINE\SOFTWARE\]

Any files, folders or Registry changes the program needs to make are redirected to local copies stored under
the current user's profile. This prevents users with insufficient privileges from harming the system, but still
allows them to install and use most types of software.

It should be noted that this is not a foolproof solution. Some applications and games will require full
Administrator access to operate properly, but may not ask for such privileges, and hence there will be no
UAC prompt to escalate their privileges during installation or at launch time. The end result is these
applications can fail to install properly or fail to launch or function properly, but the cause may not be clear.
This occurs most commonly for online games which use things like PunkBuster anti-cheat protection, and
for system-level utilities such as virus scanners, registry editors, and so forth.

To address the issue of games or applications failing to install or launch properly when UAC is enabled, you
will need to go to the main executable or launch icon for the game or application, right click on it and select
‘Run as Administrator'. This will raise a UAC prompt to elevate privileges, which you will need to
successfully accept to continue. The program or game will then launch or install as normal, having been
given full Administrator access. To set this behavior permanently for particular games or applications, right-
click on the main executable or launch icon, select Properties and under the Compatibility tab tick the 'Run
this program as an administrator' box and click OK. Alternatively if that option is not available, go to the
main Shortcut tab for the program's launch icon and click the Advanced button, then place a tick in the Run
as Administrator' box.

Importantly, because of File System and Registry Virtualization, if you install an application under a non-
Administrator level User Account or don't accept an elevation prompt from UAC, your settings for
particular games and applications will be stored under your local profile. If you then switch to another User
Account, or run that same application or game with full Administrator privileges later on, your settings may
be 'lost' or appear to have reset to the defaults as the program switches to using another folder or system
folders for saved settings. In general this means it is not wise to enable or disable UAC back and forth
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constantly - see the Disabling UAC section further below for more details. For common solutions to
Virtualization issues, see this Microsoft Article.

CUSTOMIZING UAC

Instead of turning it off, you may wish to customize UAC so that some of its behavior is changed. This is not
to be taken lightly, since changing some of the features of UAC, such as turning off the Secure Desktop
function, can in effect completely undermine the effectiveness of UAC, in which case you'd just be better off
turning it off altogether; crippling UAC is in some ways worse than just turning it off because it gives you a
false sense of security.

To customize UAC go to Start>All Programs>Administrative Tools>Local Security Policy, or go to
Start>Search Box and type "secpol.msc" (without quotes) and press Enter. In the Local Security Policy box
which opens, double-click on the 'Local Policies' item in the left pane, then select the 'Security Options' item.
In the right pane scroll down and you'll see a range of options starting with 'User Account Control'. Each is
covered in more detail below, but you can also double-click on any option and click the Explain tab to see
more details including the default settings which are different depending on which edition of Vista you're
using:

Admin Approval Mode for the Built-in Administrator account: This setting determines whether the built-in
Administrator account in Vista is affected by UAC - by default it is not. This account is not the same as the
Administrator level account you create when installing Vista, this setting refers to the hidden built-in
Administrator account in Vista - see the User Accounts section of the Control Panel chapter for details.

Behavior of the elevation prompt for administrators in Admin Approval mode: Normally the UAC prompt will ask
Administrators to simply click Continue to proceed. This is equivalent to the 'Prompt for Consent' option
and is recommended. You can however select Prompt for Credentials' if you want even tighter security, so
that even Administrators have to enter their password each time they face a UAC prompt; or you can select
‘Elevate without Prompting' which is not recommended, as it effectively turns off UAC by removing all UAC
for Administrator level User Accounts.

Behavior of the elevation prompt for standard users: This option is similar to the one above, however it controls
the behavior of UAC for Standard Users not Administrators. The default is Prompt for Credentials', but you
can change this to 'Automatically deny elevation requests' if you want tighter security, so that Standard
Users won't see a UAC prompt; they won't be able to undertake any task which triggers a UAC prompt.

Detect application installations and prompt for elevation: If Enabled, Vista will attempt to detect an application
installation and UAC will kick in to ensure the application gets Administrative access if it requests it; if
Disabled, any program can be installed without UAC prompt, but this is not wise as programs which need
Administrator access but don't request it and hence don't get it will not install properly.

Only elevate executables that are signed and validated: If Enabled forces Public Key Infrastructure (PKI)
certificate validation before an executable can be run. Disabled is recommended unless you require this
specific functionality.

Only elevate UlAccess applications that are installed in secure locations: If Enabled only applications launched
from the \Program Files or \ Windows\system32 directories will run with UIAccess level integrity; if Disabled
any program can run with UIAccess integrity. There is no reason to Disable this as it provides an extra layer
of security against malware.

Run all administrators in Admin Approval Mode: This option provides the core functionality of UAC. If Enabled
all Administrator level User Accounts will operate as described further above in this section. If Disabled then
UAC is effectively disabled for Administrator level User Accounts, so it is not recommended unless you
perhaps want to disable UAC for Administrators and leave it functional for Standard Users.
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Switch to the secure desktop when prompting for elevation: Secure Desktop mode has been described further
above and is a critical component of UAC. It prevents tampering or execution of programs in the
background when UAC is running. You can Disable it here but it is strongly not recommended except
perhaps briefly for troubleshooting purposes.

Virtualize file and registry write failures to per-user locations: As discussed under the File System and Registry
Virtualization section above, when Enabled (by default), this option ensures that Standard User level User
Accounts can still install pre-Vista applications which require traditional full Administrator access; the
system locations usually written to by the program will be 'virtualized' by redirecting them to locations
within the Standard User's personal folders.

You should ensure that you do not change any of the above options unless you have good reason to do so.
Most of the options above are necessary for UAC to work effectively.

DISABLING UAC

I strongly recommend that if you have access to an Administrator level User Account that you leave UAC
enabled. Malware is becoming increasingly more common, insidious and malicious. Simply using a few
malware scanners and 'being careful' is no longer enough to safeguard your system. As security measures
become more complex, so too is malware. It is not an exaggeration to say that all it takes is one incidence of a
malware infection and your login passwords and credit card details could be compromised and sent across
the Internet within hours. Hackers don't have to specifically target you or your machine, there are automated
scripts and software which do the work for malware creators and hence can compromise thousands of
machines with little effort if they sit unprotected.

UAC is an inconvenience when compared to not having any prompting behavior, and it can indeed seem
excessive at times. However UAC has no performance impact so disabling it will not make your system any
faster. Like most people I started off absolutely hating UAC and its continual prompting, but after a while of
using it I've found that I've become used to it and the extra layer of security is actually welcome now; it only
requires one or two extra mouse clicks to accept a UAC prompt which is hardly a major sacrifice. By itself
UAC is not the perfect form of protection, as sometimes it does seem to go overboard with its prompts, but it
does give you greater control and knowledge of exactly what is running on your system and what changes
are being made to the system at any time. Ironically this is precisely what a more advanced user should
desire - more control over the programs running on their system, not less.

If you still wish to turn off UAC, the process is relatively straightforward. Go to Control Panel>User
Accounts and click the "Turn User Account Control on or off' link. On the next screen, untick the 'Use User
Account Control (UAC) to help protect your computer' and click OK. You will then have to reboot for the
change to come into effect. Remember that whenever you enable or disable UAC, due to Virtualization (see
further above), you may lose your settings for particular programs if they were not installed with full
Administrator privileges, or were installed under a different User Account.

Some final thoughts on UAC:

= UAC has no performance impact, compared to the performance impact that background malware
scanners have in slowing down reads and writes to your hard drive.

* UAC tries to provide a compromise between the convenience of running an Administrator account all
the time with the security of running a Standard Account.

= UAC is perfect for people wanting to have multiple accounts on the same PC. By setting these accounts
as Standard Users, they each cannot install harmful software or change system settings, but due to
Virtualization can still install and use most non-intrusive software normally and without impact on the
other users.
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Make sure to read the User Accounts section of the Control Panel chapter for more details relevant to UAC.

B ACCESS CONTROL

Windows assigns every item on the system a security descriptor which describes which users or groups are
allowed access to them, and what that level of access is. This is designed to prevent unauthorized access or
harmful changes. To view these Permissions for any file or folder, right-click on it and select Properties, then
under the Security tab you can see the groups or usernames currently assigned to that object. Left-click on a
particular group or username and you will see in the box below it the types of things they are allowed to do
to that file.

If you are an Administrator or have appropriate permission you can alter the permissions for the file by
clicking the Edit button and either Add or Remove other users or groups, or alter the specific things they are
permitted to do, such as making a file read only for particularly users or groups. You can click the Advanced
button if you wish to get even more specific about permissions. One important feature is that any time a user
creates a file or folder, they are the Owner of that file and can always change the permissions of the object.
Note that in general given the system has to check permissions for every file and folder, it is better for
system performance purposes to assign permissions to groups rather than specific users wherever possible.

If as the Administrator you find a file or folder which you are not the owner of and hence may not be able to
access or alter, you can use the Takeown command to reclaim ownership of it. Open an Administrator
Command Prompt (see Vista Usage Notes chapter), and type "takeown /?" (without quotes) and press Enter
for details of how to use the command.

While users don't have to worry about Access Control for the most part, it's important to understand that
this is one reason why you may see several UAC prompts if you go to alter a file on another drive or outside
your own personal folders. Standard User privileges are generally not sufficient to alter most files except
your own, so Administrator credentials need to be shown, even for something as simple as renaming a file
you don't own. For more details of Access Control and related security features see this Microsoft Article.

B WINDOWS DEFENDER

Another layer of protection which is now included in Vista is Windows Defender. The primary aim of this
program is to provide basic protection against spyware, as this is both the most common type of malware on

the average PC, and also the most dangerous in terms of compromising personal details such as online
banking login passwords or credit card numbers. Windows Defender can also find other common forms of
malware including adware and rootkits, but it is not completely effective in finding all types of malware so it
should definitely not to be relied upon as the sole protection against malicious software.

Windows Defender is on and running in the background by default, but to access its user interface, go to
Start>All Programs>Windows Defender, or go to Control Panel>Windows Defender, or go to Start>Search
Box and type "defender" (without quotes) and press Enter. I recommend that you leave Windows Defender
enabled, but configure it to be less intrusive as detailed below. Even when you use other spyware scanners
(which you must do), Windows Defender needs to remain enabled to provide access to the Software
Explorer feature covered under the Startup Programs chapter, so that's at least one reason to not disable it
outright. If you are going to disable it altogether, make absolutely certain that you are using a combination
of UAC and a good spyware scanner, if not two. Just using another spyware scanner alone is not sufficient
protection.

Note that according to the Windows Vista license agreement (See Windows Product Activation & Validation
chapter), Windows Defender is permitted to remove any software it deems as malware. However there are
several safeguards against permanent deletion, and you will be given prominent warnings for serious
malware infections which warrant file deletion.
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CONFIGURING WINDOWS DEFENDER

Below are details on the range of options and features in Windows Defender, including my
recommendations:

Home: Takes you to the main Windows Defender screen where you can see the current status of your
machine, whether any scan is running, and when the last and next scans are scheduled to be undertaken.
Note the Definition version is important - do not allow the Windows Defender definition file to be too old,
regularly update the definition file through Windows Update - see Windows Update under the Control
Panel chapter for details.

Scan: When clicked, this option starts a Quick Scan by default, going through your important system files,
folders and Registry to look for spyware. By clicking the small triangle next to it, you can manually choose to
do a Quick Scan, Full Scan or Custom Scan. As mentioned, a Quick Scan focuses on your system files and
folders, taking the least amount of time to complete, but also providing the least security. A Full Scan goes
through your entire PC to look for malware, which is more secure but can take quite a bit longer. A Custom
Scan allows you to select the specific drive(s) and folder(s) you wish to scan - useful, but ideally you should
let Windows Defender scan all the areas it deems necessary. I recommend that for full manual scans of your
system you rely on other dedicated spyware tools as covered under the Additional Security section of this
chapter. You should only really need to run a Full Scan of Windows Defender in conjunction with other
scanners if and when you suspect you've actually been infected. A Quick Scan is fine most of the time.

History: This section displays a history of the recent actions you've taken in response to Windows Defender
notifications. You can click on each item to see more details of the exact file(s) involved.

Tools: This section contains several important settings and tools:

=  Options: Used to configure how Windows Defender actually works. I recommend disabling Defender's
automatic scans of your PC. If you wish to leave this enabled, a daily scan using Quick Scan should be
sufficient as this usually only takes a few minutes at most and is useful if you forget to manually run any
malware scanners often. I recommend ticking the 'Check for updated definitions before scanning' so that
it uses the latest definition file, as without the latest definition file it's pointless to scan your system
regularly; tick the 'Apply default action to items detected during scanning' box and configure as below.

The default actions listed allow you to specify what you want Windows Defender to do when it finds
potentially malicious software in one of three categories: Low, Medium and High risk; the fourth
category Severe is automatically acted upon. The default actions are explained in detail in this Microsoft
Article, and they seem reasonable, so select 'Default Action' for all three alert levels. You will be notified
immediately of most actions Windows Defender undertakes, unless they are extremely insignificant.

The Real-time Protection options allow you to determine which types of activities and areas Windows
Defender monitors to prevent spyware from installing or executing. These options are explained in
detail in this Microsoft Article. There have been accounts of Windows Defender causing system
slowdowns when using these options, and Windows and application startup being slightly longer,

however the precise performance impacts are not clear. They are best left enabled for more novice users,
but advanced users can disable them if you regularly scan your system with other malware scanners
(which is of course recommended) and importantly: if you have UAC enabled.

When asked to select when Windows Defender notifies you, it should be safe to untick both boxes to
reduce annoyance. Once again this is particularly true if you have UAC enabled.

To remove the Windows Defender icon from the Notification Area select 'Only if Windows Defender
detects an action to take'. That way you'll only see the Windows Defender icon if action is required.
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The three Advanced Options here should all be enabled if you use Windows Defender. They increase the
effectiveness of Windows Defender in finding new or more deeply hidden spyware. Note however that
the 'Use heuristics to detect potentially harmful or unwanted behavior by software that hasn't been
analyzed for risks' option could marginally decrease system performance. The 'Scan the contents of
archived files and folders for potential threats' will also add to scanning time if enabled. The 'Create a
restore point before applying actions to detected items' should be ticked as it provides protection against
Windows Defender accidentally deleting a file you may need.

You can manually specify any particular files or folders you wish to exclude from Windows Defender's
scanning, however this is only recommended if you know for certain that particular file or location is
going to provide a false positive. Also remember that definition file updates may resolve false positives.

Finally, the Administrator options allow you to completely turn off Windows Defender - which is not
recommended, particularly given the Software Explorer function is tied to Windows Defender being
enabled. Click the Save button when finished here, and you will be taken back to the Tools screen.

*  Quarantined Items: Shows any items which have been caught as suspected spyware and allows you to
determine what to do with them.

= Allowed Items: Lists the items which have been flagged by Windows Defender but you have manually
chosen to allow to keep on your system.

»  Software Explorer: This is a very useful utility for monitoring and enabling/disabling/removing startup
programs, background programs and network connected programs. More details of this utility's
functionality can be found under the Startup Programs chapter. Disabling Windows Defender also
prevents access to Software Explorer, which is why I strongly recommend against completely disabling
Windows Defender.

Windows Defender must be viewed in the context that it is there to provide basic protection against harmful
spyware in Windows Vista out of the box. Many users of Windows will never be fully aware of the danger of
malware nor use appropriate precautions, so Windows Defender by default gives a good level of protection
to these users. However even Microsoft have commented that Windows Defender should be supplemented
with other malware scanners. So even for more advanced users I recommend the following:

* Leave Windows Defender enabled but configured as above. This will reduce any performance impact
but still let you do Quick Scans frequently, helping in detecting common malware early.

» Use several malware scanners, including a dedicated spyware scanner, for full manual scans - see the
Essential Additional Security section below.

* Enable UAC to prevent spyware from launching or working in the background without your
knowledge.

The combination of these measures will provide the best security for minimal performance or convenience
impacts.

B WINDOWS FIREWALL

To help protect your system against intrusions through your network connection (typically the Internet),
Vista provides a built-in Windows Firewall. The major role for a firewall is to prevent unauthorized or
malicious data from being sent into your machine over the Internet or being sent from your machine via the
Internet connection. For example once a spyware or trojan program installs on your system, it needs to send
information out of your machine back to its originator. A firewall can serve to block this type of
unauthorized data transfer, thwarting the main aim of the malware which is to steal your sensitive
information. Some hackers run automated programs looking all over the Internet for entry points (called
Ports) into unprotected PCs, and once again this can only be blocked through the use of a firewall.
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To access the Windows Firewall go to Control Panel>Windows Firewall, or go to Start>Search Box and type
"firewall" (without quotes) and you can either choose the basic Windows Firewall or the Windows Firewall
with Advanced Security. Importantly, Vista's firewall now allows users to block both incoming and outgoing
network traffic, whereas Windows XP's firewall could only block incoming traffic. For more details see this
Microsoft Article.

BASIC CONFIGURATION

On the main Windows Firewall screen you will see the status of the firewall - whether it is on or off, and
details of the security and notification settings. You will notice that by default the Windows Firewall is on
and already blocks all unauthorized incoming connections, but it doesn't block any unauthorized outgoing
connections. The reason for this is that blocking incoming connections causes few problems, but blocking
outgoing connections can prevent normal Internet functionality in a range of circumstances, so it requires
specific configuration which may be beyond the average user - see Advanced Configuration further below.

To change the specific settings for the Windows Firewall, click the 'Change settings' link and a new dialog
box will open, the details of each tab are covered below:

General: Here you can turn the firewall On or Off, or choose additionally to '‘Block all incoming connections'.
I strongly recommend that you keep the Windows Firewall on at all times unless you have another firewall
installed and enabled, in which case you should disable the Windows Firewall, as two or more firewalls
working together can cause problems. A firewall has no performance impact on your system as such, it is a
barrier against inappropriate or malicious network activity and without it you greatly increase the risk of
having your machine compromised and even used by hackers to distribute spam for example. As noted
earlier, a great deal of email spam is actually distributed by ordinary PCs infected by malware and not
protected by firewalls.

Note that it is not recommended that you tick the 'Block all incoming connections' unless you want the
tightest possible security, as this although this will allow you to browse most of the Internet and send and
receive emails, it will impair necessary Internet functionality like online gaming, since all Exceptions are
ignored.

Exceptions: With the Windows Firewall enabled, Vista recognizes that legitimate programs will need to send
and receive information via your Internet connection. When you first run a program that requires such
access to the Internet through the Windows Firewall, you will receive a notification informing you that the
Windows Firewall has blocked some features of the program (namely those requiring Internet access), but
that you can either 'Keep Blocking' it or Unblock it. If you didn't initiate the program, or it appears
suspicious, select 'Keep Blocking' and investigate further. By selecting Unblock you have created an
Exception which tells the firewall to always allow this program access to the Internet through the Windows
Firewall when it starts running. The problem is that the more Exceptions you create, the more open Ports
there will be while these programs are running, and hence the greater the chance that a hacker scanning
across the Internet for open ports will find yours and use it. Fortunately the required Ports are closed as soon
as the program is closed, so the risk is minimized.

The Exceptions list shows all programs which may require access through the Windows Firewall, but only
those which have a tick next to them are currently not blocked by the firewall. Try to keep the number of
programs with ticks on this list to a minimum To see more details about a program on the list, highlight it
and click the Properties button. Should you wish to manually add a new program to the list, click the 'Add
Program' button and select the program - obviously it is imperative that you don't add a program to the list
unless you're 100% sure it is a safe and necessary program. You can also manually add a Port to open by
clicking the 'Add port' button, but this is not advisable as an open Port configured this way stays open until
you manually close it again, whereas an Exception only opens a Port when a program begins to run, and
closes it again when it exits which is far safer.
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Finally, make sure you have a tick against the 'Notify me when Windows Firewall blocks a new program’,
otherwise you will receive no warning that a new program you are attempting to run is being blocked by the
Firewall and hence may not function properly.

Advanced: This tab merely allows you to select specific connections for which these Windows Firewall
settings apply. All your connections should be listed and ticked unless it is a connection to a totally trusted
network such as another PC you own or a network within an already-firewalled business environment. If
you feel you've messed up your Windows Firewall settings and/or you're having network or Internet
connectivity issues, click the 'Restore Defaults' button. The actual advanced settings have moved from here
and are covered below.

ADVANCED CONFIGURATION

To access the true Windows Firewall advanced settings, you will need to go to Start>Search Box and type
"firewall" (without quotes) and select the 'Windows Firewall with Advanced Security' item, or in
Start>Search Box type "wf.msc" (without quotes) and press Enter. A new box will open which allows much
greater customization and monitoring of the Windows Firewall, including allowing you to configure the
blocking of outgoing network traffic, which is new to the Windows Firewall.

Covering all the functionality of the Advanced Windows Firewall settings is beyond the scope of this guide,
as it is quite detailed. Fortunately you can get detailed instructions by scrolling down the main screen of the
Windows Firewall Advanced box and clicking the links under the Resources section. Below we will only
look at how to enable the blocking of outbound network traffic, which is generally not required for the
average user, but might be desirable for people wanting tighter security.

In the main Overview box, you will see three profiles: Domain Profile, Private Profile and Public Profile.
These are covered in more detail under the Network & Sharing Center section of the Control Panel chapter,
as well as the Windows Installation chapter. As recommended there, most PC users with a standard
connection to the Internet should select the Public Profile for maximum security while still retaining normal
functionality. Regardless, the profile you are using now for your connection should show the words 'is
Active' after it in this box. You will see whether the Windows Firewall is On (it should be), and the fact that
the inbound connections that do not match a rule are blocked, meaning inbound network traffic is only
allowed for Exceptions as covered further above.

To block outbound network connections, click the 'Windows Firewall Properties' link in the Overview section
and a new dialog box will open. It has four tabs: one for each type of profile, and the last for IPsec Settings.
Go to the tab for your active profile (e.g. the Public Profile tab), and there are two settings of particular
interest to us which are not available in the basic Windows Firewall settings:

Outbound Connections: The Windows Firewall blocks inbound connections by default, only allowing
programs on the Exceptions list to go through. However all outbound connections are allowed by default;
here you can also block them from your PC by selecting Block from the drop down list and clicking the
Apply button at the bottom of the screen. I don't recommend doing this unless you genuinely feel at risk and
want tight security.

Logging: By default the Windows Firewall does not keep a log of successful or denied connection attempts
through the Firewall. If you wish to enable logging, for example to troubleshoot a problem or to see if there
is any suspicious activity, then click the Logging button and set the details of where and what to log here.

Importantly, if outbound connections blocking is enabled, you will not be able to access the Internet or
another Network through your browser or most any other means as any connection attempts you make will
be blocked without warning. This is why Vista does not have outbound connection blocking on by default,
as it requires additional configuration to work. To allow an Exception to outbound connections, you will
need to go to the 'Windows Firewall with Advanced Security' box and click the 'Outbound Rules' link in the
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left pane. Now click the New Rule' link in the right pane and a Rule Wizard will open, walking you through
the steps necessary to add a particular program to the Exceptions list for example, and hence allow it to send
data through the Windows Firewall. For example you may wish to add your Internet browser to the
exceptions, as well as any online games, and any malware scanners which update via an Internet connection.

It is not recommended that the average user block outbound connections under normal circumstances. It
should only be enabled if you are willing to spend the time configuring it, and you genuinely feel you need
this level of security. It might be useful however to temporarily block all outbound connections for example
if you believe you are infected with a serious piece of spyware or trojan, as this will prevent it from sending
any information out of your machine until you can find and remove all traces of it.

B LOCAL SECURITY POLICY

One of the Administrative Tools provided to customize general Windows Vista security settings is the Local
Security Policy tool. This can be accessed by going to Start>All Programs>Administrative Tools>Local
Security Policy, or go to Start>Search Box and type "secpol.msc" (without quotes) and press Enter. The main
purpose for this tool is to allow Administrators to be able to impose certain limitations on other users of the
same machine or network, so many of the settings are not relevant to the average home PC user and won't
be covered here. Furthermore some options have already been covered - namely the Advanced Firewall
settings and the User Account Control-related settings under the relevant sections above.

For our purposes though, the Account Policies and Local Policies categories contain several settings which
are useful in customizing the level of security on your system. To access and change a setting, click on the
relevant category in the left pane, then find the setting in the right pane and double-click on it to alter it, or to
see a more detailed explanation. Below are a range of useful settings you can alter, but please exercise
caution and do not change anything if in doubt. To see the default option for each setting, click the Explain
tab:

ACCOUNT POLICIES

Password Policy settings: These settings allow you to force passwords for User Accounts to be a certain length,
age and complexity. In general you should not alter these settings unless you want tighter security, as they
will create extra requirements for User Account passwords. For example by enabling the 'Passwords must
meet complexity requirements' option, you will force all user passwords to meet the requirements detailed
under the Explain tab whenever they change or create a password. This can cause problems with users
remembering their own passwords. Importantly, you should not enable the 'Store passwords using
reversible encryption' as it makes passwords easy to find since they will not be encrypted.

Account Lockout Policy settings: These settings control what happens when a user is locked out of their User
Account for failing to enter a correct password. By default they can't be locked out, but if you wish you can
set the number of times a user can try to login and fail before being locked out for a certain duration from
using the account. This provides tighter security against other users attempting to 'crack' a User Account
through repeated login attempts, and these settings should only be changed if you are in a less physically
secure environment.

LOCAL POLICIES

Audit Policy settings: These settings allow you to enable a range of options for logging various events,
viewable under Event Viewer - see the Performance Measurement & Diagnostics chapter. For example you
can log the number of successful and failed logon attempts. These are useful for both troubleshooting
purposes, and also if you suspect unauthorized or unusual activity.

User Rights Management settings: These settings determine the default user rights for system tasks such as
creating a pagefile, or backup files and directories. These should not be altered unless you have an explicit
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need, as in every case there is a reason why particular users are restricted from conducting these tasks,
namely to prevent a security breach or to prevent system instability or harm.

Security Options settings: These settings are the most useful in customizing Vista's security for the average
home user. However we've already looked at the User Account Control-related settings in the UAC section
further above, so we will look at the rest of the more useful settings below:

»  Accounts: Administrator account status: If Enabled, this option turns on the built-in Administrator
account in Vista. This is the global Administrator account with the username 'Administrator' which
is not obstructed by UAC and is not the same as the Administrator level account you created when
first installing Vista. For more details see the User Accounts section of the Control Panel chapter.

»  Accounts: Guest account status: Allows you to enable or disable the Guest account. For security
reasons the Guest account should be kept disabled unless explicitly needed.

»  Accounts: Rename Guest account: If you've enabled the Guest account, this option allows you to
rename the account to something other than 'Guest'. This is useful in making the Guest account
more secure, as it is harder for others to guess the username for the account if it is not set to the
default of 'Guest'.

» Interactive Logon: Do not require CTRL+ALT+DEL: If you disable this option it will require that a user
press CTRL+ALT+DEL before being able to logon. This can increase security because it will mean
users are entering their password in Secure Desktop mode, where no malware can interfere or log
your keystrokes.

»  Shutdown: Clear virtual memory pagefile: If enabled this option clears the virtual memory (stored in
pagefile.sys - see the Memory Optimization chapter) each and every time you shut down the PC.
While this can increase security since the pagefile may contain fragments of information from the
latest sessions, it also slows down shutdown time and is generally not recommended.

As noted several times before, be very careful in what you change here, as in general the defaults are
perfectly fine for most any home user, and some of the settings can cause real problems for yourself or other
users of the system if changed. Think carefully about appropriately balancing security vs. convenience
before enabling or disabling a setting.

B DATA EXECUTION PREVENTION

Data Execution Prevention (DEP) is a method that uses software and (where supported) hardware detection
of programs that try to access and run code from designated 'non-executable' memory areas. In practice DEP
protects against viruses that have become resident on the system and which then try running malicious code

from such areas. When it detects an attempt to launch an executable from a non-executable memory area it
will shut the program down and provide a notification that it has done so.

You can access the DEP settings by going to Control Panel>System and clicking the 'Advanced system
settings' link, or by going to Start>Search Box and typing "systempropertiesadvanced" (without quotes) and
pressing Enter. Then click the Settings button under the Performance section, and go to the 'Data Execution
Prevention' tab.

By default when "Turn on DEP for essential Windows programs and services only' is selected, DEP
protection is only enabled for programs that choose to work with DEP, along with Windows system files.
This is the minimum form of DEP protection and the one I recommend. For greater protection you can
choose to extend DEP to all programs by selecting 'Turn on DEP for all programs and services except those I
select' and then choose which programs to manually exclude from DEP by using the Add or Remove
buttons.

DEP is a good form of additional protection, and I strongly recommend that it be left enabled on its default
setting. However if you find certain programs not functioning correctly with DEP enabled, and you are
certain they are not infected with malware, then you can force DEP off in your boot options by using
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BCDEdit. Open an Administrator Command Prompt (see Vista Usage Notes chapter) and enter "bededit /set
{current} nx AlwaysOff" (without quotes) and press Enter. Alternatively you can use a tool like VistaBoot
Pro to toggle this option on or off more easily - see the Boot Configuration chapter for more details.

B KERNEL PATCH PROTECTION

Kernel Patch Protection, also known as PatchGuard, is a feature unique to recent 64-bit versions of
Windows, including Windows Server 2003 SP1 x64, Windows XP x64, and now Windows Vista 64-bit. This
feature is not available under the 32-bit architecture at the moment, but it is possible to implement it for 32-

bit operating systems in the future. Basically the feature protects the system Kernel - the core of the
operating system - such that only Microsoft-certified changes can directly be made to memory locations
holding the Kernel. This provides excellent protection against malware or any other software making
unauthorized changes to the Kernel which can destabilize or compromise Windows. More details are
provided in this Microsoft Article.

However Kernel Patch Protection requires that software developers work with Microsoft to ensure
compatibility of their software with this feature. This is particularly true for antivirus developers whose
software may have legitimate need to access the Kernel in ways which would normally not be allowed by
PatchGuard. For this reason some older security or system-intrusive programs, as well as unsigned drivers
will not work on Vista 64-bit. You cannot disable PatchGuard, however you can manually override the check
for signed drivers during bootup, and this is covered under the Windows Drivers chapter, but there is no
permanent way to disable this check.

While PatchGuard gives Vista 64-bit users greater protection against system destabilizing or malicious
changes, it is another reason for potential compatibility problems on Vista 64-bit. Hopefully over time
developers will adapt to it.

B ENCRYPTED FILE SYSTEM

The Encrypted File System (EFS) is the built-in file encryption protection method for Vista. It allows you to
encrypt a file or folder such that it cannot be opened by anyone else unless they have the appropriate
encryption key. To enable EFS for a file, follow these steps:

Open Windows Explorer and go to the file or folder you wish to encrypt.

Right-click on it and select Properties, and under the General tab click the Advanced button.

Tick the 'Encrypt contents to secure data' box and click OK, then click the Apply button.

You will be prompted firstly whether you want to apply the encryption to the file itself, or to its parent
folder. It is best to encrypt an entire folder, so if necessary move all the files you wish to encrypt to a new
folder and encrypt both the files and folders; otherwise just encrypt the file if you don't wish to move it.
The file will be shown in green text by default to indicate that it is encrypted.

6. You can remove encryption for your own files at any time by following the steps above and unticking
the 'Encrypt contents to secure data' box instead, then clicking OK and Apply.

L

o

To view details of the encryption, allow other users to use the file/folder, and more importantly to backup
the encryption key for this file/folder, follow Steps 1 - 2 above, then click the Details button. Whenever you
aren't using the file, it will be encrypted and thus secure against access by anyone else.

Note that EFS encryption is not available on Vista Home Basic or Home Premium editions - you can only
decrypt encrypted files in those editions if firstly you have the encryption key for the file or folder, and then
use the Cipher command in a Command Prompt. Type "cipher /?" (without quotes) in a command prompt to
see more details of this command. In general you shouldn't need to use encryption, and encryption is not a
substitute for using secure passwords, UAC and other security-related measures. If someone logs in under
your User Account they can access all encrypted material normally for example, so it is only one extra layer
of protection.
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B BITLOCKER DRIVE ENCRYPTION

BitLocker is a Windows Vista Ultimate Extras add-on which is only available to users of Vista Ultimate and
Vista Enterprise editions. It is a drive encryption technology which secures an entire drive against
unauthorized access, as opposed to the Encrypted File System (see above) which is used on a per-file or per-
folder basis. However BitLocker can be used in conjunction with EFS, so the two are not mutually exclusive.

BitLocker is aimed primarily at providing protection in case of physical theft, using the Trusted Platform
Module standard which requires hardware support. For the average home PC user I do not believe it is a
necessary feature, and I will not go into detail about its functionality here. If you want more details of how to
use this feature, see this Microsoft Article.

B ESSENTIAL ADDITIONAL SECURITY

Having examined Windows Vista's major built-in security features, it is obvious that security is very
important in Vista. However Vista's security features though more formidable than Windows XP are still not
sufficient by themselves in protecting you against all malware, nor do they pretend to be. They are simply
one layer of defence against more common security threats. They provide the average user with a good
starting point in preventing harm to their system, but there is much more that needs to be done to provide
genuinely good security. It is important to have multiple layers of different types of protection so that even if
several defences are defeated or disabled, one or more other ones will prevent or detect the malware before
it does any serious harm. That's where the use of various third party software such as standalone virus,
trojan and spyware scanners is absolutely critical to ensuring that your system is clean of malware and
remains so, but I urge you to use them in conjunction with Vista's security features, not instead of them.

The programs below are recommended for all systems, and I provide configuration advice to help provide a
balance between security and convenience with minimal performance impact. Note that since malware
scanners are system intrusive they must be run with full Administrator privileges, even if they don't ask for
it, otherwise they may not function properly - see the File System and Registry Virtualization section further
above for details.

VIRUS SCANNERS

Virus scanners serve a valuable role in finding hidden viruses and worms - as well as some other common
malware - and removing them from your system. A virus scanner is an essential part of any system, and you
run a major risk if you don't have one installed because Windows Vista does not have any decent virus
detection or prevention capabilities beyond UAC and the Windows Firewall; remember Windows Defender
is designed primarily for detecting only spyware and some trojans.

To start with, regularly download and use the Windows Malicious Software Removal Tool. This is a free tool
provided through Windows Update or the link above. Once it is downloaded and installed you can choose
to do a Quick Scan or a Full Scan of your system for the most common viruses - Quick Scan should be fine if
you also use another virus scanner as detailed below. However as the tool itself recommends, you will need

a dedicated virus scanner software which can perform regular full scans of your system for a wide range of

viruses, worms and other malware. I personally use and recommend AVG Antivirus Free Edition. AVG
strikes a good balance between effectiveness, ease of use and minimal system intrusiveness, and is Vista
compatible. However AVG is not the only good virus scanner around - there are several good free scanners
which are Vista compatible and which you can try, though some of them are only free for a trial period:

Avast
Kaspersky
NOD32
PC-Cillin
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There are many arguments about which virus scanner is 'the best', but any of the ones listed above should do
a suitable job as long as it is kept up to date. I have yet to see security experts agree on which single scanner
is the most efficient one at detecting and removing every virus and worm. Note that I do not recommend
Norton Antivirus as it is highly system intrusive, virtually impossible to remove, and does not strike a good
balance between security and convenience.

The following is information on how to set up the recommended AVG Antivirus Free Edition software for
optimal performance and minimal intrusiveness

AVG ANTIVIRUS

After you download, install and run AVG Antivirus Free Edition, make sure you click the 'Check for
Updates' button on the main screen and download all the latest updates for AVG from the Internet. AVG
will install these updates automatically once they have been downloaded. From here you can configure the
protection options by clicking the 'Control Center' button on the main screen. I recommend that you don't
have any of AVG's background protection options enabled as these can conflict with games and applications,
generally slow down Windows by using memory and CPU resources as well as slowing down reads/writes
to the hard drive. To disable this functionality go into the AVG Control Center and do all of the following;:

=  (lick once on the Scheduler item, and in the bottom of the screen click the 'Scheduled Tasks' button.
Double-click on each of the scheduled tasks listed and in the box that opens, highlight the Test Plan'
item, click the 'Edit Schedule' button and untick any options to prevent it running. If you don't want
AVG to automatically update regularly, also edit the 'Update plan' item and untick all available options,
or alter the time period during which AVG checks for updates. I recommend turning off scheduled
updates as it is always wiser to update just prior to doing a manual scan.

=  (Click once on the Shell Extension item in the Control Center, and on the bottom of the screen select the
Deactivate button to remove AVG from Windows context menus etc.

*  Double-click on the Email Scanner item in the Control Center, and click the 'Disable Plugin' button.

* Double-click on the Resident Shield item in the Control Center and untick all the options under the
Properties tab to disable background scanning.

The final step in removing all the background tasks is to disable the unnecessary AVG-related services and
startup items. These take up resources even after you have disabled much of the background functionality in
AVG itself. Remove the avgcc.exe file from your startup and disable the 'AVG7 Alert Manager Server' service.
Note however that you should set the '"AVG7 Update Service' to Manual for AVG's Internet Update
functionality to work, otherwise you will not be able to successfully update AVG. See the Services and
Startup Programs chapters for details on how to disable services and startup items correctly.

As I have mentioned Virus scanners are notorious for causing conflicts and slowdowns, and most people
don't realize that their virus scanner may be the cause of increased startup times, as well as stuttering or
crashes in games for example. AVG Antivirus is one of the less intrusive virus scanners I have used.
Importantly, make sure to update the virus definitions often, at least once a week, and always just prior to
doing a scan. If you're forgetful, you can schedule AVG to automatically update its definition file every day,
however you cannot schedule automatic virus scans in the free edition of AVG. Click the 'Scan Computer'
button in AVG to start a manual scan, or choose 'Scan Selected Areas' if you want to do a limited scan, for
example if you just want to scan a recently downloaded file in the Downloads directory before opening it.
Manually scanning your entire system at least once a week, and always scanning potentially harmful files
which you have downloaded before you open or launch them is strongly recommended if you want to
ensure your system remains clear of major malware.

TROJAN SCANNERS

Trojans differ from viruses in many ways, and many trojans are not detected by virus scanners, so you need
a dedicated trojan scanner as well. The built-in Windows Defender in Vista does pick up some trojans,
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however I strongly advise installing a dedicated trojan scanner as well. I personally use and recommend A-
Squared Free to scan for trojans. It is one of the best free trojan scanners and is Vista compatible. However
you can also try one of the following scanners, though some are only free for a limited period:

The Cleaner

Trojan Hunter
AVG AntiSpyware

The following is information on how to set up the recommended A-Squared Free trojan scanner.

A-SQUARED

To start with, make absolutely sure you are downloading A-Squared Free Edition as the other A-Squared
versions are only free for the first 30 days.

Each time you run A-Squared, click the 'Update Now' button on the main Security Status screen. The
program will download all the latest updates. Fortunately the more intrusive aspects of A-Squared, such as
‘Background Guard' background scanning, are not available in the free edition, so we do not need to
configure/disable them. To set the depth of scanning used, click the 'Scan PC' option on the left of the main
screen, and either select Smart Scan or Deep Scan - I recommend Deep Scan which is longer but much more
thorough. Now whenever you want to run a scan using A-Squared, you only need click the 'Scan Now'
button on the program'’s main screen.

Note that A-Squared may find software which it classifies as Riskware, but is not actually a virus or a trojan.
Such software is not necessarily malicious, it just carries greater risk in usage if your system is compromised
by malicious software. To disable detection of such entries, go to the Scan PC screen, select 'Custom Scan'

and you can untick the 'Alert Riskware that is often used by Malware' option. During scanning, you may
also find Heuristic ArchiveBombs in archived game files for example, which are again usually harmless.

SPYWARE/ADWARE SCANNERS

A spyware/adware scanner will find and remove this type of malware from your system. Windows
Defender is Vista's basic built-in spyware scanner, however I recommend installing and using at least one
additional third party scanner. I personally use and recommend Ad-Aware. It is very easy to use and
available as a completely free download. You may also wish to try the free Spybot scanner. One or the other
(or even both) used in conjunction with Windows Defender should detect and remove all spyware/adware.

Note that the bulk of spyware/adware found by these scanners is not always malicious, and typically
consists of tracking Cookies - small files that keep information on your user preferences for a particular site.
These have no real impact on performance or security, contrary to popular hysteria. However some
spyware, such as keyloggers, are malicious and will compromise your security for things like online
banking, so in general you should find and remove all spyware and adware from your system.

Importantly there are a wide range of spyware/adware and malware scanners which purport to remove
malicious software, but ironically contain malware themselves, or are bad knock-offs of good scanners.
Consult the lists below if you plan on installing any malicious software scanners other than the ones
recommended in this guide:

Spyware Warrior Suspect List

2-Spyware Corrupt List

The following is information on how to set up the recommended Ad-Aware scanner.
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AD-AWARE

After installing Ad-Aware make sure you update to the latest resource file by clicking the WebUpdate tool
icon - the small button with the picture of the Earth at the top right. Click the Connect button and agree to
download any updates found, and they will be downloaded and installed automatically. Close Ad-aware
and install the free Ad-Aware Plugin as well to allow access to additional Ad-Aware features.

Fortunately the free version of Ad-Aware doesn't have any major system intrusive features or services which
need to be turned off, however to set it up for the most effective scanning performance follow these steps.
First click the Configuration Window icon (the icon with the small cog), then:

* Under the General Settings, put a cross against the Prompt to update outdated definitions' item (i.e.
click on the small green tick mark until it becomes a red cross) - you should check for updates to
definitions each time you go to scan with Ad-aware.

* Under the Scanning Settings, make sure a green tick is against every available option (some are
unavailable in the free version - this is fine).

* Under the Default Settings click on the 'Read current settings from system' link and check to make sure
the homepage is what you expect it to be, otherwise change it.

=  Under the Tweak Settings:

+ Scanning Engine - place a green tick against 'Unload recognized processes & modules during
scan', 'Obtain command line of scanned processes' and 'Scan registry for all users instead of
current user only'.

+ Cleaning Engine - place a green tick against all available options.

+ Safety Settings - place a green tick against all available options.

+ Log Files - place a green tick against all available options.

+ User Interface - place a red cross against all available options.

+ WebUpdate settings - place a red cross against all available options.

¢ Misc Settings - place a red cross against all available options.

Click the Proceed button when done. Click Start to start a new full scan, and select the 'Perform full system
scan' option then click Next to start a full scan. Make sure you regularly update Ad-Aware's reference file
and also do a manual scan frequently, especially after any heavy Internet browsing or after visiting
unfamiliar or risky sites.

ROOTKIT SCANNERS

While the built-in Windows Defender can find and remove common rootkits, including the Sony music CD
rootkit released a while ago, there are specific tools designed to find and remove rootkits, with varying
success. The best Vista-compatible ones at the moment are:

Blacklight
UnHackMe

There is no need for specific usage advice, as these scanners are relatively straightforward to use - run them,
start the scan and if anything suspicious is found you will be informed. They do require some advanced
skills in identifying whether an actual rootkit has been found. If you are not clear on whether the identified
potential threat is genuinely a rootkit, do some research on Google. If you are not comfortable using these
rootkit scanners, as they are a bit more advanced than other types of malware scanners, then I recommend
doing a Full Scan using Windows Defender instead, as it much more user friendly and won't cause any harm
to the system.
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PHISHING PROTECTION

Phishing is a form of deception for which there are no 'scanners' as such. It requires vigilance and some basic
verification techniques by a user to detect and prevent. Fortunately there is some assistance now, as the three
most popular Internet browsers - Internet Explorer 7, Mozilla Firefox and Opera - all have some form of
phishing protection built into them.

In Internet Explorer 7, the Phishing Filter is enabled by default and will warn you if it suspects that a site
you are about to visit is fraudulent. This checking process may add a slightly delay to page loads as it checks
the site. You can change this setting by going to Tools>Phishing Filter in IE7, and selecting "Turn off
automatic website checking'. You can still manually check any web page by going to Tools>Phishing
Filter>Check This Website, or click the small exclamation prompt in the Status bar. If you want to completely
disable the Phishing Filter, go to Tools>Internet Options>Advanced and scroll down to the Phishing Filter
section and select 'Disable Phishing Filter'. However unless you are an advanced user I strongly recommend
against turning this feature off altogether; at worst just turn the automatic website checking off. See the
Internet Explorer chapter for more details.

The Phishing Protection feature in Mozilla Firefox is covered in more detail in my Firefox Tweak Guide, and
once again it is strongly recommended that you do not disable this functionality altogether unless you are an
advanced user. More details of Opera's Fraud Protection features are in this Opera demo and it too is best
kept enabled unless you feel you can detect phishing without its help.

For the techniques required to prevent falling victim to phishing as well malware infestation, see the
Important Security Tips section further below.

FIREWALLS

I believe the built-in Windows Firewall is completely sufficient in protecting against network intrusion. By
default it prevents external intruders from accessing your system, as long as you do not manually open lots
of Ports and/or have lots of Exceptions. It can also be configured further if required to prevent unauthorized
outgoing traffic, but this functionality is disabled by default to prevent any problems. This means that it
provides a good balance of security and convenience, and that is why I recommend the built-in Windows
Firewall for most users, particularly for online gamers.

However you do have other options if you want greater security. There are several commercial Firewall
packages you can purchase and install. Unfortunately at the moment the two major free ones ZoneAlarm
and Commodo Personal Firewall are not Vista compatible and may take some time to become compatible.

Finally, note that your Network Device may come with a hardware firewall which you can configure. For the
average home user who is using a Network Router, you can access your device's settings by going to
http://192.168.1.1 - but check your device's manual for specific details. It is important that you change the
default username/password combination for this device, which is usually just 'admin' for both. Log into the
device's settings and change the password to anything else, as the default of admin is a security risk.

B IMPORTANT SECURITY TIPS

All of Vista's new built-in security features, and all the third party malware scanners and phishing
protection in the world is no substitute for learning how to prevent malware infestation and how to detect
and avoid phishing and other forms of online fraud. Once your system is infected with malware, or once
you've compromised your credit card details for example, then it is often too late to prevent serious damage
or loss, especially if the infection has already spread to your backups as well. Despite advances in
technology and the improvements in Vista, there is no fully automatic way of protecting you against every
threat, so I strongly encourage you to read and understand the tips below.
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EMAIL USAGE

* Avoid opening any emails from unfamiliar senders, especially if the subject of the email seems
suspicious or inappropriate. Simply opening an email which contains a malware attachment will not
infect your system, especially if you have UAC and appropriate Windows Mail features enabled as
covered in this guide, however it is still not advised. Most definitely do not click anywhere inside the
email, as some emails even have text which is actually an image, and clicking anywhere on these will
launch an undesirable link or launch a program download.

= Never save or open an attachment from a suspicious email, regardless of the format it appears to be in. It
doesn't have to be an .EXE or .BAT file to be dangerous. Seemingly innocuous files such as .ZIP, .SCR
and .JPG files can be faked and may also contain malware. Remember that the most common method of
infection for malicious software is accidental installation by users, so don't let your curiosity get the
better of you - if you don't know the source of the email, then do not trust it or any attachments. If you
must save an attachment, then manually scan it with multiple scanners first before opening it.

= If you receive an email purporting to be from your bank, financial institution or online store for example,
never click on any links they provide, however genuine they may appear. Real institutions never use
email to ask you to verify important details. These phishing emails usually refer you to a fake mirror
image of the site you expect to see, and there they trick you into revealing your credit card number or
personal details on a phony login screen. Links in emails can be 'masked' - that is they can seem real but
the actual link is different to the underlined hyperlink text shown. Or the link may appear legitimate but
have additional characters or other subtle alterations which actually point to another site. If you aren't
sure if you actually do need to verify or alter details with an institution, close the email, open a new
browser window and manually type in the known web address of your institution into your browser
address window, and check for any notifications there.

* Never click on or use any links that contain just an IP address at the start (e.g. http://68.203.11.34). These
links don't provide a site name because the name would tell you the site is a scam site, or not what it
purports to be. Legitimate sites never use just an IP address.

= Never install any 'security patches' or 'important updates' that have supposedly been emailed to you
from Microsoft, a software company or financial institution for example. Microsoft and companies never
send out updates or patches this way. Also never follow any provided links to an 'update site' or
download link provided in such emails.

* Don't click on any links which supposedly remove you from a mailing list - these are used by spammers
to verify that the email address is 'live’ (i.e. a real person is receiving and opening their spam) and hence
you will receive even more spam, or worse still the links could download malware. For the same reason,
never send any kind of reply to spam emails however tempting it might seem.

» If an offer seems too good to be true, ignore it. This includes unfamiliar people offering you millions of
dollars via email or chain letters purporting to give you good health or reward you with a free product
after certain conditions. All of these are scams designed to either harvest active email addresses,
perpetuate malware, or at best a prank.

For Windows Mail users see the Windows Mail chapter later in this guide for details of how to set it up to
filter spam and also prevent harmful files from being easily accessible in emails.

INTERNET BROWSING

» I strongly suggest you always run the very latest version of Internet Explorer to ensure maximum
security. This means you must regularly run Windows Update and install all the critical updates
available. Make sure to also enable phishing protection of some kind.

= If you are going to conduct a sensitive online transaction a secure site, such as an online banking or
online shopping site, make sure that once connected you look in your browser's address bar and see
https:// in front of the address (note the difference between http:// and https://), and to further verify the
credentials of a supposedly secure site before entering any sensitive details, double-click on the padlock
icon which appears and make sure the certificate is verified as being issued to the web address or name
of the company you believe it to be. If there is no https:// and no padlock then the site is not fully secure
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and hence you should not enter sensitive information there. Contact the company for more details if you
still wish to continue.

» If you have any doubts about a particular site you are visiting, note the site's name, then exit the site and
do a Google search both on the site's name and its web address. You should be able to see if there is any
positive or negative user feedback on the site. To see who actually owns and operates the site, go to
Whois and enter the site address to see more details. If the details are unclear, do not trust the site.

* Avoid visiting sites that purport to provide free software, music, movies etc. - basically anything that
seems too good to be true or is illegal. These sites are usually designed to both earn money from
advertising clicks or referrals to other websites, and more often than not attempt to install malicious
software on your system or use scripts to compromise your browser through any known exploits.

» Never install any certificate, software or plugin for your browser that does not come from a trusted site.
Even if a website insists that you must install certain software in order to view their content or perform a
function, ignore or cancel all such attempts unless the site is reputable and familiar to you. The most
common software you require for Internet multimedia functionality are the Flash and Shockwave
players, as well as Java, which you can install safely by downloading the latest versions directly from
here: ShockWave Player, Flash Player, and [ava.

See the Internet Explorer section later in this guide for more details of how to configure Internet Explorer
properly, or see my Firefox Tweak Guide if you use the Firefox browser.

PEER-TO-PEER, MESSAGING AND IRC PROGRAMS

* Peer-to-peer (P2P) programs (e.g. Emule or Bittorrent), instant messaging (e.g. ICQ, MSN or AIM) or
Internet Relay Chat (IRC) programs (e.g. mIRC) can be used to send and receive files directly to and
from other peoples' machines so you must be extremely careful when using them. Go through their
configuration options and ensure that you are not sharing files or directories which contain potentially
sensitive information such as passwords or licenses. Make sure to disable any automatic downloading
features, so that you at least see a prompt before a file can be downloaded. If you must swap files using
such programes, I strongly recommend that you create a new empty folder and only allow download and
upload access to this folder. Then place copies (not originals) of all the files you wish to share into that
folder, and disallow access to any other directory or drive on your system. Scan any files downloaded
through these programs with multiple scanners before opening them.

* Do not download or install any software which purports to allow you to steal other peoples’ passwords
or serial numbers, lets you 'store' your passwords/serial number, or lets you 'hack email accounts' for
example. Ironically these are usually trojans designed to steal your passwords and serial numbers.

* Before downloading a file from a peer-to-peer program you can usually tell if a file is real or fake by the
number of people who are sharing it: the less people sharing a particular file, the more likely it is that it
is either another file with a deceptive title, or worse still it contains malware. However there is never any
guarantee that any file is legitimate or indeed free of infection, even if it is popular.

Sharing and downloading files over P2P is one of the most risky things you can do on your machine because
you are downloading directly from another person's machine, and it is strongly recommended that you
minimize your exposure to such programs. If you insist on engaging in a lot of file sharing then I strongly
recommend that you keep UAC enabled, that you manually scan all your downloaded files with at least one
each of a virus, trojan and spyware scanner before using it, and that you increase the frequency of your
regular manual system scans.

BALANCING SECURITY VS. CONVENIENCE

In the past the balancing act between adequate security and convenience tended more towards convenience,
since security threats were not as prominent, and even if you caught a virus, it was often just a harmless
prank or at worst it ruined a few of your files. I recall as far back as 1987 I would regularly get viruses on my
Amiga 500 computer, and they were little more than a nuisance, sometimes even entertaining in their own
way. However unfortunately in the past few years there has been a significant rise in genuinely malicious
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software; namely software designed solely to do harm to your system and/or compromise your personal
information. This coincides with the rise in the number of people who are using the Internet to pay bills, do
their banking and go online shopping.

The stakes are much higher now, so it is far more important to pay attention to the security of your PC, and
it will continue to become even more important in years to come as the malware creators and online
fraudsters find increasingly more complex and intrusive ways of getting into your system. They make
millions of dollars from undertaking this sort of activity, so they have every incentive to innovate. This is
why Vista's security features, which at first appear to be overkill - especially User Account Control - are
actually very necessary and should not be disabled without careful consideration. You will need to do more
than just a couple of manual scans of your system every week or two, or enable a malware scanner or two in
the background to keep it secure. The balancing act between security and convenience has now swung more
towards security than purely convenience, so you must make some effort to keep your system secure, even if
this can be a bit of a pain at times; it's simply unavoidable now.

I've tried in the chapter above to give what I believe is still an acceptable balance between security and
convenience, and importantly keeping in mind the impact on performance for people like gamers. Rather
than just suggest the use of background malware scanners which can hurt performance, I have
recommended a combination of Vista's own built-in features and third party tools used in manual scanning
to create a good layer of defence with no real performance impact.
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MEMORY OPTIMIZATION

This chapter looks at the configuration and optimization of memory-related functionality on your system. It
is very important to understand how your computer uses the various forms of memory on your hardware,
as well as how Vista's improved Windows Memory Management system works on conjunction with this
hardware. Memory-related hardware and software settings have a major influence on your system's
responsiveness, performance and stability, not to mention your data integrity. A system with mis-configured
memory-related settings risks slowing down, becoming unstable, experiencing errors and sudden reboots,
and ultimately causes data corruption which can even make your system unbootable.

B MEMORY HARDWARE

The following are the common forms of memory hardware used on most modern PCs:

CPU CACHE

The CPU Caches are memory chips that cache (buffer) information for faster usage by the CPU, since the
CPU is the central component of your system. They assist in temporarily storing the information in
anticipation of reading/writing by the CPU, preventing any bottlenecks or slowdowns. The cache chips
themselves vary in storage capacity depending on your CPU, but essentially they are physical chips that you
should not have to worry about. Windows and your associated hardware are designed to automatically
detect the size of these caches and use them optimally as long as you have them enabled in your BIOS. That
is, if options relating to the use of CPU L1 and CPU L2 Cache are present in your BIOS, never disable them
unless troubleshooting. Aside from BIOS settings, there is a SecondLevelDataCache Registry setting for
manually adjusting your CPU's L2 Cache setting. However as with Windows XP, altering this setting is not
necessary, as the default value of 0 already allows Windows Vista to automatically identify and use the
correct L2 Cache size.

In general since the user has no control over the CPU's L1 and L2 caches (aside from ensuring that they are
enabled in the BIOS), this is one area of the memory subset you should not worry about unless you are
troubleshooting a memory-related problem. For example, a CPU with a faulty cache may exhibit strange
behavior such as constantly returning data errors and CRC errors. In these cases you can try temporarily
disabling the caches in the BIOS to see if this reduces or resolves errors. Also see the Performance
Measurement & Diagnostics section for tools which can detect whether the caches are problematic.

PHYSICAL RAM

This is probably the most well-known form of memory. RAM (Random Access Memory) usually comes in
sticks composed of multiple memory chips adding up to a certain size (such as 256MB or 512MB). Physical
RAM, also referred to as System RAM, Physical Memory or just RAM, holds information in storage that can
be read from and written to by your system components. It is a temporary holding area for data, and is
constantly being accessed when your machine is on. The advantage of RAM over other forms of storage such
as your hard drive is that it is much, much faster to access, so optimal RAM usage means and smoother
performance for your system. There are three main factors affecting RAM performance: RAM size, RAM
speed and RAM timings, each covered below.

RAM Size: This is the actual storage capacity of the RAM in MegaBytes (MB) or GigaBytes (GB). The main
impact of having more RAM is that - when combined with appropriate Windows Memory Management
settings - your system will perform more smoothly. This is because data has to be loaded less often from
your hard drive, as more of it is stored in RAM, making it easier to access rapidly by your CPU and the rest
of your system. RAM size is very important in Windows Vista because of the way it utilizes physical
memory to speed up your system.
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Vista Home Basic has a minimum RAM requirement 512MB and the higher versions of Vista require 1GB of
RAM as a minimum. Furthermore many recent games require 2GB or more of RAM to perform optimally
without stuttering or displaying frequent loading pauses. There are no RAM size tweaks; essentially if you
have a low level of RAM (e.g. 512MB) then it is strongly recommended that you consider getting more RAM,
especially if you constantly experience stuttering and long pauses in games or the Desktop for example. Bear
in mind however that Vista 32-bit cannot practically use more than 4GB of RAM; only the 64-bit version can
do that. So any more than 4GB of RAM is usually wasted in Vista 32-bit - see the Windows Memory
Management section further below for details.

RAM Speed: This is the frequency at which RAM operates (in MHz), much like the speed at which a CPU
operates. The higher the RAM's speed, the faster it can undertake the operations it needs to perform. Each
stick of RAM has a speed rating, which is the speed up to which a stick of RAM is certified to safely operate.
However the actual speed a RAM module is currently running at on a particular system varies depending on
how fast it is set to operate in the BIOS and your Front Side Bus/HyperTransport speed. For example, a DDR
PC3200 RAM module can operate at up to 400MHz (2x200MHz) while staying within specifications.
However it is possible to adjust your BIOS such that the RAM can operate at a higher speed. The bottom line
is, the faster the RAM's actual speed in MHz, the faster it reads and writes information and the better your
performance. Remember though that the speed rating is not the same thing as the actual RAM speed - it is
only an indicator of how fast it can potentially perform and has no direct bearing on performance. However
the more the RAM's actual speed surpasses its rated speed, the greater the chance for instability, so ideally
you should keep the RAM at or below its rated speed for maximum stability and data integrity. See the
Overclocking chapter for more details of how to adjust RAM speed and the impacts this has.

RAM Timings: These are composed of several variables, set in your BIOS, which determine not the frequency
of the RAM module (RAM speed), but the Latency of the RAM - that is, the amount of time it waits between
updating various signals. For example the RAS (Row Access Strobe) and CAS (Column Access Strobe)
latency settings measure in nanoseconds the delay in sending signals which specify firstly the row in which
a particular memory cell is located, and then the column. The lower the RAM timings in nanoseconds, the
less time the RAM rests between these operations, and hence the faster it performs, but the greater the
chance for errors and instability. Just like speed ratings, RAM modules come with recommended timings
already encoded in their Serial Presence Detect (SPD) on a special chip. These SPD settings are used by
default by your system unless manually changed in the BIOS, and when used with the recommended speed
rating (see above) ensure maximum stability.

If you want to improve the performance of your RAM and your entire system, you can lower its timings
and/or increase its speed - see the Overclocking chapter. However any time your RAM is running faster than
it's rated speed or timings this can decrease your system's stability and increases the potential for errors
particularly when the system is under stress. Importantly, if you want to test your RAM for stability, see the
Windows Memory Diagnostic Tool under the Performance Measurement & Diagnostics chapter.

VIDEO RAM

Video RAM (VRAM) is the memory built into your graphics card and the size of this is usually quoted in MB
as part of the graphics card's specifications (e.g. 768MB 8800GTX). This RAM acts as a temporary storage
location to hold graphics information for faster access by your graphics card, much the same as system RAM
does for general information. For this reason the VRAM is also called the Frame Buffer, in that it holds
(buffers) individual graphics 'frames' ready to send to your monitor one by one. Just like physical RAM,
VRAM has a speed in MHz, and a latency in nanoseconds, with the higher the speed and the lower the
latency the better the graphics performance. Unlike physical RAM, altering the latency of your VRAM is
tricky and not recommended, though still possible. The speed in MHz can also be altered up or down using
an overclocking utility, with the faster the speed the higher the performance, but once again the greater the
chance of graphical glitches and freezes. See the Overclocking chapter for more details.
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If you're interested in a plain English step-by-step overview of how the hardware memory features above
are utilized for a task like gaming, check the Graphics Process section of my Gamer's Graphics & Display

Settings Guide for details.

B WINDOWS MEMORY MANAGEMENT

Windows Vista has implemented a different and improved form of memory management over Windows XP,
and the results have caused some confusion. People look at their Vista memory usage statistics in Task
Manager and are surprised to find that Vista is using a great deal of their system RAM, even immediately
after system startup. The reason for this change is simple - Vista's is trying on purpose to make sure that as
much of your RAM as is practically possible is utilized effectively via a new feature called SuperFetch. There
are many improvements to Windows Memory Management you can see a summary of them in this
Wikipedia Article, but to summarize in plain English, the changes include:

= New features including SuperFetch which attempts to anticipate and preload information for quick
access, and ReadyBoost which uses a connected USB drive to provide additional memory resources.
Both are user-configurable and both are designed to increase system responsiveness.

* Improved performance on 64-bit and multi-core CPUs.

* Increased security to maintain data integrity and prevent memory exploits.

* Registry virtualization to prevent system harm and optimizations to prevent Registry corruption.

* Removal of various limitations which affected performance under Windows XP.

* General performance improvements through optimizations in the way the memory management
algorithms work.

Below we look at the important aspects of Vista's new Memory Management system in detail.

MAXIMUM SUPPORTED RAM

Before examining Vista's memory management features, it's important to understand that under Windows
Vista 32-bit, a system can only effectively use a maximum of 4GB of RAM; any higher won't be detected or
used by default. In fact even with 4GB of RAM you may only see around 3GB of that displayed. This is a
normal limitation of the 32-bit architecture, not just Vista, and is detailed in this Microsoft Article. Basically

some of the maximum of 4GB of address space (not RAM) will be reserved by the system for hardware
requirements, which in turn limits how much system RAM can be used at any time.

To force Windows Vista 32-bit to use 4GB or more of RAM, you need to enable a feature called Physical
Address Extension (PAE), which can be done by opening an Administrator Command Prompt (See Vista
Usage Notes chapter) and typing the following:

BCDEUdit /set PAE forceenable
Alternatively you can enable the PAE option in VistaBoot Pro - see the Boot Configuration chapter.

In general under the 32-bit platform there is not much to be gained by having 4GB or more of RAM, as it
cannot be used as efficiently. If you definitely need to use large amounts of RAM then you should use the 64-
bit version of Vista instead. Under Windows Vista 64-bit, the maximum supported RAM is 8GB for Vista
Home Basic, 16GB for Vista Home Premium and 128GB for the Vista Business, Vista Enterprise and Vista
Ultimate editions. This is because the 64-bit architecture is specifically designed to support such higher
amounts of RAM without any need for changing settings or sacrificing efficiency. Of course there are other
concerns with using the 64-bit version of Vista - see the relevant section of the Windows Installation chapter
for details.
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SUPERFETCH

SuperFetch is the cornerstone of Vista's new memory management system, and is an evolution of the
Windows Prefetcher in XP. It functions on the principle that 'Free RAM is wasted RAM', which is true in
theory. For example if you have 2GB of physical RAM, and your system only uses 512MB of that at any time,
rather than being efficient this is actually quite wasteful of the other 75% of your RAM which sits idle,
drawing power but not helping to speed up the system in any way when it could do so. Rather than waiting
for you to launch common tasks and programs and then loading the data into RAM, SuperFetch uses an
intelligent prioritization scheme which over time tries to work out your usage patterns and anticipates what
you will need and when. It will load portions of your most commonly used programs into and out of
memory in advance, making the system feel more responsive on average. In effect this turns your RAM into
one big cache to improve speed and responsiveness in Windows.

However this doesn't mean that SuperFetch will go crazy and keep filling RAM until you run out of memory
and slow the whole system down. For starters Vista has a feature called Resource Exhaustion Prevention (see
further below) which specifically attempts to prevent the system from becoming slow due to a lack of
memory resources, with or without SuperFetch. Secondly, SuperFetch's caching method is designed to be
adaptive, so programs you use less often or which are a lower priority than those you are currently using
will be shifted out of RAM to make room for whatever the current top priority program is, allowing your
system to remain responsive. For example if you suddenly launch a program which requires most of the
memory, such as a game, SuperFetch will instantly free up as much memory as is required. For the most part
this actually works well in practice, with no noticeable performance impact as SuperFetch reallocates
resources almost instantly. Any program which needs memory gets it; SuperFetch does not prevent that.

The most noticeable negative impact of SuperFetch occurs as Vista starts: you may notice a fair bit of
additional drive activity as SuperFetch begins to cache as much information as it can into RAM. In fact any
time you free up memory resources, either by removing unnecessary background programs, or by closing an
open application, SuperFetch will immediately attempt to cache more into memory and this can churn the
hard drive for a short while. Rarely does this impact on performance, but it is wise not to launch a game or
major application immediately after system startup - allow a few minutes for SuperFetch to do its job. As a
tradeoff for this wait your most commonly used applications and games will load much faster and usually
have less stuttering, because major portions of them have already been preloaded into RAM.

You can see how much RAM is being used as a cache by SuperFetch at any time by opening Task Manager
and under the Performance tab looking at the Cached and Free lines under the Physical Memory section; the
main Memory graph display in Task Manager is actually the sum of memory resources used by running
processes which is not the same as total RAM used. When SuperFetch is enabled your Free RAM will be
minimal, often close to 0 as SuperFetch uses as much of it as is not directly in use by open processes for the
Cached component. This is not something to be alarmed about - see the Task Manager section under the
Performance Measurement & Diagnostics chapter for a full description of how to use Task Manager and
understand what all the components of it mean.

While I didn't like Windows XP's Prefetcher, in my experience SuperFetch does a much better job of
handling memory in day-to-day situations, and can noticeably improve responsiveness in Vista. Application
launch times can literally drop from a few seconds to a second or less, opening almost instantaneously in
some cases, making your common tasks feel very snappy. Remember that SuperFetch needs time to analyze
your usage patterns and adapt to them, and improves over time, so I recommend that you leave SuperFetch
enabled for at least two weeks of daily Vista usage before judging the impact it can have on your machine.

If you still want to disable SuperFetch, to do so open the Services utility, double-click on the SuperFetch
service and select Disabled - see the Services chapter for more details. Then you will also need to delete the
contents of the \Windows\ Prefetch directory. After a reboot SuperFetch will no longer be in use. Disabling
SuperFetch may be the best course of action for those with 1GB or less of RAM. Note that if you do disable it,
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and then want to re-enable it, remember that it will take SuperFetch a while to get back up to speed in
analyzing your usage patterns. Importantly, don't regularly 'clean out' the \ Windows\ Prefetch folder as this
ruins SuperFetch's performance.

If you want to customize SuperFetch's behavior you can do so in the Windows Registry:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\
Memory Management\PrefetchParameters]

EnableSuperfetch=3

uonyezruygd() AI0WIA

This DWORD value can be changed to a value of 1 to prefetch boot processes, 2 to prefetch applications and
3 for both. The default of 3 is recommended and generally should not be changed.

READYBOOST

Another new feature in Vista is ReadyBoost, which allows you to use external memory devices to speed your
PC in conjunction with SuperFetch. You will require a USB Flash Drive or similarly fast removable media
with 256MB of space or more. Connecting this device to your system will bring up a prompt asking if you
want to '‘Speed up my system'. Note that the prompt will not come up if you've disabled Autoplay for this
type of device - see Autoplay under the Control Panel chapter. If you select this option, the device will now
be configured for use by SuperFetch to hold information which would otherwise be cached out to your hard
drive; by placing it on the much faster flash drive, SuperFetch can access it much faster thus further
improving system performance. The less RAM you have, the more you will see a benefit from ReadyBoost;
however ReadyBoost is not a direct replacement for RAM.

In the ReadyBoost dialog box which opens - or which can be accessed by going to Windows Explorer, right-
clicking on the device, selecting Properties and then clicking the ReadyBoost tab - you can configure
ReadyBoost. You can set the amount of the device's RAM ReadyBoost uses under the 'Space to reserve for
system speed'. Windows will provide a recommendation of how much you should use as a minimum, and
the general recommendation is based on around one to three times the amount of physical RAM on your PC.
Note that the information on the device is compressed and encrypted using 128-bit AES encryption, so if you
misplace the device or it is stolen, others will not be able to access your information.

If you don't wish to use the device for ReadyBoost or wish to stop at any time, select ' Do not use this device'
in the ReadyBoost box. Note that if you've disabled SuperFetch then ReadyBoost will have no impact.

RESOURCE EXHAUSTION PREVENTION

Part of Vista's new built-in diagnostics is Resource Exhaustion Prevention which automatically detects if any
particular processes are consuming most of your memory resources. As resources come close to being
depleted Vista may present a warning to the user indicating the particular program that is using up too
much memory, and provide the user with an option to close the program to prevent data loss through forced
shutdown of processes. You can cancel out of this prompt if you know the program is supposed to take up
all available memory, such as using a benchmarking utility that uses all available RAM by design - for
example see Prime95 under the Performance Measurement & Diagnostics chapter.

However if you receive this prompt often, it is recommended that you first reduce unnecessary background
programs - see the Startup Programs and Services chapters. If that doesn't work, increase your Virtual
Memory amount (see below), use ReadyBoost to add to the system's memory resources, and if all else fails
then consider purchasing more RAM. For other Windows Diagnostics features see the Performance
Measurement & Diagnostics chapter.
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VIRTUAL MEMORY

Virtual Memory refers to a memory management technique used in several generations of Windows. During
normal operation, system RAM is the best place to store information for fast access by your CPU and other
components, since it has no moving parts and information in it can be accessed at many times the speed of
any hard drive or CD/DVD. So ideally Windows Vista likes to keep a portion of all of your most commonly
used programs in RAM, as well as most of your currently used application(s) - see the SuperFetch section
above for details. There are also other memory requirements for the hardware and software on your system
which all require some portion of memory resources.

When RAM starts to run low, or if Vista determines a particular application is no longer a high enough
priority, it breaks up some of the portions of memory (called 'pages’) and temporarily swaps them out from
your RAM to your hard drive. This 'swap file' where the memory pages are held on your hard drive is called
pagefile.sys, and resides in the base directory on your hard drive (e.g. C:\pagefile.sys). That's why you will
often see the terms Virtual Memory, Pagefile and Swapfile being used interchangeably to refer to the same
thing. Note you will only see pagefile.sys if you have enabled 'Show Hidden Files & Folders' under Folder
Options - see Folder Options under the Windows Explorer chapter.

Under Windows Vista, the improved Disk Management and Memory Management techniques try to
minimize reliance on the hard drive, since using it can cause stuttering or small delays and hence reduce
responsiveness. However a pagefile is still very important to Windows Memory Management and even with
a great deal of RAM, is not something you should disable or consider redundant.

To access your Virtual Memory settings, go to Control Panel>System and click the 'Advanced system
settings' link. Alternatively go to Start>Search Box and type "systempropertiesadvanced" (without quotes)
and press Enter. Then click the Settings button under Performance, and select the Advanced tab. Click the
Change button. Untick the 'Automatically manage paging file size for all drives' and you can now alter the
physical location and size of the pagefile. Read the advice below before making any changes however:

Clearing the Pagefile: Before setting a new pagefile size or location, I strongly recommend first clearing your
existing pagefile. To do this select each relevant hard drive, choose the 'No paging file' option and click the
Set button, then you need to reboot your system. This step does two things: first it clears the pagefile, fixing
any potential pagefile corruption which can occur after a bad shutdown; and secondly it ensures that any
new pagefile you create will start off as a single unfragmented contiguous block on your hard drive for
optimal performance, which will remain unfragmented in the future. Note that if you have any problems
booting back up into Windows due to a lack of a pagefile during this step, enter Windows in Safe Mode and
continue the setup procedures for Virtual Memory from there - see the Backup & Recovery chapter.

Location of the Pagefile: Once you've cleared the pagefile, you can now set its physical location. Highlight the
logical drive where you want the pagefile to be placed under the Drive window. Which drive or partition the
pagefile should be located on is based loosely on the following scenarios:

* 1 Hard Drive with 1 Partition - The pagefile can only be located on the first primary partition of your
hard drive, which provides optimal performance.

* 1 Hard Drive with 2 or more Partitions - Make sure the pagefile is placed on the first primary partition as
this is the fastest partition. Placing the pagefile on another partition of the same drive does not simulate
the benefits of having two hard drives since the read head of a single drive can still only seek
information from one place at a time.

* 2 Hard Drives or more (similar speeds) - If all your hard drives are similar in terms of their rated speed,
you should put the main pagefile on the drive that doesn’t contain your Windows installation and
applications/games. This will reduce hard drive head movement on the main disk and speed up access
to the pagefile on the other disk.

* 2 Hard Drives or more (different speeds) - If one drive is faster than the others, you should put the
pagefile on that drive, particularly if you have low system RAM (i.e. the pagefile is accessed more often).
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* RAID Configuration - For striped RAID configurations such as RAID 0 or RAID 5, Windows sees these
as a single large hard drive, hence you cannot actually choose which drive to place the pagefile on; it will
be split evenly across the drives which is optimal. If you have a separate faster drive outside the RAID
configuration, you can shift the pagefile there.

After selecting the location of the pagefile, you can then determine its size in MB. In the Virtual Memory
settings screen select the 'Custom size' option. Although there are many differing opinions on how big the
pagefile should be, it is important not to 'disable’ your pagefile regardless of how much RAM you have.
Windows and certain programs need a pagefile in order to operate correctly. Setting the pagefile to zero does
not force Vista to use your physical RAM. Windows Memory Management does not work that way.

Windows Vista sets your pagefile with a minimum size equal to System RAM + 300MB, and the maximum
size at 3 times System RAM. So if you have 1GB of RAM, Vista will set a dynamic pagefile which starts off at
1.3GB and can go up to a maximum of 3GB. This default pagefile size is reasonable but not optimal. Vista is
more dependent on RAM for improving performance, but it still seems to use the pagefile, so I recommend a
fixed pagefile size which provides sufficient headroom for gaming and memory-intensive applications, but
does not require Vista to constantly resize the pagefile nor is overly large:

For those with 1GB of RAM:

Set the Initial and Maximum pagefile sizes to 2048MB each - i.e. allocate 2GB for the pagefile.
For those with 2GB of RAM:

Set the Initial and Maximum pagefile sizes to 1024MB each - i.e. allocate 1GB for the pagefile.
For those with 3 - 4GB or more of detected RAM:

Set the Initial and Maximum pagefile sizes to 512MB each.
If you also have ReadyBoost:

Add the amount of ReadyBoost memory to your RAM when following the recommendations above.
That is if you have 2GB of RAM and 1GB of ReadyBoost, then consider yourself to have around 3GB
of system memory for these purposes. This is because the system will try to use the ReadyBoost
memory before it uses your pagefile.

Once you've adjusted your Virtual Memory size settings click the Set button and reboot if required. Your
pagefile will now be in a single fixed unfragmented file. The recommendations above are not strict, and will
change over time as new applications or games come out which demand more memory. For the moment
they are designed to provide enough virtual memory should you need it, especially when multitasking or
gaming. However if at any time the Resource Exhaustion Prevention prompt comes up, you should reset
your pagefile and increase it. Having a larger pagefile size does not hurt performance as such; it mainly
takes up additional drive space, so if in doubt, play it safe. If you have any doubt, reset your pagefile and
revert back to the 'System Managed Size' setting to let Windows manage the pagefile size.

Finally, remember that Windows Vista is more dependent on RAM, since it actually uses RAM to improve
performance and maintain responsiveness. Thus the Minimum Requirement for RAM in Vista is 512MB for
Home Basic, and 1GB for the other versions. If you only meet the minimum I would strongly recommend
getting more RAM if you wish to use your system for gaming or other system-intensive tasks. I suggest a
practical minimum of 2GB. There's only so much Windows Memory Management can do when it's
managing a scarce resource in such high demand.
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HARD DRIVE OPTIMIZATION

Windows Memory Management is tied closely to the way the hard drive is used in Windows Vista. The
reason for this is mentioned under the Memory Optimization chapter: your hard drive can be used as a
temporary storage area, but is one of the relatively slower components of your system. Even the fastest hard
drives cannot read or write data as quickly as RAM. So when one of your components such as the CPU or
graphics card needs information, to prevent pauses, stuttering or slowdowns, as much of the information as
possible should be held in RAM for fast access. However regardless of how much RAM you have, or how
efficient Windows is with memory management, at the end of the day RAM is only a temporary form of
storage which is cleared each time your PC shuts down. Therefore it is the hard drive where all your
information is permanently held, and your system must regularly access the hard drive for data, from the
moment the PC starts up to the time you run a program. This chapter looks at how the how drive is used in
Vista, and how you can make sure it is optimal.

B WINDOWS DRIVE OPTIMIZATIONS

To deal with the potential bottleneck that the hard drive represents on modern systems, Vista has an
improved Input/Output (I/O) System which now prioritizes the allocation of hard drive read and write tasks
by your various applications and games. When multiple applications are running on a system this can often
put great demands on your hard drive, which because of its slower mechanical nature may struggle to
smoothly supply all the data required. For example you may be using Windows Media Player to listen to
music or watch a movie while a virus scanner is doing a full scan; or you may be playing a game while the
Disk Defragmenter attempts to run a scheduled job in the background; or you may be downloading a file
from the Internet while your system is encoding a large video file. If multiple tasks like these are not handled
properly by Windows, the end result is significant stuttering, long pauses or freezes or even data errors.

Vista significantly improves the situation by allowing multiple tasks to run together more smoothly.

When you run multiple applications at once - called multitasking - first Vista prioritizes applications based
on how much CPU time they need. This is not I/O prioritization, this is the management of separate program
'threads' which are competing to get access to the CPU so they can complete their tasks. Vista prioritizes
these threads such that the important ones receive more overall CPU time if they require it. The six broad
priority categories for CPU Priority are: Real Time, High, Above Normal, Normal, Below Normal and Low.
They can be viewed and manually altered using Task Manager - see the Task Manager section of the
Performance Measurement & Diagnostics chapter for details. Note also that multitasking is where having a
multi-core CPU is of most benefit, as any time you run multiple programs at once, the separate threads are
split across your two (or more) CPU cores and thus completed faster.

Having allocated a priority for CPU time, Vista then determines the relative priority of applications for hard
drive time, or in other words I/O Prioritization. Vista bases 1/O Priority on four broad categories: Critical,
High, Normal and Low. You cannot manually alter these, as they are determined by the application itself
combined with Vista and how a user is currently using the system. The bottom line is that certain tasks will
run at reduced speed or even cease altogether if the I/O resources are required by more important tasks; this
is particularly important for gamers since games require total control of I/O resources for smooth gaming.

The practical impacts of this I/O Prioritization scheme are that firstly less critical tasks such as scheduled
Windows Defender scans, the Windows Disk Defragmenter or SuperFetch will not cause the system to
become unresponsive. In fact Vista will suspend certain tasks altogether if a more important task is being
undertaken, like playing a game or using a program. So the background Search Indexer function for example
will not suddenly conflict with whatever else you are doing; it will only run when the system is relatively
idle, and the speed with which it runs will vary to maintain system responsiveness at all times. Vista also
specifically reserves hard drive bandwidth for certain tasks which specifically need a consistent flow of data,
especially multimedia applications, so that these are not disrupted. Thus it is possible to run the Disk
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Defragmenter while also listening to music on Windows Media Player without glitches occurring for
example.

I've also found that you can run multiple drive-intensive tasks together with much less chance of conflict or
sudden freezes or slowdown; it simply may take longer to complete, but the more efficient I/O allocation
prevents serious problems. For example I tried playing the game Elder Scrolls: Oblivion while also doing a
Diskeeper defragmentation of my drive at the same time; the game was surprisingly free of major stuttering
and performed quite well while the defragmentation also continued at a reduced speed in the background.
At no point did the system lockup, or have major pauses or serious slowdowns.

However the actual impact of multiple tasks running at once on your system will vary depending on a range
of factors, particularly your hard drive speed and the amount of RAM you have. The slower your hard drive
(e.g. older 7,200RPM or 5,400RPM drives), the less RAM you have, and the more applications you try to run
at once, the more likelihood that no matter how hard Vista tries, it won't be able to prevent some slowdowns
or stuttering. In that case clearly try to reduce the number of things you're doing at once. The new 1/O
prioritization cannot work miracles, so to minimize stuttering issues when gaming in particular, I
recommend that you still close down all open applications.

As a final note related to I/O Prioritization, Vista also ensures that when you want to undertake a file copy or
move, such as moving several large files from one drive to another, it checks first to ensure the resources are
available and the task can be completed without problems before it undertakes the actual drive-intensive job
of moving files. This prevents the situation where you reach halfway through a file copy or move only to
have the task exist due to an error of some kind.

READYDRIVE

ReadyDrive is a feature of Vista which has been specifically designed to take advantage of a Hybrid Hard
Disk Drive (H-HDD) when combined with SuperFetch. Hybrid hard drives are composed of a traditional
hard drive combined with onboard flash memory which acts as a high-performance cache for the drive. This
cache reduces the actual usage of the drive mechanism itself, in turn saving power and increasing read and
write speeds for common tasks. The larger the cache size, the greater the benefit, with the minimum
supported size being 50MB, but a recommended minimum of at least 128MB is required for any noticeable
advantage, and preferably 256MB - 1GB for a genuine performance advantage. The maximum cache possible
for ReadyDrive is 2TB (TeraBytes), so it is not really limited in that respect.

Unless you have a Hybrid Drive connected to your system you will not be able to use this technology, and in
most cases the most common use for this technology would be in notebook computers which would benefit
the most from the reduction in power consumption. Note that if you disable SuperFetch you may reduce
some of the speed benefits of ReadyDrive.

DISK DIAGNOSTICS

By hourly checking data from the your hard drives' Self Monitoring, Analysis, Reporting Technology
(SMART) feature, Vista's built-in Disk Diagnostics can detect if there is going to be a potential disk failure in
the near future, and warns the user in advance, providing a set of steps to undertake to backup your data
before it may be lost through drive failure. Note that SMART must be enabled in your BIOS for your
particular hard drives for this functionality to work, so if your drive(s) don't support SMART or it is disabled
Vista won't be able to check for disk problems automatically in this way.

Alternatively if you want to manually check the SMART information yourself, you can use a utility like
PassMark Disk Checkup which provides additional information about your hard drive and the currently
monitored SMART parameters.
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Regardless of this functionality, you should already have a regular backup plan in place - see the Backup &
Recovery chapter for more details.

CHECK DISK

To check your hard drive for errors, such as bad sectors or corrupted indexes, you can run the Windows
Check Disk utility. To access it go to Windows Explorer, or click on the Computer item in Start Menu, then
right-click on your hard drive name and select Properties. Then under the Tools tab, click the 'Check Now'
button to launch Check Disk.

To run a scan of the drive for file system errors while in Windows, tick only the 'Scan for and attempt
recovery of bad sectors' box and click Start. To do a more thorough check, which I recommend you do
periodically, or specifically whenever you suspect drive-related problems, tick both boxes and click Start.
Click the 'Schedule disk check' button and the next time you reboot Check Disk will run at startup. If it finds
any problems it will try to fix them automatically.

B DRIVE CONTROLLERS

One of the determinants of your hard drive speed is the type of drive controller it is using. The most
common drive controllers are for the IDE and SATA interfaces, including the newer SATA II standard - see
the Basic PC Terminology chapter for more details. To ensure that your controllers are setup up correctly
and configured for optimal performance in Vista, follow the steps below.

First make sure that you have installed the latest and correct motherboard drivers for your particular
motherboard, as the drive controllers on your motherboard require these for optimal operation, as well as
special functions like RAID - see Step 2 under the Windows Drivers chapter for more details.

Next, open Device Manager under the Control Panel, and expand the Disk Drives section. Your hard drive(s)
should all be listed here and correctly identified. If they are not, check your BIOS to ensure that you have
enabled the relevant controllers and that the drivers are being detected in the BIOS - see the BIOS &
Hardware Management chapter.

Right-click on each drive and select Properties. Under the Policies tab, you will see some or all of the
following options:

Optimize for: The 'Optimize for performance' option should be selected for maximum performance, unless
you actually need to hot swap' hard drives regularly, that is to remove them quickly. Most desktop PC users
will not remove their hard drives often. Note that if you see a 'Safely Remove Hardware' icon in your
Notification Area, you should click it before disconnecting your hard drive. Furthermore this item cannot be
removed and is normal. You can only hide it - see the Taskbar and Start Menu section of the Control Panel
chapter for details.

Enable Write Caching on the Disk: Write caching temporarily uses the drive cache to store writes to your hard
drive before they are actually written to the drive. This allows the hard drive to write faster, since writing to
cache is quicker than writing directly to the drive. However if there's a power failure, any data in the cache is
lost before being committed to the hard drive. The risks are quite remote, so this option should be ticked for
maximum performance.

Enabled Advanced Performance: This option further relies on the drive cache for reads and writes to improve
performance, and again the risk is that if any there is any interruption to the power supply to your drive, or
any hardware issues, you may lose or corrupt data. I believe the risk to be low, so I recommend ticking this
option. If you don't have steady power supply or a reliable hard drive then you may untick this just to be
safe.

uonezrundQ aALI(] prepy

Copyright © 2007 Koroush Ghazi 117



O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

Next, go to the 'IDE ATA/ATAPI Controllers' section (or similar) and expand it. Right-click on each sub-
controller listed and select Properties and see the relevant section below:

ATA Channel: This controller affects all PATA drives which use the IDE interface. Typically this is older hard
drives and CD/DVD (optical) drives. Go to the 'Advanced Settings' tab and at the bottom make sure 'Enable
DMA' is ticked for optimal performance. You will also see what mode the drive is running under, which
should be Ultra DMA Mode 4 for optical drives, and Ultra DMA Mode 6 for IDE drives. You cannot alter the
speed here, but it be limited due to one of more of the following factors:

*  Your motherboard does not support Ultra DMA 6 or Ultra DMA 5 modes - these are also called ATA 133
and ATA 100 respectively. Check your motherboard manual and make sure you have installed the
correct IDE drivers for this motherboard.

*  Your BIOS is not configured correctly to enable the highest speed - see the BIOS & Hardware
Management chapter.

* You are sharing a hard drive and a CD/DVD drive on the same channel - move them to separate
channels.

*  Your hard drive(s) or CD/DVD drives don't support the highest transfer mode available on your
motherboard.

= No drive should be running in PIO or Multi-word DMA mode as these provide poor performance.
Check your BIOS and any switches on the back of the drive.

Serial ATA Controller: This controller affects all SATA drives connected to your motherboard. Right-click on
this controller, select Properties, then go to the Primary Channel' and 'Secondary Channel' tabs. If a drive is
connected to these channels, the "Transfer Mode' should show the correct maximum speed for the drive -
1.5GB/s for SATA 1, or 3.0GB/s for SATA II. All the boxes in this section should be ticked for optimal
performance, and if available you can click the 'Speed Test' button to do an actual quick benchmark of the
drive's speed.

If your SATA hard drive is not set to the highest mode possible for its type, or some of the options are
unavailable here then you have not set up your BIOS correctly or you have not installed the correct SATA
motherboard drivers.

B WINDOWS DISK DEFRAGMENTER

As information is written to or deleted from your hard drive, portions of individual files will become
fragmented and physically spread out all over the drive. This happens because as Windows starts writing
the data for a file onto the drive, when it reaches an occupied portion of the drive it jumps to the next
available empty spot and continues writing from there. So a single large file may actually be in several
separate chunks in various locations on your drive. The more the files on your system are fragmented, the
more time your hard drive takes to find all these fragments and access the information it needs at any time.
It's like trying to read a book with the pages out of order. This can clearly reduce drive performance and
increase the potential for stuttering and loading pauses.

Windows Disk Defragmenter - or Defrag for short - is a built-in utility that performs a very important
function: it finds all these file fragments and puts them back together in the same location on the disk,
preventing the degradation of your hard drive's performance. To access the Windows Defrag utility, go to
Start>All Programs>Accessories>System Tools, or go to Start>Search Box and type "defrag" (without quotes)
and press Enter. In Windows Vista the Defrag interface and functionality has changed. Unlike previous
versions of Windows, Defrag is now designed primarily to be automated and by default runs on a weekly
schedule, defragmenting your drive in the background at a low priority hence causing minimal disruption to
system responsiveness. It does a good job of this, however unlike previous versions of the Defrag utility,
there is no graphical progress indicator or otherwise, showing you how fragmented your drive is or how
long the process may take. Microsoft claims that this is both because an accurate graphical representation of
fragmentation, and progress towards completion of defragmentation is difficult to provide, and that users
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do not understand or want to see such a display. If this aspect of the Windows Defrag tool bothers you, then
see the Advanced Defragmentation section further below.

If you wish to change the scheduled times or frequency with which the automatic defragmentation occurs,
click the 'Modify schedule' box and you can specify how often, on which particular day and at what time the
process is initiated. If you wish to disable this scheduled defragmentation altogether then untick the 'Run on
a schedule' box. In general I suggest leaving the automated defragmentation schedule to run once a week,
preferably at a time when you will not be playing a game or doing any other drive-intensive activity. Note
that if you miss the scheduled time, such as your PC being off at that time, Vista will do it when next
possible.

However since defragmentation is best done immediately after you make major file changes to the drive, I
strongly recommend also doing a manual defrag immediately after any of the following events:

* Installation of any game or application.

* Patching any game, application or Windows.
» Installation of any drivers.

* Adding or deleting very large file(s).

This is particularly necessary for gamers, since games are already quite prone to stuttering and longer
loading times due to their data-intensive nature, so by defragmenting your drive after a game installation or
patch, you help reduce stuttering in the game.

To initiate a manual disk defragmentation at any time, first close as many applications as possible, then open
Defrag and wait for it to analyze your hard drive if necessary. When complete click the 'Defragment now'
button and it will start the defragmentation process straight away. As mentioned, no indication will be given
on how long it will take or how far it has progressed - it will continue until it indicates that it has finished. If
you run any other program during this process, Vista will reduce the priority given to Defrag, which in turn
will increase the time taken for process to complete, so try not to do much while Defrag is running.

If you want greater control and feedback from the Windows Disk Defragmenter, you can use the Defrag
command line option in Vista. Start an Administrator Command Prompt (see Vista Usage Notes chapter)
and then type "Defrag /?" (without quotes) for a list of commands. Common commands are shown below:

Defrag [driveletter:] -a
e.g. Defrag C: -a

This will run an analysis and provide more detailed information on how fragmented your drive really is. To
run a defrag on the specific drive with more detailed feedback, type:

Defrag [driveletter:] -v

By default the Defrag utility will not defragment file fragments larger than 64MB. If you want to do a more
thorough defragmentation job for all sizes of file fragments, type:

Defrag [driveletter:] -v -w

Note that for defragmentation to work, you must have a reasonable amount of free space on the drive,
preferably 15% or more. If you find that the Windows Disk Defragmenter does not provide you with
sufficient control or feedback, then you will need to consider a third party disk defragmenter. These are
covered below.
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B ADVANCED DEFRAGMENTATION

If you want a graphical interface for your defragmentation utility, and you also want it to do a more
thorough defragmentation and organisation/maintenance of your hard drive you will have to look beyond
the built-in Windows Disk Defragmenter. There are several applications which can defragment a disk in
more efficient ways, and also defragment files which the Windows Defragmenter cannot move, such as
system files. Note that the Windows pagefile will not become fragmented if configured correctly as detailed
in this guide (See Memory Optimization section), so pagefile fragmentation is not an issue.

There are several defragmentation utilities you can use in Vista which are either free or free for a while:

Diskeeper
PerfectDisk

O&O Defrag

I personally prefer Diskeeper since the default Windows Disk Defragmenter is simply a cut-down version of
Diskeeper anyway. Below is my advice for configuring and using the latest version of Diskeeper.

DISKEEPER

While Diskeeper isn't free, you can download and try its full functionality for 30 days for free. I recommend
that you trial the Pro Premier Edition as that is the edition that has all the functionality listed below,
including the I-FAAST and Invis-Tasking features. Once Diskeeper is installed, it takes the place of the
Windows Disk Defragmenter, so if you click the regular Defrag icon it will also launch Diskeeper instead. To
access the Windows Disk Defragmenter again you will need to go to Start>Search Box and type "dfrgui"
(without quotes) and press Enter. It is recommended that you do not use the Windows Disk Defragmenter
along with Diskeeper as they will work against each other and produce sub-optimal results. Below is more
detailed advice on how to set up and use the recommended Diskeeper defragmenter optimally.

To perform a manual defragmentation at any time start up Diskeeper and follow these steps:

1. Click on the logical drive you want to defragment, and select Analyze.

Once the drive analysis is over - the progress is shown in the bottom right corner - click on the 'Volume
Map View' drop box and look at the results in both File Performance and File Structure views, paying
attention to the color legend shown at the bottom. While not a perfect representation of fragmentation,
in general, the more red and pink areas you see, the more benefits defragmentation will give.

3. Right-click again on the logical drive and select Defragment.

4. Once the defragmentation is over, you will see that the layout shown under the 'Volume Map View' File
Performance section has changed, showing a defragmented (blue) drive. If you can still see pink areas,
see the boot time defragmentation instructions below. Note that any areas of cross-hatched green and
white are normal reserved system areas, typically for the Master File Table (MFT).

To configure your Master File Table (used by NTFS drives) optimally, follow these instructions:

Open Diskeeper and click the 'Configure Diskeeper' item on the left of screen.

Click the 'Diskeeper Configuration Properties' option.

Select the 'Frag Shield' option, then click the Edit button which appears in the right pane.

Scroll down the list, and near the bottom you will see your MFT usage for each drive - pay particular
attention to the 'Percent Used' figure. If it is at 100%, you will need to select the 'Configure the MFT to
the recommended size' option (if not already selected) to allow Diskeeper to provide more space for
your Master File Table, then click Submit at the bottom of this page. This prevents the MFT from
becoming fragmented as more programs are installed on your system, and will result in optimal drive

L

performance.
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5. If on the other hand your MFT is below 100%, leave it on the 'Do not configure the MFT' option, scroll
down and click the Cancel button.

The MFT is the large area displayed as a green and white cross-hatched block, and by default Windows can
reserve 12.5% or more of your total drive space to allow the MFT to grow without becoming fragmented.
This space cannot be reduced but you should regularly check to make sure your MFT is allowed enough
space - especially after installing lots of new files or a large application/game. If Diskeeper recommends
increasing your MFT size, I suggest you do as it says and allow the new recommended size. The Master File
Table is important in accessing your files, and programs like Diskeeper can help make sure that your MFT is
kept defragmented for optimal drive performance.
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To defragment system files such as the MFT, you must do a 'boot time defragmentation’. This is because
some files are protected system files and can't be moved while they're loaded up in Windows. To do a boot
time defrag using Diskeeper, follow these instructions:

1. Open Diskeeper and highlight the logical drive where your pagefile resides.
Right-click on that drive and select 'Boot-Time Defragmentation'

3. In the box that opens, tick the 'Enable boot time defragmentation...' box and select 'Run boot time
defragmentation the next time this computer is manually rebooted'. Then tick all available options
except 'Produce the summary log file'.

4. Click the Apply button, and then OK and a boot-time defragmentation is now scheduled. Note if you
ever want to cancel this, simply follow steps 1-3 above but this time simply untick the 'Enable boot time
defragmentation...' box and click Apply.

5. Reboot your system and upon rebooting Diskeeper will commence defragmenting system files for
optimal performance.

Do not disturb this process and at the end of it press ESC to boot back into Windows. Upon booting back
into Windows I recommend doing a manual defragmentation of your drive again with Diskeeper.

The Diskeeper Professional Premier version contains a technology called I-FAAST which is not available in
other versions of Diskeeper. It is basically an advanced analytical method. I-FAAST can result in an
improvement in drive performance, but whether you want to invest in the Premier version of Diskeeper to
be able to use it is up to you. Diskeeper also includes the Invisi-Tasking Automatic Defragmentation feature
which runs in the background, defragmenting your drive on the fly to prevent fragmentation. You should
enable it to start with, and then if it appears to be interfering or causing stuttering in games for example,
disable it and stick with running manual defragmentation jobs. Diskeeper installs an additional service
called simply called 'Diskeeper’, which is necessary for the day-to-day usage of Diskeeper, so it should be
kept at its default of Automatic. If you run into any problems, check the Diskeeper FAQ.

A third party defragmentation utility is not essential, as the normal Windows Disk Defragmenter utility is
sufficient. I do however recommend at least trialing Diskeeper for a few weeks to see if it makes a real
difference on your system, as proper defragmentation can make a substantial difference particularly for
stuttering in games.
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THE CONTROL PANEL

This section covers all the general options available under the default Windows Vista Control Panel, which is
an important central location for accessing many of Vista's settings. I cannot go into each section of the
Control Panel in great detail due to space considerations however all the important settings which are
relevant to the average home PC user are covered here and where necessary you will be referred to the
various relevant chapters of this guide. My recommendations for each are safe to use on most systems unless
you have very special requirements. In any case, take the time to go through this section carefully as
although it is long, it is very important for Vista's performance and functionality.

Note that I am using the 'Classic view' option to view the contents of the Control Panel, as this provides the
most detail of all the different utilities and options available. Furthermore you may have additional items
showing in your Control Panel, as some third-party programs will insert shortcuts into the Control Panel,
however only the default Windows Vista items are covered below. Some editions of Vista may have less
than the number of items discussed here.

B ADD HARDWARE

This utility allows you to go through a set of procedures for adding a new piece of hardware to your system.
In most cases though, since Windows Vista is a 'Plug and Play' operating system, and as long as you have
'Plug and Play' enabled in your BIOS and the 'Plug and Play' service set to Automatic, all you need to do to
add any new hardware is to connect it to your system and Vista will automatically detect it and either install
basic drivers for it, or if it can't determine the type of hardware, request that you insert a driver disk. See the
BIOS & Hardware Management chapter for more details.

The main use for the Add Hardware function therefore is for adding non-Plug and Play hardware to the
system. In these cases, Windows may not detect the device automatically, so firstly before adding any new
piece of hardware, spend some time reading through the installation instructions which come with the
hardware, as some have unique requirements for optimal installation which may be different to what you
might expect, such as requiring special drivers to be installed first before connecting the device.

If there are no specific instructions, then connect the device and click Next in the Add Hardware Wizard,
and first select the 'Search for and install the hardware automatically' then click Next. If the device isn't
found and/or is not identified correctly, click Next and attempt to choose it from the list provided, or try to
find a similar device from the same manufacturer.

B ADMINISTRATIVE TOOLS

The Administrative Tools are a range of utilities for advanced configuration and monitoring of the system.
As their name suggests, they are designed for Administrators, so some of the utilities and functions are not
useful to normal home PC users. However I provide details of the main Administrative Tools and point out

their most useful aspects for the average user below.

COMPUTER MANAGEMENT

This utility provides access to a combination of several Administrative and system tools which are covered
in other sections, including Event Viewer, Task Scheduler, Device Manager, Reliability and Performance and
Services - see the relevant chapters of this guide for more details on each of these.

The main use for the Computer Management tool is the Disk Management sub-component, which you can
find under the Storage section in the left pane. Once you click on it you will then see your hard drive(s)
listed in the top right pane, with all your available drives (including optical drives) listed in the bottom right
pane. Some common tasks you can do with Disk Management include:
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Changing Drive Letters: If you want to change any of the drive letters on your system - for example if you
want to alter your CDROM drive from being called D: to F: or change a hard drive letter from E: to Z: you
can do so here by right-clicking on the drive letter in the bottom right pane and selecting 'Change Drive
Letter and Paths’, then highlight the drive letter which appears, click the Change button and assign a new
drive letter. You cannot change system drive letters under some circumstances.

Partitioning: Vista allows more comprehensive partitioning options for hard drives. A Partition is a logical
subdivision of your hard drive. To create a new partition on your current drive(s), you will need to have
some Unallocated Space. In most cases there will not be any since your existing partition(s) are likely taking
up all space. You can however create unallocated space by using the Shrink function which reduces one of
your partitions and in return creates unallocated space. Once you have some unallocated space, you can
right-click on it and select 'New Simple Volume' to create a new partition, and follow the Wizard to choose a
size for it. You can also format an existing partition, which destroys all data currently on it and prepares it
for use. If you want to create more than three partitions, you will have to create an Extended partition within
an existing partition. For more details on partitions see the Partitioning section under the Windows
Installation chapter.

Basic and Dynamic Disks: All your hard drives are formatted as a Basic disk with partition(s) as necessary.
However if you wish, you can format them as a Dynamic Disk by right-clicking on the relevant drive and
selecting 'Convert to Dynamic Disk'. Dynamic disks can emulate a RAID array - that is they can span
multiple drives as though they are one large drive, and they do not use partitions. The features of Dynamic

Disks are discussed in this Microsoft Article. It is generally not necessary nor recommended that you convert
your disk from Basic to Dynamic for the average home PC user, and note that you cannot reverse the process
without losing all your data, so it is not worth experimenting with. You should only use this option if you
have specific needs which you know will need a Dynamic Disk, such as for holding very large databases.

DATA SOURCES (ODBC)

This tool lets you add and configure drivers for managing access to data on various database management
systems. Unless you use databases extensively on your machine, you can ignore this tool as it is not relevant
to the average home PC user.

EVENT VIEWER

The Event Viewer is a useful troubleshooting tool which shows a list of system events. These events are
recorded by Windows over time, and reflect information alerts, warnings and errors that have occurred to
date. Details of Event Viewer usages are provided in the relevant section of the Performance Measurement &
Diagnostics chapter.

ISCSI INITIATOR

The iSCSI Initiator is a management interface for iSCSI devices. These devices can be disks, tapes or other
storage devices which are connected to your network. The iSCSI Initiator initiates the connection and control
of these target devices, and thus is not relevant to the average home PC user as it is mainly used for remote
storage over a network.

LOCAL SECURITY POLICY

This tool allows you to establish and alter security-related settings. The main purpose is to allow an
Administrator to limit or control the usage rights of other user accounts on the system or a network. For
more details see the relevant section of the PC Security chapter.
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MEMORY DIAGNOSTICS TOOL

The Memory Diagnostics Tool is a troubleshooting utility designed to determine if your system memory
(RAM) has any physical problems. Its functionality is covered in detail under the Performance Measurement
& Diagnostics chapter.

PRINT MANAGEMENT

This tool allows you to manager print servers and printers connected to the PC. Full details of its usage are
in this Microsoft Article.

RELTABILITY AND PERFORMANCE MONITOR

This tool allows you to monitor the usage of major system resources, as well as seeing a graphical
representation of system errors and failures. It is covered in detail under the Performance Measurement &
Diagnostics chapter.

SERVICES

This tool is extremely useful in configuring service usage under Windows Vista. See the Services chapter
which explains its features in detail.

SYSTEM CONFIGURATION

The Microsoft System Configuration tool is also known as MSConfig for short, and is covered in greater
detail under the Boot Configuration, Startup Programs and Services chapters.

TASK SCHEDULER

The Task Scheduler maintains all the existing scheduled tasks on the system, and also allows users to add
custom tasks for future execution on a defined schedule. You can also access the Task Scheduler at any time
by going to Start>Search Box and typing "taskschd.msc" (without quotes) and pressing Enter.

In the center of the main screen, you can view the recently executed tasks under the 'Task Status' box. You
can choose the time period over which the tasks were performed in the box at the top right - the default is
'Last 24 hours'. Each listed task can be expanded to show when it was last run, and whether it was successful
or not.

To view all currently running tasks, first go to the View option in the right pane, click it and select 'Show
Hidden Tasks'. Then click the 'Display all running tasks' link in the right pane, and a box will open with the
tasks listed - you can manually force any of these to end if you wish, though this is not recommended unless
you are troubleshooting. You can customize the system tasks currently queued for execution by looking
under the 'Active Tasks' section. Double-clicking on a task provides a range of additional options for
customizing the tasks. In general you should not alter tasks in this way, it is best to alter them firstly through
the actual program or Windows function first, and only come here if you need additional ways of
customizing the task.

If you are looking for a particular task, such as the Windows Backup task, use the directory tree in the left
pane, expand the top item and look under the Microsoft>Windows branch to see all the various applications
and features. For Windows Backup the relevant subfolder is labeled WindowsBackup - click on it and all
relevant tasks are shown in the middle box.

To add your own custom task, click the 'Create Basic Task' link in the right pane, and you will be presented
with an automated Wizard which will step you through the process.
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Task Scheduler can be turned off altogether by forcing the "Task Scheduler' service in the Services utility to
Disabled, but this is not recommended at all. It is an important component and disabling it prevents any
scheduled tasks from running, some of which have important diagnostic or system maintenance functions.

WINDOWS FIREWALL WITH ADVANCED SECURITY

This tool allows you to configure the Windows Firewall in much more detail. It is covered under the PC
Security chapter.

That covers the administrative tools in Windows Vista. Most of the tools are covered in detail in various
other chapters of this guide as they can be quite complex and provide a range of important functionality.

B AUTOPLAY

Whenever you insert a particular type of media such as an audio CD or a movie DVD, or connect a device
such as a portable media player or digital camera, Vista automatically detects the type of device or media
and can automatically take specific action, such as opening a movie in Windows Media Player. This
functionality is called AutoPlay, and while it can be very handy in some instances, it can also be highly
annoying in others. By default the first time you connect a particular device or insert a new type of media
Vista will ask you what to do, and whether you want this to be the default action. However under the
Autoplay component of Control Panel you can manually adjust Vista's default behavior for each and every
particular type of media or device. For example if you insert an audio CD into your CD/DVD drive, you can
tell Vista to automatically start playing the music, to prepare to rip the music, to take no action at all, or to
prompt you to decide each time.

I recommend going through and selecting the default action for all of your common media types. I also
recommend connecting any devices you wish to use with Vista if they are already not listed here and also
telling Vista what to do in each case. If for some reason you do not want AutoPlay to be used for any of your
devices or media, untick the box at the top of the screen. In fact you may wish to do this for security reasons,
as a recent rootkit which was used on Sony music CDs used the AutoPlay functionality to install itself.

B BACKUP AND RESTORE CENTER

The Backup and Restore Center provides access to a range of functionality which is covered in full detail in
the Backup & Recovery chapter.

B BITLOCKER DRIVE ENCRYPTION

BitLocker Drive Encryption is a security feature for available to Vista Ultimate and Vista Enterprise owners.
It is covered in more detail under the relevant section of the PC Security chapter.

B COLOR MANAGEMENT

Windows Color Management is a tool which allows users to ensure that the colors displayed on their screen

are accurate and will be reproduced faithfully across a range of devices. For accurate color reproduction it is
very important that your monitor have proper drivers loaded in Vista - see the Windows Driver chapter for
details of how to check and update device drivers as necessary. More details of how the Color Management
functionality works is in this Microsoft Article, but for the average home PC user you should not change

these settings as they require more specialist knowledge.

B DATE AND TIME

Although relatively straightforward, it is important that you have the correct system date and time. Some
software and some Internet sites will not function properly unless these are set and maintained correctly.
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DATE AND TIME

Make sure the date and time are set correctly here. Click the 'Change data and time' button if necessary and
set the current date and time. Make sure to set the correct Time Zone for your region as well, as this will
affect the way changes like Daylight Savings will impact on your system. I strongly recommend ticking the
'Automatically adjust clock for Daylight Savings Time' so that your clock is automatically adjusted back or
forward when Daylight Savings occurs in your area. If necessary also tick the 'Remind me one week before
the change occurs', though this is not vital.

ADDITIONAL CLOCKS

Under Windows Vista you can select to maintain and show up to two additional clocks in different time
zones from your main system clock. Click the '‘Show this clock' option above each of the clocks you wish to
show, set the time zone for the clock, and I recommend naming the clock(s) with suitable names such as
‘London Time'. The clock name(s) and the time for each clock will then appear whenever you hover your
mouse over the time display in the lower right corner of the Taskbar at any time.

INTERNET TIME

By default Vista connects to the Internet once a week to update your system clock and ensure its accuracy. If
you wish to disable this option or manually update your clock at any time, click the 'Change settings' button.
To update manually immediately, click the 'Update now' button. To disable the automatic update
functionality, untick the 'Synchronize with an Internet time server' option. If for some reason the system time
is not updating or is inaccurate, click the drop down box and select another time server for Vista to connect
to for this purpose. In general I recommend allowing Vista to update the clock automatically, as it has no
performance impact and helps prevent the clock from slowly becoming more and more inaccurate.

B DEFAULT PROGRAMS

This option has a range of sub-options which allow you to set the default programs your system uses for a
range of functions and importantly the file associations Vista users when launching certain file types. Note
that the AutoPlay settings here are fully covered under AutoPlay section further above. Each of the other
sub-options are covered in detail below:

SET YOUR DEFAULT PROGRAMS

This option only allows you to control the files which the main built-in Windows programs handle by
default. Select a listed program, and in the right pane you will see that you can either 'Set this program as
default' which basically sets the program as the default one for all the file types it can open; or you can
manually choose which file types it can open by clicking the 'Choose defaults for this program'. For example
if you select Windows Media Player, you can either let it automatically become the default for all the media
types it can support, or see the details of the specific file types, and choose from them manually.

In general I recommend that you do not alter these settings, and if you do want to manually assign a default
to a particular file type, it is quicker and more thorough to use the 'Associate a file type or protocol with a
program’ option further below.

ASSOCIATE A FILE TYPE OR PROTOCOL WITH A PROGRAM

This option allows you to manually view and set the default program to be used when opening a file with a
particular type of extension. For example you can choose the program which will open all .MP3 files, or all
.DOC files on your system by default. It doesn't prevent other programs from opening these files, it just
chooses the default program. Note, if you can't see file extensions for your files then make sure the 'Hide
extensions for known file types' option is unticked in Folder Options - see Folder Options under the
Windows Explorer chapter.
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When you first open this tool, it will take a moment for it to populate the list of all file types on your system
and their associated default programs. You can then scroll down the list to view the associations, and note
that where 'Unknown application' is listed, that means there is no default for that file type. To change the
association for a file type, highlight the file type and click the 'Change program' button at the top right of the
box. If it already has a default program, it will be shown and recommended. To add a new program to the
list, click the Browse button and go to the specific program file which you wish to use.

Don't change a program association unless you want that program to become the default for an entire file
type. If you have problems with an association changing suddenly, remember that when installing certain
programs, they will automatically make themselves the default program for particular file types, often
without asking your permission. Your best bet is to go into the options for the particular program which is
associated with a file and check for any settings or file associations there, and alter them first before coming
here and changing file associations manually.

You can even associate protocols like HTTP with a particular program here at the bottom of the list. For
example you can associate FTP with your own FTP client instead of Internet Explorer which is the default.

SET PROGRAM ACCESS AND COMPUTER DEFAULTS

This section allows you to set the general defaults for your Internet browser, media player, instant
messaging, Java virtual machine and email program. It also allows you to prevent access to particular built-
in Vista programs, effectively blocking them (because they cannot normally be uninstalled). The main reason
for these options existing is that Microsoft has been charged with monopolistic behavior and as part of the
terms of settlement of a case against them, they are required to provide users with the option to disable
certain built-in programs such as Internet Explorer, Windows Media Player and Windows Mail.

To start with you should select the Custom option and a drop-down box will appear with further options to
customize. Choose your default programs, and I strongly recommend that you do not untick the 'Enable
access to this program' option for Internet Explorer or Windows Media Player, as both of these may be
required to view certain web page or play certain media sources.

If you really want to remove certain built-in features completely from Windows Vista, see the Modifying the
Windows Installation Disk section under Windows Installation chapter. Note that it is generally not wise to
strip out important Vista components because you may need them one day, and some of them cannot just be
reinstalled as standalone components.

B DEVICE MANAGER

The Device Manager is an important hardware management tool which is covered in detail under the BIOS
& Hardware Management and Hard Drive Optimization chapters.

B EASE OF ACCESS

There are a range of features here that can be used to accommodate different keyboard usage styles, make
Windows easier to see on screen, or provide audible notification of events for example. Quite obviously
which settings you choose will depend on your individual requirements. If you want to find out more about
these options go to the Windows Vista Accessibility Page. The majority of users will not need to enable or

use these settings, and can leave them at their defaults. Some of the more useful functions such as Speech
Recognition are also covered further below in this chapter.

B FOLDER OPTIONS

The Folder Options are often overlooked, but are actually very important to the look and feel of Windows,
especially when using any Windows Explorer-based interfaces as well as the general Windows Desktop. It
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also has specific settings for the Search functionality in Vista. Folder Options is covered in more detail under
the Windows Explorer chapter.

B FONTS

This item displays the contents of your \ Windows\ Fonts folder, which contains all your currently installed
system fonts. Fonts are the various types of text styles used by a variety of programs such as word
processors, paint programs and the Windows WordPad for example. You can install a new font simply by
copying its .FON or .TTF files into this folder, or by going to the File menu (or right-clicking on an empty
column) and selecting 'Install New Font' and pointing to the directory where the new font files reside. Note
that TrueType is a font technology that ensures good scaling and that what is displayed on your screen
should come out exactly the same on your printer. Other types of fonts may look slightly different in
different applications and/or when printed and/or when using different font sizes. To find out more about
fonts, go to the Microsoft Typography Website. A good site that contains additional fonts you can download
and install for free is Simply The Best Fonts. See the Graphics & Interface chapter for more details on how to
make fonts look better in Vista.

B GAME CONTROLLERS

This tool allows you to configure gaming controllers detected by Vista to be connected to your system. This
typically includes gamepads, joysticks and game simulation hardware. If your device is not being detected
by Vista then follow the procedures for installing and setting up the device which come with it, and also see
the Add Hardware section further above. Note that although often used in PC games, the mouse and
keyboard are not classed as 'game controllers' here - they have their own separate setup tools in the Control
Panel (see Keyboard and Mouse below). Further note that if you play certain games only using the keyboard
and mouse combination, and you find your character is displaying strange movement behavior (e.g.
constantly moving with no user input), then physically disconnect all game controllers from your system
(excluding the keyboard and mouse), reboot then relaunch the game.

B INDEXING OPTIONS

This tool displays and controls the indexing of files and folders for the Windows Search functionality. This is
covered in more detail under the Windows Search chapter.

B INTERNET OPTIONS

This setting in the Control Panel simply brings up the Internet Explorer 'Internet Properties’ box. There is no
difference between accessing it here and accessing from within Internet Explorer, so see the Internet Explorer
chapter for full details of how to configure these options. Note if you are using another browser as the
system default browser then clicking this item will still bring up the Internet Explorer 'Internet Properties'
box, not the one for your other browser - this is normal and cannot be changed.

Bl 1SCSI INITIATOR

The iSCSI Initiator is a management interface for controlling iSCSI storage devices connected via a network.
This functionality is not relevant to home PC users.

B KEYBOARD

Under the Speed tab, I recommend you set the 'Repeat Delay' slider to the far right (Short) and also set the
'Repeat Rate' slider to the far right (Fast). This will provide the maximum responsiveness for your keyboard
under Windows Vista. You can test these settings by holding down a key in the box provided to see if they
suit you. You can also adjust the 'Cursor Blink Rate' to your taste, and then click OK to apply.
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B MOUSE

I only cover the performance-related mouse settings below, as the other mouse settings can be adjusted
according to your taste. If you've installed a special mouse driver for your mouse, you may see different
settings available under this screen, however the settings below should still be available on most systems.

BUTTONS

Adjust the double-click speed to the rate which suits your usage patterns, and test it on the image of the
folder provided. I generally recommend setting a slower double-click speed so that you can open files and
folders more comfortably.

POINTER OPTIONS

I recommend ticking the 'Enhance pointer precision' option before you adjust your pointer speed. This
option enhances the acceleration/deceleration of your mouse to provide for larger movements when you
move the mouse fast, and finer movements when you move the mouse more slowly, allowing more
precision while still allowing you greater coverage of your Desktop with the mouse.

WHEEL

If your mouse has a mousewheel, you can increase the wheel's responsiveness by increasing the number of
lines it will scroll on each turn of the wheel. Even an increase from the default of 3 to 4 will make a subtle,
but noticeable difference if you previously found the mousewheel relatively unresponsive.

B NETWORK AND SHARING CENTER

The Network and Sharing Center provides a visual representation of your current network setup and allows
you to further customize and troubleshoot your connection settings. Note that detailed network setting
configuration advice is beyond the scope of this guide, as it is a very complex topic which varies based on
the type of connection and hardware involved. In general Vista detects and sets up your network/Internet
connection automatically and does a good job of it. Changing your network settings beyond what is covered
below can cause problems including being unable to connect to the network/Internet, which is not worth
risking. The main settings and functionality of the Network and Sharing Center are covered below:

Network: When you first installed Vista, you were prompted to choose your Network Type, however you can
change it again by clicking the Customize link here. In the 'Customize Network settings' box which opens,
you can choose to make the location type Public or Private with the difference described in this Microsoft
Article. For the average home PC user with a connection to the Internet, I strongly recommend Public, which
ironically is more private and secure, because it means that you are connecting to a Public Network (the
Internet) and hence require more protection than if you were connecting to a Private network (e.g. at work).
Only choose Private if you're connected to a trusted network of other PCs. In any case you can customize the
details of this network type further below. Once done click Next then OK.

Importantly, remember that the Network Type you choose also affects the profile used in the Windows
Firewall Advanced Settings, so if you set up specific settings for a Network Type there, then altered your
Network Type afterwards, go back and change the firewall settings to apply to the new Network Type as
well. See the PC Security chapter for details.

Connection: Here you will see your current connection type. This is usually set automatically based on the
type of network device you have connected or installed on your PC. Click 'View Status' to see more details
on the device, and if you're having problems click the Diagnose button. Generally as long as you use the
latest drivers for the device then there shouldn't be any problems or any need to alter the device settings.
However for advanced configuration, click the Properties button. Here you can see the various clients,
services and protocols the connection uses, which again should not be altered unless you know what you are
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doing. Below are my recommendations for a standard Internet connection via a modem or router on a home
PC not connected to a network of other PCs:

You can untick the following items (but don't Uninstall them):

* Client for Microsoft Networks

* File and Printer Sharing for Microsoft Networks

= QoS Packet Scheduler

* Link-Layer Topology Discovery Mapper 1/O Driver
* Link-Layer Topology Discovery Responder

The above protocols, clients and services are intended primarily for PCs connected to a network, and hence
are not needed by the average non-networked home PC for normal Internet access. However if at any point
you experience reduced functionality or problems, re-tick them all again and restart your PC.

Importantly, you may experience issues with general Internet browsing when using the new IPv6 protocol
enabled by default in Vista as detailed in this Microsoft Article. You can try to resolve this by temporarily
disabling the 'Internet Protocol Version 6 (TCP/IPv6)' item. Alternatively you can highlight it, select
Properties and try to configure it manually using the details in this Microsoft Article. In general though this
should not be necessary as Vista is designed to fall back to IPv4 if IPv6 starts experiencing issues on your
system. And again, if in doubt do not alter any settings here as there is more potential to do harm than good.

Sharing and Discovery: These options relate to the way in which your PC interacts with other PCs on a
network of computers. For the average home PC connected to the Internet, most if not all of these options
should be turned Off - except 'Password protected sharing' which should be On. If you're on a network then
make sure at least the 'Network discovery' option is On, and configure the other options as advised by your
Network Administrator.

Set up a Connection or Network: Should you wish to add a new connection type, click this link in the left pane
and follow the Wizard. Again, Vista does a good job of detecting your existing networking device(s) and
configuring them properly, so you should not need to use this under normal circumstances. You may need
to follow the manufacturer's instructions and/or download the most recent Vista drivers if your network
device is not being detected.

B OFFLINE FILES

Offline Files allow users connected to a network of PCs to be able to store copies of particular network files
on their own PC. That way you can work with these files even when you are not connected to the network.
The average home PC user should not need to enable this functionality.

B PARENTAL CONTROLS

The Parental Controls option is designed to let an Administrator set particular limitations on specific User

Accounts. You will need to create Standard User Accounts for each person you wish to control using these
features, and you will need to have an Administrator User Account with a password. See the User Accounts
section further below for details of how to enable and configure Parental Controls.

B PEN AND INPUT DEVICES

This option allows you to configure and Pen-based or similar input devices connected to your system. Go
through and adjust these as necessary, and obviously none of the settings impact on standard input devices
such as keyboard or mouse.
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B PEOPLE NEAR ME

People Near Me is a feature which allows you to invite other users on the same network to engage in a
shared task. The average home PC user will not need to use this function, so make sure not to have 'Sign me
in automatically when Windows starts' option ticked here, and under the 'Sign in' tab make sure the 'Sign
out of People Near Me' is selected.

B PERFORMANCE INFORMATION AND TOOLS

This option takes you to a range of tools which are useful in troubleshooting and benchmarking your
system. Full details of these tools can be found under the Performance Measurement & Diagnostics chapter.

B PERSONALIZATION

This option provides a range of features designed to allow you to alter the appearance and sound of
Windows Vista. To start with, note that you can click the 'Change desktop icons' link in the left pane if you
wish to add, remove or change the appearance of several of Vista's standard desktop icons including the
Recycle Bin. Importantly, if you wish to change the general size of all text in the Windows interface, you can
click the 'Adjust font size (DPI)' link in the left pane. Below are the general settings for this feature:

WINDOWS COLOR AND APPEARANCE

Here you can adjust the color of the general Windows interface, including the level of transparency used for
Vista's Aero Glass see-through effects. If you don't like the sample colors shown, click the ‘Show color mixer'
option and you can create your own custom color using the Hue, Saturation and Brightness sliders.

If your graphics card supports the Vista Aero interface, and you have it selected, you can use the Color
Intensity slider to adjust the level of transparency - at far right the see-through effect is disabled, at far left it
is as transparent as possible. You can turn off transparency altogether by unticking the 'Enable transparency’
box. As discussed under the Graphics & Interface chapter, for most systems Aero has no real impact on
Desktop performance, and your Desktop configuration in general has no impact at all on gaming
performance, because it is suspended when a 3D games is running.

You can customize the settings further however; click the 'open classic appearance properties for more color
options' link and you will see more options, some of which are quite important and covered below:

Color Scheme: If your graphics card can support it, you can select the 'Windows Aero' transparency-based
effects for the Vista interface. If your graphics card doesn't support this feature, or you have Vista Home
Basic then you can select 'Windows Vista Basic' for a similar interface with no 3D or transparency effects. If
you wish to return to a Windows 98/2000 style interface, select 'Windows Standard' or 'Windows Classic'.
The 'High Contrast' options are primarily for the visually impaired (See Ease of Access section).

Windows Aero is actually designed to be smoother in transitions and screen updates, such as moving an
open window around the screen. However it can also be slower on some systems which have older/slower
graphics cards, so if you feel the interface is sluggish then select the Vista Basic option, though note that
things like the 3D Flip function will be disabled as well as transparencies. If you want to further increase
interface responsiveness then switch to 'Windows Standard'.

Effects: Click this button and you will see several additional effects which you can alter. In the 'Use the
following method to smooth edges of screen fonts' box you can choose ClearType or Standard font
smoothing. Either method reduces the jaggedness of text on the screen and is best left enabled. I recommend
you select ClearType if you have an LCD or Plasma display, but for more details see the Graphics &
Interface chapter.
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You can also choose whether to have a shadow show under the menus, and whether to display the contents
of a dialog box or window while it is being moved around. Both should be left enabled unless once again
you want to improve your desktop responsiveness if it seems slow, particularly while dragging around
windows.

Advanced: If you really want to customize your Windows Desktop appearance, clicking the Advanced button
takes you to a screen where you can select the various components of the desktop, such as window borders,
window titles, icons and so forth, and manually adjust their size, color and font type and size if applicable.

DESKTOP BACKGROUND

Here you can select the type of image you wish to use as the background wallpaper on your Windows
Desktop. More details of this feature are covered under the Graphics & Interface chapter.

SCREEN SAVER

Here you can set whether a screen saver becomes enabled after a period of inactivity. A screen saver is not
necessary on modern CRT or LCD displays, so if you don't wish to use one simply set this option to None.
However a screen saver is useful in preventing temporary image retention on LCD monitors, and also to
prevent image retention and permanent burn-in on Plasma monitors. It can also be useful in saving energy,
or improving security by preventing others from seeing what is on your desktop when you are away from
the PC. In fact to further bolster security you can tick the 'On resume display logon screen' to force a logon
prompt whenever the screen saver is exited. Of course this has no impact if the User Account does not use a
password.

Go through and preview the screen savers, then select one and choose how long a delay is required before it
kicks in. I recommend the Blank screen saver as this will use less energy, provide the most security and
privacy, and prevent any potential image retention. Note that some screen savers can be configured further
by clicking the Settings button; e.g. the Photos screensaver requires you to tell it where your desired photos
are stored. An idle period of 5 - 10 minutes is sufficient under the Wait option for the screen saver to kick in
during genuine idle periods without interrupting you while you work. Note that the screen saver will not
interfere with games or applications.

Note that the settings found when clicking the 'Change power settings' link are covered further below under
the Power Options section.

SOUNDS

These options are covered under the Sound section of this chapter further below.

MOUSE POINTERS

These options are covered under the Mouse section of this chapter further above.

THEME

When you have configured the various personalized Windows appearance and sound settings the way you
want them, you can come to this section and save this collection of customized settings as a Theme. Click the
'Save As' button and specify a location and name for your theme. This is important because sometimes
unintended system changes can alter various aspects of your current theme and to get it all back without a
lot of tedious work you can come back here and reload it all at once.
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DISPLAY SETTINGS

These option allow you to configure the Windows Desktop resolution and color depth, as well as your
monitor configuration, as covered below. Note that you may need updated graphics and/or monitor drivers
for the functionality below to work properly:

Monitor: This should be automatically configured and not changed if you have a single monitor setup. If you
have two or more monitors you can use the drop box to select which monitor to add/extend your Windows
Desktop to, or set as your main monitor. Clicking the 'Identify Monitors' option will briefly display a large
white numeral on the screen to show which is the primary monitor (denoted by the number 1) and which
the secondary (2) and so forth.

Resolution: When selecting your desktop Resolution, if you have an LCD or Plasma monitor then try to match
the desktop resolution with the monitor's 'native' resolution. More details can be found under the Resolution
section of my Gamer's Graphics & Display Settings guide. This setting only affects your resolution when

using the Windows Desktop, it has no impact on games and other 3D programs which have their own
resolution options.

Colors: Under this option select 'Highest (32 bit)' as this provides the most accurate representation of colors;
the 'Medium (16-bit)' option will reduce color complexity and hence not look as good. There should be no
reason why any graphics card would struggle with 32-bit color on the Windows Desktop, there is minimal
performance impact - but if you absolutely need more desktop responsiveness select the Medium option.
Note that Windows Aero will not function unless you set 32-bit here.

If you click the 'Advanced Settings' button under the Settings tab, you will be taken to the advanced control
panel for your graphics card. While many sections of this screen differ based on your particular graphics
card, all graphics cards share the following common elements, which are described below:

Adapter: Here you will find the details of your current graphics adapter (i.e. your graphics card). If the details
are incorrect, this could indicate a poorly installed or incorrect graphics and/or motherboard driver, or
modified hardware.

Monitor: You can set the Refresh rate used by your monitor for the current screen resolution. I strongly
recommend that you first tick 'Hide modes that this monitor cannot display’, then select the highest refresh
rate listed. The refresh rate determines how many times per second the image onscreen is redrawn. The
higher the setting, the more times the screen is 'refreshed’, and the less strain there is on your eyes - see the
Refresh Rate section of my Gamer's Graphics & Display Settings Guide for full details. If you cannot see your
monitor's known maximum supported refresh rate in this box, then you can either wait for updated graphics
drivers, or you can untick the 'Hide modes' box and manually select the closest refresh rate which is still
lower than your maximum. Most refresh rate issues in Vista are due to drivers, so install the very latest ones
for your graphics card and also your monitor if possible.

Troubleshoot: You can click the 'Change settings' button to access the 'Graphics Hardware Acceleration' slider.
Normally this slider should be at the far right for full graphics functionality. However if you are
troubleshooting a graphics-related issue, lower this slider and test to see if this resolves the problem. If the
problem is resolved when the slider is at None or Basic, then the issue is likely with your graphics drivers as
these control the more advanced graphics functionality.

Color Management: These settings are already covered under the Color Management section in this chapter.

Graphics Card Name: The tab bearing your graphics card name contains the means by which you can access
further graphics-card specific settings. It is important that you set these up correctly as they control the bulk
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of your graphics card's advanced 3D functionality, particularly in games. See my Nvidia Forceware Tweak
Guide or ATI Catalyst Tweak Guide as relevant for more details.

Once again remember that all of the major graphics and display settings on your system are heavily
dependent on your graphics driver, especially if you're using Vista Aero. Any glitches or problems you
experience are generally due to the relatively immature drivers for Vista which only time and driver updates
can improve. To make sure you have the latest drivers, see the Windows Drivers chapter, and to see more
details of graphics-related functionality in Vista see the Graphics & Interface chapter.

B PHONE AND MODEM

This option lets you configure any connected phone or modem devices. Details are provided in this
Microsoft Article, and won't be covered in any more detail here.

B POWER OPTIONS

These options impact on the power consumption and idle behavior of Windows Vista. They also allow you
to change the behavior of the Power, Reset and Sleep buttons on your PC.

POWER PLAN

There are three preset levels of power management, called Power Plans: Balanced, Power Saver and High
Performance. These are described further in this Microsoft Article. I strongly recommend that you actually
customize the settings rather than relying on any of the presets, since none of them is exactly right for most
systems. To customize your own settings, follow these steps:

Click the 'Create a power plan' link in the left pane.

I suggest choosing 'High Performance' as the basis for your changes.

You can give the plan a descriptive name, or use the default which is fine.

I recommend turning off the display after a set period of system inactivity, as this has no performance

Ll e

impact and does not harm to the monitor, but prevents energy waste and potential image retention on

LCD or Plasma displays. Something around 15 - 20 minutes should be reasonable.

I don't recommend enabling the Sleep functionality (select Never), see further below for details.

Click the 'Change advanced power settings' to access the more detailed settings.

7. Click the small plus sign next to each and every setting to fully expand them one by one, changing them
as covered below. Note that if any settings are unable to be changed, click the 'Change settings that are
currently unavailable' link then go back and change them.

AN

The settings are covered below, with my recommendations. Note that Mobile PC users will have two sets of
options, to configure, 'On battery' for when using battery power, and Plugged in' for when connected to
mains power - configure the 'On battery' setting differently than below. Below are my recommendations for
a standard desktop home PC:

Additional Settings - Require a password on wakeup: When waking up from sleep mode, if set to Yes this option
forces you to reenter the password (if one exists) for the current User Account to unlock the PC. Set to suit
your security needs.

Hard Disk - Turn off hard disk: Set this to the number of minutes of inactivity before your hard drive is turned
off. I recommend selecting Never to maintain maximum responsiveness; hard drives are best not switched
on and off constantly.

Wireless Adapter Settings - Power Saving Mode: If you have a wireless network adapter connected to your
system, select the power saving mode. Again for maximum responsiveness select Maximum performance'.
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Sleep - Sleep after: This option lets you choose how long a period of inactivity is required before your system
goes to Sleep. Sleep is a power-saving mode designed as a compromise between totally switching off your
PC and leaving it running at full functionality. It is primarily intended for mobile PC users who need to
conserve power but maintain responsiveness. In Sleep mode your computer turns off most components and
saves your documents to RAM. Thus it uses minimal power and appears to be inactive, but it can be 'woken
up' almost instantly by pressing the Power button. Sleep replaces the Standby mode of previous Windows
versions as detailed in this Microsoft Article, though Hibernate is still available and covered further below.

The problem with Sleep mode is that firstly it can potentially cause system instability or strange behavior
after recovering from sleep mode. So for the average mobile PC or home user it might be fine, but if you are
a gamer or use system-intensive programs I don't recommend using Sleep mode (set this to Never). Secondly
of concern is that in Sleep mode your open documents, programs and general system state are saved to RAM
and the RAM is kept on, which means your system is more susceptible to data loss should anything go
wrong. If you still wish to use this mode, I recommend Hybrid Sleep as covered below.

Sleep - Allow Hybrid Sleep: In this section you can choose whether to enable Hybrid Sleep mode or not. I
recommend turning it On. Note that if you can't see the Hybrid Sleep or Hibernate settings here you need to
open an Administrator Command Prompt (See the Vista Usage Notes chapter), then type:

Powercfg /hibernate on
This will re-enable the display of these options in the advanced power options.

Hybrid Sleep mode is the same as Sleep mode covered above, however instead of saving your open
documents, programs and system state to RAM, it saves them to a Hiberfil.sys file in your hard drive's base
directory, providing added security against data loss. This file is exactly the same size as your system RAM
and the act of writing to it when entering Hybrid Sleep and reading from it during waking up will make
Hybrid Sleep less responsive during this time.

Sleep - Hibernate after: This option allows you to configure Hibernation, which is the same as Hybrid Sleep in
that it will write your open documents, programs and system state to the Hiberfil.sys file after a period of
inactivity as specified here. However unlike Sleep or Hybrid Sleep, rather than putting your system into a
power-saving mode, it allows you to turn off the entire PC and leave it that way for as long as you like. You
can then turn the system back on in the future to find that your previous session is restored as you left it.
This mode is generally not recommended to anyone but mobile PC users who plan on not using their mobile
PC for several days or more but still want to quickly get back to where they were. I do not recommend
Hibernation for the standard desktop home PC user (i.e. set this to Never), once again due to the potential
for complications and problems. It is much wiser to start with a 'clean’ session each time you boot your PC.
Note that just as with Hybrid Sleep, if you cannot see the Hibernation options under the advanced power
options, you will need to execute the Powercfg command shown further above.

Importantly, whether for Hybrid Sleep or Hibernate, if you have disabled these options and do not plan on
using them, you should also delete the Hibetfil.sys file as it can be quite large. However you cannot do so by
just highlighting and deleting it. You must go to Disk Cleanup (See the Cleaning Windows chapter) and on
the main screen select 'Hibernation File Cleaner' as one of the items to remove, then click OK. This will also
remove the Hibernate and Hybrid Sleep options from your Power Options as well. They can only be
restored using the Powercfg command further above.

Power buttons and lid - Power button action: This is actually quite an important setting as it determines what
happens when you press the Power button on your PC. I strongly recommend setting this to 'Shut Down'
which is the normal expected behavior for a power button.
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Power buttons and lid - Sleep button action: This setting determines what happens when you press the Sleep
button - if one exists - on your PC. Set to suit your taste, though again I don't recommend using Sleep under
normal desktop conditions.

Power buttons and lid - Start menu power button: This setting determines what the red power button (next to
the Search box) on the Windows Start Menu does by default. It should be set to 'Shut Down' as that is the
expected behavior for this button. Note that you can access all the power options by clicking the small white
triangle to the far right of the red power button on the start menu. Of annoyance is the fact that there is no
restart button, however this is addressed under the Graphics & Interface chapter where you can create your
own Shutdown and Restart desktop icons for quicker access.

PCI Express - Link state power management: This setting will allow an idle PCI-E connection to reduce power
consumption depending on the option chosen here. Since PCI-E is most commonly used for graphics cards
on higher-end systems at the moment, I would strongly recommend against anything other than Off for this
setting to prevent slowdowns or crashes.

Search and Indexing - Power savings mode: If search indexing is enabled (See the Windows Search chapter), this
option determines whether to allow background disk indexing to use more or less power by updating the
index more or less frequently. For the average home PC user there is no reason to attempt to save a small
amount of power by setting this option to anything other than 'High Performance'. Any power savings you
might make by lowering this setting will mean that your index will be less up to date and hence less useful
in return.

Display - Turn off display after: This setting lets you select the amount of inactivity before your monitor is
switched off. It will instantly switch on again as soon as you press a key or move the mouse. Since displays
use a fair bit of power, and since LCD and Plasma displays in particular can suffer from temporary image
retention or permanent burn-in (Plasma only) from displaying a static image for too long, it makes sense to
enable this option and set it to something like 20 or 30 minutes of inactivity. That way when you're away
from your PC for long periods your monitor switches off, protecting the display and having no impact on
your PC's performance or stability since monitors are designed to turn off and on frequently. If you're not
sure of how long to set this, use the setting below.

Display - Adaptive display: If you enable this setting, in conjunction with the setting above it will monitor to
see how often you wake up your display with the mouse or keyboard. If it finds you're waking up the
display shortly after it has turned itself off, it may automatically extend the inactive time period for the "Turn
off display after' setting above, to both suit your usage pattern and optimize energy savings.

Multimedia settings - When sharing media: Determines your PC's behavior when your PC is sharing or playing
back media from your PC via a connected device or other computer(s). I recommend selecting 'Prevent
idling to sleep' so that your PC doesn't enter Sleep mode, disrupting the media stream, unless you manually
select to put it to Sleep.

Battery: These settings can be configured to determine what your mobile PC does under various custom
battery levels.

There may be additional settings, or options missing, compared to those listed above. This depends on your
actual hardware and its capabilities. Once done with these settings click the Apply button and your scheme
will now be configured and put into effect. You can see this under the main Power Options screen. Note that
other plans which may not be in use will be under the 'Show additional plans' line; click it once to expand it
and show the other available plans.

In general while there are valid concerns about Global Warming and the wasteful use of energy and
resources, I believe it is false economy to enable too many power saving features as you may reduce the
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functionality of your PC, increase instability and also lose data if you go overboard. For gamers and other
high-end users I certainly don't recommend that most power saving options be used aside from those
recommended above. For mobile PC and casual desktop PC users however the options require personal
choice and thought based on individual usage patterns and battery life. Regardless, if you experience any
system instability or strange system behavior, I recommend using the 'High Performance' preset for
troubleshooting purposes.

B PRINTERS

This section allows you to view all connected printers, and add, remove or configure such devices. It is
recommended that you refer to the particular device's instructions for optimal setup information as each will
differ. Right-click on each printer and select Properties for more detailed configuration options. Importantly,
note that if you have disabled the 'Print Spooler' service then any printer on your system will not function.
Make sure the 'Print Spooler’ service is set to Automatic in the Services utility if you want to use a printer.
This also includes virtual printers, such as PDF makers. Finally, if you are connected to a network printer
and you have followed my configuration recommendations in this guide - which are usually noted where
relevant as not intended for networked computers - then your network printer may not be detected by
Windows. Go back and change your settings to default, especially the Services and Network and Sharing
Center settings.

B PROBLEM REPORTS AND SOLUTIONS

This tool provides a means by which you can view recorded system problems, and also check for possible
solutions. Usage details are covered under the Performance Measurement & Diagnostics chapter.

B PROGRAMS AND FEATURES

Programs and Features can be used to view or uninstall the programs and drives currently installed on your
system. It provides details of when the program was installed under the 'Installed On' column, and the total
size of the program on disk at the moment under the Size column. Unfortunately some programs and
drivers installed on the system will not appear in this list, possibly because of non-compliant installers; this
situation should improve. See the Windows Drivers chapter for how to manually find installed drivers.

The main functionality for Programs and Features is covered below:

Uninstalling Programs: Highlight the program you wish to uninstall, right-click on it and select Uninstall to
commence removal of it. If the program allows you to alter its installation, a Change option will also be
available, or you may see Uninstall/Change, meaning you will have to choose which you prefer in the
wizard which launches.

Get New Programs Online: This option shown in the left pane allows you to go to the Windows Marketplace
site and purchase a range of software made by or approved by Microsoft online.

View Purchased Software (Digital Locker): This option shown in the left pane launches the Digital Locker
Assistant. The main purpose for Digital Locker is to complete an online purchase at Windows Marketplace,
allowing you to download and install your purchased software.

Turn Windows Features On or Off: When shown in the left pane, when launched displays a list of all the built-
in Windows features which you can install or uninstall. This is very important because by making sure you
have only the features you need, you can save a bit of disk space, but by the same token if you strip out
functionality from Windows which you may need later, it can be an inconvenience. You will need to take
your time going through these features and deciding if you really need them. If in doubt, do not remove or
alter a feature as it is not necessary and could cause more problems than any benefits you experience. A

detailed listing of features you can use to help you is this Vista Feature Guide. Below are my own brief

[ueJ [01U0D) YT,

Copyright © 2007 Koroush Ghazi 137



http://www.windowsmarketplace.com/
http://www.bleepingcomputer.com/tutorials/tutorial134.html

e.l.lﬂ ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

descriptions and recommendations, intended for a standard home PC connected to the Internet but not to a
network. Note that some editions of Vista will not contain all of these features:
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Feature Recommend Details

ActiveX Installer Service Untick ActiveX is not necessary and carries a security risk.

Games Tick There is no harm in keeping the standard Vista games such as
Solitaire and Chess Titans.

Indexing Service Untick This is not the same as the Vista search indexing service; it's for
legacy applications and may cause issues if left enabled.

Internet Information Service Untick These are all designed for users running a Web or FTP server.

Microsoft NET Framework 3.0 Tick Required for applications programmed using .NET.

Microsoft Message Queue Untick Not necessary unless you really want run an MSMQ server.

(MSMQ) Server

Print Services Untick Not needed for standard home printers, only required if you use
or provide remote (networked or web-based) printers.

Remote Differential Compression Untick Only tick if connected to a network at any time.

Removable Storage Management Untick Only tick if you use removal storage media.

RIP Listener Untick Only tick if on a network which uses the RIPv1 protocol.

Services for NFS Untick Not required, NFS Protocol is for networks.

SNMP Feature Untick Simple Network Management Protocol is for networks.

Subsystem for UNIX-based Untick Only tick if running Unix-based applications, which home users

Applications don't normally do.

Tablet PC Optional Components Untick/Tick | This component is required for access to the Snipping Tool

covered in the Tablet PC section of this chapter. Tick if you want
to use that tool, untick if you don't.

Telnet Client Untick Only tick if you plan to use Telnet features to connect to a server.

Telnet Server Untick Lets others connect to your machine via Telnet, which is a
security risk unless you need this functionality.

TFTP Client Untick Only tick if you want to use TFTP to connect to TFTP server,
which normal Internet usage does not require.

Windows DFS Replication Service Untick Only tick if connected to a network at any time.

Windows Fax and Scan Untick Only needed if you want to use connected fax devices.

Windows Meeting Space Untick Only tick if you use the Windows Meeting Space functionality,
see the People Near Me section of the Control Panel chapter.

Windows Process Activation Tick Nothing to do with Product Activation, required for some

Service applications to be able to transfer information.

Windows Ultimate Extras Tick Allows Vista Ultimate owners access to any Ultimate Extras.

After changing these settings you may need to reboot and/or insert your original Vista DVD as required. If
you experience any odd behavior, reduced functionality or other problems then come back to this area and
reset the features back to their defaults - see the guide linked further above for a detailed list of the default
values for every feature and sub-feature.

B REGIONAL AND LANGUAGE OPTIONS

The basic region and language options should have already been chosen during the installation process,
however here you can change or refine these settings. It's important to select the correct location in
particular, as this determines things like daylight savings adjustments to the system clock.

FORMATS

Select the language format that suits your particular region of the world. This is important for making sure
that tools such as spell checkers can operate correctly, and that your currency and time are appropriately
displayed. If you want to alter the way these things are displayed, click the 'Customize this format' button
and manually edit the way numbers, dates, times and currency is shown.

Copyright © 2007 Koroush Ghazi 138




O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

LOCATION

Set your current physical location from the list.

KEYBOARDS AND LANGUAGES

Click the 'Change keyboards' button to access the advanced settings here. Each tab is covered below:

General: The default input language used for your keyboard should be chosen correctly based on your
location and hardware. In many countries using the western alphabet the keyboard used is a standard
QWERTY US keyboard. However if you have a different type of keyboard and/or you want to set a different
language from the location you are in, click the Add button, select the language you wish to use, then tick
the box for the actual keyboard hardware you're using. To see a graphical representation of what the
keyboard layout looks like, highlight the keyboard type and select Properties or Preview. If you are not
going to use a particular location or keyboard layout, then highlight it on the list and click Remove. Note, if
your keyboard hardware is not being detected correctly you may have to install specific drivers for the
keyboard.

Language Bar: The Language Bar is a small icon or floating bar which only appears if you have two or more
keyboard languages installed. It is used to provide easy access for switching between languages. To alter
where the Language Bar is shown, select whether to have it as a floating rectangular box on the desktop or
whether it will sit in the Taskbar at the bottom of the screen. To alter the appearance of the language bar use
the three checkboxes on this page to suit your tastes. If you want to get rid of the Language Bar then either
select Hidden or go and delete all additional languages from under the General tab above.

Advanced Key Settings: Here you can set the keyboard shortcut method to switch between languages. The
default for switching between input languages is Left ALT+SHIFT to switch language, and CTRL+SHIFT to
switch keyboard layouts. You can change this sequence by highlighting the 'Between input languages' item
and select 'Change key sequence’, and you can also assign a key shortcut combination to switch directly to a
specific language by highlighting the language in the list and once again clicking the 'Change key sequence'
button.

ADMINISTRATIVE

Language for non-Unicode programs: The Unicode system basically allows most modern programs to adapt
their menus and dialogs to your system's default language, so this setting only applies to older non-unicode
programs. For these older (non-unicode) programs you can set the locale which they will use in case the
program'’s text is not being displayed correctly. In most cases the system locale and non-Unicode locale
should be the same.

Reserved Accounts: You have the option of copying your Regional and Language settings to the default
template used to create new User Accounts in the future. To do this, click the 'Copy to reserved accounts'
button and tick the 'Default user account' option. If you also want to copy these settings across and make
them the default for the system (aside from existing User Accounts), then also tick the 'System Accounts'
option as well, then click OK and click Apply.

B SCANNERS AND CAMERAS

This section will allow you to install and manage any digital image devices such as scanners or digital
cameras you've connected to your machine but which are not being recognized by Vista. Typically you only
need to attach your device to the PC and Windows will detect it and install drivers. For unrecognized
devices first refer to your device's manual for specific setup recommendations, and if necessary attach the
device to the PC, come to this utility, click Refresh and if that fails click the '"Add Device' button and follow
the Wizard.
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B SECURITY CENTER

The Windows Security Center unifies access to and monitoring of major security-related Windows settings
on your system. It is not a security utility in itself, as it does nothing but warn you about certain security
features. It is covered in detail in the PC Security chapter.

H SOUND

One of the major changes in Windows Vista is the way in which it handles sound. These changes have been
made to both increase the stability and performance of audio, as well as its compatibility with a range of
audio devices, plus provide additional audio functionality at the system level. The changes are detailed in
this Microsoft Article as well as this OpenAL Article and this Creative Article.

In plain English, the changes mean that:

= There is much less potential for system instability, since the drivers are not entangled with the Kernel of
the OS. This means a sound-related problem is less likely to slow down or crash the entire system.

* The Vista audio engine runs faster and with greater accuracy than the XP audio engine.

*  You can now separately set the individual volume level of different devices or applications using the
Volume Control. This means that you can have your media player at full volume for example, but at the
same time a Windows sound like a warning prompt from UAC will be played at its normal volume.

* Increased configuration options for different speaker setups, including headphones, and more options
for genuine home theater usage.

*  Most sound card users will have access to a range of audio enhancements which do not require high-end
sound hardware.

There is however a major drawback to the way in which Vista forces most audio through software mode,
and that is any current program or game using the DirectSound/DirectSound3D API will not be able to use
hardware-accelerated functionality like Creative's EAX audio effects, since under Vista this runs only in
software mode. More details of this, including a patch for X-Fi sound cards is at the Creative ALchemy
Project site as well as the links further above. Fortunately games running OpenAL audio are not affected,
and can use hardware acceleration since they bypass the software mode emulation, so it is likely that most

upcoming games will switch to OpenAL to maintain advanced audio functionality. For the moment only
driver updates, as well as compatibility fixes and patches from game developers and Microsoft themselves
can fix audio problems under Vista. In fact some users who are having major problems may wish to remove
or disable their sound cards and revert to onboard sound functionality, since this is designed for software
mode and is likely to be less troublesome under Vista. The performance difference should be minimal and
you may even gain access to additional features as covered below.

Below we look at the new sound features, beginning with the Volume Mixer found in the Notification Area:

VOLUME MIXER

Shown as a small speaker icon in the Notification Area, the Volume Mixer allows you to adjust the master
volume level for the current sound output device. When you hover your mouse over it, it will show the
current master volume level as a number between 1 and 100, the current output device, as well as the sound
hardware being used. If you click once on it you can adjust the master volume level using a slider. If you
want to mute or unmute all sound, click the small blue speaker icon.

To open the full Volume Mixer, left click on the Volume Mixer icon in the Notification Area and select the
Mixer link. The Volume Mixer lists the separate sound output device(s) supported and enabled, as well as
the application(s) supporting sound input/output currently running, including Windows itself. You can
individually adjust Windows and application volumes to suit your taste or mute them individually. I
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recommend firstly setting a master volume for the sound output device quite high (e.g. at 75%), then adjust
other devices accordingly.

Below are the features of the Sound component found in the Control Panel:

PLAYBACK

This tab lists all the available sound playback devices on your system. This includes devices such as speakers
or headphones. To select which will be the default playback device (denoted by a small green tick on its
icon), highlight the device and click the 'Set Default' button.

Certain devices allow additional configuration, so highlight the device and if the Configure button is
available, click it and follow the Wizard to correctly configure the device. Most commonly this involves
configuring a set of speakers for the correct number and type of speakers used.

Each sound playback device can be configured in more detail, including access to a range of new functions,
by highlighting it and clicking the Properties button. While I can't detail every features for all types of
playback devices, below are the common features for speaker output. Importantly, some of these features
depend on specific types of hardware and/or drivers and hence may not be available on your system:

Tone: This option allows you to set the Bass and Treble level for all sound playback. I recommend playing
some music or a movie on a media player with a neutral or disabled graphic equalizer and adjust these
settings appropriately. Judicious use of this feature can make a real difference to sound quality.

Levels: The sliders under this section allow you to adjust the volume levels for each of your various output
and input types, such as CD audio, microphone, Line In, etc. I recommend muting (clicking on the blue
speaker icon) each input/output type you don't use, as this helps reduce background hissing. You can also
set the Balance for each one by clicking its Balance button; you will be able to set the relative volume level for
every channel possible on that output type.

Enhancements: This is an important set of features now included with Vista, and is covered in detail in this
Microsoft Article. It is only available on certain types of sound hardware, and the full set of enhancements
are summarized below:

* Bass Management - Controls Bass for home theater particularly when a subwoofer is missing.

* Speaker Phantoming - When using a multi-channel source, fills in any gaps in an incomplete multi-
channel speaker setup.

* Speaker Fill - The reverse of Speaker Phantoming, takes a two-channel source and spreads it over more
channels.

*  Virtual Surround - Converts multi-channel sound to two-channel, and back again if required.

* Loudness Equalization - Attempts to maintain a more constant sound level across a range of sources.

* Room Correction - Through the use of a microphone Vista can automatically calibrate a multi-channel
home theater setup.

* Headphone Virtualization - Creates a 3D sound environment for headphones.

* Bass Boost - Boosts the Bass response on smaller speakers such as mobile PC speakers.

The availability of any of these options is dependent on the sound hardware and drivers you are using, as
well as the playback device chosen.

Advanced: The 'Default Format' option shown here is the number of channels, the sample rate and the bit
depth generally used to play back all audio (i.e. the normal 'shared mode' Vista uses) through this playback
device. This is very important to the overall quality of sound you will experience in Vista. You can try
various options and click the Test button to hear the difference in audio quality. I recommend that you select
at least 16-bit 44,100Hz sample rate or the default already chosen by Vista, whichever is higher. You can then
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set this higher if you want. The higher this is set the greater the clarity and quality of most sound, however
some audio is encoded at a relatively low sample rate or bit rate, so raising this setting won't magically make
a bad audio source better. Also remember that setting this to an extremely high rate can also cause sound
glitches on some hardware, and may also reduce performance depending on your CPU - the sample rate
conversion is a done by Vista, not your sound hardware (except in OpenAL and ASIO environments - see
further above for details).

I recommend ticking the 'Allow applications to take exclusive control of this device' and 'Give exclusive
mode applications priority'. These will ensure that a program or game using the sound output device in
Vista can bypass the Windows audio engine if it needs to. If you run into problems with your sound output
in particular applications, untick the first option as it may cause compatibility problems with older programs
under certain circumstances.

RECORDING

This tab lists all the available sound recording devices on your system. This includes devices such as a
microphone. To select which will be default recording device (denoted by a small green tick on its icon),
highlight the device and click the 'Set Default' button. Just like playback devices, recording devices have
advanced options which can be configured. When you highlight the recording device and click the
Configure button, this will take you to the advanced configuration options. For microphones in particular,
the options are covered under the Speech Recognition section further below in this chapter. When you click
the Properties button for the recording device, and you are taken to a set of tabs similar to those shown
under the Playback section discussed above. The descriptions and recommendations are much the same.

SOUNDS

You can assign different sounds to particular system events in this section. Each system event is listed under
the Program box, and to hear the current sound assigned to it, highlight an item and click the Test button. To
assign another sound to the event, choose from the list available under the Sounds box, or click the Browse
button and find a .WAYV sound file which you can use instead, then click the Apply button and it will now be
used for this event.

While system sounds are important in warning you about various things that may be occurring at any time,
the problem is that they take up memory because they are loaded into RAM at Windows startup and stay
there most of the time. Therefore I recommend disabling as many unnecessary sounds as you can (highlight
the item and select None under the Sounds list then click Apply when done). Unnecessary sounds can
include sound prompts for obvious things like the Windows Logon or Logoff sounds, or the sound prompts
for features you don't have or don't use, such as the Battery-related, Fax-related or Windows Speech
Recognition-related events on PCs which don't use these features. You can even disable the new Vista
Windows Startup sound by unticking the relevant box, and this can help speed up system startup slightly,
not to mention that I recommend disabling the sound for the Windows Exit event to speed up exiting.

Furthermore, for the sound events you do wish to keep I recommend assigning the same sound to several
types of warnings - for example, I've assigned the 'Windows User Account Control' sound to all the other
types of system warning sounds including Asterisk, Critical Stop, Default Beep and Exclamation. By
assigning the same sound to multiple events you will still get audible alerts of certain events, but you save
memory since only one sound has to be loaded into memory, regardless of how many uses it may have.

As you install new programs or features they may add new system events and sounds, so make sure to go
through this list every once in a while to refine it and remove unnecessary sounds, and as recommended, try
to use the same sound for as many events as possible. Once you've set up the sounds the way you like them,
click the 'Save As' button at the top of the box and save your new sound scheme under a suitable name; any
changes you make in the future will be saved automatically to this scheme. If you just want to quickly
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disable all system event sounds select the 'No Sounds' item under the sound scheme area, but note that this
doesn't turn off all sound on your system, it simply removes sounds effects from all the system events.

B SPEECH RECOGNITION

This component allows you to configure the Speech Recognition functionality of Windows Vista, which will
let you control the computer using voice commands. To use speech recognition, you will require a
microphone connected to your system, preferably a good quality one. The Speech Recognition feature is
quite specialized, and fortunately Microsoft has provided a lot of resources to both configure and learn more
about this functionality, so it won't be detailed here. More details can be found in this Microsoft Article and
also by clicking the 'Take the Speech Tutorial' link in the Speech Recognition Options box. Most problems
experienced with Speech Recognition are due to either using a poor quality microphone and/or being in a
noisy environment. For those who don't use Speech Recognition functionality, click the 'Advanced speech
options' link in the left pane and make sure the 'Run Speech Recognition at startup' link is unticked.

B SyYNC CENTER

The Sync Center is a feature for people working on two or more copies of the same file across different
devices or a network. Note that synchronizing across network folders is only possible under Vista Ultimate,
Vista Business and Vista Enterprise Editions, and if synchronizing across two computers, both need to be
running Windows Vista. When a compatible device is detected, Vista will show it under the list of available
Sync Partnerships you can use in the Sync Center. Then when a file is stored on both your PC and the device
with which you have a partnership, if one version of the file is changed, Sync Center allows you to
synchronize the files, such that the newest version is always maintained in both locations. If there is any
doubt - for example if both file locations show a changed version, then Vista will ask you which version to
keep. I won't go into more detailed description of the Sync Center functionality here, but bear in mind that
synchronization can sometimes take quite a while if you have a lot of shared or offline files, and also some
devices will have problems being correctly detected by Sync Center until newer drivers are released.

B SYSTEM

The System component of Control Panel provides central access to a range of functionality, as well as an
overview of the system on the main page, showing the details of your CPU and RAM, as well as the specific
edition of Vista you are currently running. The actual functions found here are covered in full detail under
other chapters. In particular see the BIOS & Hardware Management chapter for Device Manager, Backup &
Recovery chapter for System Protection, and Performance Measurement & Diagnostics for the Windows
Experience Index.

Therefore the main functionality unique to this area is access to the System Properties box which contains
advanced configuration options, and this is covered below. Note that you do not need to open the System
component in Control Panel to gain access to the System Properties box; you can access it directly at any
time by going to Start>Search Box and typing "systempropertiesadvanced" (without quotes) and pressing
Enter. Below are the details of the System Properties box:

COMPUTER NAME

The Computer Name tab is only really useful for PCs connected to a network, since these details are used to
make it easier to identify this PC and connect to a network properly. For the average home PC user you can
skip this tab; do not alter any of these details.

HARDWARE

You can access Device Manager here. Importantly, you can also set Windows Vista's behavior when a new
device is connected and detected. Click the 'Windows Update Driver Settings' button and you will be able to
choose whether to allow Vista to 'Check for drivers automatically’; 'Ask me each time I connect a new device
before checking for drivers'; or 'Never check for drivers when I connect a device'. As mentioned under the
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Windows Drivers chapter, I recommend that you set this to the middle option, namely to force Vista to ask
you before checking for new drivers. This gives you more control in case you wish to install an older driver
rather than the latest one, or if the latest drivers are known to be problematic for example.

ADVANCED

This section has four main sub-sections, covered below:

Performance Settings: Clicking this button takes you to a set of performance options. Under the 'Visual Effects'
tab you can select a range of graphical effects you can enable or disable within Windows, depending on your
graphics card's capabilities. In general the fewer of these are ticked, the more responsive Windows usage
will feel. Refer to the Graphics & Interface chapter for more details. Under the Advanced tab you can select
whether Vista allocates more CPU resources towards the Programs you run, or for 'Background Services'
such as the Search Indexer or other scheduled/background tasks. It is strongly recommended that you leave
this set to Programs for optimal performance in Vista; only if your system is used primarily for very basic
tasks and has a lot of background tasks constantly running should you consider selecting the other option.
The Virtual Memory settings accessed here are covered under the Memory Optimization chapter. Finally,
Data Execution Prevention is a security measure which is covered in more detail under the PC Security
chapter, and should be left on except perhaps when troubleshooting.

User Profile Settings: This area allows you to view and if necessary change User Profiles, i.e. the profiles
which hold all the Windows Desktop and User Account-related settings for each user. There should be at
least one User Profile here for you, and one for every other user. You can Delete or Copy a profile if you
wish, though this should be done with caution. Clicking 'Change Type' allows you switch between a
Roaming and Local profile if on a network, but for the average home PC user you cannot do this.

Startup and Recovery Settings: These settings control the display of the Windows Boot Menu and Advanced
Recovery Options menu when applicable, and they are covered under the Boot Configuration and Backup &
recovery chapters respectively. The System Failure functionality is covered under the Performance
Measurement & Diagnostics chapter.

Environment Variables: These variables are all configured by Windows Vista when it first installs, and for the
most part are always set appropriately. You should not change these unless you have specific knowledge of
what it is you're about to change.

SYSTEM PROTECTION

The features here are covered under the Backup & Recovery chapter. I strongly recommend not disabling
System Protection on your Vista drive.

REMOTE

This tab allows you to configure how a remote (outside) connection to your PC is controlled. The main
purpose for remote connections is when someone in another location on the same network wants to control
your PC, for the purpose of troubleshooting a problem you're having for example, or to access resources on
your machine directly as though they were sitting in front of your machine. While this is an extremely useful
feature when you're on a trusted network (e.g. your work network), it is a security risk for home PCs or
when you are on an untrusted network. I strongly recommend that you disable (untick) the 'Allow Remote
Assistance connections to this computer' option and only enable it when prompted by a technical support
person from a trusted company (e.g. Microsoft or your hardware manufacturer). I also recommend setting
the Remote Desktop option to 'Don't allow connections to this computer’, and only manually configure this
to allow particular users - click the 'Select Users' button - if once again you are dealing with someone from a
trusted company. Leaving these features enabled when you don't use them is a security risk, so disable them
whenever they're not in use. There are also relevant services you can disable, so see the Service chapter.
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B TABLET PC SETTINGS

This component of the Control Panel allows you to configure a Tablet PC. Such functionality will not be
covered in this guide.

However there is one component of the Tablet PC functionality which all Vista users may benefit from. It is
called the Snipping Tool, and if you haven't uninstalled the Tablet PC component from Windows - see the
Programs & Features section further above for details - then you can access it by going to Start>All
Programs>Accessories, or by going to Start>Search Box and typing "snipping" (without quotes) and pressing
Enter. The Snipping Tool allows you to take a screenshot of whatever portion of the screen you select, and
you can then edit the image immediately, email it to someone or save it as a normal .JPG image.

B TASKBAR AND START MENU

The Taskbar is the bar which sits at the bottom of the Windows screen by default, and the Start Menu is the
main menu which opens when you click on the circular Start button with the Vista logo on it at the far left of
the Taskbar. There are a range of features which can be customized here, and they are detailed as follows:

TASKBAR

The Taskbar contains the Start button, Quick Launch area, buttons for any open programs, and the
Notification Area at the far right. Below are brief descriptions of what each of the functions in this tab do,
along with recommendations:

Lock the taskbar: When ticked it prevents accidental resizing or movement of the Taskbar. When unticked,
you can left-click and hold on the Taskbar and drag it to reposition where it sits, you can resize it to make it
thicker, and you can also resize the components on it such as the Quick Launch bar. Once you're done
customizing the Taskbar, make sure to tick this option again for normal daily use to prevent accidental
resizing or movement. Note, you can also lock or unlock the Taskbar quickly at any time by right-clicking on
the Taskbar and ticking or unticking 'Lock the Taskbar' from there.

Auto-hide the taskbar: When ticked the Taskbar is automatically hidden whenever your mouse is elsewhere on
the screen, and only shown when you move your mouse to the bottom of the screen. Set to suit your taste.

Keep the taskbar on top of other windows: If ticked, the Taskbar is always displayed on top of all open Windows
for easy access; it can never be obscured. If unticked you may have to go back to your Desktop at any time to
regain access to the Taskbar. For that reason I recommend keeping this option ticked.

Group similar taskbar buttons: If ticked, multiple buttons from the same or similar applications will be
grouped together into one button. For example multiple open documents in a word processor will show up
as only one button with a number indicating how many of that type the button contains. This can help
reduce clutter but it can also reduce speed of access to individual documents or applications, so set to suit
your taste.

Show Quick Launch: The Quick Launch bar is the section on the Taskbar where small shortcut icons
representing various applications can be placed. These allow you to quickly launch particular programs by
clicking the relevant icon. In general you should keep the Quick Launch bar enabled, but if you want to
remove it, untick this option. If you want to resize or reposition the Quick Launch bar, make sure the 'Lock
the taskbar' option is unticked then move the Quick Launch bar left or right, and you can also drag its small
'grip' area to widen or shorten its length. To remove a component from the Quick Launch bar, left-click and
hold down on the component, then drag it off the bar. To add a component, drag a shortcut onto the Quick
Launch bar. Note that you can add other toolbars to the Taskbar aside from the Quick Launch bar - see
Toolbars further below.
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Show window previews (thumbnails): If ticked, shows small preview images of what each button on the taskbar
represents. While this can be handy, they can also get in the way at times, and in general the title on the
Taskbar open application buttons should be sufficient to tell you what each one is.

START MENU

The Start Menu is an important component of Windows, and is accessed very often so you need to make
sure it is configured correctly. To begin with, you have two choices - whether to use the new Vista Start
Menu, or to use a Classic Start Menu which looks the same as under Windows XP. I strongly recommend the
Vista Start Menu as it has very useful new features such as the Search Box. Throughout this guide and in this
section it is assumed that this is the version we are using. At the bottom of this box you choose two options:

Store and display a list of recently opened files: If this option is ticked, the 'Recent Items' menu in the Start Menu
will display all your recently opened files (documents, music files, pictures etc.). If unticked, nothing will be
shown under Recent Items. Set to suit your taste.

Store and display a list of recently opened programs: 1f this option is ticked then your most recently opened
programs will be shown in the main Start Menu area. The number of these displayed depends on the
'Number of recent programs to display' setting found further below.

By default the Start Menu may not contain all the items you want, and usually contains far too many items
you don't want which makes it large and unwieldy. So once you've selected the Start Menu type, click the
Customize button and examine the details and recommendations below. Note that some items have the
option of 'Display as a link' which means the item will be displayed as a clickable link on the Start Menu;
'Display as a menu' which means that clicking the item on the Start Menu opens up a sub-menu of options
instead; or 'Don't display this item' which completely removes it from the Start Menu. Also note that any
changes you make will only come into effect if you click OK then click Apply:

Computer: This option controls whether the Computer item appears on the Taskbar. Clicking this option or
menu opens Windows Explorer, and generally this isn't a necessary item. You can open Windows Explorer
much more quickly using a Quick Launch icon or by pressing WINDOWSH+E for example.

Connect To: If ticked this option places a 'Connect To' link on the Start Menu which when clicked allows you
to choose a network to connect to. If you're not connected to a network of PCs, untick this option.

Control Panel: This item allows quick access to the Control Panel, either as a menu or a link. I recommend
selecting 'Display as a link', since the menu version can be very large.

Default Programs: 1f ticked places a 'Default Programs' link on the Start Menu which accesses the Default
Programs options - not necessary for daily usage, and can be readily accessed from Control Panel when
needed anyway so untick.

Documents: This option places a Documents item on the Start Menu which links to your
\ Users\[username]\ Documents folder. I recommend selecting 'Display as a link' so that you can quickly
navigate to the particular documents under it when required.

Enable context menus and dragging and dropping: I strongly recommend that this option be ticked, as it allows
you to move around and add or remove items from the Start Menu just as you would in Windows Explorer.
It also allows you to use the right-click context menu on the Start Menu items, which is important if you
want to rename icons, pin/unpin items or run them as Administrator from the Start Menu easily.

Favorites Menu: If this option is ticked, your Internet Explorer Favorites menu will be displayed on the Start
Menu as a menu. If you don't use Internet Explorer as your default browser you may want to untick this.
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Games: This item will take you to the Games Explorer which shows installed games on your system, both the
default Windows games as well as third-party games you have installed yourself. Set to suit your taste.

Help: If ticked, the 'Help and Support' link is shown on the Start Menu. I strongly recommend ticking this
option and making use of the help functionality when you have a question about a feature. Alternatively if
you disable this, you can bring up Help and Support at any time by pressing WINDOWS+F1.

Highlight newly installed programs: If ticked this option will highlight in orange the directory and launch icon
for recently installed program(s) on the Start Menu. This generally isn't necessary but set to suit your taste.

Music: Determines whether a menu or link is shown to your \Users\[username]\ Music folder or not. Set to
suit your taste.

Network: If ticked displays a Network item on the Start Menu which when clicked takes you to a list of
available network drives. Untick unless you are on a network.

Open submenus when I pause on them with the mouse pointer: I recommend that this option be ticked, as it allows
you to open a submenu or directory link in the Start Menu just by hover your mouse over it; otherwise you
will have to click on the item to open the menu.

Personal Folder: This displays an item or menu on the Start Menu with your username as its title. When
clicked on or hovered over, it opens up the contents of your entire \Users\[username] directory. Generally
not necessary, especially if you have the relevant subfolders (i.e. Documents, Music, Pictures) as items on the
Start Menu already.

Pictures: Determines whether a menu or link is shown to your \Users\[username]\ Pictures folder or not. Set
to suit your taste.

Printers: If ticked a Printers item will be placed on the Start Menu, which when clicked launches the Printers
component which allows management of printers and print jobs. Untick if you don't have a printer, and note
that even if you do, this component is also readily accessible under the Control Panel.

Run Command.: If ticked this places a 'Run..." item on the Start Menu, which when clicked opens a Run box for
entering command line commands. This item is very useful and I recommend that you do not disable it,
although note that you can bring up a Run box at any time by pressing WINDOWS+R. Note further that the
default Search Box in the Start Menu can also execute commands much the same way as a Run box.

Search: If ticked this places a Search item in the Start Menu which opens the detailed Windows Search box
when clicked - see the Windows Search chapter for details. This is generally unnecessary, since you can
trigger a search by using the existing Search Box on the Start Menu, and then escalate to an advanced search
by clicking one of the additional search options offered there.

The following items all control the default search behavior of the Search Box in the Start Menu. Depending
on which of the below are ticked, a particular search phrase will be searched for and presented under certain
category headings:

»  Search communications - Searches the communications-related files, namely email.

» Search favorites and history - Searches through Internet Explorer Favorites and History.

»  Search files - The sub-options here allow you to not search through files; search the entire Search Index;
or only search through the current user's personal folders.

*  Search programs - Searches through installed program names.
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In general you should at least tick Search Programs, and for Search Files set it to search the entire index. If
you haven't enabled the Search Index or restricted the index in some way this will result in not finding all
relevant files - see the Windows Search chapter for details.

Sort All Programs menu by name: If ticked, your All Programs menu in the Start Menu will have all the items
automatically arranged in alphabetical order. This is recommended, however if you wish to rearrange things
manually untick this. Note that when this option is select, the 'Sort by name' context menu item will not
appear when you right-click on any item in All Programs; with it disabled, the context menu entry will
reappear, allowing you to manually force a sort by name whenever you wish.

System Administrative Tools: The Administrative Tools covered earlier in this chapter can be displayed or
removed here. Generally it is not necessary to display them here, as they aren't used all that often and can be
easily accessed through shortcuts to individual components, or via the Control Panel.

Use large icons: If ticked, the main items in the Start Menu will use the default larger icons. Unless you're
running a very high screen resolution, I recommend unticking this option to force Vista to use smaller icons.
In return you can fit more items in the front page of the Start Menu and in my opinion it is easier to navigate.

Number of recent programs to display: If you have ticked the 'Store and display a list of recently opened
programs' item, then this determines how many recently opened programs will be shown in the main Start
Menu area. Set to suit your taste.

Show on Start Menu: These two options, namely 'Internet Link' and 'Email Link' pin the relevant programs
chosen in the drop boxes at the top of your Start Menu. The default programs are Internet Explorer and
Windows Mail, but you can set other programs by first making sure they're available under the Default
Programs area of the Control Panel (see further above in this chapter). If you don't want one or either of
these links automatically shown on the Start Menu (e.g. if you default browser is not showing up in the list)
then untick the relevant boxes.

Once you've made all your changes, make sure to click the Apply button on the main Start Menu tab
otherwise you will not see your changes applied to the Start Menu. Note that you can manually reorganize
or change the shortcuts and folders shown in the Start Menu by going to the following directories:

\ Users\ [username]\ AppData\ Roaming \ Microsoft \ Windows \ Start Menu
\ Users\ All Users\ Microsoft\ Windows\ Start Menu

Any changes you make to the second directory will affect all users on the machine however.

NOTIFICATION AREA

The Notification Area was previously known as the System Tray in other versions of Windows. It contains
icons from some of the currently running programs, warnings or notifications from programs and Windows,
and the System Clock, Network indicator and Volume Mixer icons.

Hide Inactive Icons: When ticked the Notification Area hides icons for particular programs or notifications
which are not urgent or necessary to draw attention to, both to reduce annoyance and make sure Taskbar
space is not unnecessarily taken up. When holding hidden icons, the Notification Area will show a small
while arrow which you can click to show all hidden icons. It is wise to minimize how many background
programs and hence icons in the Notification Area there will be. Some icons can also be removed by
configuring the relevant program or utility, and looking for a 'System Tray' or Notification option to turn off,
such as those for Windows Defender or the Security Center discussed under the PC Security chapter.

Regardless of how many programs you have running in the background, there may still be some icons
shown here which you may wish to hide (or show). For example some types of hardware will place a 'Safely
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Remove Hardware' icon in the Notification Area. This icon is not needed add cannot be removed, so it is
worth hiding. The same with the Windows Sidebar icon which is not really necessary, since you can always
access Sidebar options by right-clicking on the Sidebar area itself. I recommend ticking this option and
clicking the Customize button to manually adjust which icons are always shown, which are always hidden,
and which are hidden after a period of inactivity. If in doubt, leave an item at its default which is usually
'Hide when inactive'. Again, hiding an icon does not remove the program from memory, so as
recommended in the Startup Programs chapter, make sure to remove unnecessary startup programs and
also go through existing programs to remove unnecessary Notification Area/System Tray icons properly.

System Icons: Here you can select which of the four types of permanent system icons usually shown in the
Notification are displayed or removed. This includes the System Clock, the Volume Mixer icon, the Network
Animation icon and the Power icon for mobile PCs. I generally recommend all of them being enabled as they
provide valuable information and features.

TOOLBARS

A Toolbar is a portion of the Taskbar which contains specific functionality. By default the Quick Launch
toolbar is enabled, and is discussed further above. It is quite handy for quickly launching commonly used
programs, or even commonly used files or folders. You can however add several additional built-in
Toolbars, including;:

Address: If ticked this places an Internet Explorer address box on the Taskbar, and any text you enter will be
launched as a URL.

Windows Media Player: When ticked, this allows Windows Media Player to sit in 'Mini Player' mode when it
is open and minimized to the Taskbar, which is recommended. See the Windows Media Player chapter for
more details.

Links: This item places a Links box on the Taskbar if ticked, allowing you to select any custom Internet links
you've placed there. Any links you select will be launched in an Internet Explorer window.

Tablet PC Input Panel: If ticked this places an icon on the Taskbar which when clicked opens the Tablet PC
Input Panel. It is more of a novelty and is not needed for the average home PC user.

Desktop: If selected, when clicked this item opens a list of Desktop icons you can select to launch, as well as
links to common resources including the Control Panel and your user folders.

Quick Launch: This item is covered in more detail under the Taskbar section further above.

Note that at any time you can quickly add or remove Toolbar items by right-clicking on the Taskbar and
select the Toolbars menu item. You can also create your own custom Toolbar by clicking the 'New Toolbar'
item and selecting a program, file or folder to link tos.

B TEXT TO SPEECH

Text to Speech is a function which allows Windows Vista to use a synthesized voice to read text on the
screen out aloud through speakers or a headphone. To change the voice used for Text to Speech, select a
voice under the Voice selection box. The default Microsoft Anna is the best choice as it uses a new more
natural sounding voice than the older voice engines. To preview the voice enter some text in the box below
then click the Preview Voice button - don't just press Enter as this will exit the program. You can adjust the
voice speed using the slider further below.

By itself the Text to Speech component does not allow you to enable the functionality required to actually
read out any text on the screen under normal circumstances. To actually have Vista read out portions of the
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screen aloud using the Text to Speech voice, you will need to enable the Narrator, found under Control
Panel>Ease of Access Center, or by going to Start>Search Box and typing "narrator" (without quotes) and
hitting Enter. Basic details of how to use Narrator are in this Microsoft Article.

More details of this functionality and for additional voices you can download see the Microsoft Speech Site.
Additional voices are available at places like ByteCool.

B USER ACCOUNTS

User Accounts are a way of allowing more than one person to use the same machine in isolation of one
another. Thus two or more people can use one PC, but have different background wallpapers, different
mouse settings, and different files and documents all stored separately from each other (under their own
\ Users\ [username] directory) and without impact on or access to each other. However User Accounts are not
solely designed for sharing purposes; even if there is only ever one user of the machine, you will still need to
have a User Account, maybe even two, for security reasons. When you first install Vista, a default User
Account with Administrator privileges is created with the username and password (optional) you choose
just prior to finalizing installation. Every time you start using Vista from then on, this User Account is used
by default unless you create others.

To start with it's important to understand the privilege levels given to User Accounts. In Vista there are three
main types of User Accounts: Guest, Standard and Administrator. Each has different privileges - when using
a Guest or Standard account, by default some actions are initially blocked by the system due to insufficient
privileges. This is done to prevent these users from viewing or deleting each others' files for example, or
installing or running programs or making system-wide changes that can destabilize or harm the entire
system. An Administrator level account on the other hand can undertake a full range of actions, from
installing programs and making system-level changes, to viewing the files and folders of other User
Accounts on the system (if they are not password-protected accounts). Administrators can also create,
change or delete new or existing User Accounts. While some systems may not have any Standard User
Accounts, there must always be at least one Administrator User Account on the system to be able to manage
it - which is why Vista creates one by default straight at the end of installation. There is also another built-in
Administrator account but that is disabled and hidden by default and discussed under the Advanced section
further below.

The problem is that an Administrator level account is so powerful, it also poses a security risk if used on a
day-to-day basis as the default account. If the system is compromised by malware, or physically accessed by
another person, they can do anything they want using an Administrator account. So for security purposes, it
has long been recommended that even sole users of a PC create two accounts; one Administrator and one
Standard, and use the Standard account for day-to-day purposes, and then login to the Administrator
account only to do more system-intensive tasks. Unfortunately this is usually such an inconvenience under
older versions of Windows such as XP that most people run as Administrator users the whole time.

Vista's solution to this dilemma is called User Account Control (UAC), and is covered in more detail under
the PC Security chapter. Basically it means that whether you're using an Administrator or Standard User
Account, you are actually running with only Standard account privileges. Then, whenever you actually go to
do something which requires Administrator privileges, a UAC prompt appears asking you to either click the
Continue button (if you're an Administrator) or enter the Administrator password (if you're a Standard user)
to continue. This prevents malware programs launching or making changes in the background without your
knowledge, and it also prevents inadvertent or unauthorized system changes.

So while many people hate UAC and its incessant prompting, the benefits of UAC - and I strongly
recommend you keep it enabled - are that you don't need to create additional User Accounts and switch
back and forth, nor do you need to expose yourself to the major security risks of running the Administrator
account on a regular basis as has been in the past; you can now run an Administrator account as your main
account, and use UAC to have tight security as well.
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What follows is my advice on how to set up User Accounts on your system based on four common scenarios.

USER ACCOUNT SCENARIOS

When you are setting up User Accounts in Vista, you must first decide on how many people you want to
provide access to your machine, and also consider whether the PC is readily accessible by others or is
relatively isolated from physical access. The number of users is an obvious factor, but the second variable
has to do with the fact that a PC which can be physically accessed by other people you don't necessarily trust
requires much tighter security than one which is physically isolated. Below are my recommendations for the
various scenarios which are possible and the best way to configure one or more User Accounts to suit:

Single user, isolated machine: If the PC only has one user and is not accessible by anyone else then the default
User Account created by Vista during installation is sufficient. For maximum convenience this
Administrator level account may also not have a password, which provides the fastest startup into Vista as
you won't have to see a login screen.

Single user, accessible machine: If the PC has only one user but others can physically access it, or you are
worried about sensitive information and potential theft, then the default User Account created by Vista is
sufficient but you must assign a strong password to the account. See the Backup & Recovery Chapter for
details. The password will need to be entered at the login screen each time you start up Vista, and as long as
the password is quite strong, this will prevent anyone from gaining access. You may also with to use EFS
Encryption and/or BitLocker if the threat of physical access or theft is quite high - see the PC Security
chapter.

Multiple users, isolated machine: If the PC has more than one user but is only physically accessed by trusted
users (such as close family members) then I recommend creating a Standard User Account for each of the
additional people who will be using the machine, and keeping the Administrator account for yourself to use.
However importantly you must now use a password for your Administrator account and you must also
enable UAC. Aside from malware risks, a password and UAC are required to prevent the other User
Accounts from making system-wide changes which may destabilize or harm the PC, and it also allows you
to use the Parental Control features detailed further below. Note that the Standard accounts themselves
don't have to have passwords, but it is recommended in case one user accidentally (or purposely) logs in
under another user's account and makes undesired changes. Furthermore Standard accounts which don't
have passwords can have the contents of their personal folders viewed by Administrators; if password
protected, personal folders cannot be viewed by anyone else.

Multiple users, accessible machine: If the PC has more than one user, but is also physically accessible by a range
of people who you may not completely trust, or there is greater risk of theft, then I recommend the same
procedures as the scenario above, however the Administrator password must be made very strong, and the
Standard account passwords should also be made quite strong. Individual users may also wish to use EFS
Encryption for sensitive files or folders. In addition, if you want to allow an untrusted person limited access
to your machine (e.g. for basic web browsing), then turn the Guest account on as well and ask them to use
that - they won't be able to change any settings or access your personal files using the Guest account. UAC
must be enabled at all times for maximum protection against unauthorized changes and to prevent malware.

Note that on a PC with multiple user accounts, you can quickly switch between accounts without restarting
the machine by pressing CTRL+ALT+DEL and selecting 'Switch User'. You can also go back to the main
logon screen by selecting Log Off' instead. Once again, if you aren't clear on how UAC works, or want to
know about additional ways you can customize both UAC and User Account-related security, see the User
Account Control and Local Security Policy sections of the PC Security chapter for more details and tips.
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MANAGING ACCOUNTS

Once you've decided on the best strategy, you will need to create, delete or modify existing User Accounts to
suit your needs. This is done by first logging in as an Administrator, then going to the main User Accounts
screen. Here you can either edit your own account, or by clicking the 'Manage another account' link you can
edit the details of any other accounts on the system. Below are the typical range of options shown when
managing an account:

Create a new account: This allows an Administrator to create a new account, assigning it a name and an
account type. I strongly suggest only creating as many additional Standard accounts as you actually need.
Unused accounts will simply take up drive space for no purpose, as each account automatically has a set of
personal folders created for it. Remember also that the more Administrator accounts you have, the more
likelihood there is that a user can cause unintended harm to the system, or inadvertently allow malware
onto the system. For that reason if you do wish to have more than one Administrator I strongly recommend
enabling UAC and having strong passwords on all Administrator accounts. Generally I only recommend one
Administrator account - the default one created by Vista. There is also a hidden Administrator account
which is discussed further below.

Delete the account: You can delete any account except your own. This is obviously something that should
done with caution, since deleting an account not only deletes all that accounts saved preferences, it can also
deletes all their personal files and folders. For this reason you will be asked whether you wish to save the
account's personal files to a new directory before deletion, but you will not be able to save their emails and
personal settings.

Create a password: If the account doesn't have a password, and you need to create one (see scenarios above),
then click this link and enter an appropriate password. Importantly, if you lose or forget the password for an
Administrator account you will need someone with another Administrator account on the same machine to
help you - if another Administrator doesn't exist you will be in serious trouble - see the Backup & Recovery
Chapter for options. If a Standard User Account forgets their password, an Administrator can click the
'‘Change the password' or 'Remove the password' links as appropriate to fix this. To change your own
password at any time press CTRL+ALT+DEL and select 'Change a password'.

Change the picture: By default each User Account has a small picture attached to it to make identification of
different accounts easier on the login screen and at the top of the Start Menu among other places. Select one
from the list shown, or to use your own custom picture click the 'Browse for more pictures' link at the
bottom of the images and find an appropriate image to use. Note that you can quickly open the User
Account properties by going to Start Menu and clicking your User Account picture at the top of the menu.

Change the account name: You can change an account name at any time if you are an Administrator, including
your own. However aside from causing confusion at login time, it also causes further confusion because the
actual name of the personal folder for the user found under \Users\[username] will not be changed; it will
remain as originally set, while the version of it shown under My Computer will change to the new name.

Change the account type: An account can be changed from Administrator to Standard user and vice versa,
though this is obviously something which should be done with some consideration. I don't recommend
changing the first default account created under Vista to a Standard user as this can cause problems.

Guest account: You can select whether to turn the Guest account on or off, and in general it should remain off.
It is only to be used if you wish to give temporary access to a user who will then be able to use your machine
in a limited capacity, unable to access or alter any personal files, nor able to change any system settings or
install software or hardware. It is still a security risk when left on, and also forces the logon screen to appear
if you only have one other account, so turn it off until or unless it is truly needed.
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PARENTAL CONTROLS

One of the options under the account management section (as well as in the Control Panel) which an
Administrator can use is 'Set up Parental Controls'. Since by far one of the most common uses of User
Accounts is by parents who want to restrict their kids from making a big mess of the family computer, this
set of controls is extremely handy, but it is not just for managing kids. Parental Controls allows you to lay
down certain additional limitations on a Standard User Account, and these are described below:

Activity Reporting: If enabled, the user's activity will be logged. You can view these logs here by clicking the
‘View activity reports' link at the right of the screen. You can see more details by browsing the log categories
in the left pane.

Windows Vista Web Filter: The web filter allows you to manually allow or block specific websites by address,
as well as setting a general restriction level of None, Medium or High. To specify the exact type of content
you want to block, click the Custom option and select the categories to be blocked. Keep in mind that the
rating system is not perfect, it is based on the Windows Live Family Safety service, so material which you

may find offensive may still slip through if you rely solely on the rating system; it is not foolproof, but it
should be quite robust. You can even tick the 'Block file downloads' option to prevent any files being
downloaded to the machine.

Time limits: You can specify the time of day in one hour blocks that this user is not allowed to logon to the
PC, for every day of the week. Any areas shaded with a color block mean the user will not be able to use the
machine at that time.

Games: This area lets you select firstly whether the user can play any games at all, and then you can block
games with particular ratings - these should be set to match your local region's rating scheme. You can
choose either to allow or block unrated games, but note that some (mainly older) games may be unrated
regardless of their content type. You can then manually specify the games you wish to block or allow, in the
case of exceptions which aren't handled by the ratings scheme for example.

Allow and block specific programs: If you wish to block the user from being able to run particular programs,
click the '[user] can only use the programs I allow' and then select from the list of all installed programs
shown. If a program file is missing from the list, click Browse and go to its directory then select it.

As you can see, these controls can be used not just for kids but also to prevent certain users from running
specific programs or accessing certain websites, or if you just wish to monitor a particular user's activities.

ADVANCED USER ACCOUNT PROPERTIES

There is another area of User Account options which you can access by going to Start>Search Box and typing
"control userpasswords2" (without quotes) and pressing Enter. The options provided here are more
advanced than those provided under the normal User Accounts area, and require much more caution as you
can easily delete or ruin a User Account or create a major security risk if you're not careful. If in doubt do not
alter anything. Below are the descriptions for these settings:

Users must enter a user name and password to use this computer: If your system is only using one account - the
default one created at Vista startup - and you have not set a password, then in effect you won't have to enter
a username or password at any time regardless. However if you have two or more User Accounts then
unticking this option means that the account which is shown highlighted (and which you can select while
the box is ticked) will become the default account. This account will then automatically login each time you
start Vista. This is a major security risk and is not recommended unless you are the sole user of the machine
and the machine is in a physically secure environment.
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Users for this computer: This area lists all the User Accounts on this PC. You can add or remove accounts here,
though it is not recommended. Highlight an account and click Properties; aside from letting you change the
name and description of the account, under the 'Group Membership' tab you can not only select whether to
set this as an Administrator or Standard account, you can select one of the other more specialised sub groups
which have specific limitations. For example you can select the Power User' group which provides more
privileges than a Standard User and less than an Administrator. To add these groups to the list of selectable
account types in the main User Accounts box, see the Advanced user management option below.

Reset Password: Allows you to set a new password for the highlighted User Account, but to change your own
password press CTRL+ALT+DEL and select 'Change a password'.

The following options are under the Advanced tab:

Manage Passwords: This option allows you store and backup various passwords - see the Backup and
Recovery chapter for more details.

Advanced user management: Clicking the Advanced button opens the Local User Management box. Click the
Users or Groups item in the left pane and you will see list of current users on the system, as well as the
available group types.

Importantly, you will see under Users that aside from your own User Account and any you've created, there
is also an account with the username 'Administrator’ - this is the built-in Administrator account in Vista, and
is different to the one created during Vista's installation. This Administrator account is not available by
default and is very powerful, since it has no password, allows complete access to the system and is not
affected by UAC at all - which is precisely why it's hidden by default. Double-click the account and you can
untick the 'disabled' box to re-enable it again and it will be available for login and configuration as a normal
User Account. I must stress that you should not use this account regularly as it is a major security risk, since
it is not protected by a password, nor is it affected by UAC. A user logging in under this default
Administrator account is leaving a major security hole open.

Secure Logon: If you wish to have added security, you can tick the 'Require users to press
CTRL+ALT+DELETE' box, and thus whenever anyone tries to logon on this PC, they will have to press the
CTRL, ALT and DEL keys together to bring up the logon screen; it will not display automatically. This
increases security because it places the logon screen in Secure Desktop mode (See User Account Control in
the PC Security Chapter) - this means the logon screen cannot be faked by malware to capture your login
details. Normally however this level of security is not necessary for the average home PC user.

B WELCOME CENTER

The Welcome Center is a central location showing the exact edition of Vista you are using, a brief snapshot
of your PC's basic system specifications, as well as a range of Vista options and Microsoft offers. It is shown
by default the first time you start Windows Vista and every time after that, and in general it is not necessary
at all since all of the information and utilities it contains are available from various places in Vista. I
recommend disabling the Welcome Center to speed up Windows startup - untick the 'Run at startup' option
at the bottom of the Welcome Center then close it.

B WINDOWS CARDSPACE

Windows CardSpace is form of digital identity verification 'Card' which you can use online rather than a
username and password combination. You can create a Personal Card or a Managed Card, with Personal
Cards being less reliable and less likely to be accepted for important transactions since they rely on you to
enter and store all the details on your own PC (though the data is encrypted); Managed Cards on the other
hand are created by a third-party provider who manages the card for you and thus verifies who you are. Full
details of how CardSpace works are in this Microsoft Article. Whether you use CardSpace is up to you. To
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start with you should have no need to set this system up until you run into a site which uses it; you can then
decide whether to proceed, and whether to only use Personal Cards or set up a Managed Card as well.

B WINDOWS DEFENDER

Windows Defender is a security feature which is covered in detail in the PC Security chapter.

B WINDOWS FIREWALL

The Windows Firewall is a security feature which is covered in detail in the PC Security chapter.

B WINDOWS SIDEBAR

The Windows Sidebar is a visual feature and is covered in detail in the Graphics & Interface chapter.

H WINDOWS SIDESHOW

Windows Sideshow is a feature only available in Vista Ultimate, Vista Home Premium and Vista Business. It
allows a user who has connected an external device with a display to their computer to show a range of
information on this device without turning the PC on. I won't detail this feature in the guide.

H WINDOWS UPDATE

Windows Update is the main tool used to obtain security patches, as well as driver and feature updates in
Windows Vista. Vista users no longer need to access the Windows Update website for this functionality. By
default Windows Update prompts you to allow a scheduled check of the Microsoft site for updates every
day, and to download and install them automatically as required.

The information Windows Update sends to the MS site during an update is as follows:

*  Computer make and model

= Version information for the operating system, browser, and any other Microsoft software for which
updates might be available

* Plug and Play ID numbers of hardware devices

* Region and language setting

*  Globally unique identifier (GUID)

* Product ID and product key

=  BIOS name, revision number, and revision date

*  Your Internet Protocol (IP) address

Full details of what information is collected and how it is used are in this Microsoft Article.

To customize the Windows Update settings, click the 'Change settings' link in the left pane. The main choice
is under the 'Choose how Windows can install updates' section. If the 'Install updates automatically' option
is enabled, set it to check for updates 'Every day' at the time when you are most likely to be connected to the
Internet. This allows Windows Update - if you are connected to the Internet - to check for updates and
download and install important updates such as security patches and fixes. If you also want Windows
Update to download and install 'recommended' updates which include driver updates and compatibility
patches, tick the 'Include recommended updates' link at the bottom of the screen. Configuring Windows
Update to undertake automatic updates in this way is recommended for those who are more forgetful, or
who are less experienced and just want to remain up to date and secure.

For medium to advanced users I actually recommend selecting the 'Check for updates but let me choose
whether to install them' option instead. This includes ticking the 'Include recommended updates' box. The
reason for this is that it provides the best of both worlds: Vista will check for updates daily so that you don't
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have to remember to do so manually, but it will not download or install anything without your permission -
instead you will see a small Windows Update globe in the Notification Area at the bottom right of the
screen. You can then click it to open Windows Update and then click the 'View available updates' link to see
the details of updates, and select which update(s) you want to install. Then simply click the Install button
and they will be downloaded and installed. If you've unticked the update and don't want to see it again,
right-click on it and select 'Hide update'. This gives you greater control over what you are installing on your
system. Obviously all important updates should be installed, and if you do see any optional updates of
interest, they are usually safe and worth installing (e.g. driver updates).

I do not recommend selecting Never check for updates'. Windows Update is a very important part of
keeping Vista up to date and secure, and as such should never be completely disabled. If you are in an
environment where you need to control access to the Internet, then read this Microsoft Article. If you do
insist on disabling update checking, then you must check Windows Updates manually every couple of days
by clicking the 'Check for updates' link in the left pane; clearly this requires a lot of discipline. Failing to
check Windows Updates regularly opens your system up to recent security exploits and vulnerabilities,

which nowadays can quickly circulate around the Internet within days or even hours. For maximum security
you must always install the latest important updates - see the PC Security chapter for more details of why
PC security is such a big issue now.

To view the updates already installed on your system via Windows Update at any time, click the View
update history'. To view further details of each update installed, right-click on it and select 'View details'. To
remove an installed update, you can click the 'Installed updates' link at the top of the detail update history
box.

If you want to download updates for other Microsoft products, click the 'Get updates for more products’, but
this is not necessary for most users unless you have specific Microsoft products which need regular
updating, such as Microsoft Office. You will not get general updates for your installed programs this way;
there are no automated methods of keeping all your installed programs up to date, it requires you to keep an
eye out for update notifications on various websites.

If you are using Windows Vista Ultimate Edition, you can also select the available list of Ultimate Extras to
download here. This includes extras such as BitLocker and EFS Enhancements, Hold Em Poker and
DreamScene as detailed at the Windows Ultimate official site, as well as under the PC Security and Graphics
& Interface chapters.

If you are receiving an error when using Windows Update, check this Microsoft Article.

Finally, by default Windows Update creates a Restore Point prior to installing new updates, so I strongly
recommend leaving System Protection enabled to allow this to happen, as it provides an extra layer of
protection in case an update goes wrong and you want to put your system back to the way it was before it.
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STARTUP PROGRAMS

Windows Vista loads up a range of programs into memory during its startup procedure, including drivers
and programs needed to provide the main functionality in Vista just prior to showing the Windows Desktop
or the logon screen. However unlike previous versions of Windows, Vista is designed to try get the user to
the Windows Desktop as fast as possible. This means that certain programs, scripts and services will run in
the background with a lower priority and continue to load even after the Windows Desktop has appeared.
Plus of course after the Desktop has appeared, you may see additional loading due to SuperFetch and
scheduled tasks commencing. See the Memory Optimization, Drive Optimization and Services chapters for
more details of those aspects of post-startup behavior.

Thus it's important to understand that unlike previous versions of Windows, reducing the number of startup
programs is not absolutely necessary for Windows Vista to load up relatively quickly and be fairly
responsive, since changes in its underlying technology have already made this possible. However removing
unnecessary startup programs, services and tasks is still recommended, and can help reduce excessive
loading during and immediately after Vista startup, which in turn may boost startup speed and initial
responsiveness. It can also reduce unnecessary RAM usage, leaving more for SuperFetch to do its job.

Below we look at how to find, correctly identify and properly remove unnecessary startup programs. Some
startup programs are actually services and are covered under the Services chapter.

B FINDING STARTUP PROGRAMS

The first step in the process is to find the names of all the programs and files which are running at startup on
your system. To do this you will need to use one or more of the several tools covered below:

SOFTWARE EXPLORER

Windows Vista has a built-in utility which among other things allows you to view and if necessary disable
the main startup programs on your systems. It is available from within Windows Defender, and if Windows
Defender is disabled that also prevents access to this useful tool - see the PC Security chapter. To access
Software Explorer open Windows Defender and click the Tools link, then select 'Software Explorer'.

On the main page of Software Explorer you will be able to select which types of programs you can view
based on one of the following categories: 'Startup Programs'; 'Currently Running Programs'; 'Network
Connected Programs'’; and 'Winsock Service Providers'. Regardless of which you choose, make sure to click
the 'Show for all users' button so you can see all the programs and importantly this also allows you to
change their status from Enabled to Disabled and vice versa, or to Remove them if applicable. To see further
details for any program on the list, click once on the program item and in the right pane its details will be
shown. In particular note the 'File Name' field as this is important in correctly identifying the program, and
also note the 'Ships with Operating System' field as this tells you whether it was installed as part of Vista, or
if it's been installed by a third-party program.

MICROSOFT SYSTEM CONFIGURATION UTILITY

Another built-in Windows utility for additional tweaking and troubleshooting of your system is the
Microsoft System Configuration Utility (MSConfig). To access it, go to Start>Search Box and type "msconfig"
(without quotes) and press Enter. Its main use is to provide a brief snapshot of key system variables, and
provide a means for troubleshooting Windows boot and startup problems. The options under the Boot tab of
MSConfig are covered in more detail under the Boot Configuration chapter, the options under the Services
tab are covered in more detail in the Services chapter, and the options under the Tools tab are merely
shortcuts to other features of Vista covered throughout this guide. So below we examine the General and
Startup tabs of this utility.
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General: By default when your system is running at full functionality, MSConfig will show the 'Normal
startup' item selected. This means all programs, drivers and features are loading up as normal. If you wish to
boot up into Safe Mode (See Backup & Recovery chapter) you can select the 'Diagnostic startup' item instead.
To perform a quick temporary check to see the impact on functionality and performance of your startup
items, you can set a 'Selective Startup' and untick the 'Load startup items' box then click Apply. When you
next reboot your system, Vista will start up without loading any of the additional programs it would usually
load at startup - only the core Vista features, device drivers and services. You will then be able to see firstly
how much of an impact your startup programs are having on startup time, as more importantly on post-
startup drive usage. You will also be able to see the types of functionality which are no longer available as a
result of these items being removed. This can range from not being able to open certain programs or use
certain features of these programs, through to certain Windows features not being available, like the Sidebar.

Make sure to run MSConfig again and reset it back to 'Normal startup' under the General tab, then examine
the details below to see how to identify startup items using MSConfig.

Startup: This tab under MSConfig shows all the current programs which load into memory at Windows
startup. You should note the file path and filename shown under the Command column. The Location
column shows where in the Windows Registry the command to run this particular file sites. Any item here
can be temporarily disabled by unticking the box next to its name, however this should only be done for
testing purposes; MSConfig is not the correct place to permanently disable or remove a startup program.

REGISTRY EDITOR

The Registry Editor is detailed under the Windows Registry chapter. To launch the Registry Editor go to
Start>Search Box and type "regedit" (without quotes) and press Enter. Below is a brief run-down of where in
the startup items are held in the Registry and how to remove them. The Windows Registry holds a record of
the programs to launch at startup, contained in four separate areas:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Run]
[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\RunOnce]
[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]
[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\RunOnce]

If you find any items listed under any of these keys, it means they are set to run at Vista startup, with those
under the Run keys being permanent items, and those under RunOnce being temporary items which only
run for the next bootup. You cannot temporarily disable a startup item here. However to permanently delete
any of these items, right-click on it and select Delete, though note that there is no backup functionality, so
you should consider doing a backup of the Registry in part or in full, as detailed under the Backup &
Recovery chapter.

AUTORUNS

Autoruns is a much more advanced and highly useful startup identification and removal utility. Download
the program, extract its contents to an empty folder and run the Autoruns.exe file to start it. You will see a
large number of items which are loaded up with Windows - far more than most other utilities will ever
show; this is what makes Autoruns so valuable for a range of purposes. Most of the entries shown are
required for various programs to run, and a large proportion of them are Microsoft items which Windows
Vista absolutely needs to function correctly.

To correctly identify and remove the truly unnecessary items using Autoruns is much more complex
precisely because it shows so much detail, however to narrow down the list to startup items you may want
to remove, click the Logon tab in Autoruns. Note in particular the filename shown under the Tmage Path’
column, or right-click on the item and select Properties to clearly see the filename. If you want to filter out
Microsoft entries from this list, go to the Options menu and tick the 'Hide Microsoft Entries' item, then click
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the Refresh icon on the taskbar (or press F5). The list of items shown will be reduced, leaving only third-
party programs showing, making it easier to spot unnecessary programs.

If you are an advanced user, or you're feeling more confident, click the Everything tab, and follow the steps
above again to list only the non-Microsoft entries. What remains will be a range of startup programs, scripts,
services and driver files. Some of these can be safely disabled, however you will need to research before
doing so. To do some basic research on an item, right-click on it and select 'Search Online' and Autoruns will
launch a search in Google for that item's name.

You can disable any item temporarily by unticking its entry, and Autoruns will prevent that item from
loading up the next time Vista starts up. This is a good way of testing to see if the item is essential, and what
impact its removal may have, without actually removing it. If you then wish to permanently remove an item
in Autoruns, right-click on it and select Delete, though clearly this must be done with caution.

B IDENTIFYING STARTUP PROGRAMS

Once you have noted the names of all the startup programs and files using one or more of the utilities above,
the next step is to correctly identify their functionality and determine whether they are truly necessary. Some
features require that a program or certain components load into memory at Windows startup otherwise they
may not function correctly or at all. Other times a startup component is not necessary at all for a program to
function properly, or provides optional functionality for particular features you may not use. Some startup
items may even be part of malware or other undesirable programs and hence must be removed.

Follow the steps below to try to correctly identify your startup programs:

1. Some filenames will tell you quite clearly what the startup program relates to. For example the startup
program Sidebar.exe relates to the Vista Sidebar. If in doubt, also check the directory path of the file and
see if there are any other indications as to which program it relates to. It's important to know the actual
program the file is for, firstly so you can tell what functionality may be affected, and secondly as
covered in the step below. Importantly, some files actually relate to Windows services, so see the
Services chapter and check against the list of filenames provided there.

2. Launch the program which the file relates to and look through its options for settings like 'Load with
Windows', 'Load at startup’, 'Enable System Tray’, 'Enable Shell Integration’, and so on. You should be
given the option to disable any such options, and you may also find text which explains whether doing
so will affect the program's functionality in any major way. Typically disabling a program from loading
at startup means it won't be available after Vista loads; you will have to manually open it yourself. For
some programs this is not an issue, for others it can prevent them from working automatically in the
background or even from being able to be launched.

3. If the filename still isn't clear, and you can't determine from its directory path which program it relates
to (e.g. it resides in the \ Windows\ System32 directory) then you will have to do some online research to
find out more details. Start by searching one or more of the following databases using the exact filename
(e.g. wpcumi.exe):

Google
SysInfo Definitive Startup List (mirrors: here and here)

WindowsStartup Online Search

ProcessLibrary
Security Task Manager List

Since Vista is relatively new, some Vista system files and services, as well as files for Vista-specific
programs may not be listed in the sources above just yet. Usually Google will be the first to list any such
files, so you should always check there first.

sweror ] dnyeig

Copyright © 2007 Koroush Ghazi 159


http://www.google.com/ncr
http://www.sysinfo.org/startuplist.php
http://castlecops.com/StartupList.html
http://startup.networktechs.com/
http://www.windowsstartup.com/wso/search.php
http://www.processlibrary.com/
http://www.neuber.com/taskmanager/process/

O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

4. Run several malware scanners to ensure that none of the startup files relate to malicious software. If any
such files are flagged as malware by your scanner, you can usually click on their names or a provided
link to find out more details from the scanner's own database.

5. Use Software Explorer, MSConfig or Autoruns to temporarily disable the startup item in question - that
is, untick it in Autoruns or MSConfig, or highlight it and select Disable in Software Explorer. Restart
Vista and see if over time any of your program functionality is impaired. You should be able to see after
a few days of normal usage whether the startup item(s) was necessary or not, and which particular
programy(s) it relates to.

B REMOVING STARTUP PROGRAMS

Once you've followed all the steps above, and you're confident that you've found an unnecessary startup
item, the final step involves permanent removal. You can do this in several ways (in order of preference):

* Go to the program in question and make sure there are no options to disable it from running at
Windows startup. As noted further above, if any options such as 'Load with Windows', 'Load at startup'
or similar exist, disable them otherwise if you manually delete the item it may be recreated each time
you boot into Vista.

*= Go to Software Explorer>Startup Programs, make to press the 'Show for all users' button and if the item
is listed there, highlight it and click the Remove button.

* Go to Autoruns, right-click on the program and select Delete.

* Go to the Registry Editor, find the item under the relevant key, highlight it and select Delete. Unlike the
methods above, Registry Editor does not have any 'undo' capabilities, so it is best used as a last resort or
if you are absolutely certain.

Once the item is removed from your startup, you should reboot Vista and see if it is indeed gone. If at any
point any of your programs start to behave strangely or do not function at all, then you can uninstall and
reinstall that particular program and its relevant startup items will be recreated. In general it is wise not to
permanently remove any Microsoft startup programs unless you are certain you will never use such
functionality. Having removed unnecessary startup programs make sure to run through the Services chapter
and disable unnecessary services as well.

B STARTUP PROBLEMS

As noted at the start of this chapter, Vista is designed to prioritize boot programs, services and drivers such
that the system reaches the Desktop as quickly as possible, and if necessary continues loading programs as
required. This means that the removal of startup programs may not visibly reduce the startup time. The best
way to measure startup time is not to count the number of times the bar scrolls on the bootup screen, as
these can vary for any number of reasons; rather you should time the overall Windows startup. If you want
an objective measure of your startup time and/or if you believe you are having startup problems then you
can see specific statistics on this in Event Viewer. To view your startup and shutdown times and any
associated problems follow these steps:

Open Event Viewer.

In the left pane go to Applications and Services Logs>Microsoft>Windows>Diagnostics-Performance.
Click on the Operational log shown, and in the centre of the screen you will see a range of events.
Typically there will be items with the Task Category 'Boot Performance Monitor' or 'Shutdown
Performance Monitor' (Event IDs around 100 or 200). Click on the more recent of these to see details.

In the details box the precise startup time (Boot Duration) or shutdown time (Shutdown Duration) is
shown in milliseconds (ms), which you can divide by 1000 to get seconds. You may also see which
particular program or driver may be slowing down performance, though obviously many of them are
necessary and can't be disabled.

e

o

For more details about Event Viewer usage see the Performance Measurement & Diagnostics chapter.
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SERVICES

Services are programs that run in the background and support specific functionality in Windows Vista. They
can be initiated by Windows itself, or they can be installed and initiated by third party programs. They may
start automatically during or immediately after Windows startup, they may be triggered to start or stop by
the launching of certain programs or functionality, or they can be blocked from running altogether. Aside
from the addition of several new services, the main changes to services under Windows Vista include the
ability to specify a delayed start to a service, preventing it from conflicting with Windows startup, as well as
security and stability enhancements to isolate services such that they cannot be as easily compromised by
outside attackers, nor can then be as easily destabilized by running programs.

Services are user-configurable under Windows Vista, just as they were in Windows XP. This means that
there is scope to improve system resource usage and startup time by disabling unnecessary services, and
also by setting certain Automatic services to the new 'Automatic (Delayed Start)' setting such that they load
immediately after Windows startup, not during. As before, it is wise to learn more about what a particular
service does before considering altering its default status. In this chapter we look at customizing services,
and I provide safe recommendations for service configuration for the average home PC user.

B SERVICES UTILITY

The built-in Services utility gives you the ability to view and edit your Service configuration. To access the
Services Utility, you can either go to Control Panel>Administrative Tools, or go to Start>Search Box and type
"services" (without quotes) and press Enter. This opens the Services utility, displaying all installed services
by name, showing you whether they are currently running or not under the Status column, and whether
they're set for Automatic, Automatic (Delayed Start), Manual or Disabled under the 'Startup type' column.

You can see the details of each service by left-clicking on it and the default Extended view will show the
description to the left of the service. To see more details and configure a service, right-click on the service
and select Properties. Here you can where the actual program file resides for the service, and you can also
manually Start, Stop or Pause/Resume a service as applicable. Importantly, you can change its startup type
here. The startup type of a service is defined as follows:

Automatic: This service is automatically started during the Vista boot process.

Automatic (Delayed Start): This service begins loading automatically after Vista has reached the Windows
Desktop.

Manual: These services must be started manually, or requested by a program. They do not reside in memory
nor load at startup otherwise.

Disabled: The service is blocked from running and does not load into memory at any point, even if a program
requires it. It can only be started by manually setting it one of the above startup types then clicking Start.

DEFAULT SERVICES

Before we move on to service customization, it is important to note your default service configuration in
Vista in case you have any problems and need to return any of your services to their default state. Services
may be configured differently on various machines based on the particular features and programs you are
using, as well as your specific hardware configuration, so the best thing to do is save your current service
configuration. To do this, open the Services utility, then right-click on the 'Services (Local)' item in the left
pane and select 'Export List'. In the box which opens, enter a name for the list and save it as the default "Text
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(tab delimited) (*.txt)' option. This file will then save with all the details of your services as they currently
stand, and can then be viewed with correct formatting in a program like Microsoft Excel.

For convenience sake, I have also listed my default Windows Visa Ultimate service configuration in the table
further below under the column labeled 'Startup Type (Default)', but again, remember that this will vary
from system to system so as a precaution take the steps above before altering your services.

CUSTOMIZING SERVICES

The Vista Services Control Manager has configured services to ensure full functionality for all the programs
and features you use in Windows Vista, including any third-party programs you have installed. While we
can customize these further, it is important to note that by setting a service to Disabled you may cause a
particular function or feature(s) of Windows or your programs to stop working without warning. If you
change several services at once in particular, it can sometimes be extremely difficult to track back your
problems to a particular service - not all services are obvious in what they affect.

The main aim of customizing services is to:

* Help speed up Windows startup time especially on systems with slower hard drives.

* Help reduce post-startup drive activity since Vista relegates some services and programs to loading in
the background and post-startup.

* Reduce unnecessary RAM usage by removing unwanted services.

* Speeding up shutdown time since Vista has to close some running services before shutdown.

Keep in mind that altering the service configuration will not increase your framerate in games, it will not
have a significant visible impact on visible RAM usage because SuperFetch takes up any slack, and it can
impair your functionality if not done carefully. It is not something to be taken lightly. It does have benefits,
but they won't necessarily be dramatic. Windows Vista's default service configuration is already quite good;
most unnecessary services are set to Manual, meaning they already don't up any resources and will only
start if required.

With all of the above in mind, on the next few pages are a list of the services in Windows Vista, the defaults
for Vista Ultimate and my recommendations for any services that can be changed on an average standalone
home PC not connected to a network of other PCs and with full Internet functionality. This configuration
should be safe on most any PC, however if your system is unique in some way, or is on a network of PCs,
make sure to read the descriptions for any service in the Services utility before altering it.

Note that there are some unnecessary services which are already set to Manual, and hence don't need to be
altered, and there are some which are set to Automatic which I recommend setting to Manual. Most services
do not need to be set to Disabled as that has no benefit whatsoever - a service set to Manual is not taking up
resources nor will it load up unless it is needed, yet provides a safeguard because if it is truly needed it can
be restarted relatively easily. Only disable a service if it keeps restarting and you are 100% certain that it is
not needed on your system. As noted above, some services can be very tricky in the impact they have - for
example disabling the Server service winds up turning off the display of Previous Versions for files, despite
no indication that it would do so from its name or description. I urge you not to consider the disabling of
services as some sort of major performance tweak and go crazy turning everything off.
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Service Name Startup Type Recommended Notes
(Default) Change

Application Experience Automatic

Application Information Manual

Application Layer Gateway Service Manual

Application Management Manual

Background Intelligent Transfer Service Automatic (Delayed Start)

Base Filtering Engine Automatic

Block Level Backup Engine Service Manual

Certificate Propagation Manual

CNG Key Isolation Manual

COM+ Event System Automatic

COM+ System Application Manual

Computer Browser Automatic Disabled Network-related

Cryptographic Services Automatic

DCOM Server Process Launcher Automatic

Desktop Window Manager Session Manager Automatic

DEFS Replication Manual

DHCP Client Automatic

Diagnostic Policy Service Automatic

Diagnostic Service Host Manual

Diagnostic System Host Manual

Distributed Link Tracking Client Automatic

Distributed Transaction Coordinator Manual

DNS Client Automatic

Extensible Authentication Protocol Manual

Fax Manual

Function Discovery Provider Host Manual

Function Discovery Resource Publication Automatic Disabled Network-related

Group Policy Client Automatic

Health Key and Certificate Management Manual

Human Interface Device Access Manual

IKE and AuthIP IPsec Keying Modules Automatic Manual Network-related

Infrared Monitor Service Automatic Disabled If not using
infrared devices

Interactive Services Detection Manual

Internet Connection Sharing (ICS) Disabled

IP Helper Automatic

IPsec Policy Agent Automatic Disabled Network-related

KtmRm for Distributed Transaction Coordinator Automatic (Delayed Start) Disabled Network-related

Link-Layer Topology Discovery Mapper Manual

Microsoft NET Framework NGEN Manual

v2.0.50727_X86

Microsoft iSCSI Initiator Service Manual

Microsoft Software Shadow Copy Provider Manual

Multimedia Class Scheduler Automatic

Net.Tcp Port Sharing Service Disabled

Netlogon Manual

Network Access Protection Agent Manual

Network Connections Manual

Network List Service Automatic

Network Location Awareness Automatic

Network Store Interface Service Automatic

Offline Files Automatic Disabled If not using
Offline Files

Parental Controls Manual

Peer Name Resolution Protocol Manual

Peer Networking Grouping Manual

Peer Networking Identity Manager Manual
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Service Name Startup Type Recommended Notes
(Default) Change

Continued...

Performance Logs & Alerts Manual

Plug and Play Automatic

PnP-X 1P Bus Enumerator Manual

PNRP Machine Name Publication Service Manual

Portable Device Enumerator Service Automatic Manual If not regularly
using portable
devices

Print Spooler Automatic Disabled If not using a
printer, incl.
virtual printers
(e.g. PDF maker)

Problem Reports and Solutions Control Panel Manual

Support

Program Compatibility Assistant Service Automatic

Protected Storage Manual

Quality Windows Audio Video Experience Manual

ReadyBoost Automatic Manual If not using a
ReadyBoost
device

Remote Access Auto Connection Manager Manual

Remote Access Connection Manager Manual

Remote Procedure Call (RPC) Automatic

Remote Procedure Call (RPC) Locator Manual

Remote Registry Manual Disabled Security Risk

Routing and Remote Access Disabled

Secondary Logon Automatic Manual If only using one
User Account at
a time

Security Accounts Manager Automatic

Security Center Automatic (Delayed Start) Manual If not using the
Security Center

Server Automatic

Shell Hardware Detection Automatic

SL UI Notification Service Manual

Smart Card Manual

Smart Card Removal Policy Manual

SNMP Trap Manual

Software Licensing Automatic

SSDP Discovery Manual

Superfetch Automatic

System Event Notification Service Automatic

Tablet PC Input Service Automatic Disabled If not using a
Tablet PC

Task Scheduler Automatic

TCP/IP NetBIOS Helper Automatic Disabled Network-related

Telephony Manual

Terminal Services Automatic Disabled Network-related
Security risk

Terminal Services Configuration Manual

Terminal Services UserMode Port Redirector Manual

Themes Automatic

Thread Ordering Server Manual

TPM Base Services Manual

UPnP Device Host Automatic

User Profile Service Automatic
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Service Name Startup Type Recommended Notes
(Default) Change
Continued...
Virtual Disk Manual
Volume Shadow Copy Manual
WebClient Automatic Disabled Network-related
Windows Audio Automatic
Windows Audio Endpoint Builder Automatic
Windows Backup Manual
Windows CardSpace Manual
Windows Color System Manual
Windows Connect Now - Config Registrar Manual
Windows Defender Automatic Manual If Windows
Defender is
disabled
Windows Driver Foundation - User-mode Driver Manual
Framework
Windows Error Reporting Service Automatic
Windows Event Collector Manual
Windows Event Log Automatic
Windows Firewall Automatic
Windows Image Acquisition (WIA) Manual
Windows Installer Manual
Windows Management Instrumentation Automatic
Windows Media Center Extender Service Disabled
Windows Media Center Receiver Service Manual
Windows Media Center Scheduler Service Manual
Windows Media Center Service Launcher Automatic (Delayed Start) Manual If not using Media

Center functions

Windows Media Player Network Sharing Service Manual
Windows Modules Installer Manual
Windows Presentation Foundation Font Cache Manual
3.0.0.0

Windows Process Activation Service Manual
Windows Remote Management (WS- Manual
Management)

Windows Search Automatic
Windows Time Automatic
Windows Update Automatic (Delayed Start)
WinHTTP Web Proxy Auto-Discovery Service Manual
Wired AutoConfig Manual
WLAN AutoConfig Manual
WMI Performance Adapter Manual
Workstation Automatic

Copyright © 2007 Koroush Ghazi

165




e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

RESTARTING A SERVICE

If for some reason you find that a Disabled or Manual service is required for certain functionality you want
to use, you can simply go to the General tab for that service, change the Startup Type back to Automatic or
Manual, and then click the Start button. If the Start button is greyed out or the service fails to restart, it is
because it is dependent on another service which is currently disabled or stopped. Go to the Dependencies
tab for the service and under the first box you will see the other services it relies on - go to those services and
set them to Manual or Automatic as required. The bottom box displays the services which depend on this
service to function, so also keep that in mind when disabling a service, as other dependent services will also
stop working.

NON-MICROSOFT SERVICES

You may notice that your services list has several additional services that are not listed in the list above. This
is because particular programs and drivers, such as graphics drivers, antivirus programs and system
utilities, can install their own unique services. These services power some of their specialized functionality,
but as with many of the Microsoft services some of these can be set to Manual or even Disabled to reduce
background resource usage and prevent conflicts.

There best way to quickly find all non-Microsoft services is to run MSConfig (See the Startup Programs
chapter), go to the Services tab and tick the 'Hide All Microsoft Services' box at the bottom. The only services
which will then be shown are those that have been installed by third party software. To determine which of
these are truly unnecessary, you will have to work out which software package has installed the service - in
most cases it is fairly obvious. The '"AVG?7 Update Service' for example is clearly related to the AVG
Antivirus program; the 'Diskeeper’ service clearly relates to the Diskeeper defragmentation program, and so
forth. However some services are either not clear, or may even be part of malware and hence difficult to
identify.

IDENTIFYING NON-MICROSOFT SERVICES

To correctly identify which program a service relates to, and in particular which file is launching it, follow
these steps:

1. In MSConfig, having ticked the 'Hide All Microsoft Services' box, write down the exact name of each
non-Microsoft service (e.g. AVG7 Update Service).

2. Go to Control Panel>Administrative Tools>Services and find the same service name in the listing.

3.  Double-click on the name of each non-Microsoft service and under the General tab for that service, look
at the 'Path to executable' item and note both the filename and its directory path. For example the
service '"AVG7 Update Service' has the path C:\PROGRA~1\Grisoft\ AVGFree\avgupsvc.exe. Write down
the filename (i.e. avgupsvc.exe).

4. If the service is currently running, open Task Manager, click the 'Show Processes from all users' button,
then under the Services tab see if you can find the filename. Right-click on this filename and select 'Go to
Process'. This may show you the program which is running it, though often it's just the generic Service
Host process svchost.exe.

5. Search Google or one of the databases shown under the Startup Programs chapter for this particular
filename. This should give you an indication of what its functionality is related to. If necessary you can
temporarily set the service (one at a time) to Manual or even Disabled to see what functionality it
impacts on.

As with Microsoft Services, you should be able to Disable a range of these third-party services as they are not
necessary. In some cases, Manual is the correct choice, and in other cases Automatic must be chosen
otherwise the relevant program will not launch or will have problematic functionality. I cannot provide
guidance in this respect as it depends on the program and the functionality you wish to use. If in doubt,
leave a non-Microsoft service on its default setting.
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CHANGE SERVICE STATUS VIA COMMAND LINE

If you wish to change the status of a service without opening the Services Utility, you can do so by using an
Administrator Command Prompt (see Vista Usage Notes chapter). To do this you will need to know the
name of the service, either its short name or full name. For example the full name for the Windows Defender
service is 'Windows Defender', while its short name is WinDefend. You can find these details in the Services
utility by double-clicking on a service, or under the following key in the Windows Registry:

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Services]

To start or stop a service via command line, go to the Administrator Command Prompt and use the form:
Net [Start/Stop] "servicename"

Remember that if using the short name for a service, quotes are not necessary, but if using the service's full
name, quotes must be used around the name. For example to start the Application Layer Gateway Service,
you can use either command below to achieve the same result:

Net start alg
Net start "application layer gateway service"

You will receive a confirmation that the service has been started or stopped if successful. This method is
really mainly useful if you want to compile a batch file to start or stop particular services, or if you can't
access the Services utility for some reason.

Service editing is an area of ongoing debate. Some people suggest that altering services from their default is
completely pointless and unnecessary and should not be done due to the potential problems it can cause;
others will argue that many services should be disabled to 'increase performance'. I tend to be in the middle -
there is certainly a case for disabling genuinely unnecessary services for functions you will never use, but
this must be done with a bit of thought and research: only disable services if you are absolutely certain of
their functionality and that you don't need them, and if in doubt, leave the services set at their defaults. This
is particularly true of Manual services which do not need to be set to Disabled in most cases as this has no
impact on resource usage whatsoever.

Editing services wisely is one more way of reducing resource usage and improving startup times, but it is
not a major performance-boosting exercise. I've tried to provide the best of both worlds in this chapter by
giving you a thorough list of 'safe’ changes you can make, and also showing what the default settings are in
case things go wrong. However if you are not confident in what you are doing, or don't have the time or
patience to do the research and sort out your own service needs properly, then leave your services on their
default Windows configuration for the moment. This will prevent a lot of problems in the long run.

SIDIAIIG

Copyright © 2007 Koroush Ghazi 167




e..uenm_-.u.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

WINDOWS REGISTRY

The Windows Registry is a central database for a range of system and program-related settings. Whenever
you change your Windows settings, add or remove components or install new programs and/or change their
settings, or even move or resize open windows, the registry will be updated with key pieces of information
marking many of these changes. Under Windows Vista, the registry remains much the same as before,

however there have been some improvements to decrease the possibility of registry corruption, and most
importantly there has been the addition of Virtualization support, as part of the User Account Control
feature. This allows the installation of applications which usually require Administrator privileges under a
Standard account - see the UAC section of the PC Security chapter for more details.

B REGISTRY EDITOR

To access the Windows Registry Editor, go to Start>Search Box and type "regedit" (without quotes) then
press Enter. You can also access the Registry Editor by typing "regedt32" instead of Regedit, but Regedt32 is
a just a small program that runs Regedit anyway, so there is no difference between either method. For our
purposes, the main reason for editing the registry is to alter settings that cannot otherwise be changed using
the normal Windows interface. Learning to use the Registry Editor is important because it is a powerful tool,
and unlike any third-party utility designed to edit the registry, using Registry Editor provides the most
direct access to the entire Windows Registry and ensures that you are aware of precisely what has been
changed each time, and where it originally resides should you need to change it back. I recommend you take
the time to learn more about using this important tool.

To use the Registry Editor correctly, open it and you will see what looks like a directory listing under
Computer, with five folders starting with 'HKEY_' e.g. [HKEY_ CURRENT_ USER]. Under these Root Keys are
a series of sub-folders called Keys. Within each key there is at least one Value called (Default), visible in
the right pane of the Registry Editor window when you click on the key name. Typically there are several
other values underneath the Default entry. These values can be of several types, including STRING,
DWORD and BINARY values.

The most common form of registry editing involves changing the contents of values, or adding new values
under certain keys. Note that in this guide the key name and location is provided in square brackets [ ], and
the name of the value to be edited is shown underneath. The data to be entered into the value is given after
the '=' equals sign.

EDITING REGISTRY ENTRIES

To edit an existing Registry entry follow the example below to see the correct procedure:

[HKEY CURRENT USER\Control Panel\Desktop]

CursorBlinkRate=600
The text above indicates that to make this registry change, you should open Registry Editor and then:

1. Double-click on the HKEY CURRENT_USER root key (or click the '+' sign next to it) in the left pane of the
registry editor window. This will show every key sitting directly under it.

2. Next, you must double-click on the Control Panel key.

3. Highlight the Desktop key by left clicking on it once, and in the right pane of the Registry Editor
window, look for a value called CursorBlinkRate.

4. Double-click on this item and in the box that opens, click in the Value box, delete the current number
there, and enter '600' instead.

5. Assoon as you click OK the change has been saved - you can now close Registry Editor if you wish.
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CREATING NEW REGISTRY ENTRIES

You may need to create a new key or value as it does not exist by default in your registry. To create a new
entry from scratch correctly, follow this procedure:

1. Go to the particular area where you have been instructed to create the key.

Make sure you highlight the key name of the particular key under which the new entry is to be created.
If the new entry is a key, then right-click on the name of the key under which it must be created in the
left pane, and select New. If the new entry is a value, skip to step 4 below.

3. Enter the name for the new key and press Enter. It should now sit as a folder in the tree listing
underneath the key it was intended for.

4. If the new entry is a value, left-click on the name of the key under which it must be created, then in an
empty area in the right pane, right-click the mouse and select New, then choose the type of value it will
be - the main types we will use are String, DWORD and Boolean. Enter the name for the new value and
press Enter. Double-click on the new value, and enter the data for the new value as recommended.

Note that you will not see any confirmation or sign that you've entered a valid key. Further note that
DWORD (32-bit) is the type you should use for 32-bit Vista if prompted to create a DWORD.

A more detailed guide to editing the Registry is in this Microsoft Article. It applies to Vista in much the same
way as previous versions of Windows. Just remember that the Windows Registry is very important, and
editing it is not to be taken lightly, so if in doubt, don't edit the registry unless you absolutely have to.

BACKING UP AND RESTORING PORTIONS OF THE REGISTRY

The registry is an important component of Windows and it is crucial for you to understand that the Registry
Editor does not have an 'undo' function. Hence the best course of action prior to using the Registry Editor to
alter any part of the registry is to back up your important data and settings, as well as your entire registry
(See the Backup & Recovery chapter for details). A more practical precaution is to make a backup of the
particular registry key(s) you are about to edit, especially if you don't feel confident about making the
change, or aren't sure how the change will impact on your system. That way if anything goes wrong you
don't have to go through a lengthy process - you can restore the individual key(s) that you have changed
quickly and easily. The steps to backing up a specific registry key are as follows:

1. In the left pane of the Registry Editor window, right-click on the name of the key that holds the settings
you wish to edit.

2. Select the Export option, and choose a suitably descriptive name and appropriate location for the file.
Make sure that the 'Selected Branch' option is ticked at the very bottom of the box, so that only the
particular key and all its sub-components are saved, not the entire registry. Click the Save button and
the file will be saved with a .REG extension.

3. Once the relevant section of the registry has been saved, you can go ahead and edit the registry entries
underneath the key you've just saved.

If you experience any undesirable behavior after your registry changes - and remember that some registry
changes require a reboot before their effects can be seen - then you can restore the backup of your registry
keys by going to the place where you saved them, and double-clicking on the relevant .REG file. This will
overwrite the existing sections of the registry with the backed up versions, effectively undoing your changes
quickly and easily.

If you don't feel comfortable with the above method, or if you want to backup the entire Registry, see the
Backup & Recovery chapter for more details on how to make proper full Registry backups.
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B MISCELLANEOUS REGISTRY TWEAKS

Having learned how to edit the registry, you can now use a range of tweaks to customize your system using
the Registry Editor. This section covers the more miscellaneous tweaks; most registry tweaks are actually
covered under the chapter relevant to the specific area of Windows they relate to. For example, registry
tweaks relevant to Internet Explorer are covered in the Internet Explorer chapter.

Note that some registry changes require a reboot before they come into effect, though you can use the
Explorer Reboot trick covered in the Windows Explorer chapter in many cases. Importantly, don't forget to
backup your Registry properly before changing anything in it.

CUSTOMIZE SHUTDOWN SPEEDS

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control]

WaitToKillServiceTimeout=20000

By default Vista waits for some running services to end for 20 seconds as shown in the STRING above.
However you can edit this to a lower amount, such 4000 to speed up shutdown speed. Note however that
often services may be doing necessary tasks and terminating them sooner may cause problems, so I
recommend caution in lowering this too much. Try a value of 10000 to start with for example and see what
impact it has.

INCREASE NTFS SYSTEM PERFORMANCE

These tweaks can improve the performance of Windows systems that use the NTES File System. See the
Windows Installation chapter for more details of NTFS.

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem]

NTFSDisablelLastAccessUpdate=1

This DWORD disables the constant updating of dates a file/folder was last accessed if set to 1. It should be
disabled by default in Vista, but if not set it =1 here.

NTFSDisable8Dot3NameCreation=1

This DWORD disables support for old MSDOS 8-character filenames if set to 1. It should not cause any
problems except with much older programs.

TURN OFF SYSTEM BEEPS

By default Windows XP makes beeping noises under certain situations, regardless of your Windows sound
settings. To alter this behavior, go to the following Registry entry:

[HKEY CURRENT USER\Control Panel\Sound]

Beep=Yes

Set this STRING to No to disable any system beeps that occur during Windows usage. Note that to disable
other Windows event-based sounds you will still need to go into Control Panel>Sound.
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DISABLE WINDOWS KEY

If you want to disable the Windows Keys on your keyboard, perhaps because they are interfering in a game
you are playing, do the following:

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Control\Keyboard Layout]

Scancode Map=

Under the Keyboard Layout key above (not Keyboard Layouts) create a new BINARY value called
Scancode Map and then double-click on it and click once in the top right hand side of the value data box.
Manually type in the following values in the exact order as shown (note all the 0's are zeros, and no spaces
are necessary):

00 00 00 OO 00 OO OO 0O 03 00 OO 00 OO 0O 5B EO 00 0O 5C EO 00 00 00 OO

You will need to reboot for this change to come into effect. If you want to reverse this tweak, delete the
above key and reboot. The Windows key is very useful for a range of reasons, so generally there should be
no reason to disable it.

While you will find a range of Registry changes throughout this guide, I don't recommend implementing a
large number of Registry changes at once, as this makes troubleshooting difficult in the future. Select the
ones that you feel are the most necessary for performance and convenience sake, implement them
individually if possible and reboot. If your system remains stable and trouble-free, implement another one
and repeat. Remember, there is no 'undo' for the Registry Editor, so take the appropriate backup precautions
as spelt out earlier.

B MAINTAINING THE REGISTRY

The Windows Registry has thousands of entries, and can grow to be over 100MB in size on a common PC.
Over time some of its entries can become obsolete due to changes in hardware and software, and some
entries can even become corrupted due to bad shutdowns, overclocking or faulty software or hardware.
Therefore it is sound practice to undertake some basic Registry maintenance using the tools below.

REGISTRY CLEANING

A registry cleaner trawls through the registry to find any invalid or unnecessary entries, such as entries that
point to non-existent files or programs or corrupted entries. Since the registry loads into memory and
controls a great deal of system behavior, the leaner and cleaner the registry is, the less space it takes up, and
the less the likelihood for errors or strange behavior. Windows Vista's registry is very similar in structure to
that of Windows XP, however while many registry cleaners designed for Windows XP will run under Vista,
it is not wise to simply assume that they will not do any harm. Until more dedicated Windows Vista registry
cleaners become available, for the moment I suggest using RegSupreme as covered below or the registry
cleaning functions in CCleaner covered in the Cleaning Windows chapter.

REGSUPREME

To access RegSupreme, download it from the RegSupreme Website and install it. Note that it is only free for
a limited trial period. RegSupreme has an extremely simple interface, and there is no need to configure it in
any particular way. To begin a registry cleaning session, start RegSupreme - the first time you run

RegSupreme, it will prompt you to create/update RegSupreme's cache. You should click OK, as this process
needs to only be done once in every while and will speed up registry cleaning sessions a great deal. Once
RegSupreme's caching has been completed you can continue with the actual registry cleaning.
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Click the 'New Scan' button, or if automatically presented with the scanning options, I recommend selecting
Aggressive - it is a thorough but safe method of searching through your registry for invalid entries. Click the
Start button and the registry scanning will commence. This may take a little while depending on how large
your registry is, but usually no longer than a few minutes. Once the scan is completed, nothing is deleted or
altered in the registry. To actually remove all the invalid entries found, you should go to the Select menu and
choose All to place a tick next to all the invalid items, or if you wish, manually select items from the list.
Then click the Fix button to remove them - you will be prompted for a name to give the automatic backup
that is created. Should anything go wrong later on, this backup can be restored at any time by opening
RegSupreme, clicking on the Backup button, highlighting the backup and clicking the Restore button.

Note that RegSupreme will sometimes find hundreds of 'invalid' files, but don't be alarmed: this doesn't
mean your registry was a total mess. Rather, RegSupreme categorizes such harmless things as MRU (Most
Recently Used) registry entries, or entries pointing to deleted files as invalid, even though they are perfectly
normal. For example, if you use the WinZip archiving utility it will record the last few archives you accessed
should you want to quickly access them again. Of course they're better off being removed, but they will
simply build back up again within a matter of days, so don't be concerned if you run RegSupreme again
later and still find lots of invalid entries.

Registry cleaning is not a critical part of Windows optimization, it is just one more small step and if you
don't feel comfortable taking the risk, or don't want to pay for a registry cleaner, you can skip this altogether.

NTREGOPT

After cleaning the registry, and before we enter into any registry editing, there is a utility called NTRegOpt
you can use to optimize the size and layout of the Windows Registry in Vista. If you have installed Erunt
then you will have already installed NTRegOpt. If not, or you're not sure, download it from the link above
and install it. Then run the NTRegOpt.exe file to start the program and click OK to begin the optimization
procedure. It may take some time, so be patient. You will have to reboot for the optimization procedure to
complete. This process compacts your registry, which can help improve Windows startup times and
memory usage. NTRegOpt is best used infrequently, perhaps once every month, to ensure optimal registry
size is maintained. Note however the program does not physically defragment your registry; only one of the
advanced defragmentation utilities under the Hard Drive Optimization chapter can do that.

The Windows Registry is an important part of Windows, and if it is damaged or if parts of it are removed
without knowledge of what they do, you may even run into a situation where you can't boot into Windows.
See the Backup & Recovery chapter both to read details of how to recover from such startup problems, and
more importantly to see how you can use the System Protection and Registry Backup procedures to prevent
this from happening. If you have doubts about editing or altering the Registry, it is best to leave it alone.
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GROUP POLICY

The Group Policy Editor is an Administrative Tool designed primarily for Administrators to alter the way in
which Windows behaves for groups of users on their network. It is only available in Windows Vista
Business, Vista Enterprise and Vista Ultimate. To access the Group Policy Editor go to Start>Search Box and
type "gpedit.msc" (without quotes) and press Enter. This will open the Group Policy Editor, which shows
two main branches: 'Computer Configuration' and 'User Configuration'. Changes made under the 'User
Configuration' sections only affect the current user; changes made under the 'Computer Configuration'
section apply to the entire machine and affect all users on that machine. Note that the Security Settings
found under the Computer Configuration branch are the same as those covered in detail under the Local
Security Policy section of the PC Security chapter and won't be covered here again.

The Group Policy Editor can be useful if you wish to prevent users on your system accessing specific
features, because it allows you to remove access to virtually any component of Vista. In terms of changing
various settings, many of the options in Group Policy Editor can be applied using the various normal Vista
settings and options. Furthermore some of the settings are legacy options left over from previous versions of
Windows and have no impact on Vista, so only those that work are covered below.

To change a setting, go to the sub-folder shown and double-click on the setting in the right pane then choose
Enabled, Disabled or 'Not Configured' as required and click Apply. The default for each setting is usually
'Not Configured' unless otherwise noted. Before changing a setting left-click on it and in the Extended view
you can see a brief description of the setting to the left of it. If in doubt, do not alter a setting; none of these
are necessarily recommended, they are provided in case you require this functionality. If you want to see the
defaults for all Group Policy settings, see this Microsoft Article.

PREVENT AUTOMATIC RESTORE POINT DURING DRIVER INSTALLATION

Folder: Computer Configuration\ Administrative Templates\System \ Device Installation
Setting: Do not create system restore point when new device driver installed

If Enabled prevents Vista from automatically creating a Restore Point during installation of new drivers.

PREVENT WINDOWS MEDIA DRM INTERNET ACCESS

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Media
Digital Rights Management
Setting: Prevent Windows Media DRM internet access

If Enabled prevents Vista from automatically connecting to the Internet to check for Windows Media Digital
Rights Management (DRM) licenses or upgrades. Existing DRM protected material with proper licenses will
still play as normal.

PREVENT WINDOWS MEDIA PLAYER AUTOMATIC UPDATES

Folder: Computer Configuration\ Administrative Templates\ Windows Components\ Windows Media Player
Setting: Prevent Automatic Updates

If Enabled prevents Windows Media Player from automatically downloading updates of itself.
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TURN OFF THUMBNAILS
Folder: User Configuration\ Administrative Templates\ Windows Components\ Windows Explorer\

Setting: Turn off the display of thumbnails and only display icons

If Enabled prevents any folder from displaying Thumbnail view. This can increase the speed with which you
can browse such folders, but obviously removes thumbnail previews from such folders and replaces them
with a standard icon.

REMOVE 'MAP NETWORK DRIVE' AND 'DISCONNECT NETWORK DRIVE'
CONTEXT MENU ITEMS
Folder: User Configuration\ Administrative Templates\ Windows Components\ Windows Explorer\

Setting: Remove 'Map Network Drive' and 'Disconnect Network Drive'

If Enabled removes the 'Map Network Drive' and 'Disconnect Network Drive' items which appear on the
right-click context menu in certain circumstances.

REMOVE ALL RIGHT-CLICK CONTEXT MENUS

Folder: User Configuration\ Administrative Templates\ Windows Components\ Windows Explorer\
Setting: Remove Windows Explorer's default context menu

If Enabled removes all right-click context menus from Windows Explorer-based interfaces, including within
Windows Explorer itself and on the Desktop.

REMOVE CLOCK FROM NOTIFICATION AREA

Folder: User Configuration\ Administrative Templates\ Start Menu and Taskbar
Setting: Remove clock from the system notification area

If Enabled removes the main clock displayed in the Notification Area at the bottom right corner.

REMOVE BALLOON TIPS
Folder: User Configuration\ Administrative Templates\ Start Menu and Taskbar

Setting: Turn off all balloon notifications

If Enabled removes the small popup 'balloon tips' shown around various places in the interface when the
mouse is hovered over them.

HANDLING OF WINDOWS MAIL ATTACHMENTS

Folder: User Configuration\ Administrative Templates\ Windows Components\ Attachment Manager
Setting: Inclusion list for ...

Here you can specify precisely what file types (entered as a list of extensions, such as .EXE) the Attachment
Manager in Windows Mail determines to be High, Medium and Low risk attachments. By moving certain
file types into the Medium or Low category you can access them more easily in Windows Mail.
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MODIFY CTRL+ALT+DEL SCREEN

Folder: User Configuration\ Administrative Templates\ System \ CTRL+ALT+DEL Options
Setting: Remove...

Here you can specify which components to remove from the screen which appears when you press
CTRL+ALT+DEL. Enable the specific components you want to remove.

There are a wide range of things you can do in Group Editor, and you can browse to see all the available
functionality, but bear in mind that most of what can be done in Group Editor is already possible using the
normal Vista settings. It is not wise to force things off in Group Editor if you can change them in Vista
normally, because in the future if you or another user forgets about the changes you made here, it will cause
confusion when you find you can't re-enable or use certain functionality - remember, Group Policy overrides
the ability to adjust the features within Vista, so use it only when required.
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WINDOWS SEARCH

One of the major changes in Windows Vista is the enhanced Windows Search functionality. Microsoft has
integrated the Windows Desktop Search engine into Vista such that there are now many ways of quickly
finding the files, folders, emails and even programs that you are after. The most fundamental change is that
searching is no longer about knowing file details, like filename, creation date, location or file extension. By

typing in a particular word, sentence, or even part of a word, the Vista search engine can find the most likely
targets quickly and easily. In this way Vista's search is much more like Internet searching, and hence is much
easier and more useful in day-to-day situations for the average user.

People may claim that they already know where all the files on their PC are, and so search isn't a necessary
function. This is not true - the major use for the new search functionality is in speeding up access to regularly
used programs and files. For example if I want to open a particular picture or song quickly, instead of
navigating to it in Windows Explorer I can click the Start button and type its name, or even the first few
words or characters of its name in the Search Box, and it will be instantly displayed for me to click on and
launch. So Windows Search is no longer just about finding 'lost' files; it's about making access to the files and
programs on your drive quicker in every way.

Before we examine how to use the Search functionality, it's important to understand the way in which Vista
searches for files and how to configure this behavior, as this has a significant impact on how quickly Vista
finds what you want, how successful more thorough searches are, and what sort of performance impacts
you may experience.

B SEARCH INDEXING

In previous versions of Windows, searching for files generally required that you knew some exact details
about the file (e.g. its filename, date of creation/modification, or file type), and even with specific details it
could still take quite a while to perform a search, even for a commonly-used file. To facilitate faster
searching, the core of Vista's new search engine is the Search Index. This index is a pre-built file similar to
the index of a book, and it stores a range of details about files on your system, updated regularly by Vista. So
when you launch a search in Vista, it will look at this index first rather than searching across your entire
hard drive(s), with the result being a more thorough search done much faster than before.

However to start with the search indexer does not index your entire hard drive, nor all the details of your
files as this would take a long time to regularly update, and reduce search performance and the quality of
search results. By default the indexer only indexes the following information to start with:

» Allfiles and folders under the Personal folders - i.e. everything under the \ Users\ directory.

* Email

*  Offline Files.

=  Only certain more commonly-used file types are indexed; some with the contents of their Properties tab
only and some with their entire file contents indexed as well. E.g. .DOC files have their properties and
contents indexed; .EXE files only have their properties indexed; .BIN files are not indexed at all.

The actual index files used by the Search Indexer to store this information are held under the
\ ProgramData\ Microsoft\ Search\ Data\ Applications \ Windows \ Projects \ SystemIndex directory which is usually
hidden. The index files don't usually take up much drive space, and you should not delete them manually.
Furthermore, for indexed searching to work properly the Windows Search service must be running (See the
Services chapter), and indexing must be enabled under your drive - that is go to Windows Explorer, right-
click on your hard drive and select Properties; the 'Index this drive for faster searching' box must be ticked.
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PERFORMANCE IMPACT

The search indexer is a very useful feature given the significant integration of search functionality in Vista. It
makes searching much faster especially when using the Instant Search feature. However the index is really
only useful if it is constantly kept up to date by the system, otherwise your searches may exclude more
recently added files, or show results for files which have been deleted or moved or altered. By default Vista
runs the search indexer in the background as a low priority process. This means that only during periods
when your system is idle, the indexer may spring to life and update the index for any changes to the
contents of indexed folders. This usually happens at least once a session on average, but it really depends on
how often you alter the contents of indexed folders.

Indexing is a hard drive and CPU intensive task, and if your system is idle the indexer may use up all of
your spare CPU resources and churn the hard drive noticeably for a short period of time. This shouldn't be
cause for alarm, because as covered under the Hard Drive Optimization and Memory Optimization
chapters, as soon as you launch a program or do something on your Desktop which requires resources, Vista
will automatically throttle back or even stop the indexer immediately to provide all the resources the other
task or program needs. This prevents the indexer getting in the way of major programs and games, and even
during normal Desktop usage the indexer will run at greatly reduced speed to maintain system
responsiveness. The time taken to maintain the index depends on how many folders you have indexed, how
many files you have under those folders, how often these change and how many tasks you do in Vista while
the indexer is running.

To see the progress of the indexer when it is running, you can go to Control Panel>Indexing Options and at
the top of the main screen you will see how many files it has indexed so far, and you may see something like
'Indexing speed is reduced due to user activity', which means it is taking a back seat to some other task, even
if it's something as simple as you accessing a Control Panel option. Again, the indexer is not going to impact
on system responsiveness. For this reason, and given how useful the Search features can be - as we discuss
further below - I recommend leaving the indexer enabled, and instead customizing the folders it indexes to
be those which contain the files you would regularly access. This speeds up searches and makes the index
easier for Vista to regularly update. However if you still wish to disable the indexer see further below.

CUSTOMIZING THE INDEX

To view the folders currently indexed, and to configure indexing in Vista, go to Control Panel and open the
Indexing Options component. The main screen shows the folders which are currently indexed and at the top
of the box displays how many actual files are in the index. To add or remove indexed locations, click the
Modify button, then click the ‘Show all locations' button. Expand the directory listing for the drive you wish
to index. As mentioned, by default Windows Vista already indexes the files in several folders including the
\ Users folder, however you can choose to remove these if you wish, or add other folders and their contents
by browsing to them and ticking the boxes for each folder and/or sub-folder you wish to add (or remove). I
recommend that you untick any folders/subfolders you know are never going to contain files you wish to
search for or regularly access. When finished, click OK and there will be a wait as Windows adds or removes
these folders and their contents in the index.

If you wish to further customize the search index, click the Advanced button. There are some important
functions here, and these are covered below:

Index encrypted files: If this option is ticked, encrypted files will be included in the index. However because
the indexer cannot access the contents of EFS encrypted user files, this option really only indexes encrypted
Offline Files (if any). Hence it is best left unticked.

Treat similar words with diacritics as different words: Diacritics are accent marks used in different languages and
even for certain words in English, such as touché and fouche. Ticking this option tells the indexer to treat the
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words as different if there is a difference in accent marks. Best left unticked unless you specifically remember
to include diacritics when searching.

Re-Index selected locations: The indexed folders selected can have their index rebuilt at any time by clicking
the Rebuild button. The process can be quite lengthy, especially if you have a lot of files and folders indexed,
however this may be necessary if you experience problems with search results not finding indexed files. It is
recommended that if you choose to rebuild, that you shut down all other programs and leave the system idle
for a while otherwise it may take even longer to complete.

Restore your index to its original settings: Click the 'Restore Defaults' button if you wish to return the indexer to
its default folders and settings at any time.

Index Location: As mentioned further above, the actual files for the index are held in a particular location by
default. If you wish to move these files to another directory/drive you can do so by clicking the 'Select new'
button and browsing to the new location. The main reason you would want to change this is if you wish to
move the index contents to a faster hard drive for example, as this helps speed up both use of the index in
searches, and more importantly allows faster updating/rebuilding of the index by Vista without interfering
with your current drive usage.

File Types: Under the 'File Types' tab of the Indexing Options you will be able to see the types of files the
indexer can currently include in the index, listed by file extension. Any extensions which are ticked are
included in the search index, and you can tick or untick any of these extensions as you wish. By default all
the major and indeed many less common file extensions are already indexed so you should not need to
change the indexed file types. If you have an extension which is not listed, you can add it manually by
clicking in the text area at the bottom left of the box, typing the extension and pressing the 'Add new
extension' button which will become ungreyed.

Importantly, here you can change whether a file type only has the contents of its Properties tab indexed
(Index Properties Only'), or whether all of its contents are also indexed ('Index Properties and File
Contents'). For example highlight the .DOC extension and you will see that it has both its Properties tab and
its contents indexed. So if you enter a sentence in the search box, if it exists within one of your indexed .DOC
files the document will be included in the search results shown. It is generally pointless to index the contents
of files which only have computer code as their content, so for many file types such as .EXE or .JPG files, the
contents are not indexed and should not be; they don't have any useful plain English text in them. Certain
types of files can have their contents 'translated' into something intelligible by Windows Search with the use
of Filters. For example .PDF files can use an Adobe PDF [Filter to allow their contents to become searchable
by Vista's search engine. You will see if any filters are used for each file type under the 'Filter Description'
column; since most files don't have their contents indexed they will have 'Null Filter' listed.

Whether a file type has its properties, or the both properties and content indexed has an impact on
maintaining the index, because the more files with complex contents are indexed, the more work the indexer
has to do to maintain the index if these contents change regularly and/or significantly. I recommend only
indexing the contents of file types for which you actually do wish to initiate a content search.

If you've changed the index settings I strongly recommend that when finished you click the Rebuild button
to do a total rebuild of the index data using the latest settings, though note that this may take quite some
time to complete. This will help prevent the index file retaining older entries and also make sure all your
search results will be completely up-to-date and accurate.

INDEXING AND FILE PROPERTIES

As discussed above, the search indexer will index most files by what is in their Properties as well as their
content in some instances. So one of the ways in which you can further influence search indexing is by
configuring the Details tab of a file under its Properties. You will notice there are a range of fields here either
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empty or already filled in with certain details about the file, such as its Size, Date Created, Title, and so forth.
This is referred to as Metadata and provides additional information which the indexer can use to identify the
file. If you want to make it easier to access or group a particular file(s) in the future, it is wise to add some
metadata to it. For example you may wish to tag all your Jazz songs with the word Jazz. Then when you
type the word Jazz in the Start Menu Search Box all these songs will be listed for you to choose from.

Right-click on any non-write protected (untick the 'Read Only' box) personal file in Windows Explorer, select
Properties and click the Details tab. Now move your mouse cursor over the fields under that tab, and you
will see that many of these fields can be edited. Edit the field(s) appropriately and when you click OK, that
information is saved along with the file. You can now search for that file using any one of the pieces of
metadata entered into the Details tab of the file's properties - see the Search section below for details.

There is another useful function you can perform when in the file properties. Right-click on a file, select
Properties and under the main General tab, click the Advanced button at the bottom. In the box which opens
you can untick the 'Index this file for faster searching' box, and now the file will no longer be included in the
indexer. In this way you can exclude any private files, or particular files which may be useless for indexing,
from being included in indexed search results.

DISABLING THE INDEX

The indexer does not have a major performance impact because it uses idle resources which would otherwise
go wasted. And the benefits of indexing are much more tangible in Vista because of the way the search now
resembles web searching functionality and hence improves speed of access to commonly used files and
programs. However if after reading this chapter - especially the Search section further below - you still feel
you won't use the search features often and you want to disable indexing completely (which is not
recommended), follow these steps:

1. Remove all indexed folders from the indexer. This may take a few moments.
Go to Windows Explorer, right-click on your hard drive, select Properties and untick the 'Index this
drive for faster searching' box, then click Apply. Choose to apply this to the drive and all subfolders, and
click 'Ignore all' to ignore any errors for system files which can't have their properties changed (this is
normal). The process may take quite some time to complete.

3. Set the Windows Search service to Disabled and Stop the service.

4. To confirm that indexing is disabled, go to Control Panel>Indexing Options and it should now say
'Indexing is not running'.

You can enable indexing again at any time by reversing the steps above, however it may take Vista some
time to again apply indexing to your files and folders and rebuild the index so be patient.

Note that this procedure does not disable searching in Vista, though it does make Instant Search relatively
useless, and it will also make general searches much longer and more system intensive, because they can't
rely on the index. Importantly, you must configure your searches correctly if you've disable indexing,
otherwise by default the search functionality looks in the index and without one it may incorrectly report
that it cannot find certain files or folders even if they exist - details are below.

B SEARCH METHODS

Having covered the way in which Vista actually indexes and maintains files for quick searches, we now look
at the ways in which you can undertake searching in Vista. Even though the search indexer is used by
default, it does not necessarily mean that you are restricted to searching in indexed files. Furthermore there
are many uses to search, beyond simply finding hard-to-locate files. While you may put your most
commonly-accessed files and programs as icons on the Windows Desktop or in the Quick Launch bar for
example, there are still many files on your system which you might want to access as quickly as possible,
and the search functionality can help in that regard.
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INSTANT SEARCH

Possibly the most useful new feature of Vista in my opinion is the Instant Search box which you can find at
the top right of most any window, and of course most handily at the bottom of the Start Menu when you
click the Start button. Extensive use of this search box is already made throughout this guide to quickly find
and launch particular Vista programs, such as typing 'Services' and pressing Enter to quickly launch the
Services Utility in less time than it would take to open the Control Panel, double-click on the Administrative
Tools component then double-click on the Services item for example. Or if you want to launch the Windows
Calculator utility, you can simply type 'calc’ and press Enter in less time than it would take to click All
Programs, then Accessories then Calculator on the Start Menu. If you've added TweakGuides.com to your
Internet Explorer favorites, then any time you want to visit the site, just type 'tweakguides' in the search box
and press Enter; a new IE window opens and loads the site straight away.

This search box is powered primarily by the indexing functionality described earlier in this chapter, and is
one of the main reasons I strongly recommend keeping indexing enabled. You may even find over time that
you get used to launching most of your programs using this box as opposed to any other method, as I have.

The Instant Search box has certain features which make it even more useful. To start with it will provide
rapid matches for incomplete text, so you can start by typing the first few characters of what you're looking
for, and you will be presented with a list of applicable files. In a normal window using the Instant Search box
this way refines the available contents of that particular window to the files which contain the search term or
letters; in the Start Menu Search Box using incomplete text will provide you with a list of all relevant files,
programs, emails and so forth shown under appropriate category headings (Files, Programs,
Communications, Favorites & History). Note that how the Start Menu search box functions and precisely
what it searches for and shows when doing searches is actually configured under Control Panel>Taskbar
and Start Menu>Start Menu>Customize - see the Taskbar and Start Menu section of the Control Panel
chapter for details.

If you cannot find what you are looking for by using the search box, or if there are too many results, you can
click the 'See all results' link. If you want to narrow it to an Internet-only search, click the 'Search the Internet'
link. When clicking 'See all results’, the Search Explorer window will open, and this is covered below.

SEARCH EXPLORER

When Instant Search doesn't provide useful results, or if you want to do a more thorough search of all files
and folders on your hard drive(s) for example, you will need to use the Search Explorer. You can access this
either by entering search text in the Start Menu search box then clicking the 'See all results' link which
appears, or by going to the Start Menu and clicking the Search button - if it is not there, see the Taskbar and
Start Menu section under the Control Panel chapter for details of how to enable it.

The Search Explorer interface is minimal to begin with, and you can enter your search term in the Instant
Search box in the right top corner as normal. You can refine the search location in the location box to the left
of the search box, and you can choose which category to limit the instant search to, e.g. music, documents,
email. However to genuinely make use of Search Explorer, click the 'Advanced Search' link at the right
instead and you can now use the search functionality in the more traditional method as done in previous
versions of Windows.

You can search for a file using a combination of its file type, its metadata such as 'date modified', name, or
any major tag, and importantly you can specify a particular hard drive and then tick the 'Include non-
indexed, hidden, and system files' box, then click the Search button to do a thorough and complete search on
that entire drive for the search phrase. This will bypass the index and hence may take a while to conduct the
search, but the results are complete and not restricted in any way aside from the parameters you specify
here. The green progress bar in the Address Bar at the top will show you how far the search has progressed,
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and this can be quite CPU and drive-intensive, so let it complete without initiating any other major tasks or
programs. If you wish to stop the search at any time click the red X next to the progress bar; merely closing
the search box will not end the search.

Note that if you wish to set this type of advanced search behavior permanently, either click the 'Search Tools'
button in the Search Explorer and select 'Search Options', or go to Control Panel>Folder Options>Search tab.
There you can specify the option 'Don't use the index when searching the file system', along with other
customizations to make searching more thorough, albeit also much slower - see the Folder Options section
under the Control Panel chapter for details.

If you wish to save your search for future use, click the 'Save Search' button in Search Explorer and it will be
saved under your \Users\[username]\ Searches directory.

CUSTOMIZING SEARCH

A useful Search enhancement tool you can use to further customize Windows Search is Start++. The utility
lets you specify aliases which will assist in further automating actions based on search results. You can even
export and share these small macros as 'Startlets'. It demonstrates one more reason why Search should not be
disabled or ignored in Vista.

The search functionality in Windows Vista has been enhanced over previous versions of Windows and now
forms an integral part of Windows usage. The average user who may never have needed to use the Search
function in Windows XP may now find themselves using it in Vista many times a day, and not even thinking
about is as being a 'search'. Given the way in which the search indexer is genuinely not intrusive, and given
the many benefits of search, I strongly encourage you to leave indexing enabled and configure search in
Vista for maximum functionality to begin with, then as you refine your usage patterns over time, disable the
components you don't need and change the indexer to only index folders you really wish to access regularly.
I do not recommend simply turning off the indexer or avoiding the use of search-related features, as there
are no real performance benefits - the search indexer will not run while a game is running for example.
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INTERNET EXPLORER

Internet Explorer (IE) is the most popular Internet browser in the world today. Even if you use an alternative
browser such as Mozilla Firefox or Opera, Internet Explorer is very tightly integrated into Windows Vista
and hence it is important to learn more about its functionality and configure it correctly. Indeed there are a

range of new features in Internet Explorer 7, some of them only available in Vista, which once correctly
configured provide an excellent balance of security and convenience. IE also allows add-ons which allow
some level of user customization. This chapter looks at the optimal configuration of Internet Explorer.

B BASIC SETTINGS

To configure Internet Explorer, open the browser, go to the Tools menu and select 'Internet Options' - note
this is the same as if you go to Control Panel and choose 'Internet Options'. Below are the descriptions and
my recommendations for the important settings under each tab of Internet Options in IE:

GENERAL

Home Page: Here you can set the page that opens by default whenever you first start Internet Explorer. If you
don't want any homepage to start when IE is opened, click the 'Use blank' button; if you want to set the
website you are currently viewing as your homepage, click the 'Use current' button; clicking 'Use default'
will restore IE's default homepage which is a Microsoft site such as MSN (depending on your location). If
you are using tabbed browsing (see further below), then you can enter multiple website addresses in the box,
one on each line. Then whenever you open IE, all of these pages will open at the same time as separate tabs.

Note, if the home page will not change regardless of what you do here see the Programs section further
below as well as the PC Security chapter - this may be caused by malware such as a browser hijacker.

Browsing History: As you browse the Internet, certain files and settings are stored (cached) by IE to make
your browsing faster in the future. Click the Settings button and you can select how IE uses this cache to
speed up your browsing. Under the 'Check for newer versions of stored pages' you can tell IE how often to
check to see if a web page has been updated; any parts of a site which don't appear to be updated will be
loaded from your cache rather than site, and this can increase page load times especially for sites which have
a lot of items to load up. I recommend selecting 'Automatically' as this allows IE to detect updated content
and reload from the site only when it believes it is necessary. However this does not guarantee that you will
always see the very latest content on the sites you visit, so if you want to see the absolute latest version of
every page you visit select 'Every time I visit a webpage', though note this may increase page loading times.
If you only want to view the latest version of certain pages at any time, press CTRL + F5 when on the page
and this forces IE to reload the entire page from the site rather than from its own cache. Importantly, do not
select the Never option here as that will mean IE will not update web pages you commonly view; it will
always rely on the cached version which always results in out-of-date web pages.

If you wish at any point to delete any components of your browsing history from the cache, click the Delete
button here and you can clear any Temporary Internet Files, Cookies, History, Form Data or Passwords here
by clicking the relevant button. I don't recommend doing this too often as it will result in slower browsing.

Disk space to use: You specify the maximum amount of space IE uses for its cache (in MegaBytes) in the box
provided. If the cache is too small, it will generally result in longer page loading times; if the cache is too
large then depending on your Internet connection speed and your hard drive speed, you may get longer
page loading times as IE has to search its cache to find the components of a web page to load, when it may
actually be faster just to reload them from the original site. Therefore I recommend 100MB of disk space for
the cache as a balance of size and speed. If you have a faster hard drive and view more complex sites with
lots of large images or scripts you may wish to increase this further.
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Current Location: Internet Explorer lists the current location of its cache, typically under the
\ Users\ [username]\ AppData\ Local\ Microsoft \ Windows \ Temporary Internet Files directory. You can view the
files already there by clicking the 'View files' button, and you can view any downloaded programs necessary
for certain sites to run by clicking the 'View objects' button. If you wish to move the cache, for example to a
faster drive, click the 'Move folder' button.

History: Internet Explorer can keep a record of the addresses of all the websites you have viewed for a certain
number of days. Here you can select how many days worth of recently viewed websites IE keeps. If you
don't want a history of visited sites to be kept at all enter 0.

Search: The Instant Search box at the top right of Internet Explorer 7 allows you to quickly initiate a web
search using the search engine of your choice, the results of which are displayed on the main IE screen. By
default it is set to use Windows Live, however if you wish to set it to another engine such as Google, click
the Settings button and select a new engine, then click the 'Set Default' button. If you want to use a search
engine not listed here, click the Find more providers link at the bottom of the box.

Tabs: Internet Explorer 7 adds Tabbed Browsing functionality, that is new web pages launched from links or
popups can be opened as tabbed pages within the current browser window, rather than opening a new
browser window. This helps reduce resource usage and when you become familiar with tabs, is also much
easier to manage multiple open pages this way. To configure tabbed browser, click the Settings button. In the
box which opens you can select whether to enable or disable tabbed browsing altogether and set the
behavior of tabbed browsing. Briefly, I recommend ticking the following settings:

* Enable Tabbed Browsing - As mentioned above, tabbed browsing reduces resource usage by only
keeping one IE window open; each new tab takes up far less memory than new IE windows.

= Enable Quick Tabs - Quick Tabs places a small box at the far left of your tabs when you have multiple
open tabs. Clicking it opens a page which contains previews of the content of every open tab.

* Always open popups in a new tab - This prevents popups from using extra resources and forces them to
open in a new tab instead of a new window.

= A new tab in the current window - When a program launches a web page, this option forces it to open a
tab in any existing IE window rather than open a new IE window, again conserving resources.

You can select other options as you wish, but the main aim of tabbed browsing is to make viewing multiple
web pages more manageable and prevent having lots of separate open IE windows which can use resources
for no good reason. Some tips you can use to make tabbed browsing easier in IE include:

* C(Clicking on any link with the middle mouse button opens that link in a new tab.

* (licking on any tab with the middle mouse button closes that tab.

* Holding down SHIFT and left-clicking on any link forces it to open in a new IE window.

* Holding down CTRL and left-clicking on any link forces it to open in a new tab.

*  Use CTRL+TAB to switch from tab to tab.

* Left-click and hold on any tab and you can then drag and drop it to rearrange tab order.

* Right-click on any tab to bring up a tab-specific context menu.

= If you want to save a set of tabs as a single bookmark folder, click the Add to Favorites icon (the star
with a plus sign) and select 'Add Tab Group to favorites'.

* To open the contents of an entire Favorites folder in a series of tabs, right-click on the folder under
Favorites and select 'Open in Tab Group'.

As you can see, tabbed browsing can become very useful once you get the hang of the tips above.
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Appearance: These options allow you to change the appearance of web pages, customizing colors, fonts and
even forcing particular style sheets. In general you shouldn't alter these options unless you have specific
needs.

SECURITY

Security level for this zone: You can set the level of security Internet Explorer uses here, from Medium to
Medium-High, to High. I recommend the default Medium-high level of security as it designed to allow most
normal Internet functionality without being overly restrictive nor too relaxed. However if you constantly
browse unsafe or untrusted websites, you may wish instead to set the High security level. If you want to be
even more selective, click the 'Custom level' button and manually select each security function; clearly this is
for more advanced users. More details of IE's security features are in this Microsoft Article.

Protected Mode: One of the most important security features in Internet Explorer - and this is only available in
the Vista version of IE7 - is Protected Mode. This feature works for browsing much like User Account

Control does for general system usage: it restricts websites and online programs from accessing system areas
or installing malicious software. It is not foolproof, but it is an important level of protection and I strongly
recommend it be left enabled.

PRIVACY

Settings: The slider here controls the level of privacy in IE, which for the most part pertains to Cookies - small
files stored on your machine designed to hold your preferences for particular websites. Cookies are not
usually malicious or dangerous, and can be very useful. For this reason, the default 'Medium High' level is
recommended as it provides the best security/functionality compromise and does not prevent legitimate
cookies from being placed on your machine. However to be even more selective, you can click the Advanced
button and tick 'Override automatic cookie handling'. Third-party Cookies can usually be Blocked without
any major issues, as these are mainly from advertisers. First-party Cookies on the other hand are often useful
(e.g. for holding your login details for forums, or recording visual settings for particular sites), and blocking
them can impair a site's functionality. If you do decide to block all first party cookies, click the Sites under
the Privacy tab and here you can manually allow or block specific website's cookies. I recommend adding
your favorite sites to this list and allowing them to prevent any problems with functionality. For example, if
you set a High or Very High privacy setting this will block almost all cookies, but you can still allow specific
sites' cookies by adding it to the list of allowed sites.

Popup Blocker: A popup is a new window which opens when you visit particular sites and/or click on
particular links or areas of a site. They are most commonly used for advertising, and hence the option here to
block them. I recommend ticking the "Turn on Pop-up Blocker' box, but you should also click the Settings
button and manually add the names of websites you trust which have legitimate popups that would
otherwise be blocked. For example you may wish to add your Internet banking site to the list, or
Microsoft.com. By default when a popup is blocked by IE, a small yellow warning bar will appear at the top
of the page to inform you of this, and you may also hear a sound. If you want to disable either or both of
these visual warnings, untick the relevant boxes here. Bear in mind that this may mean you will not be
aware that a legitimate site is trying to open a necessary popup box, and thus you may run into problems on
some sites - again make sure to add trusted sites manually to the list if you want them to function properly.

Filter level: You can set the behavior of the popup blocker by selecting either Low, Medium or High
protection against popups. The default Medium is fine however High is recommended if you genuinely
want protection against popups. If you do set High protection though, take the time to manually add all
your regularly-visited trusted sites to the Allowed Sites list. Bear in mind that in most cases these days,
popups are launched by scripts in such a way as to get around popup blockers, so unless you use the High
setting, many sites will still launch popups. Even then the occasional popup will get through because to
access certain links or functions on some sites, you will need to allow them to launch popups, so keep this in
mind if you notice that clicking on a particular link seems to have no result.
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CONTENT

Parental Controls: Clicking the 'Parental Controls' button opens the Parental Controls section of the User
Accounts screen, allowing you to set specific parameters for Internet surfing for particular accounts. This is
covered in detail under the User Accounts section of the Control Panel chapter.

Content Advisor: If enabled, the 'Content Advisor' allows you to attempt to filter out and control access to
websites that contain offensive or inappropriate material. Go through each category of content and use the
slider below the box to set the restrictions on that category. Once done, click OK and you will be prompted
to set a Password, as well as a Hint in case you forget that password. IE will now attempt to restrict content
based on content advice from the ICRA (Internet Content Rating Association), so this is not fool-proof.

Certificates: Certificates are a form of electronic authentication method to verify that a particular website or
individual is what/who it claims to be. They are described in more detail in this Microsoft Article, and are
too complex to discuss here. I don't recommend altering any of the settings in this section unless you are

acting under advice from a qualified tech support person. If a particular site displays a certificate error or
warning, I recommend pursuing this further with the site owner before conducting any financial
transactions with the site, as advised in this Microsoft Article.

AutoComplete: AutoComplete can save any website address you have typed into the address bar (or already
stored in your History), any text you've entered into online forms, and any usernames and/or passwords
you've entered on a web page. The aim is that next time you visit that site it will automatically restore your
typed text, speeding up logging in or filling out details, or typing URLs into the address bar. Click the
Settings button to configure which particular aspects of a web page AutoComplete will function for, but in
general for security purposes I don't recommend enabling any of these options unless you have strong
protection on your User Account and/or the PC is physically isolated from anyone else.

Feeds: If a website you're viewing has RSS capability, you will see the orange RSS icon in the Status Bar. You
can then click the orange icon to view the feed, or subscribe to it and specify how often news feeds are
automatically sent to you. Clicking the Settings button here allows you to configure how often such feeds are
updated, how they're read, and how IE warns you about feed-capable websites.

CONNECTIONS

You should set up and customize the details of your Internet connection under the Network and Sharing
Center in the Control Panel. See Network and Sharing Center under the Control Panel chapter.

PROGRAMS

Default web browser: If you have installed any other browsers, you can choose to set or reset IE7 as your
default browser by clicking the 'Make default' button. Unless you are worried about another browser taking
over this default association, you needn't tick the 'Tell me if Internet Explorer is not the default web browser'
box for optimal startup. If you wish to make another web browser your default, see the Default Programs
component under the Control Panel chapter for details.

Manage Add-ons: Clicking this button allows you to configure Add-ons in IE. Any small program installed for
use within Internet Explorer is an add-on, and generally you will be aware that a site is installing an IE add-
on through prompts. However you can view all the main add-ons here by selecting the 'Add-ons that have
been used by Internet Explorer' option. For example Adobe Flash Player is a common add-on which allows
flash animations to play on web pages. When you first visit a web page with a flash animation, IE will
prompt you with a yellow warning bar that "This website wants to install the following add-on:" and mention
the name of the add-on, in this case 'Adobe Flash Player from Adobe Systems Incorporated'. If you wish to
continue you then click the warning bar, select Install and if Protected Mode and/or UAC are enabled (which
is strongly recommended), you will see one or more prompt to continue until the software is installed.

1a101dxq jJourejuy

Copyright © 2007 Koroush Ghazi 185


http://www.icra.org/faq/
http://technet2.microsoft.com/WindowsServer/en/library/fb3df0cd-0aae-472b-9e9c-bb8ca878bc341033.mspx?mfr=true
http://support.microsoft.com/kb/931850/en-us
http://en.wikipedia.org/wiki/RSS_(protocol)
http://windowshelp.microsoft.com/Windows/en-US/Help/e85a03aa-c7c6-428e-9891-67ea76df9b7e1033.mspx
http://www.adobe.com/products/flashplayer/

O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

For the most part add-ons are legitimate, such as allowing you to view PDF files from within Internet
Explorer, or run playing free Browser Games. You can also download a Range of Add-Ons which provide
useful additional functionality for Internet Explorer, such as spell checking. Many of these add-ons are free
and operate similar to Extensions for Firefox, making Internet Explorer more customizable.

The problem is that some sites try to install add-ons which contain malicious script, designed to hijack your
browser and/or alter its settings to suit their purposes (e.g. forcefully setting an undesirable home page), or
launch an attack on your system. This is one reason why it's important to have both UAC and Protected
Mode enabled - see the Security section above as well as the PC Security chapter. More importantly you
should make sure you don't just automatically accept the installation of any add-on; only install add-ons
from trusted websites. In general the less add-ons the better both for security and performance purposes.
Regularly browse the list of add-ons in this section and disable those you don't trust. Do a Google search if
the name does not seem familiar.

HTML Editing: Here you can set the program IE uses for editing the HTML code of web pages when you
select the 'Edit with' option under the File menu.

Internet Programs: Clicking the 'Set Programs' button here simply opens the Default Programs component of
Control Panel, covered in full detail under the Default Programs section of the Control Panel chapter.

ADVANCED

This section contains important settings for Internet Explorer's functionality, security and general behavior.
There are too many settings to be able to describe them all in full detail, however I want to discuss the
Phishing Filter separately as it is both an important and relatively new setting:

Phishing Filter: As discussed under the PC Security chapter, Phishing is a form of deception designed to
illegally secure your personal details, such as logon, password and credit card numbers. It is usually done
for financial gain, and is becoming an increasing major threat. Internet Explorer 7 has a built-in Phishing
Filter which warns you if a particular site may be deceptive or a known phishing perpetrator. When the
automatic website checking is turned on, the Phishing Filter will work in the background, checking each
page by sending the following details to Microsoft for verification:

*  The address of the website you are visiting.

*  Your computer's IP address.

* Browser type.

*  Phishing Filter version number.

*  The time and total number of websites browsed since an address was sent to Microsoft for analysis.

This information is encrypted and anonymous, and note that cookies, search terms and other information
you enter into a site will not be sent to Microsoft. Microsoft uses this information to both check the web page
and inform you whether it is a reported phishing site or a genuine one, and also to refine the Phishing Filter
itself to be more effective. However automatic website checking can increase the time taken to load a page.

I don't recommend disabling the Phishing Filter as it is a good layer of additional protection against phishing
For the average home PC user I recommend the default which is to leave the automatic website checking
enabled. If you feel more confident and want to increase performance, I recommend selecting the "Turn off
automatic website checking', and then whenever you visit a site which you are doubtful about, click the
small yellow exclamation mark icon in the Status Bar at the bottom of IE to initiate a check using the
Phishing Filter, or to report a site you know for certain to be a phishing site.

The rest of my recommendations for the more important Advanced settings in IE are provided below.
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Tick the following;:

= Disable script debugging (Internet Explorer)

* Disable script debugging (Other)

* Enable third-party browser extensions

* Enable visual styles on buttons and controls in webpages
*  Show friendly HTTP error messages

* Use Passive FIP
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*  Use smooth scrolling

= UseHTTP1.1

* Use HTTP 1.1 through proxy connections

*  Check for publisher's certificate revocation

*  Check for server certificate revocation

= Check for signatures on downloaded programs

* Do not save encrypted pages to disk

* Enable memory protection to help mitigate online attacks
* Enable native XMLHTTP support

= UseSSL 2.0
= UseSSL 3.0
= UseTLS1.0

*  Warn about certificate address mismatch
*  Warn if POST submittal is redirected to a zone that does not permit posts

I recommend the following be unticked:

* Display a notification about every script error
= Allow software to run or install even if the signature is invalid

Settings for which I have no specific recommendation, but which are noteworthy:

Use most recent order when switching tabs with CTRL+TAB: If using tabbed browsing, as noted further above
you can switch between tabs by using CTRL+TAB. By default this cycles through the tabs from left to right.
If this option is ticked, the tabs will be cycled through based on how recently the tab was opened instead.

Search from Address Bar: Given Vista already provides an Instant Search box at the top right of Internet
Explorer 7, this functionality appears superfluous, but if you select 'Just display the results in the main
window', then whenever you enter some plain text in the Address Bar it will initiate a search using the
default search engine set for the Instant Search box.

Empty Temporary Internet Files folder when browser is closed: As discussed under the General section above, the
use of the browser cache speeds up browsing in IE. However if for privacy and/or security purposes you
want the cache cleared every time you close IE, tick this option. This may result in slower browsing each
time you open IE.

The remaining settings can be set to suit your taste. If any setting is greyed out then make sure to launch IE
with full Administrator privileges; i.e. right-click on the IE launch icon and selecting 'Run as Administrator'.
For many settings to work after being changed you will need to close all instances of Internet Explorer and
reopen it again.
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B ADVANCED SETTINGS

The following are some more advanced settings and useful customizations to make IE easier to use:

CHANGE OR DISABLE CLICK SOUND

Every time you navigate anywhere using Internet Explorer, or for that matter in Windows Explorer, you will
hear a 'click’' sound. To disable this clicking sound, or to change it to another sound follow these steps:

Go to Control Panel>Sound.

Go to the Sounds tab.

Scroll down the list of event sounds and left-click on 'Start Navigation' to highlight it.

To disable the sound completely go to the Sounds list below it and select (None) at the very top of the

Ll e

list, then click Apply; or

5. To change the sound (which is Windows Navigation Start.wav by default), pick another more suitable
sound from the list, or click the Browse button to find another sound file on your hard drive to use -
remember, the larger the sound file the more memory is used (See Sound under the Control Panel
chapter). Click Apply when done.

Note that changing or disabling this sound will affect both Internet Explorer and Windows Explorer equally.

CHANGE DEFAULT DOWNLOAD DIRECTORY

By default Internet Explorer uses the same directory path to save files whenever you download a file from
the Internet. You can change this default path at any time by opening the Registry Editor and going to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer]

Download Directory=E:\Users\Userl\Downloads

This STRING specifies the default directory where IE will save downloaded files. Enter the path to wherever
you want the new default to be.
CUSTOMIZE I1E TITLE BAR

If you want to customize what is displayed at the top of each Internet Explorer window (typically the name
of the site followed by Windows Internet Explorer), go to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Main]

Window Title=Windows Internet Explorer

Create a new STRING called Window Title (there is one space between the two words), and assign
whatever text you wish to use. The next time you launch a new Internet Explorer window this text will be
displayed at the top of IE. Delete the entry if you wish to return to the default.

INCREASE MAXIMUM SIMULTANEOUS DOWNLOADS

By default Internet Explorer only allows 2 downloads at a time. This is the Internet Standard for maximum
number of simultaneous connections to a server. You can increase this value beyond 2 by going to:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings]
MaxConnectionsPerl 0Server=0x00000005(5)

MaxConnectionsPerServer=0x00000005 (5)
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Create two new DWORD keys with the names shown above. Double-click on each one in Decimal view
enter the maximum number of simultaneous downloads you want in the 'Value data' box (e.g. 5) and click
OK. Note that increasing the maximum number of simultaneous connections to a server is technically a
breach of Internet Standards, so if you experience any problems reset these values to 2.

DNS CACHE ISSUES

Whenever your browser tries to load up a page on the Internet, it has to access a Domain Name System
(DNS) server to resolve or translate the text address you use (e.g. www.Google.com) into the actual IP
address for the website (e.g.: 216.239.57.99). Since your browser needs to check DNS addresses each time it
loads any web pages, the browser speeds up this process by locally storing the addresses you use for a
period of time so that next time you try to go to the same address it uses the IP address it has cached rather
than looking it up again on a DNS Server. Unfortunately if a site is down temporarily, or has recently
moved, then your DNS cache may store the site as being inaccessible for a while even if it comes back online
shortly afterwards, and therefore every time you try to connect to it for a while you will get an error.

To resolve any DNS problems with web pages not loading up at all or loading up with outdated
information, open an Administrator Command Prompt (see Vista Usage Notes chapter) then type "ipconfig
/flushdns" (without quotes) and press Enter. This will clear your DNS cache. Furthermore, to make sure that
your browser never stores a ‘negative’' DNS cache entry - i.e. one which says a site is inaccessible - then go to
the Registry and do the following:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache\Parameters]

MaxNegativeCacheTt1l=0

If the value above doesn't exist, create it as a new DWORD and assign it a value of 0 so that no negative DNS
entries can be kept in the DNS cache. You can also set the length of time in 'Time To Live' (TTL) for a
‘positive' (or working) DNS cache entry to remain active before being updated. To do this, add the following
DWORD:

MaxCacheTt1=10800

Assign it a value which measures (in seconds) the total Time To Live for the positive cache entry. Make sure
to enter the amount of seconds in Decimal - not Hexadecimal - view. Do not set this value too low as your
DNS cache will effectively become useless and browsing will take longer. A value of between 3 and 6 hours
(10800 - 21600 seconds) should be fine.

B OTHER INTERNET BROWSERS

You may be wondering if there are other browsers you can try if you are not happy with Internet Explorer 7.
Fortunately there are at least two other major free browsers which are a viable alternative to IE: Opera
Browser and Mozilla Firefox.

My personal preference is for Firefox. It is an excellent browser which is free and well-supported and runs
without any problems alongside Internet Explorer, giving you the opportunity to try it out to see if you
prefer it. The main advantage of Firefox over Internet Explorer is that Firefox is much more customizable. If
you want to find out more about Firefox I recommend you read my Firefox Tweak Guide which covers all
aspects of Firefox from the basic to the advanced.

You have nothing to lose by trying other browsers out, since none of them conflict with each other
whatsoever. I strongly recommend installing Firefox and Opera alongside Internet Explorer, and getting into
the habit of switching between them if a major unpatched vulnerability or security breach is reported in one
browser. All of three browsers function quite well, have similar functionality, and similar levels of
performance.

1a101dxq jJourejuy

Copyright © 2007 Koroush Ghazi 189



http://en.wikipedia.org/wiki/Domain_name_system
http://www.opera.com/
http://www.opera.com/
http://www.mozilla.org/products/firefox/
http://www.tweakguides.com/Firefox_1.html

O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

WINDOWS MAIL

Windows Mail is the Vista replacement for Outlook Express, the built-in mail client for Windows users. It
looks and behaves similar to Outlook Express, so users should be quite familiar with most of its
functionality, however it does contain some important new features. For starters all stored emails are held as
individual files, not in a single database as in Outlook Express. These emails are indexed and hence are
easier to rapidly search through using the Instant Search box at the top right of Windows Mail. Furthermore
your email account(s) and emails are more secure and more reliable, with less chance of any data corruption,
and easier to move around. Importantly, there is a new phishing protection and Junk Email filter built into
Windows Mail. All of these features are examined in this chapter.

B BASIC SETTINGS

To configure Windows Mail, open the program and go to the Tools menu and select Options. Each section of
the tabs under the Options box are covered below. Note that the options under most tabs can be set to suit
your personal tastes, so I only cover recommendations for some of the more important or confusing settings:

GENERAL

Check for new messages every: 1f ticked, Windows Mail will automatically check for new messages at set
intervals which you specify. If you are not connected to the Internet when it tries to do this, you can tell it to
connect automatically or to remain disconnected. In general I strongly recommend this option be ticked, and
that you set the interval fairly short (e.g. 5 or 10 minutes). That way if you leave Windows Mail open in the
background while doing other things, it will inform you much earlier about any new emails you have
received. However if you plan to play an online game make sure to close Windows Malil first if this option is
enabled, as the act of checking for mail may briefly disrupt your game.

Default Messaging Programs: This area tells you if Windows Mail is your default mail or news handler. If you
are using another application to handle your mail and/or newsgroups, see the Default Programs section of
the Control Panel chapter for details of how to make them the default instead.

READ

Automatically download message when viewing in the preview pane: If ticked, Windows Mail will automatically
download and show a preview of the contents of any highlighted email in the Preview Pane at the bottom of
the Windows Mail window. I recommend unticking this option, otherwise any highlighted spam or malware
emails will be downloaded and opened in the Preview Pane as well. In fact it is recommended you disable
the Preview Pane by going to the View menu, selecting Layout and unticking the 'Show preview pane’ box.

RECEIPTS

Read receipts tell the sender of a message whether a message has been opened by the recipient. If you want
to use them it is up to you, however keep in mind that many people find them annoying. Under the
‘Returning Read Receipts' section I recommend selecting 'Notify me for each read receipt request'. That way
you know when someone has sent an email to you with a receipt request, and you can choose whether to
accept or deny the request to send a receipt when you open the email.

Secure receipts are useful if you are sending a very important message and you want to make sure that the
recipient has opened the message and/or that the message arrived at the other end unaltered. Otherwise the
same settings apply.
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SEND

Automatically put people I reply to in my Contacts list: 1 generally recommend unticking this option, as
otherwise every person you reply to will go into your Contacts list, and hence if you are infected with any
malware it will usually automatically send out infected emails to all your Contacts as well. Ideally I
recommend not having anyone in your Windows Contacts list, however this is up to you - see the Windows
Contacts section further below for more details and tips in relation to this.

COMPOSE, SIGNATURES, SPELLING

Everything under these tabs should be quite clear and can be set to taste here.

SECURITY

Security is an important consideration in Windows Mail, since a lot of malware and phishing attacks are
initiated through emails:

Virus Protection: Here you can select either the 'Internet zone' or 'Restricted sites zone' for your default email
behavior. When in Internet Zone mode, HTML-based emails with active content will display their content
just like a web page in Internet Explorer. In fact the security settings you choose under the Security tab in
Internet Explorer Options also apply to Internet Zone email content. When in Restricted Sites Zone mode on
the other hand, Windows Mail will disable active content from HTML-based emails, which is much more
secure, but may reduce email functionality for HIML formatted emails. I strongly recommend running in
Restricted Sites Zone mode, as most HTML-based emails are spam or malicious. For the most part legitimate
emails come with plain text or minimal formatting, so this should have little visible impact on everyday
email usage.

Warn me when other applications try to send email as me: I recommend ticking this option as it provides a
warning when an application initiates an email with your email address as the sender. This helps prevent
any unauthorized emails going out under your name, though this setting does not stop most malware which
sends out email such as spam from your account, as that works differently.

Do not allow attachments to be saved or opened that could potentially be a virus: This option will attempt to protect
you from malware in email attachments. When this option is enabled, Windows Mail's Attachment Manager
will analyze the attachment and the email it is part of to determine whether the attachment is likely to
contain malware. By default if this option is ticked you will not be able to download attachments which are
flagged as malware. Note however that firstly just because an attachment is not blocked, doesn't mean that it
is safe to open - you should still consider the source of the email as to whether it is trustworthy, and then
save it (by default it is saved under your \Documents folder) and scan it for malware. However if an
attachment you trust is blocked, untick this option temporarily, view the email again, save the attachment
then retick this option. Regardless of whether you trust the sender of an email or not, I strongly recommend
scanning attachments you receive just in case the person sending it to you is unknowingly infected with
malware themselves. See the PC Security chapter for details. For details on how to adjust the Attachment
Manager's behavior, see the Group Policy chapter.

Block images and other external content in HTML email: If enabled this option blocks certain images and content
in HTML email which may be exploited by malware to infect your system. I recommend ticking this option
as generally most emails do not contain images or even HTML, so it should have minimal practical impact.

You should not alter the remainder of the settings here, as doing things like encrypting your emails or
digitally signing messages can cause problems for people who receive your email and want to reply for
example. Only alter these settings if you know what you are doing, they are not needed for the average
home PC user.
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CONNECTION

The settings here apply to dialup users only, so only change if needed. When you click the Change button it
will open the Internet Explorer Connections tab - see the Internet Explorer chapter for details.

ADVANCED

Contact Attachment Conversion: This option allows you to change any file attachments which is in the new
Contacts format to the vCard format used in previous versions of Windows.

IMAP: If this option is ticked, when using an IMAP email folder, if you delete a message it also removes the
message from your message list at the same time.

Compose reply at the bottom of the original message: If ticked, when you reply to a message your reply will begin
at the bottom of the original message text, as opposed to the default of the top.

Insert signature at the bottom of a reply: If ticked this option automatically inserts the default signature you
have created under the Signature tab for every reply you make; normally a signature is only inserted for new
emails you initiate.

Windows Contacts: These settings determine the pictures used to graphically represent your contacts on your
Windows Contacts list, and are not significant as such.

When you click the Maintenance button you will see additional options. The most significant of these are:

Compact database on shutdown every: This option determines how often Windows Mail compacts your stored
email messages to save space. You can set the number of times Windows Mail shuts down between each
compacting. Since the process can take some time, particularly if you have a lot of stored emails, I
recommend something like 30 or 50 shutdowns, which should equate to roughly once every few weeks. If
you open and close Windows Mail many times a day, increase this limit accordingly.

Store Folder: Clicking this button shows you where your emails are actually stored. By default it is normally
under the \Users\[username]\ AppData\ Local/Microsoft\ Windows Mail directory. However you can change
the location if you wish. If you're after a method of exporting or backing up your messages instead of just
moving the stored location of them, see further below for details.

Once you've changed all the settings you wish to change in Windows Mail click the Apply button and exit
the settings screen. You may need to close and reopen Windows Mail for some of the settings to come into

effect.

WINDOWS CONTACTS

Windows Contacts is the new central location for storing contact details for people you know, replacing the
Address Book in previous versions of Outlook Express. However Windows Contacts is not restricted to
being a feature of Windows Mail; you can open it separately at any time by going to Start>All Programs, or
Start>Search Box and typing "contacts" (without quotes) and pressing Enter, as well as under the Tools menu
in Windows Mail. To add a contact to your list, you can do so in four main ways:

* If you ticked the 'Automatically put people I reply to in my Contacts list' option under the Send section
of Windows Mail options, then each time you send an email reply to someone, they will be
automatically added to your contacts.

*  You can right-click on any email address in any email message and select 'Add to contacts'.

*  You can click the 'New Contact' button in Windows Contacts to create a new contact.

* You can click the Import button and import an existing file with contact details, such as your Address
Book from a previous version of Outlook Express.
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In any case once a contact is added to the list you can view and edit their details by double-clicking on their
contact item. This allows you to enter a range of personal and/or professional details as necessary. You can
even add photos of these people to be the default display picture for each contact, making them easier to
identify. You can export contacts to any application which supports the new .contact file format, and you can
also use contacts for other Windows features like People Near Me.

In general while this is a handy utility, particularly for corporate users on a network, for the average home
PC user I would consider it a risk to hold detailed information about yourself and/or other people here. To
start with, if your PC becomes infected with malware, it may attempt to use the Contacts list to send itself
out to all the other people you know, proliferating the malware. If someone compromises your account then
they can see personal details of not only you, but your friends as well, and this can be very useful in
successfully undertaking identity theft. Instead I recommend keeping emails from all the people you wish to
regularly contact under a general folder in Windows Mail. That way if you want to contact someone you can
simply do a reply to their last email. Malware cannot use these stored emails to send itself out, and if
someone compromises your machine it will take much more effort to work out personal details.

JUNK EMAIL OPTIONS

One of the important new features of Windows Mail is the additional Junk Email Options it provides in
protecting you against spam. Spam is unsolicited email which usually contains malware, or at best is simply
an annoyance. These options allow you to tell Windows Mail how to deal with emails it suspects to be spam.
Windows Mail uses a special junk email filter called Microsoft SmartScreen to detect and flag email as spam.
This filter is enabled by default and often updated through Windows Updates, so make sure to download
relevant updates as they are available. Unfortunately no spam filter is ever 100% successful because
spammers are constantly finding new ways of fooling the filters.

Options: Here you can choose the level of spam protection, and this is a very important setting so it must be
set knowing the possible problems it may cause. By default Windows Mail is set to Low junk email
protection. This means that only very obvious email emails are flagged as spam and moved into your 'Junk
E-mail' folder, and most if not all legitimate email will get through to your inbox. I don't recommend
selecting the lower 'No Automatic Filtering' option, as there is no real benefit to turning off the spam filter.
The only reason you might do this is if you regularly receive a lot of legitimate unsolicited emails and you
need to respond to them in a timely manner. If you're worried about legitimate emails being caught up in the
spam filter, simply remember to check the Junk Email folder regularly and sift through it for legitimate
emails; with the default Low filter setting few if any real emails should ever be caught up in there.

If you want strong protection against spam, select the High filter setting, but keep in mind that at some point
some legitimate email will be classified as junk email and moved to the Junk Email folder, so you will have
to regularly check your Junk Email folder for these, which can be difficult if there are hundreds of spam
emails in there as well. High is not recommended for most people.

If you only communicate with a set few people, and you want almost total protection against spam, you can
select the 'Safe list only' option, and make sure to add all the email addresses of the people you communicate
with under the 'Safe Senders' tab. Clearly this is only viable if you know exactly whom to expect emails
from, as everyone else who sends you email will wind up in the Junk Email folder.

Regardless of which option you choose I strongly recommend not ticking the Permanently delete suspected
junk email instead of moving it to the junk email folder' box. If this option is ticked, you stand a very good
chance of automatically deleting legitimate emails without ever seeing them, and this could cause you
confusion and problems if the emails were important. As noted earlier no spam filter is 100% accurate.

Safe Senders: To ensure that emails from people you know and trust do not ever get caught up in the Junk
Email folder, you can manually enter the email addresses or domains of trusted people/sites here. For
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example you can enter Userl@TweakGuides.com to mark that single address as safe, or you can enter
TweakGuides.com to allow any email address from the domain TweakGuides.com to send you email without
problems. It is recommended you also tick the "Automatically add people I email to the Safe Senders list' as
this automates the process of making sure people you email are not blocked in future by the spam filter
when they attempt to reply. Importantly, remember that some spammers 'spoof email addresses or
domains; that is they can make the email appear to be coming from TweakGuides.com when in reality it's
coming from another address altogether. So this is no guarantee that you won't receive spam, but it does
help guarantee that legitimate emails are not blocked, so on balance it is still useful to flag particular
addresses/domains in this way.

Blocked Senders: If you know particular individuals or domains are only ever going to send you spam, enter
their address or domain here. Again, bear in mind that spam email spoofing may mean you might block a
legitimate domain or address, so be careful what you add here.

International: These options allow you to block emails which are from a domain indicating another country
(e.g. domains ending in .au are Australian, .ca for Canadian, etc). You can also block emails encoded in
particular character sets indicative of certain languages (e.g. block all emails which contain characters
specific to Turkish). Once again these tools must be used with caution. It is generally safe to block domains
from which you know you would never receive an legitimate email, but bear in mind most spammers use
email spoofing to fake common US email addresses ending in .com so this is only useful if you are getting a
lot of spam from a particular country address, or filled with characters from a particular language.

Phishing: Enabled by default, this option uses Internet Explorer's Phishing Filter technology for checking
emails - see the Internet Explorer chapter for details. By default any emails which are known to have
fraudulent phishing-based content are flagged as such as you may not be able to access the links within
them. If the 'Move phishing email to the junk email folder' option is ticked as well, these emails will be
moved to the Junk Emails folder when received, which can provide added security. Not many legitimate
emails should ever get caught by the Phishing Filter, so it should be safe to tick both options. I recommend
enabling the phishing filter at all times.

Note that if you wish to set up additional filters to send certain types of mail to the Junk Email folder - or
any other folder for that matter - you can do so by going to the Tools menu, selecting 'Message Rules>Email.
This opens a box where you can set up custom filters as you wish, containing specific conditions such as if
the Subject line of an email contains a particular phrase that you specify, it can be deleted from the server
without downloading it, or moved to a particular folder you specify, deleted immediately, or have an
automatic reply sent to it. You can even set up multiple layers of filters if desired to truly refine the types of
emails for which particular actions are applied. This gives you more control over not only spam but other
emails as well, but obviously requires a bit more time and effort to setup, whereas the built-in spam filter in
Windows Mail is totally automated.

B ADVANCED SETTINGS

This section contains more advanced setting and tips for Windows Mail users:

BACKING UP AND RESTORING EMAILS AND ACCOUNTS

If you want to back up the emails you've saved in Windows Mail, follow these procedures:

Open Windows Mail, go to File>Export and select Messages.

Select the format for the emails to be saved in - Microsoft Windows Mail is recommended. Click Next.
Specify the folder location to export these emails and click Next.

Choose the specific email folders you wish to export. Select All Folders if in doubt. Click Next.

Your messages will be saved to your specified location as a series of folders which contain the messages
in .FOL files. You can then back these folders up, perhaps by archiving them first into a single .ZIP file.

A
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To restore these emails back into Windows Malil at any point, say after a reformat of Windows, follow these
steps:

1. Open Windows Mail, go to File>Import and select Messages.
Microsoft Windows Mail, or if importing from a previous version such as Outlook Express, select that
and click Next.

3. Select the location of the backup files you wish to restore, then click Next.

4.  Your emails will be restored in Windows Mail.

To back up your mail user accounts, follow these steps:

Open Windows Mail, go to Tools>Accounts.

Highlight the account you wish to export and click the Export button.

Choose a location for the .IAF file and click Save.

The account and all its relevant details will be saved with your account email address as the filename.

e

To restore your mail user accounts, follow these steps:

Open Windows Mail, go to Tools>Accounts.

Click the Import button.

Browse to where the saved .IAF file(s), highlight it and click OK.

The account is added into Windows Mail, complete with email address, passwords and any associated
settings.

L e

DISABLE WINDOWS MAIL SPLASH SCREEN

By default when Windows Mail launches, a small 'splash screen' is shown each time. To remove this
permanently, go to the Windows Registry as below:

[HKEY CURRENT USER\Software\Microsoft\Windows Mail]

NoSplash=1

Create this new DWORD value and set it to =1, and it will remove the splash screen. Removing the splash
screen doesn't necessarily make Windows Mail load up any quicker, but it can remove the annoyance. If you
want to regain the splash screen at any time, just delete the above entry.

B OTHER EMAIL CLIENTS

Windows Mail should be more than enough for the average PC user's everyday email needs, particularly
with its new features and improved security. However if you are not happy with Windows Mail, you do

have other options. To start with, the standard free webmail sites Yahoo, Hotmail and GMail are not only
useful in providing you with free email addresses, they also provide good built-in protection against viruses
and spam and plenty of storage space. However in general I don't recommend relying on an online provider
only, it's best to still use a mail client to store emails, especially if you want to search through them.

If you want an actual free email program to replace Windows Mail, I suggest you check out Mozilla
Thunderbird - it is both very customizable and also offers more methods of blocking spam.

Finally, I strongly suggest once more that you examine the tips provided in the PC Security section of this
guide for ways you can protect yourself while also preventing the spread of spam and malicious software.
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WINDOWS MEDIA PLAYER

Windows Media Player is Window's built-in utility for playing music and movies. It has many useful
features and is actually a very efficient, feature-packed media player, but is often dismissed as being
'bloated' or 'spyware’. In actuality it is smaller and more efficient than some popular media players, and if
configured correctly should provide good privacy. This chapter contains configuration advice and details on
WMP's features. If you don't like Windows Media Player, some alternative free players are covered at the
end of this section, as well as a discussion of media-related issues including Codecs and DRM.

Note that I do not cover Vista's Media Center functionality as this is too specialised and too varied based on
different home theatre setups to be explained adequately in this guide.

B BASIC SETTINGS

To access Windows Media Player, go to Start Menu>All Programs or go to Start>Search Box and type
"windows media" (without quotes) and press Enter. You can also launch Windows Media Player by going to
Start>Search Box and typing the name of a song or movie stored in your personal folders then selecting it.

To configure Windows Media Player go to the Tools menu and select Options:

PLAYER

Automatic Updates: WMP can automatically check for updates at set intervals. Since it is not updated all that
often, the 'Once a month' option should be fine. If you tick 'Download codecs automatically’, whenever you
attempt to play a media file for which you don't have the correct codec (and you are online), Windows
Media Player will automatically try to find and download the required codec and install it so you can play
the file. This is recommended, and see the Audio and Video Codecs section below for more information.

Player settings: You can set these to suit your taste, however I recommend unticking 'Connect to the Internet’
if you want to maintain your privacy.

Start the mini player for file names that contain this text: This option allows you to tell WMP to automatically
launch into Mini Player mode (see further below) for files containing the specified text in their filename.

RIP MUSIC

Rip music to this location: Ripping music is the process of copying it from an audio CD to a media file on your
computer. Click the Change button and select the directory where any ripped music or media is placed; by
default it will be placed under the \ Users\[username]\ Music directory. Click the 'File Name' button to specify
the particular attributes of the CD which will be used to compose the ripped music track's filename. Check
the preview at the bottom of the box to see how this will look.

Rip Settings: I strongly recommend you untick the 'Copy protect music' option as otherwise each track you
rip will become DRM protected and this cannot be changed - see the DRM section further below. Choose the
audio quality you prefer - 160Kbps or above is recommended for good quality audio, 128Kbps is the
minimum recommended. The higher the quality the larger the file size of the ripped file however.

To use WMP to convert any audio tracks you want from a non-protected Audio CD to .WMA or .MP3 format
do the following;:

1. Insert the Audio CD in your drive.
2. Close and restart Windows Media Player to make sure it detects the CD.
3. Maximize WMP so you can see the track listing.
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4. Click the Rip button at the top of the screen.

Put a tick against the track(s) you wish to rip

6. Click the arrow under the Rip button and you can select the specific Format you wish to use. .MP3 is
recommended as a good balance between quality, size and compatibility with a wide range of media
players, Windows Media Audio (WMA) is good but less compatible, and .WAV provides the best
quality but is usually too large because it doesn't compress the audio information.

@

There are better ripping tools available however Windows Media Player is free, quick and easy to use, and
the audio tracks it produces will not contain any copy protection (as long as you use the options further
above) so it is well worth using.

DEVICES

The devices listed under this tab are capable of media playback, whether video or audio or both. Select each
playback device and click the Properties button. Adjust settings as appropriate, and if in doubt leave at their
defaults which are fine for most purposes. Note that for your Display properties, you can alter the aspect
ratio for video/DVD playback if it appears to be too wide or too narrow; the circle should be perfectly round.

I recommend that you untick the 'When deleting playlists from devices, also remove their contents' option to
prevent undesired file deletion.

Click the Advanced button to alter the settings for audio and video file conversions when being transferred
to/from multimedia devices and set to suit your tastes.

BURN

Windows Media Player allows you to also burn music or media files to a CD or DVD. Music can be burnt as
an audio CD, but other media can only be burnt to CD or DVD as data files. If you want to burn pictures or
movies to DVD for playback on an actual DVD player, you can use the Windows DVD Maker instead,
accessible by going to Start>Search Box and typing "windows dvd" (without quotes) and pressing Enter. Its
features are fairly self-explanatory and won't be covered in this guide. Note that a useful free general
burning program compatible with Vista is Deep Burner.

Select the burning speed, keeping in mind that if you are continually having errors with burnt disks, it may
help to reduce the speed one notch to ensure more accurate burning.

Apply volume leveling across tracks on the CD: If burning an audio CD, you can tick this option to have WMP
attempt to set a common volume level for all audio tracks. This can help prevent some tracks from being
overly loud or soft relative to others.

Use media information to arrange files in folders on the disk: If you are burning a data disk and this option is
ticked, WMP will sort your media into separate folders using \Music\Artist\ Album, \TV, \Video and
\Picture folders. If unticked, WMP will burn all tracks to the base directory of the disk without sorting.

Conversion: If you tick the 'Convert to' option here, you will be able to use a slider which determines how the
various music files will be resampled for burning to audio CD. I strongly recommended against allowing
conversion, as most music files will lose quality if converted, especially if it's to 128Kbps or below, and more
importantly WMP automatically converts all files to .WMA format during conversion which is not
necessarily desirable.

To burn a disk, open WMP in full view, click the Burn button at the top of the screen, and an interface for
arranging files for burning appears. Click the small arrow under the Burn button to select whether to burn
an audio CD or a data CD/DVD. You can then drag and drop files into the right-hand pane to add them to
the list of media to be burnt to disk, and when finished clicked the 'Start Burn' button at the bottom.
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PERFORMANCE

Connection Speed: If WMP consistently has problems detecting your connection speed, then set it manually
here. The 'Use default buffering’ option is also fine to use.

DVD and video playback: These options affect all DVD and video playback, and can be used to help resolve
issues with particular videos or DVDs. If your video goes out of sync - sometimes due to lack of sufficient
bandwidth - tick the 'Drop frames to keep audio and video synchronized' option. Tick the 'Use video
smoothing' option if playing back video with low framerate, as WMP will try to interpolate frames (fill in the
blanks) to provide the appearance of smoother video playback.

When playing fullscreen video, if the 'Display full screen controls' option is ticked, a set of controls will be
shown at the bottom of the screen. If you want these removed, untick this box for true fullscreen video
playback. You can then control playback at any time using your mouse and the following commands:

* Play or Pause - Left-click.

* Change Volume - Use the mouse wheel to increase or decrease volume.

=  Mute Volume - Press the middle mouse button.

*» Fast Forward/Rewind - Press and hold the front and back thumb buttons (if any) for Fast
Forward/Rewind.

=  Skip Forward/Back - Click the front or back thumb buttons to Skip Forward/Skip Back.

* Command Menu - Right-click.

* Return to Full Mode - Press ESC.

If you have a medium to high-end graphics card, tick the "Turn on DirectX Video Acceleration for WMV
Files' option to allow your graphics hardware to provide better video playback performance for WMV
video. Finally, for videos which don't fill the entire screen due to their aspect ratio being different to your
monitor shape, you can set the color used to display the surrounding area. For example for playback on a
Plasma TV to prevent burn-in or uneven phosphor aging, you can set a white background by clicking the
Change button.

LIBRARY

Sharing: If you wish to share the media on your current PC with other machines or devices on the same
network, click the 'Configure Sharing' button. For instructions on how to configure this, click the 'Learn
about sharing Online'. It won't be covered here as it's not a feature for the average home PC user.

Update Library: By default when Windows Media Player is first run it checks your personal folders to find
any media files it can use, and adds them to your Library - a listing of all the media files on your PC.
Windows Media Player will keep monitoring your personal folders to add or delete listings from the library
as you add or delete your media files. You can access the Library listings by category at any time by going to
WMP and clicking the Library tab. Here you can view the media files in various ways, sorted by categories
such as Album, Genre, even Rating. You can create specific Playlists from the listings, and you can use the
Instant Search bar to search through your media files as described in the Windows Search chapter.

While this is handy, the Library function is not absolutely necessary, it is simply an organisational tool, so if
you want to stop it or alter it, click the 'Monitor Folders' button, then on the next screen click the 'Advanced
Options' button. You can now add further folders to monitor if you wish, but you cannot remove the default
folders WMP monitors; you can only choose to Ignore certain folders. If you want to prevent WMP from
adding any more files to the Library, enter the maximum values of 9999 for the 'Skip files smaller than' boxes
at the right side, so that any file smaller than 10MB is not automatically added to the Library. When done
click OK and WMP will scan for any changes it needs to make to the Library. Finally, I strongly recommend
unticking the 'Delete files from my computer when deleted from the Library' box, to prevent accidental
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deletion of files. This allows you to edit or delete items in your Library listing without deleting the
corresponding media files.

Automatic Media Information: If you want WMP to retrieve information about the particular media you are
playing from the Internet - such as the name of the Album or Artist for a track - then tick the 'Retrieve
additional information from the Internet box'; you can then choose to have it fill in the gaps or overwrite all
existing information for the media. This information can be useful in making searches much easier, since the
more details there are about a particular file, the more efficiently you can search for it (again see the
Windows Search chapter). You can also manually force Windows Media Player to fill in missing information
for particular files by clicking the Library button in WMP, then right-clicking on a particular track which
isn't fully identified and select the 'Find Album Info' option - a new box will open which loads up the
possible matches for this track and you can select the appropriate one, or enter the media information
manually.

The remaining options here determine how WMP behaves when a track is ripped - see the Rip Music section
further above.

PLUG-INS

Plug-ins are various modules which add functionality to Windows Media Player such as Visualizations or
Digital Signal Processing (DSP) effects. These can be added, removed or configured here. To find more
plugins to add, click the 'Look for plug-ins on the web' link, and for more visualizations, click the look for
visualizations on the web' link - you will be taken to relevant Microsoft sites where you can download useful
plugins or visualizations which should be safe to use with WMP. You can remove any added plugin by
highlighting it and selecting the Remove button, and you can configure any settings they may have by
selecting the Properties button. Bear in mind that the more plugins you use in WMP, the more resources the
player may take up, and also the greater the chance for potential problems, so only install plugins you feel
are genuinely necessary.

PRIVACY

This is an important area of Windows Media Player which causes users a lot of concern. There is a fear that
by using Windows Media Player, Microsoft is spying on your media usage behaviors. This is not true,
however to ensure that none of the media on your hard drive is altered, or any information about it reported
back to Microsoft, follow the recommended settings in this section. To begin with untick every option on this
page. None of them are necessary for normal media playback. If you use DRM-protected media, you may
want to tick the 'Download usage rights automatically when I play or sync a file' and 'Automatically check if
protected files need to be refreshed' options to prevent problems, but best to do so only if you run into a
problem playing back such files.

If you don't want your media files altered in any way without your permission, I suggest that you make all
of your media files (e.g. .MP3, MPG, .WMB and .AVI files) write protected. To do this, in Windows Explorer
go to the folders where your media files are stored and highlight all of them, right-click on them, select
Properties and place a tick in the 'Read Only' box. By write-protecting all your media, Windows Media
Player can't alter them or add any additional identifying information without your permission.

Finally, see the Windows Media Digital Rights Management (DRM) option under the Group Policy chapter
of this guide and enable it if you want to prevent Windows DRM from accessing the Internet when you use
Windows Media Player.

SECURITY

Your Internet Explorer security settings will be used when Windows Media Player is browsing any web
content, so see the Internet Explorer chapter for details. For the remaining boxes here, I recommend you set
them to suit your taste. You can start off by having them all unticked for maximum security, then if you
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encounter a legitimate website which doesn't function correctly, you can tick these options to allow it to do
so. None of these options should be necessary to view most online medjia.

DVD

If you have a DVD drive on your system and use Windows Media Player to play DVD movies, you can
adjust the settings in this section to suit your needs.

NETWORK

Configure this section according to your needs - the defaults should be fine.

GRAPHIC EQUALIZER

Windows Media Player comes with a fairly decent graphic equalizer which can noticeably enhance audio
quality if set up correctly. To alter it, go to Full View mode and under the View menu select
Enhancements>Graphic Equalizer. While you can use a range of presets, I recommend selecting the
individual slider movement option - the top option on the far left - and then customizing the settings to suit
your tastes. For reference, my personal settings from left to right for each slider are: 46401224 69.

Other options found under the Enhancements section include enabling SRS WOW effects, as well as Video
Settings to alter the Brightness, Contrast, Hue and Saturation of video, and Crossfading and Auto Volume
Leveling. You can close the Enhancements box at any time by clicking the small red 'x" at the far right of the
Enhancements area.

SKINS

You can customize the way Windows Media Player looks through the use of skins. These skins can change
the appearance and visible functionality of Windows Media Player. There are some skins which already
come with the player, and you can view them by opening Windows Media Player, and under the View
menu select 'Skin Chooser'. In the Skin Chooser box you can click on a skin to see a preview of it in the right
pane. If you want to try a skin out, click the 'Apply Skin' button. If you want to get new skins online click the
‘More Skins' button, or go to a site such as The Skins Factory to download more free skins. Some skins will
install automatically when you download them, but if you download a skin file in .WMZ format you can
manually install it so that it appears in the Skin Chooser by putting the .WMZ file into your \Program
Files\ Windows Media Player\ Skins directory. Note that using more complex and elaborate skins can take up
slightly more memory and possible extra CPU power when you run Windows Media Player, so if you want
to ensure the fastest performance and least resource usage simply use the default WMP appearance - that is,
under the View Menu select 'Full Mode'.

In fact my preferred look for WMP is to switch to Full Mode and then simply use the resizing button at the
bottom right of the player to shrink it down to the Compact Mode. In 'Mini Player' mode WMP uses even
less resources - see below.

MINI PLAYER MODE

One of the neat features of Windows Media Player which sets it apart from many other media players is the
ability to shrink it down into a 'Mini Player' interface which sits in the Windows Taskbar. To activate this,
right-click on an empty area of your Windows Taskbar and under the Toolbars sub-menu select the
‘Windows Media Player' option so a tick appears next to it. Now open Windows Media Player and click the
Minimize button on the top right of the player window. The player will minimize and sit in your Taskbar
with a handy interface that allows access to all the major functions of the player, and whenever you want to
maximize it again click the Maximize button on the bottom right of the mini player. Not only is this a neat
feature, but more importantly while sitting in the Taskbar the player also uses less resources. You can also
access WMP's seek functionality by hovering your mouse over the mini player, and using the slider bar
which appears.
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Finally, if you are having problems running Windows Media Player, or any other media-related features in
Windows Vista, check the Windows Media Knowledge Center for help resolving it.

B AUDIO & VIDEO CODECS

A Codec (Compressor Decompressor) is a program which allows audio or video to be compressed and
decompressed to or from the original format for which it is designed. Compressed files use special
algorithms, and it is the codec which can encode/decode these algorithms. If you can play or record
audio/video in a particular format, you have a codec for that format already installed on your system. More
details about Codecs in WMP can be found in this Microsoft Article.

To view the codecs already installed on your system, do the following;:

Open Windows Media Player.

Go to the Help menu and select 'About Windows Media Player'.

Click the 'Technical Support Information' link at the bottom of the box.

A new browser window will open listing all the audio and video codecs installed on your system.

Ll e

If you want to uninstall a non-standard codec, the best way to remove it is to go to Control Panel>Programs
and Features and look for the codec name in the list shown. If you need to download a new codec, remember
that you can set WMP to automatically download a codec for a particular format if it's not already on your
system - see the Player section further above.

If you want to manually find the codec, try checking WMPlugins first. If the codec you want isn't there, the
most common third party codec required to play back video found on the web is DivX, however you can
also download FEDShow which is a filter which decodes most common video and audio formats, including
DivX, XviD, AC3 and OGG.

There are also certain types of media which won't normally play back on Windows Media Player or other
common media players due to proprietary issues. The QuickTime .MOV and the RealPlayer .RM formats are
two types of files which require special codecs and are usually viewable using their respective players:
QuickTime Player and RealPlayer. If you don't want to install these players and instead want to view these
audio/video files on Windows Media Player, or other players, you should install the Real Alternative and
QuickTime Alternative codecs. Usually a Google search for any codec you require should find you a place to
download it, but very old or proprietary codecs may be difficult to find or may cost money to obtain.

Note that I do not recommend installing lots of 'Codec Packs', as these often cause all sorts of issues, from
impeding proper video or audio playback in games, to strange system crashes. Stick with the codec provided
above as they cover all the major formats.s

B DIGITAL RIGHTS MANAGEMENT

A major issue of concern for people playing back media in Windows Vista is Digital Rights Management
(DRM). To see if a media file you are trying to play back is protected by DRM, open Windows Media Player
in Library view, right-click on the Title of the file and select Properties. Under the 'Media Usage Rights' tab
you will see if the file has any protection, and what if any conditions there are to its usage, such as number of
times you can play it back, or when the file usage rights expire. In general you cannot remove or alter DRM
legally, so it will not be covered here. If you have a file protected by DRM, comply with the terms it requires
and see further below for some DRM tips.

A new form of DRM has been integrated into Vista to provide protection of High Definition (HD) video
content for the new HDDVD and Blu-Ray disk formats. These formats allow resolutions of 720 (i.e. 720
vertical lines in Progressive format) and 1080p, whereas standard DVD for example is 480p or 576p. To
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ensure that content from these new formats is not being copied, altered, or coming from an unauthorized
copy, Vista requires that all of the following conditions be satisfied:

* The TV or monitor is connected via a pure digital DVI or HDMI cable.

* The TV or monitor supports the High Bandwidth Digital Content Protection (HDCP) format.
* Anoriginal HDDVD or Blu-Ray disk is being used.

* An Activated and legitimate copy of Windows Vista is being used.

*= A signed WDM graphics driver is being used.

Vista will check at startup to ensure that your hardware and system drivers support HDCP and the
conditions above, and if satisfied will enter Protected Environment such that you can play back any HDDVD
or Blu-Ray content without any problems. Note that any other HDDVD/Blu-Ray playback device will
require the first three conditions above to met as well for the playback of commercial content, so this is not a
Vista-specific requirement. More details of the specific requirements and impacts are in this Microsoft
Article.

If you don't meet any of the requirements above, and thus don't enter Protected Environment, the content
provider - that is the company producing the actual HDDVD/Blu-Ray material you are trying to view - can
decide whether to degrade the quality of the video to that of a regular 480p DVD, or to prevent playback
altogether. This is left up to the provider to decide; Vista has no involvement in this process, it simply tells
the media that it is not running on a Protected Media Path.

DRM should have no major impact on most Vista users since it is being handled by Vista without any need
for user input. As long as you use legitimate media and appropriate hardware then you will not have any
problems and there will be no performance impact. However if you want to minimize the impact of DRM
media on your system then purchase physical music CDs as these are not protected and can be ripped
without any DRM,; consider purchasing physical DVDs rather than online movies, as DVDs although copy-
protected have no usage limitations. If you're looking to purchase a new HDTV, or a PC monitor for HD
movie playback, I strongly recommend that you make sure it has an HDCP-compliant HDMI or DVI input.
Most recent HDTVs do indeed meet this requirement. Finally, for more details of Blu-Ray and HDDVD, see
these detailed Blu-Ray FAQ and HDDVD FAQ.

B OTHER MEDIA PLAYERS

If you don't wish to use Windows Media Player to view media, there are several alternatives including the
following popular free media players:

WinAmp
QuickTime Plaver
RealPlayer

DivX Player
iTunes

I can't go into detail about each of these players here, however they are each good players, and it depends on
your personal preference and specific needs as to whether you choose them over Windows Media Player. A
specific media player worth noting is below:

MEDIA PLAYER CLASSIC

There is a free generic media player which can play back most formats, including proprietary formats, and is
also both easy to use and utilizes very little system resources. It is Media Player Classic and requires no
installation - it is in one .EXE file which launches the player. It also requires no tweaking as such, it is ready
to be used immediately without any issues. Give it a try as it is a great alternative to the other players, and
you may even end up preferring it over Windows Media Player or any other media player.
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GRAPHICS & INTERFACE

One of the most talked-about changes to Windows Vista is the way it handles graphics under DirectX10, and
its glass-like Windows Aero interface. These changes both rely on Vista's new Windows Display Driver
Model (WDDM) as well as the Windows Presentation Foundation (WPF). Much the same as the changes
undertaken for other types of drivers under Vista, WDDM ensures that the graphics driver does not have
direct access to the software Kernel. All Desktop rendering, whether 2D or 3D is now done through
Direct3D, a component of DirectX which is integrated into Vista. WDDM also provides advanced graphics
card memory management and scheduling to allow better use of graphics hardware, which can further
improve performance and stability.

In plain English, the changes mean that:

* There is much less potential for system instability, since the graphics driver is not directly entangled
with the software core of Vista. A graphics-related issue is less likely to slow down or crash the entire
system. E.g. If Vista detects that the system is frozen it can restart the display driver without a reboot.

* Vista utilizes the graphics hardware on your system for everything from rendering the Desktop to 3D
games, freeing up the CPU and making better use of the GPU when it would otherwise be relatively idle.

*  You can now have advanced graphical effects, including a combination of 2D and 3D effects, on the
Windows Desktop in an efficient manner. This is what allows the glass-like transparencies of the Aero
interface, as well as features like Windows 3D Flip.

* Graphics card memory and resources are now better managed. The graphics card can be properly
multitasked, so that switching between multiple 3D applications or games (or the Desktop) won't result
in system instability. This means for example that when running a game, Vista's Aero interface has no
impact on performance at all because it is suspended when the game enters Exclusive Mode; thus you
can enable a range of advanced Desktop features without worrying about their impact on games. This is
only possible because of the improved resource management.

* Video playback is improved under Vista, due in part to the new video memory management features
which allow smoother playback and help in maintaining audio and video sync.

= Both gaming performance and eye candy can be increased under DirectX10 as it has improved
functionality and has removed some of the limits on programming a graphics card which developers
faced in the past.

The major drawback to Vista's new driver model is that it is dependent on graphics card companies
providing good WDDM graphics drivers to allow the correct functionality. This is something which has
proven difficult even for major graphics companies like ATI and Nvidia, however the situation is improving.

Below we look at the major graphics-based components of Vista, starting with its interface.

B WINDOWS AERO INTERFACE

Windows Aero is the new Graphical User Interface (GUI) unique to Windows Vista. It is a mix of two
dimensional and three dimensional components, and thus it requires Vista's new Windows Display Driver
Model to operate. Some of the prominent features of Aero include:

*  (Glass-like transparencies on window borders and buttons and Desktop elements like the Sidebar.

* Thumbnail previews of the contents of currently running applications by hovering your mouse over
their Taskbar button or when accessing Task Switcher by pressing ALT+TAB.

*  Animated 3D previews of running applications while using the Windows 3D Flip task switcher accessed
by pressing WINDOWS+TAB.

* Animated 3D transition effects when minimizing or maximizing windows.
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REQUIREMENTS

Aero is not automatically available to all users of Vista. If you do not see all the features above keep in mind
that you must meet all of the following conditions to run full Aero mode:

* You must have Windows Vista Business, Vista Enterprise, Vista Home Premium or Vista Ultimate. You
cannot access full Windows Aero mode in Vista Home Basic.

* You must have the appropriate settings enabled in Vista. Under Control Panel, open Personalization.
Click the 'Display Settings' link and make sure your Colors setting is set to 32-bit; click the "'Windows
Colors and Appearance' link and make sure 'Enable Transparency' is ticked, then click the 'Open classic
appearance properties for more color options' link and set the Color Scheme to 'Windows Aero'.

* You must have a supported DX9-capable graphics card with 64MB of Video RAM or higher, and the
card must have hardware support for Pixel Shader 2.0 or above. Specifically this means a Radeon 9500,
GeForce FX 5200 or Intel 945G/GM or newer graphics solution.

*  You must be using a proper WDDM-supported graphics driver for Vista.

*  You must have more than 512MB of System RAM.

* The monitor must have a refresh rate of more than 10Hz.

If you do not meet all the requirements above, you cannot run the Aero interface simply because it requires a
combination of hardware DX9 functionality with proper driver support for Direct3D under Vista, and
sufficient power and memory to allow Aero to perform with reasonable smoothness and to full effect. For
example Vista uses the pixel shader pipeline to achieve the glass-like transparency effect, so cards that don't
provide hardware support for Pixel Shader 2.0 cannot undertake this effect in real-time. See the System
Specifications and Performance Measurement & Diagnostics chapters for details of how to find out if you
meet these requirements.

Additional points to consider when attempting to use Aero:

* You will need a Windows Experience Index score of 3.0 on the Graphics component for Aero to be
enabled automatically. If you've installed a new graphics card or drivers and you lose Vista Aero, or it
still doesn't show up despite having appropriate hardware, drivers and settings as above, go to Control
Panel>System and update your Windows Experience Index score. Vista should detect the new hardware
capabilities properly and enable Vista. See the Performance Measurement & Diagnostics chapter for
more details of what the Windows Experience Index calculates and how to troubleshoot it.

* If you are running a very high resolution and/or multiple monitors the minimum requirements for
graphics card memory will rise. Typically anything above 1280x1024 requires 128MB of Video RAM, and
dual monitors running 1920x1200 require 256MB of Video RAM as a minimum for full Aero effects.

* If you are using a Mobile PC set to a Power Saver power plan, Vista may automatically exit the Aero
interface at any time to save power. To prevent this, go to Control Panel>Power Options and change the
plan from Power Saver to Balanced or High Performance.

If after all of the above Aero is still not working for you and you have appropriate hardware, try the
following changes to the Windows Registry:

[HKEY CURRENT USER\Software\Microsoft\Windows\DWM]

Composition=1
CompositionPolicy=2

Find and change the DWORDs above to the values shown. Then open the Services Utility (see the Services
chapter), go to the 'Desktop Window Manager Session Manager' service, double-click on it, select Stop and
then select Start to restart it. Aero should now be available to choose and enable. If it is not then your
graphics hardware and/or drivers do not meet the minimum requirements for Aero. There was a tweak
available to force Aero for non-compliant hardware, but it only worked in the pre-final versions of Vista and
has been disabled since then.
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PERFORMANCE

Vista's WDDM framework means that as soon as you start Vista, the Desktop Window Manager starts
running and uses Direct3D to compose the desktop image in a back buffer, a process similar to the one
described under Step 8 on this page of my Gamer's Graphics & Display Settings Guide. This process makes
the Desktop smooth to view and reduces/removes any 'tearing' or visual glitches. When you then launch a
full-screen 3D application such as a game, it is launched in Exclusive Mode, and Vista suspends any
rendering for the Desktop. This means that there is no performance impact on games from using Aero or
additional Desktop features.

Most systems with supported graphics cards should be able to support full Windows Aero functionality
without problems. However if your Desktop starts to become sluggish or less responsive at times, to
customize the effects used for the interface go to Start>Control Panel and open the System component. Then
click the 'Advanced System Settings' link, or go to Start>Search Box and type "systempropertiesadvanced"
(without quotes) and press Enter. Under the Advanced tab, click the first Settings button and you will see a
range of options under the Visual Effects tab. Here you can customize precisely which effects are activated
and which are disabled for the Windows interface. For example to turn off the animation effect in Aero,
untick the 'Animate windows when minimizing and maximizing'; if your desktop windows are behaving
sluggishly when being moved around, untick the 'Show windows contents while dragging', and so forth.
You shouldn't have to disable many if any of these options unless they're not to your liking. Obviously
though if your Desktop is filled with gadgets, windows and 3D items then at some point your system will
become more sluggish depending on your graphics card's capabilities.

B DESKTOP BACKGROUND

You can set an image for your Desktop background by going to the Control Panel, opening Personalization
and clicking the 'Desktop Background' link.

STATIC BACKGROUNDS

By default you will see a range of Vista background wallpapers held under the \ Windows\ Web\ Wallpaper
directory. When you click on any image it is instantly shown as a 'wallpaper' on the Desktop, so you can
preview as many desktop backgrounds as you like in real-time to see how they'll look. At the bottom of the
box you will notice there are three ways to show the wallpaper - the first option stretches or shrinks the
wallpaper to fill your Desktop; the second option tiles the image repeatedly across the Desktop; the third
option shows the image in its full resolution, and this may be too small or too large to fit exactly on your
Desktop so there may be a colored border shown (which you can also change the color of here).

If you want to use your own images for the Desktop background, click the Browse button and go to the
directory which holds your preferred image. The image needs to be .JPG or .BMP format to be used, and
ideally for optimal display I recommend making sure that it is the same resolution as your Desktop so that
Windows doesn't have to rescale it. If necessary manually rescale the image using a paint program like
PhotoShop, as this provides the best image quality.

ADDITIONAL VISTA STATIC BACKGROUNDS

The photographer who took a range of photos for the default Vista backgrounds has placed a range of the
photos which did not get included in the final version of Vista on his site. You can view and download them
here: Hamad Darwish.

ANIMATED BACKGROUNDS

One of the Extras that Windows Vista Ultimate owners can access for free is Windows DreamScene which
allows an animated desktop background to be set using a video loop. For example a looping video of
raindrops hitting a puddle of water can be set as the Desktop background. You can download custom-made
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videos for DreamScene from WinCustomize or you can use your own custom-made videos in .MPG or
.WMYV formats, such ones you can download from SkyTimelLapse for example. The Windows DreamScene
feature can be downloaded by Vista Ultimate owners under Windows Update in the Control Panel.

The Desktop background you choose may have an impact on memory usage since it is loaded into memory
at Windows startup, though this shouldn't be of any real concern. Because Vista suspends the Desktop while
a game is running, having a fancy desktop background or animated desktop is not going to have any impact
on gaming performance. If however you find an animated background impacts on Desktop performance and
responsiveness, it is recommended you use a simpler video loop or failing that, consider disabling it.

B WINDOWS SIDEBAR

The Windows Sidebar is a utility which runs on the right-hand side of the screen by default, providing a
place to hold Sidebar Gadgets - small programs which provide custom Desktop functionality. By default the
Sidebar comes with a range of Gadgets you can try, including a clock, calendar and live weather forecast.
When you hover your mouse over the right-hand side of the screen the Sidebar becomes visible as a
translucent strip (under Windows Aero). A small Sidebar icon is also displayed in the Notification Area in
the bottom right hand corner of the screen as well. To access the Sidebar options, right-click on the Sidebar
area, or go to Control Panel and select the Windows Sidebar Properties component. In the box which opens,
you can select from the following options which I will cover below:

Start Sidebar when Windows starts: Even if the Sidebar itself is not being displayed (see further below), to
display and access Gadgets on your Desktop, the Sidebar process needs to start at Windows Startup.
Alternatively you can manually start the Sidebar at any time by going to Start>Search Box and typing
"sidebar" and pressing Enter. If you wish to disable the Sidebar and Gadgets altogether untick this box.

Sidebar is always on top of other windows: This option forces the Sidebar to remain on top of all other open
windows. This is not recommended as it gets in the way. Ticking this option does not force all floating
Gadgets to remain on top of open windows; only those which are docked onto the Sidebar. To force a single
Gadget to remain on top see further below.

Display Sidebar on this side of the screen: Choose whether to have the Sidebar on the left or right side of the
screen. Set to suit your taste.

View list of running gadgets: Clicking this button shows all the running Gadgets.

Gadgets: These are the individual small programs which can either sit on the Sidebar, or can be dragged and
dropped anywhere to 'float’ on your Desktop. Almost every Gadget has options which can be customized, so
right-click on the Gadget and select Options to see its individual options or left-click on the small wrench
which appears when you hover over the Gadget. When you right-click on a Gadget you can also determine
how transparent it is by selecting the Opacity item and choosing a percentage; you can select whether the
individual Gadget remains on top of all open windows by ticking 'Always on top'; or you can 'Attach it to
Sidebar' to remove it from floating mode. Note that you can temporarily bring all Gadget to the top of all
open windows by pressing WINDOWS+SPACEBAR.

Gadgets can be detached or attached to the Sidebar as you wish just by dragging and dropping them. In fact
if you detach all the Gadgets from the Sidebar, you can remove the Sidebar from view altogether if you wish
by right-clicking on the Sidebar area and selecting 'Close Sidebar'. Aside from the Gadgets already in
Windows which you can add - right-click on the Sidebar or a Gadget and select 'Add Gadgets' - you can
download and add new ones by going to the Windows Live Gallery. You can also download and use the
Amnesty Generator to allow you to make custom Gadgets out of a range of existing small programs from
around the web, or the Windows Sidebar Styler to make custom Gadgets.
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In general Gadgets usually have a relatively insignificant impact on Desktop performance, and of course no
impact on gaming performance. Far from being just a gimmick they can actually become very useful as
informational tools and even help in troubleshooting problems - for example you can use the CPU Meter
Gadget to display and monitor real-time CPU or memory usage while using certain programs. I recommend
that you see if you can find Gadgets to suit your needs.

B DESKTOP FONTS

Windows Vista contains several new fonts, including Segoe Ul, Constantia, Cambria, Corbel, Candara,
Calibri, and Consolas. These give Vista its distinctive look, however if for any reason you wish to change the
font type, size and general clarity of the user interface, the first place to look is under the Personalization
component of the Control Panel. Select 'Windows Color and Appearance', then click the 'open classic
appearance properties for more color options' link. Here you can several aspects of the Vista interface
appearance:

Effects: Click this button and you can choose whether to use font smoothing (recommended), and whether
you use ClearType or not. ClearType is a particular type of technology designed to make text clearer,
particularly on fixed pixel displays such as LCD or Plasma, so I recommend that if you run such a display
that you set this option to ClearType. If you run a CRT, or just want to see what text looks like without
ClearType, set this option to Standard, click OK then click Apply - now check to see whether text quality has
improved (you may have to press F5 to refresh the screen). Note that at the moment Microsoft's ClearType
Tuner does not work with Vista, so ClearType can't be easily customized. The only method of customizing
ClearType is to go to the following key in the Registry:

[HKEY CURRENT USER\Control Panel\Desktop]

FontSmoothingGamma=1000
FontSmoothingOrientation=1

The first DWORD above (viewed in Decimal view) determines how bright or dark the text will be. The
default of 1000 is usually the best, but you can increase it, up to 2200 to see if this improves the appearance
of ClearType text. The second DWORD above determines the type of display used, with 0=CRT, 1=Standard
fixed-pixel RGB display, 2=fixed pixel display using non-standard BGR arrangement.

Advanced: If you wish to change the actual fonts and font sizes used for particular interface elements, click
the Advanced button and you can now select a particular component of the interface in the Item box, and
not only customize its size and color, but for relevant elements, you can also change the font and font size
used. If you don't wish to make this change manually, and want to apply a global change to all the fonts
used for the interface, you can access the specific font types and settings under the following Registry keys:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\
FontSubstitutes]

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Fonts]
[HKEY CLASSES ROOT\Local Settings\Software\Microsoft\Windows\Shell\MuiCache]

[HKEY_LOCAL_MACHINE\ SOFTWARE\Microsoft\Windows
NT\CurrentVersion\FontMapper\FamilyDefaults]

By specifying different fonts, you can change the entire Vista interface. For example changing the line in the
Registry under the following key:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Fonts]
Times New Roman (TrueType)=times.ttf

to

aoeyIa)u] 2y sorydern

Copyright © 2007 Koroush Ghazi 207



http://windowshelp.microsoft.com/Windows/en-US/Help/c3a4da66-c335-45f5-a71f-d162d1b64ed41033.mspx
http://www.microsoft.com/typography/cleartype/tuner/Step1.aspx
http://www.microsoft.com/typography/cleartype/tuner/Step1.aspx

e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

Times New Roman (TrueType)=segoeui.ttf

Will tell Vista to use the Segoe UI TrueType font in all places where Times New Roman would normally be
used in the Vista interface. All the font names can be found under the Fonts component in the Control Panel
- right click on a font there, select Properties and you will see its real filename. Make sure to backup the
Registry and set a Restore Point first as this cannot be undone any other way. For a simpler but less
thorough method of changing the size of fonts displayed see below.

INTERFACE FONT SIZE

If you find that Vista's screen fonts are generally too small especially at higher resolutions, you can easily
change the Dots Per Inch (DPI) Scaling setting which will resolve this issue. Go to the Control Panel, open
Personalization and click the 'Adjust font size (DPI)' link in the left pane. Here you can adjust the DPI font
scaling to a larger number than the default of 96, thereby increasing text size without altering any other
aspect of the interface. To scale the text to suit your needs, click the 'Custom DPI' button at the bottom right
of the DPI Scaling box, and either enter a percentage of the normal size you wish to scale to, or drag the ruler
with your mouse. The 'Use Windows XP DPI Scaling' option should be enabled to prevent some programs
which were not originally designed to work with Vista's DPI scaling from showing blurry fonts.

CUSTOM FONTS

Vista has a built-in font editing utility called Private Character Editor which you can access by going to
Start>Search Box and typing "eudcedit" (without quotes) and pressing Enter. It allows you to create custom
fonts which you can then insert into documents using the Character Map utility. For more details see this
Microsoft Article.

B DESKTOP ICONS

Vista uses a new icon system which results in smoothly scalable icons. All system icons in Vista can be
smoothly resized using a slider from within Windows Explorer, and most any program or file can be
rescaled or set to display as a Live Icons; thumbnails of the actual contents of a file - see the Windows
Explorer chapter for details.

To adjust the appearance of Desktop icons, you can right-click on an empty space on the Desktop and under
the View menu select either Classic, Medium or Large icon size, whether to let Vista 'Auto Arrange' the icon
layout, or 'Align to Grid' to place an invisible grid on the Desktop that icons will 'snap' to when moved. You
can even disable Desktop icons if you so wish, though this is not normally recommended. Fortunately there
is much more that can be done to customize the Desktop icon size, layout and appearance, and these tips are
covered below:

RESIZE DESKTOP ICONS

You can manually resize the Desktop icons beyond the three fixed sizes already available. To do so click
once on an empty spot on the Desktop, then hold down the CTRL button while using the scrollwheel on
your mouse to gradually increase (scroll up) or decrease (scroll down) the size of the icons to suit your taste.
This works much like the resizing slider in Windows Explorer. Note that icons not designed for Vista will
not scale well, and beyond a certain size cannot be made any larger; default system icons will scale smoothly
due to the new icon system.

REMOVE TEXT FROM DESKTOP ICONS

To remove the text beneath any icon on your Desktop, follow these steps:

1. Right-click on the icon whose title you want to remove and select Rename
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2. Instead of entering any characters in the text box, hold down the ALT key and type 255 (ALT +2 + 5 +5).
Note you need to use the NUMPAD number keys for this to work (i.e. the numbers to the right of your
arrow keys, not the ones at the top of the keyboard).

3. When you release the ALT key the title will be blank, and you can press Enter to accept this. Blank titles
are usually denied under Windows, but not when done this way as it inserts a special blank character.

4. For every icon whose title you wish to remove, do the same as above. Note however that since no two
icons can have the same name, for each subsequent icon you'll have to add an additional ALT 255 to the
end of the string you enter. E.g. to blank a second icon name you'll need to hold down ALT and type
255, release, then hold ALT and type 255 again, then release and press Enter. For a third, you'll have to
type ALT 255, ALT 255, ALT 255, Enter and so on.

If you want to regain the icon names you will have to manually edit each icon's name to whatever you want.

REMOVE SHORTCUT ARROWS FROM ICONS

All the small Shortcut Arrows which display at the bottom left of any shortcut icon are associated with the
following Registry entry:

[HKEY CLASSES ROOT\1lnkfile]

IsShortcut=

The STRING entry above can be deleted to remove shortcuts, however this will cause a range of problems,
such as being unable to launch certain links (e.g. Games Explorer game links). Therefore the best way to
actually remove shortcuts is to use a free utility called Vista Shortcut Overlay Remover. Download and
install the FxVisor program, then launch it and select the type of shortcut arrow appearance you like, and
once your session is restarted the change should be applied.

CREATE DESKTOP ICONS FOR SHUTDOWN OR RESTART

Instead of trying to find the Shutdown or Restart options on the Start Menu, you can create desktop icons
which automatically shutdown or restart your PC with just a double-click. This tweak makes use of the
Shutdown.exe command line to create a new shortcut as follows:

SHUTDOWN ICON

Right click on an empty area on your desktop.

Select New>Shortcut.

In the first box of the Create Shortcut Wizard, type "shutdown /s /t 00" (without quotes) and click Next.
Call the shortcut something descriptive like 'Shutdown' and click Finish.

To add the finishing touch, right click on this new icon, select Properties, click the Change Icon button
and select an appropriate icon.

A

REBOOT ICON

Follow the same steps as for the Shutdown Icon, but substitute the following steps in place of the
corresponding ones above:

3. In the first box of the Create Shortcut Wizard, type "shutdown /r /t 00" (without quotes). Click Next.
4. Call the shortcut something like 'Restart' and click Finish.

Note that double-clicking on these icons will commence shutdown or restart of the PC straight away without
any warning. If you want a countdown before a shutdown or restart, substitute a time in seconds in place of
the '00" entries in the shortcut properties above (e.g. shutdown /s /t 10 gives 10 seconds warning before
shutting down). Also note that once the shutdown or restart process begins it can't be aborted. If you want
more command line switches which can be used with the shutdown command, open a command prompt
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and type "shutdown" (without quotes) and press Enter. For example you can use the /h switch instead of /r
or /s above to create a Hibernate icon instead.

SAVE DESKTOP ICON POSITIONS

This tweak allows you to save the current positions of your desktop icons so that if the icons are rearranged
or moved you can quickly restore them back to their saved positions at any time. To give you this added
functionality do the following:

Download the file Layout.zip (mirror: here) and extract the contents to an empty directory.

Copy the Layout.dll file to your \ Windows \ System32 directory.

Double-click on the Layout.reg file to automatically make the appropriate changes to your Registry.

Go to your Desktop and arrange all your icons as you would like them to be saved.

Once done, right-click on the Recycle Bin and select the new 'Save Desktop Icon Layout' option. The
positions of all the icons are now saved.

Ol LN

6. You can move the icons around freely and whenever you want them restored to their original saved
positions, right-click on Recycle Bin again and select 'Restore Desktop Icon Layout'.

This tweak is particularly handy if you're installing new graphics card drivers for example and your
Desktop icons get messed up, or you change resolutions and they get scrambled around.

SET SPACING BETWEEN DESKTOP ICONS

To adjust the spaces between your desktop icons, you can manually move them. However if you've chosen
automatic spacing - that is right-click on the Desktop and select Arrange Icons by>Auto Arrange - then you
can still adjust the fixed vertical and horizontal spaces placed between each icon by doing the following;:

Right-click on the Desktop and choose Personalization.

Select the 'Window Colors and Appearance' item.

Click the 'Open classic appearance properties for more color options'.

Click the Advanced button, and under Items select Icon Spacing (Horizontal) and 'Icon Spacing
(Vertical)' and edit their values to determine how many pixels are placed between the icons. The defaults
are 43 pixels between icons. Smaller values squeeze them closer together, higher values spread them
further apart. Click Ok then click Apply and the changes should immediately impact on the Desktop.

Ll

Note that by changing these icon spacing values, you will also change the spacing between all icons in
windows as well, such as in the Control Panel window for example.

REMOVE '- SHORTCUT' FROM NEW SHORTCUTS

Whenever you create a new shortcut, the words '- Shortcut' appear at the end of the shortcut's name. To
remove this default prefix for new shortcuts, open Registry Editor and change the following:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer]
Link=1E 00 00 00

Create this BINARY value if it doesn't exist and set it equal to 00 00 00 00 to remove the '- Shortcut' suffix on
new shortcuts. Reboot Windows to implement the change.

REPAIR INCORRECTLY DISPLAYED ICONS

By default Windows stores a range of commonly used icons in a cache to speed up their display on the
Windows Desktop for example. If you are experiencing problems with your icons displaying incorrectly, go
to the \AppData\Local directory under your personal folders and delete the file IconCache.db. Reboot
Windows and this file will be recreated afresh, resolving any icon incorrectly displayed.
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B GENERAL INTERFACE CUSTOMIZATION

The following are some general interface customizations that most users should find handy:

CUSTOMIZE VISTA BOOT SCREEN

Already covered under the Boot Configuration chapter is the No GUI Boot option which you can easily
enable under the Boot tab of the MSConlfig utility. This replaces the 'scrolling green bar' Vista boot screen
with the Aurora desktop image.

However you can further customize Vista's boot screen by using the Vista Boot Logo Generator. This free
utility allows you to turn any 24-bit .BMP file into a boot screen image for Vista, which you should then copy
into your \Windows\System32\en-US (or relevant language) directory, and then enable the No GUI Boot
option in MSConfig for it to work.

CREATE CUSTOM DESKTOP TOOLBAR

If you want to create a full length separate customized toolbar on your Desktop, follow these steps:

Go to the Windows Desktop.

Right-click on an empty area and select New>Folder.

Give the new folder a name, then double-click on it to open it.

Drag and drop any files, folders or shortcuts you wish into this folder, then close it.
Drag the folder icon to the very edge of your screen and drop it.

A SER .

The custom folder you created will suddenly turn into a full-length toolbar complete with all your files,
folders and shortcuts each shown as an icon on the toolbar. You can resize the toolbar's width, and by right-
clicking on it you can access further options such as being able to enable or disable its title, any text shown,
and whether it shows small or large icons. To close it simply right-click on it and select 'Close toolbar'.

SLOW DOWN VISTA ANIMATIONS

If you want to enable the ability to slow down Vista Desktop animations, such as when maximizing or
minimizing windows, go to the following Registry key:

[HKEY CURRENT USER\Software\Microsoft\Windows\DWM]

AnimationsShiftKey=1

Add the DWORD shown above and set it to =1. Reboot your system, and now whenever you hold down the
SHIFT key while an animation is playing, it will slow down so you can see precisely what it's doing. This is
more a novelty than something to permanently enable, so delete the entry above if you want to remove it.

CUSTOMIZE 3D TASK SWITCHING

By default, pressing WINDOWS+TAB brings up the Windows 3D Flip task switcher. If you want to have 3D
Flip remain in 3D mode without having to hold down WINDOWS+TAB, use CTRL+WINDOWS+TAB
instead; now 3D Flip will remain as such when you let go, and you can use the TAB key or the arrow keys to
cycle through open windows and press ESC to return to normal 2D mode.

More importantly, if you want another neat way of flipping through open tasks, you can use the free
SmartFlip utility. This tool allows you to cycle open windows in a 2D/3D rotational manner and is
customizable.
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MULTI MONITOR CUSTOMIZATION

If you run a dual or multi monitor setup with Vista, there are a range of additional features you can
customize using the tool UltraMon. The tool is free for a trial period if you wish to see if provides features
you need.

B DIRECTX 10

Microsoft has introduced the new foundation for multimedia in Windows Vista called DirectX 10 (DX10).
DirectX 10 is designed solely for Vista, and is not backward compatible with any other version of Windows.
It is a collection of Application Programming Interfaces (APIs) which include Direct3D for advanced
graphics, and DirectSound and Direct3DSound for advanced sound in Vista. More details can found in this
Microsoft Article and this Microsoft Article. However DirectX is not the only API which can be used under
Vista - OpenGL (for graphics) and OpenAL (for sound) are open-source alternatives which are still
supported and functional under Vista.

The specific benefits of DX10 are demonstrated in this Microsoft Article, and in plain English include:

»  Unified Shaders which mean more efficient use of graphics hardware for complex shader effects.

* The addition of a new Geometry Shader to add to Pixel and Vertex shaders. This new shader type allows
a range of 'organic’ special effects without reliance on the CPU.

* Paging of graphics memory, allowing Video RAM to page data to the System RAM and back. This
allows games to use much larger textures for example.

* Texture arrays allow texture swapping to occur without CPU intervention. In fact due to a range of
CPU/GPU resource balance improvements such as the Geometry Shader further above, the CPU is much
less likely to bottleneck the GPU.

* Removal of the limits on the number of objects rendered.

* Improved Instancing which allows multiple objects of the same type (e.g. multiple trees, grass or people)
to be rendered much more quickly.

* Removal of backward compatibility with DX9 means improved performance. Because DX10 has been
built from scratch it isn't constrained by the usual compromises needed to run legacy hardware.

While the changes in DirectX 10 are designed to make it easier for programmers to develop advanced games,
the choice of which API to use for particular games for example still depends on the software developer.

Since most current games are still programmed for use under DirectX 9.0 (DX9), Vista also contains a version
of DirectX 9.0 called DirectX 9.0EX (Extended). This version of DX9 is again unique to Vista, as it is also
based on Vista's new Window Display Driver Model, so it cannot be used under any different version of
Windows. To see which version of DirectX 10 you are running, go to Start>Search Box and type "dxdiag"
(without quotes) and press Enter. This opens the DirectX Diagnostics Tool (DXDiag), and you can view your
DX version at the bottom of the main page. See the System Specifications chapter for more on DXDiag.

B GAMING IN VISTA

This guide has already been written with gamers in mind, so there are no specific additional performance or
customization tips in this section for gamers - follow the recommendations throughout this guide to get
improved performance in both games and general Vista usage. However I do want to cover several game-
related features and tips for gamers below.

DX10 AND GAMING

The changes in DirectX 10 covered further above are of greatest benefit to gamers. However the important
thing to note if you want to undertake DX10 gaming is that it will require three things:
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* Games written to take advantage of DX10 - It may be a while before a full DX10 game is released.
Current and upcoming games for Vista will be a combination of DX10 and DX9EX, so the full potential
of DX10 may take some time to realize.

* DirectX 10 Graphics Hardware - You must have a graphics card specifically designed to provide
hardware support for DX10 features. This means the GeForce 8X00 series or ATI X2X00 series or newer
graphics cards. If you do not have a full DX10-capable graphics card then you cannot run DX10 games in
DX10 mode, there is no way around this.

=  WDDM Graphics Drivers - You must have the latest WDDM graphics drivers to run DX10 in Vista, and
the level of DX10 performance, compatibility and stability will change as these drivers mature.

There are no DirectX 10 games available at the moment, however there are several prominent ones which
will be released soon. See this list of Upcoming DX10 Games for example. For the moment if you meet all the

requirements above, and you have an Nvidia DX10 graphics card, you can try this Cascades DX10 Demo or
EPS Creator DX10 to experience some of the benefits of DX10.

GAMES EXPLORER

Games Explorer is a central location for games in Vista, both the games built into Vista such as Hearts and
Solitaire, as well as games you have installed yourself. You can access it by opening the Games item on the
Start Menu, or by going to Start>Search Box and typing "games explorer" (without quotes) and pressing
Enter. The main use for Games Explorer is in conjunction with the Parental Controls features detailed under

the User Accounts section of the Control Panel chapter. However even for regular gamers, the Games
Explorer can also provide useful information and easy access to games-related features in Vista.

To configure Games Explorer, aside from the usual Windows Explorer-related choices such as the View type,
click the Options button in the green Command Bar area and choose whether to allow Games Explorer to
download game-related information, and whether to list the recently played games. I recommend you
enable both these options to make Games Explorer useful. The main features are covered below:

Game Details: If you have the Details pane enabled in Windows Explorer - see the Windows Explorer chapter
- then when you click on a game icon you will see in the Details pane at the bottom useful information about
the game's release data, version number, publisher and developer, and you can click on the links in this pane
to take you to their home page.

If you have the Preview Pane enabled as well, a small preview of the game's box cover is also shown in the
right hand pane, and for games which support it, namely those designed for Vista (e.g. click on Hearts), a
listing of your current Windows Experience Index (WEI) performance rating, and the game's required and
recommended performance rating. The WEI is covered in more detail under the Performance Measurement
& Diagnostics chapter. As more games start to support this feature, this will give you a good indication of
whether your system is capable of playing the game properly or not without having to check the system
requirements for the game. Furthermore in the future games developers are likely to customize games such
that they automatically disable or reduce certain features if your performance index is not sufficient for full
functionality.

Tools Button: In the green Command Bar area of the Games Explorer you can click on the Tools button and
you will see shortcuts to games-related functionality in Vista, including Audio Devices, Display Devices,
Input Devices and Performance Information and Tools. These are all covered throughout various chapters in
this guide, however having them all under one button here allows quicker access.

Community & Support Button: If a game supports it, when highlighted you can click on the 'Community and
Support' button in the Command Bar area to see links to the game's home page, support page, forums and so

forth.

Note that you can also access many of the features above simply by right-clicking on the selecting game.
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Adding Missing Games: If an installed game on your system is missing from Games Explorer, that means by
default it hasn't been designed for Games Explorer. You can still add any game by dragging and dropping a
game icon or game executable into the Games Explorer window and it will create a launch icon for it.
However this doesn't necessarily create the full details Games Explorer needs to define things like box art,
support links and so forth. These details will either be downloaded by Games Explorer from the Microsoft
database if the 'Download Information about installed games' item is ticked under the Options button, or are
provided in an . XML file along with the game.

If neither is working, or if you want to manually edit game details for a game in Games Explorer, go to the
following area of the Windows Registry:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\GameUX\]

Open the relevant key with a string of numbers under here (each one refers to a different User Account), and
click on the sub-entries, looking in the right pane for the ConfigApplicationPath entry which points to
the appropriate game. Once the correct folder has been found, you can edit entries, and if you have another
game with full details, click on its key and you can replicate similar entries in the key for the games which
lack them.

PROBLEMS LAUNCHING DX9 GAMES

If you are having problems launching or running any existing DX9 game under Vista, you can try resolving
it by one or all of the following methods:

= If UAC is enabled, make sure the game is being run in Administrator mode. Some games - particularly
online games - will not request Admin access even if they require it, and hence will not run properly.
Right-click on the game's launch icon and select 'Run as Administrator', or right-click on it, select
Properties and under the Compatibility tab select 'Run this program as an administrator, or click
Advanced under the Shortcut tab and tick the 'Run as Administrator' box. See the UAC section under the
PC Security chapter for details.

* Make sure that you are using the latest Vista-compatible graphics drivers. See the Windows Drivers
chapter for links to the relevant graphics hardware manufacturers.

* Run the latest DirectX9 Web Installer to update some of the legacy DX9 components in Vista. This will
not harm your DX10 functionality, and can help resolve DirectX-related problems in legacy DX9 games.

* Run the game in Windows XP compatibility mode. Right-click on the game's launch icon, select
Properties and under the Compatibility tab, tick the 'Run this program in compatibility mode' box and
select 'Windows XP (Service Pack 2)', then click OK.

Make sure to see the Performance Measurement & Diagnostics chapter if you are having problems with
games, and don't forget to check the specific Game Tweak Guides I publish on TweakGuides.com for full
details of all major games, including customization, performance and troubleshooting tips.

Remember that many problems are due to hardware issues such as overheating or overclocking, or sub-
optimal settings in the BIOS, or a driver problem, so the issue is often unrelated to Vista or DirectX. Vista
may have improved stability and performance, but poor quality drivers, sub-optimal system conditions and
incorrect settings will still cause problems; no OS can overcome these types of things, it is up to the user to
understand how their system works and best configure their machine, which is precisely what this guide is
about.
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OVERCLOCKING

When people want additional performance from their machines, they may undertake a procedure called
Overclocking. Overclocking is the process of increasing the clock speed of a component in your PC. The
‘clock’ referred to is a specialized oscillator pulsing with a frequency that determines the rate at which a data
processor can perform instructions. A 3 Gigahertz (GHz) CPU for example has a frequency of oscillation of
around 3 billion pulses per second by default. The theory of overclocking is simple: increase this clock speed
and you'll increase the rate at which instructions are performed, leading to a faster PC. Overclocking is
possible on a range of hardware components including CPUs, Graphics cards, Motherboards and RAM.

There is also another way of overclocking which doesn't really involve increasing the clock rate: altering
timings. Memory-based components such as system RAM and Video RAM have latency timings - rest
periods between operations measured in nanoseconds. By decreasing the latency time, a memory component
can be made to wait less between completing specific operations and hence function faster.

So why is overclocking possible or even necessary? Why aren't the hardware components you buy not
already performing to their absolute maximum potential? Well ironically the reason for that is just the same
as the reason why Windows Vista has so much scope for optimization and customization: the many different
circumstances under which the hardware will potentially be used. Because components are expected to work
in diverse environmental conditions and be put to vastly different tasks, hardware manufacturers ensure a
safe headroom is provided so that in adverse conditions the component can still operate safely and with
stability. Overclocking takes up this slack by pushing the component beyond manufacturers' specifications.

Of course when you push a component beyond its recommended specifications the component requires
ideal conditions to continue operating with stability. That usually means more cooling on/around the
component, since any cooling device it already uses is only really designed to deal with stock operation. The
component also requires stable voltage from the Power Supply either directly or through the motherboard.
Often to achieve a stable overclock the component may also require additional voltage, which in turn can
add to heat and hence raise the cooling requirements even further. Furthermore, the additional heat being
dissipated from one component may cause other nearby components to overheat. As you can see
overclocking is not as simple as it first sounds, and there are often complex interactions involved both at the
hardware and software level which must be taken into account to achieve proper stability.

B BENEFITS AND DRAWBACKS

Before going into any more detail about overclocking it is important to discuss the advantages and
disadvantages of overclocking objectively, so you don't undertake it without knowing what you're getting
yourself into:

BENEFITS

* Increased performance - this is of course the primary reason why people overclock. The degree to which
performance improves depends on the component(s) being overclocked, how far they are overclocked,
and whether they are the hardware most relied upon by particular games and applications. The
performance difference can be anywhere from negligible up to 25% or even more.

» Bragging rights or 'coolness factor' attached to overclocking - some people gain a great deal of
satisfaction and prestige in having the fastest machine, or the highest overclocked component, or the
highest benchmark score. Or they may simply feel they are extracting the most out of their hardware by
overclocking it. Some people also enjoy the tinkering and hobbyist aspect of overclocking and hardware
modification. In that way it's a lot like tweaking.
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DRAWBACKS

* There will be costs in providing additional cooling - in almost all cases you will have to purchase
additional cooling for your system in the form of more efficient heatsinks and/or more fans, a case with
more space or better airflow, or even specialized equipment like water cooling or phase-change cooling
units. Of course if you start out by planning your system carefully, you can minimize the additional
costs by beginning with the right components.

* The component, and therefore your entire system, may become unstable and crash randomly - without a
doubt the number one cause of problems in games and applications is overclocking. People often refuse
to acknowledge that their overclocking is the cause of the problem, and mistakenly blame Windows,
their drivers or the game or application instead. Different programs react differently to overclocking.
Some can tolerate much higher levels of overclocking on particular components, some cannot tolerate
any overclocking at all; it all depends on how stressful the game or program is, and how stable or
unstable the overclock actually is.

= Potential data corruption if certain components are pushed beyond their limits - pushing components
like the CPU or RAM beyond their limits on your system can result in instability leading to data
corruption, up to and including the loss of all your hard drive data. Often this data corruption can occur
subtly over time without any indication or warning.

» [Excessive heat can damage or permanently kill a component - since computer hardware is based on
sensitive electronic equipment, if a hardware component is not kept adequately cool (and even in some
cases if it is) it can be permanently damaged or destroyed through overclocking. It happens quite often,
especially with graphics cards, so it is not as rare as you might think.

= Overclocking automatically voids the warranty on the component - hardware manufacturers make it
clear that overclocking beyond recommended clock speeds or timings will instantly void your warranty.
This also goes for any physical modifications to the hardware such as changing its cooling. A warranty is
only designed to cover unmodified hardware operating within specifications.

* Overclocking reduces the life span of the component - since the component is working beyond
specification and working hotter and faster than it was designed to handle, most components will have
reduced life spans. This can vary from a reduction of a few months to a few years, depending on the
extremity of the overclock, the quality of the components and how well the components are kept cool. A
mild overclock typically has little or no practical impact on the life expectancy of a component; an
extreme overclock can drastically reduce the error-free life of a component.

So far the disadvantages appear to far outweigh the advantages of overclocking. This is not strictly true, it all
depends on how far you overclock a component and how much performance you can gain in return, as well
as the quality of the hardware itself. Don't get me wrong; I'm not suggesting you categorically shouldn't
overclock. But I do feel that it's important to point out that it is not a simple or even beneficial procedure at
all times. Despite everyone urging you to overclock your system you should weigh up the options rationally
and either choose to avoid overclocking due to potentially modest performance gains and/or the strong
likelihood of instability/damage; or alternatively research the topic thoroughly and invest appropriately to
achieve a good balance of performance, stability and safety.

The bottom line is if you can't afford to replace a vital system component should it get damaged, do not
overclock it. If your CPU or graphics card dies for example and you can't replace it your entire computer
becomes unusable, so it is not something to be taken lightly just because people egg you on to do it.

B METHODOLOGY

Below I discuss how to overclock key system components. The precise details will vary depending on your
particular hardware configuration and BIOS options. The information below is only indicative and should
broadly give you an idea of the types of steps involved in overclocking. Importantly, before commencing any
overclocking you must make sure you are totally familiar with the exact brand, model and specifications of
your major hardware components. If necessary refer to any packaging or manuals which came with your
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system, and more importantly see the System Specifications chapter for links to tools which can help you
identify your components and their precise capabilities in detail.

Also make sure that before changing any BIOS settings for the purposes of overclocking that you record
your existing BIOS settings. This is because in some cases when overclocking beyond the point of stability,
you will have to reset your BIOS (or it may reset automatically) back to its factory default settings, losing any
customized settings you've put in. So make sure you document what the major BIOS settings are which
you've altered through any general BIOS customization.

CPU OVERCLOCKING

Overclocking a CPU on most systems involves increasing the Front Side Bus (FSB - for Intel CPUs) or
HyperTransport (HTT - for AMD CPUs) speed of your motherboard in your BIOS. The FSB/HTT is the main
pathway (Bus) between your major system components, and as its speed increases, information is
transferred back and forth more rapidly between all your major components working off this bus speed.
However there are certain problems with increasing the FSB/HTT. To start with, some components running

off this bus, such as your PCI devices (e.g. a Sound card) operate at a much lower bus speed by default, so
your motherboard has special dividers/multipliers or even a Lock to maintain the bus speeds at or close to
their default. Importantly, your system RAM may rely on the main Bus speed to determine its speed in
conjunction with some form of divider/multiplier.

Your CPU also has a Multiplier, which as the name suggests sets the CPU speed in MHz as a multiple of the
main Bus speed. For example on a system with an effective Bus of 200MHz and a CPU that has a multiplier
of 20 gives you a CPU speed of 20x200 = 4000MHz = 4GHz. Note that some CPUs have their multiplier
locked at the hardware level, which means you can't actually change it. The Multiplier and the Bus speed
can be used together to achieve a performance result in conjunction with the RAM speed.

RAM OVERCLOCKING

Increasing the speed of your RAM is dependent on a number of factors. Overclocking refers to the process of
increasing the clock speed of a component; in the case of system RAM this involves raising the system Bus
speed and/or changing the memory divider/multiplier and/or simply raising the RAM's Frequency directly
to alter the RAM's speed in MHz - depending on your available BIOS options. However you can also alter
the Timings (or Latency) of a memory chip such that it refreshes faster between operations, meaning less
waiting time between each operation and hence faster performance. Changing timings is not overclocking
strictly speaking, since you are not increasing any clock speeds, but in general terms it has similar
performance-boosting potential.

People often ask whether increasing RAM speed or lowering latency is the better option. This White Paper
by Corsair covers the issue, but there is no set answer - it all depends on your system and the applications
and games you most commonly run as to the precise combination of RAM speed and RAM latency which
will perform best and with greatest stability, so you will have to experiment. Generally speaking,
applications or games which have large amounts of non-graphics information to transfer to the CPU and
back will benefit more from greater RAM speed, which provides more bandwidth. On the other hand
applications and particularly games which primarily require very complex calculations with repeated access
to information in memory will benefit more from lower RAM latency. Obviously some games require both,
so there is no clear-cut answer.

RAM overclocking also depends a great deal on how many sticks of RAM you have, their quality, and how
‘matched’ they are. Because your RAM sticks work together, if you have two or more sticks of RAM in your
system, you must try and ensure that firstly they are all equally matched in terms of rated speed and
timings, and secondly that they should ideally be from the same brand and model of RAM. RAM sticks can
vary in quality and performance, so having mixed brands or types of RAM can lead to a variety of problems
- even when running at default speeds.
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GRAPHICS CARD OVERCLOCKING

The following is a modified summary from the overclocking section of my ATI Catalyst Tweak Guide and
Nvidia Forceware Tweak Guide. It applies to all graphics cards regardless of brand, however if you are an
ATI or Nvidia graphics card user please read through the relevant guide above for full details.

The modern graphics card is a lot like a small computer by itself. It has a Graphics Processing Unit (GPU)
which is the graphics equivalent of the CPU, it sits on a motherboard-like Printed Circuit Board (PCB), and
has its own Video RAM (VRAM). And just like a computer system, the components on a video card can be
overclocked to increase performance. Overclocking a graphics card involves increasing the frequency of the
GPU (also called the Engine or Core) and/or the Video RAM (also called VRAM or Graphics Memory). You
can overclock one or both of these components, with varying results based on a number of factors, but
generally resulting in an increase in performance the higher you overclock each component. To overclock
your video card, ideally you'll need a tool which allows you to change the clock speeds of the Core and the
VRAM - refer to the guides above for links and instructions.

Overclocking your video card is similar to CPU overclocking and RAM overclocking combined - simply
increase the clock speed of the Core/Engine, and/or the clock speed of the Graphics Memory, both of which
are measured in MHz. The Core generates graphics data, and depending on your CPU and the rest of your
system specifications, increasing the core speed can result in a small or large performance improvement. The
Video Memory transfers information to/from the Core, and increasing its speed can once again improve
performance either slightly or significantly, in conjunction with your Core speed and the speed of the rest of
your system.

As a general rule, if you have a fast graphics card and a slow CPU, then overclocking your graphics card
yields less performance improvements. If you have a fast CPU and a slower graphics card, then overclocking
the graphics card can show greater improvement. The reason for this is that if the graphics card is the weak
link (or 'bottleneck’) in the equation, and a particular game requires more graphical power and speed, then
quite clearly overclocking the graphics card can show more of an improvement than in situations where the
CPU or the rest of your system is the weak point.

Remember if you have an old or low-end graphics card then overclocking is unlikely to improve
performance dramatically. The reason for this is that certain lower end graphics cards simply do not have
hardware support for the advanced functionality demanded by recent games, like the latest Pixel Shaders
and Vertex Shaders. If your card does not have hardware support for a required advanced function,
overclocking cannot surmount this handicap.

VOLTAGE ADJUSTMENT

As components are pushed outside specifications with overclocking, they will do more work. Often they can
accommodate this extra work within their current voltage, however sometimes to gain stability and/or to
push a component further, you will have to increase the voltage to these components. The three main
components that can benefit from voltage tweaking are the CPU, the graphics card and RAM. The two main
voltage adjustments you will find in almost any BIOS are VCore and VDIMM, and these are explained
below.

CPU Voltage (vCore): This is the amount of voltage applied to the CPU. The base voltage will vary depending
on the CPU architecture, however make sure to note what your CPU's default voltage is before raising it. The
only reason to alter the vCore from its default is that when overclocking your CPU you may notice that you
cannot overclock it beyond a certain point, or that you experience a lot of instability. Raising the vCore
slightly in your BIOS may allow the CPU to regain stability and/or allow you to push the CPU further. The
theory behind raising the vCore is more complex than just supplying more juice to the CPU, and you can
read about it in this CPU Overvolting Article as well as this Wikipedia Article. The most important thing to
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understand is that upping the VCore beyond a certain point can result in permanent damage to your CPU,
and generally speaking any increase in the VCore can further shorten the life span of a CPU. However for
the most part a small bump in voltage (e.g. 0.1 or 0.2 volts) can help stabilize an overclocked CPU that is
acting slightly unstable. Just remember that more voltage requires greater cooling to maintain safe
temperatures.

RAM Voltage (vDIMM): Also sometimes called DDR Voltage, this is the amount of voltage for the RAM
DIMMS (Dual Inline Memory Modules). Just like vCore, increasing vDIMM can improve stability, and RAM
in particularly can benefit from higher voltages when your system is suffering from stability issues under
overclocked conditions. This is particularly true if you're experiencing random reboots or crashes to desktop
as these are almost always RAM related in some way. Once again, increasing the voltage to your RAM can
result in permanent damage so do not overvolt by a substantial amount without first consulting with other
owners of the same RAM and motherboard combination to see what a recommended 'safe' voltage level
would be. As always make sure your RAM has plenty of fresh cool air circulating around it to prevent any
heat buildup.

There may however be additional voltage settings in your BIOS, and unless you have full knowledge of
what they do, and what a safe adjustment is, do not alter them as you can permanently damage or kill your
components this way.

POWER SUPPLY UNIT

Your Power Supply Unit (PSU) is an essential part of your system, and one that is often ignored, especially
when overclocking. For basic details regarding PSUs see this PSU Article and this PSU Article which talk
about the common output specifications for PSUs and what they mean. Essentially while the amount of
voltage supplied for each component is important, equally as important is the variability in this voltage and
how closely it adheres to the specified requirements for each component. Sensitive electronic components
require stable 'clean’ voltage to operate at maximum stability. If there is substantial variability in the voltage
to a particular component as its demands change, this can contribute towards crashes, freezes and sudden
reboots.

There are two main aspects to a power supply that will tell you how good they are for your system. The first
is the Wattage. This specifies the maximum power output of the PSU in Watts, and a simple rule is that the
more devices you have connected to your system, the higher the Wattage of the PSU you will need. As a rule
of thumb, I recommend at least a 350W power supply for modern PCs, preferably 480W or above. However
as soon as you attach several optical drives, hard drives, case fans and various USB devices for example you
will find even 480W may not be enough when combined with a power-hungry CPU and graphics card. To
work out the PSU Wattage which is sufficient for a particular system, use this Interactive PSU Calculator.

The second, and more important, but lesser known aspect of a PSU is the stability of the voltages along the
+12V, +5V and +3.3V rails. That is, how close is the actual voltage being supplied to your components on
these rails to the advertised requirements (i.e. 12V, 5V and 3.3V). For an explanation of these see the PSU
guide mentioned above. The most accurate way to check is to use a voltmeter, but that requires the right
equipment and a bit of technical expertise. The common way for most people to get an indication of voltage
stability is to use some sort of monitoring software. There should be one such utility included on your
motherboard's driver CD, or available on your motherboard manufacturer's website. Use it to check your
voltages and see how variable they are when performing various tasks. The more variation there is in the
voltage over time, and greater the variation from the rated voltage for a rail - especially when you computer
is under load - the greater your chances of experiencing crashes, freezes and reboots due simply to
inadequate and/or unstable power supply to your components - especially when overclocked.

Do not underestimate the importance of a good quality PSU with sufficient wattage and stable voltages.
Your entire system can suffer from constant instability unless you have a decent suitable PSU.
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COOLING

Most overclockers will want to know what is a 'safe’' temperature for their component - there is no single
answer. Different components and different hardware architectures have different acceptable temperature
ranges. Furthermore most components such as the CPU and graphics card have built-in thermal throttling
which reduces the speed of the hardware if it reaches a preset temperature, however the temperature limits
are different for various hardware, and really you should never let your component become hot enough to
get close to these limits. You will need to download a temperature monitoring utility, and also conduct some
research to see what the 'normal' temperatures are under idle and full load conditions for your particular
hardware.

In general cooling is critical for overclocking; without adequate cooling on and around your components,
overclocking simply results in massive instability or even permanent damage. However because cooling is
just as important on non-overclocked machines, for more details see the Cooling section in the BIOS &
Hardware Management chapter.

COMPARING OVERCLOCKS

One of the most common statements I hear when people compare overclocks or are told that their overclock
is unstable is: "But my friend who has the exact same system can overclock it much higher than me and his
games don't crash!". A comment like that demonstrates a lack of understanding of some fundamental
principles of overclocking when comparing overclocks:

* No two components are exactly the same. Even if the two components being compared are an identical
brand, model and speed, they may have very different tolerances to overclocking depending on which
factory they were produced in and which revision they are (how early/late into the production run they
were produced - e.g. for CPUs this is called Stepping).

= No two people have the exact same conditions for their overclocking. Your computer room may be hotter
or cooler than your friend's, your case may provide better or worse cooling, your combination of
components may include a different PSU or different brand or speed of RAM, etc.

*  Your Windows settings and software environment will not be identical to anyone else's. You may have
sub-optimal software settings, background programs that are the source of conflicts, or even malware
causing problems, or you may even have data corruption.

* No two games are identical in the way they stress components on your machine, and hence if all of your
other games work absolutely fine at a certain level of overclock, it may well be that the latest game you
are playing has a completely different tolerance to your overclock and will crash 3 times out of 4.

OVERCLOCKING AND STABILITY

I'have a golden rule about troubleshooting any problem on an overclocked system:
Always start by assuming your overclock is the primary source of any problems

Begin the investigation of any problem on your PC by suspecting your overclock as the source of a problem.
Reset your entire system to its default speeds and see if the problem persists or is as severe. If the problem
goes away, or doesn't happen as often you can be certain your overclocking is contributing in some way to,
or is the sole cause of, your problems. You will have to lower or remove your overclock and/or increase your
cooling.

Details on how to correctly test your system for stability are covered in the Performance Measurement &
Diagnostics chapter, but bear in mind that even if your system passes every artificial test, the real test is
having complete stability day-in, day-out even when running stressful games and programs. If your system
starts behaving strangely, or you are having crashes and problems, don't persist in maintaining your
overclock. I know from experience that it is psychologically difficult to lower or remove an overclock
because you may feel you are losing extra performance that you deserve, but this is something you will have
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to deal with. Virtually every day I receive emails or see forum posts from people who are wondering about
some 'mysterious' problem on their machine, only to eventually find that it was in some way related to their
overclocking. Subtle data corruption can occur over time on overclocked systems, even seemingly stable
ones, and this is one of the main reasons why so many people often find they have to reinstall Windows
every few months. This is not exaggeration or scaremongering - electronic hardware components are highly
accurate devices, forcing them to run outside their normal operating speeds can increase the potential for
small errors to creep into their operation. Manufacturers often push a particular component close to its limits
by default from the factory, so even a small amount of overclocking is enough to cause problems.

If it appears that I'm being overly harsh or biased against overclocking, it is because I've been doing it myself
since 1999 and I know full well how easy it can be to become lulled into accepting an unstable system as
somehow being the norm. It is totally false to claim that it is normal to constantly reinstall Windows, or that
it is normal for your system to crash every few hours. My last two (non-overclocked) systems have been rock
solid every single day for years, even after hours of very stressful gaming. My current system still has its
original two-year old installation of Windows XP running perfectly alongside Vista, as fast as the day I
installed it. My games do not crash randomly nor do my programs or system behave strangely. The point is
if you're going to overclock, don't do it at the cost of system stability; do it properly. At the first sign of
strange behavior, don't be quick to blame everything else - suspect your overclock first and foremost.

RESEARCHING OVERCLOCKING

Having stressed the importance of researching overclocking before you dive into it, I recommend that you
start by referring to the following guides for more details. This is obviously not a definitive list of places to
research, nor have I personally tested out all the procedures in these guides - they are simply a good starting
point:

Comprehensive Overclocking Guide
Tom's Hardware Overclocking Guide
Core2Duo Overclocking Guide 1

Core2Duo Overclocking Guide 2

Core2Duo Temperature Guide
AMD CPU Overclocking Guides & Resources

Take the time to search Google and various tech forums for peoples' experiences with overclocking
hardware similar to your own. More often than not you will find someone who has a similar setup and who
has overclocked it with reasonable success, so look out for such information. Be aware however that people
often have different definitions of 'stable’ when it comes to overclocking, and of course as noted further
above, no two systems are identical so don't just automatically assume you can reach the same results using
similar hardware. Take the time to research, read and think about overclocking and make sure you have the
right tools and knowledge to undertake it properly.
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PERFORMANCE MEASUREMENT & DIAGNOSTICS

When you change settings on your PC it is difficult to tell whether your overall performance or system
stability has improved or decreased, and by how much. While you can observe some changes and get a
general feel for whether things have improved, it is often best to gauge performance and stability changes
objectively by using a range of performance measurement tools. You may be trying to resolve a problem
which is showing up in the form of poor performance, strange behavior or an error message. Through the
use of appropriate performance measurement tools and tools with specific diagnostic capabilities, you can
troubleshoot a problem more efficiently and quickly find the root cause of the issue.

Fortunately Windows Vista contains a range of handy tools which you can use to both monitor and measure
your performance, as well as accurately troubleshoot and diagnose problems. Furthermore, as part of the
new Windows Diagnostic Infrastructure, Vista can automatically identify and point out potential causes of
problems. In addition to Vista's tools there are a range of third party programs which will help you
benchmark performance and assist in isolating the cause of a problem, and these are all covered in this

chapter.

The central location for many of Vista's built-in performance and diagnostic tools is the Performance
Information and Tools component under the Control Panel. This is an important area of Vista which contains
access to a range of tools, and we examine the main ones below, starting with the Windows Experience
Index shown on the main screen of Performance Information and Tools.

B WINDOWS EXPERIENCE INDEX

One of the first things Vista does after you have installed it is to examine your system with the Windows
System Assessment Tool (WinSAT), running a series of tests to calculate the Windows Experience Index
(WEI) for your system. This is an important process, and the results are shown as a series of five sub-scores,
culminating in a single base score shown as the large number at the right of the sub-scores. The base score is
determined by the lowest of your five individual sub-scores; it is not an average or cumulative score.

Windows Vista actually uses the base score and sub-scores to determine a range of things, such as whether
your system can display Windows Aero, so this score is quite important and you should investigate further
into the areas where you score relatively lowly. From the article linked above, below is a summary of how
WIinSAT calculates your Windows Experience Index number for each sub-score:

Processor: The results of this score are calculated as a weighted average of the following tests:

*  Compression and decompression using the LZW compression algorithm.

* Compression and decompression using the Windows Vista compression algorithm used for hibernation
files, ReadyBoost and other features.

* Encryption and decryption assessment.

* Computing hashes.

* Encoding of video.

Memory: The results of this score are calculated based on the amount of bandwidth (in MB/s) that the
memory can move within a certain period. However the highest score attainable is constrained by the
amount of system RAM (minus any memory reserved for graphics). This is shown in the table below - e.g. if
you have 640MB of system RAM, the highest you can score regardless of RAM speed is 3.5:

= Less than 256 MB - 1.0
= Lessthan 500 MB - 2.0
= 5]12MBorless-2.9
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= Lessthan 704 MB - 3.5
= Less than 960 MB - 3.9
= Lessthan15GB-4.5

Graphics: This score is mainly used to determine how your system will run Windows Aero and play back
Windows Media Video. It measures video memory bandwidth (in MB/s). However note the following
restrictions:

* If your graphics card does not support DX9 than it can only score a maximum of 1.0.
» If the system supports DX9, but does not have a WDDM Driver than it can only score a maximum of 1.9.

Gaming Graphics: This score is calculated based on how many Frames Per Second (FPS) your graphics card
can display for various textures. However note the following restrictions:

so1psouer(] 29 JUSWDINSEIA SDUBWLIONIS ]

= If the graphics card does not support D3D 9 then it can only score a maximum of 1.0.
= If the system supports D3D 9, is DX9 capable and has a WDDM driver, it will score at least 2.0.

= If the score is greater than or equal to 5.0 but the graphics card doesn't support Shader Model 3.0 then
the maximum score possible is 4.9.

Primary Hard Disk: This score is calculated based on your primary hard disk's bandwidth measured in MB/s.
All modern hard drives will score a 2.0 or above.

The scoring system has been set up so that at the moment the highest score that any system can attain for
any component is 5.9. In the future Microsoft will update Vista to allow for scores higher than this. When
looking at your base score, the breakdown of what to expect in Vista is as follows:

= Base Score 1.0 - This is the absolute minimum specifications needed to run Vista, but without Windows
Aero and with a range of general performance problems. Best used only for email, Internet browsing,
Solitaire.

*  Base Score 2.0 - This is the recommended minimum specification to run Vista, and may be able to run
Windows Aero but with some performance issues. Similar usage scenario as above, but with more
responsiveness.

*  Base Score 3.0 - This is the 'average' Vista system which can run Windows Aero and perform reasonably
well in normal applications, and provide basic performance in games.

*  Base Score 4.0 - This machine will run Vista well and be quite responsive, even in multitasking. Runs
most applications and games quite well.

* Base Score 5.0 - This machine is a high-end machine suitable for excellent performance in gaming,
multimedia and multitasking. Some very high-end 5.0 machines may be reclassified as 6.0 when the
scoring system is updated.

These scores are not the ultimate test of what a machine is capable of, as clearly different applications and
games will rely more on different components. However because of the way the base score is shown not as
an average - which would be misleading (e.g. a 1.0 and a 5.0 average out to be 3.0) - but as the lowest of your
individual sub-scores, it is very useful for gauging the general performance level of a PC, and its existing
bottlenecks. The idea is that it highlights the weakest link on the main hardware components of your system,
and there is good reason for this; your system is only as fast as its weakest link.

For instance on a PC which scores a 5.9 on its Gaming Graphics sub-score, you would expect excellent
gaming performance, but this is not necessarily so. If the same system scores lowly on other areas then it is
likely you will run into problems with gaming. Let's say the Memory or Primary Hard Disk score is below
3.0 - this means that while your graphics card can easily handle intensive 3D rendering for a game, your
hard drive and/or memory may simply not be fast enough to continually supply the graphics card with the
information it needs, and the end result will be major stuttering or frequent loading pauses, or indeed you
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may not be able to run some games due to insufficient RAM. Ideally your scores should be very close to each
other, and if you are looking to upgrade your system, then it would be wise to pay attention to which
components are scoring lowly. If you want to view other peoples' scores, either check on your favorite online
forum, or you can view and compare Windows Experience Index scores at ShareYourScore.

If you're buying a pre-built system then make sure it has a good score, and don't accept any statements that
the Windows Experience Index is "not important" - see below to understand why.

WINDOWS SYSTEM ASSESSMENT TOOL

Windows Vista takes the performance information it obtains from the Windows System Assessment Tool
(WIinSAT) to calculate the Windows Experience Index (WEI) quite seriously. For example if you don't score
3.0 or higher in the Graphics component, then Vista will not enable Windows Aero by default. In the future
as more applications and games are designed for Vista, they may make use of WinSAT's ability to provide
performance information and thus automatically customize or disable certain settings based on your scores,
in order to provide better performance - see the Games Explorer section under the Graphics & Interface
chapter for details. So the score is important, and it's not just haphazardly put together.

Therefore one of the first things you should do is to make sure that you keep the performance scores
accurate and up to date. Whenever you change your hardware, update your graphics drivers, alter relevant
BIOS settings (such as RAM speeds), or overclock your system you may be prompted to update the WEIL,
and I strongly recommend that you do so straight away. You can also manually update these scores at any
time by being to go to Control Panel>Performance Information and Tools and click the 'Update my score'
link on the main page. I encourage you to do this often, and be sure not to do anything while your score is
being updated if you want the best results.

To update individual scores for a particular component, and to also see more details of the actual tests being
undertaken and the results, you can access WinSAT directly through a command line interface. Open an
Administrator Command Prompt and type "WinSAT features" (without quotes) and press Enter. This will
list the details about your system as identified by WinSAT. To do a full test and update your scores, type
"WiInSAT formal" (without quotes) and press Enter. You can also run specific tests on individual
components, with the results being shown in more detail. This is useful to see precisely what is going on in
each test and view the actual results in detail. WinSAT can be used to run a variety of complex specific tests -
see this detailed WinSAT Command List. Below are basic WinSAT commands to run the default WEI tests:

Winsat cpu
Runs the Processor test. Add the -encryption or -compression switch to specify which type of test to run.
Winsat mem
Runs the Memory test. Shows memory bandwidth in MB/s.
Winsat dwm
Runs the Graphics (Desktop Window Manager in Direct3D) test. Shows graphics performance and memory
throughput in MB/s. You can also get a similar test by using the command AURORA. Press ESC to exit the
aurora screen.
Winsat media
Runs the Graphics (Media) test. Must specify a media file in WMV format to test. The default test file is

under \Windows\ Performance\ WinSAT and is called WinSAT.wmv, so for example you can type "Winsat
media -input e:\ windows\ performance\ winsat\ winsat. wmv" (without quotes) to have it run the test.
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Winsat mfmedia

Runs the Media Foundation-based test. Requires an input file similar to the media command above.
Winsat d3d

Runs the Gaming Graphics (Direct3D) test. Runs a texture test on screen, press ESC to exist and see result.
Winsat disk -drive

Runs the Primary Hard Disk test on the drive specified. For example type "Winsat disk -drive ¢" (without
quotes) to have it run the test on C: drive.
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WiInSAT can be used to help both measure performance and to troubleshoot a problem with a specific
component, so it is well worth becoming familiar with it. Each time a full WEI test is run, the results from

WInSAT are stored in your \ Windows\ Performance\ WinSAT\ DataStore directory in an .XML file which you
can open and view to see the details if you wish. If you are having problems with WEI or WinSAT, you can
delete or move these files to another location to clear the results and then rerun the WEI tests.

In particular if you are having problems with WEI/WInSAT correctly identifying your graphics card's
capabilities, consider the following causes of problems:

* Some graphics drivers have bugs that prevent WinSAT from correctly assessing the full capabilities of
the graphics card.

*= At times a graphics driver may cause a crash or freeze during the graphics card's setup. If the system is
restarted this means the card may not be detected properly.

* Graphics driver bugs may cause problems in correctly identifying the amount of Video RAM on the
card.

The solutions to this problem are firstly to try another version (preferably newer) of the graphics drivers.
However if this doesn't work, you can go to the Windows Registry and manually check and alter the
following areas:

[HKEY LOCAL_ MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winsat\]

DedicatedVideoMemory=
SharedVideoMemory=
VideoMemoryBandwidth=
VideoMemorySize=

These DWORD values should all exist in the Registry; if any are missing then this indicates a fault or
problem, and you can manually insert them. The values shown should be viewed in Decimal format and
represent an amount in Bytes. To see what it is in MB, divide the number by 1048576 (i.e. divide by 1024 then
1024 again). The VideoMemorySize value is calculated as the sum of DedicatedSystemMemory +
DedicatedVideoMemory, which should be equivalent to your onboard Video RAM amount for standalone
graphics cards. Make sure to backup your Registry before making any changes here. You may also be able to
manipulate your score by changing the values in this section of the Registry but that is not recommended.

Finally, if you want to disable the way in which WinSAT scales Windows features based on your scores, you
can do so under Group Policy - see the Group Policy chapter.
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B EVENT VIEWER

An important place to view details of any performance impediments or potential problems is the Event
Viewer. Though complex, learning how to use the Event Viewer can greatly improve your chances of
quickly find the cause of any problems or performance issues. Aside from going to Start>Search Box and
typing "eventvwr" (without quotes) and pressing Enter, there are two ways to directly access specific Event
Viewer functionality, depending on your primary purpose:

PERFORMANCE MEASUREMENT

If you are trying to improve performance, then to access the performance-specific logs in Event Viewer go to
Control Panel>Performance Information and Tools, click the 'Advanced tools' link in the left pane, then click
the 'View performance details in Event log' link. This will take you immediately to the Operation log under
the Applications and Services Logs>Microsoft>Windows>Diagnostics-Performance area of Event Viewer.
Here you can see individual events which describe potential performance issues, as identified by the
Windows Diagnostic Infrastructure which automatically monitors a range of events, including Windows
startup, shutdown, Desktop performance and a range of other system events. For example if you have a
'‘Boot Performance Monitoring' warning here, it is because Vista thinks your boot time may be too long. It
will provide details such as how many seconds boot time is taking up (e.g. 38000ms = 38 seconds). Go
through these warnings or errors and see if there are any which specify things you can do to rectify them.
Note that as discussed under the Startup Programs chapter, these logs are also very useful if you want an
objective measure of exactly how long your bootup or shutdown times have been.

Fortunately, Vista reports the most significant of these performance issues in more intelligible form - when
you open the Advanced Tools area of the Performance Information and Tools box, you may see listed at the
very top of the box under 'Performance issues' a series of links, which are the results of Window's diagnostic
analysis. For example you may see a 'Startup programs are causing Windows to start slowly' link, which is
connected to the log warning mentioned above. Clicking this link however gives you very clear details as to
what Windows thinks is the problem, in some cases even a specific file or setting you should investigate. Of
course it's not as simple as removing or disabling the component(s) Vista thinks is the problem, as they may
be necessary, and Vista sometimes may be hasty in identifying something as a problem when it isn't. But this
form of automated diagnostics still provides information which is much easier to understand than the raw
Event Viewer logs.

TROUBLESHOOTING

If you are trying to do some general troubleshooting, you can access Event Viewer either under the
Administrative Tools (see the relevant section of the Control Panel), or via the method above, but you should
then click on the main 'Event Viewer' item at the top the left pane. This brings up the Overview and
Summary screen, showing the major events and warnings summarized and ranked from Critical events,
Errors, Warnings, Information down to Audit Success and Audit Failure.

To run through an example of how to use Event Viewer to find system problems, in the Overview and
Summary page follow these steps:

1. Click on the '+' sign next to Error to expand it. You will see all Errors listed in order of Event ID number,
with the number of errors in the last hour, 24 hours, 7 days and Total shown to the right (expand the
Event Viewer box if necessary to see these).

2. Double-click on the Event ID which has had the most number of errors in the last 24 hours. You will see
a listing of all the individual event logs, sort from latest to oldest.

3. Click once (or double-click) on the first Error listed at the top of the table, and look at the pane below,
under the General tab. You will see a general description of the error. The information under the Details
tab is usually not easy to comprehend, but you can view that also if you wish.
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4. Under the General tab, click the 'Event Log Online Help' link and you may be able to see helpful
additional advice on what the actual problem is.

Often times you won't be able to find much helpful advice about a particular Event ID, so instead you can
firstly try searching the official Microsoft Error Message Center, and if you have no luck there or need
further clarification try this Event ID Site for more details.

If instead of viewing the logs by type, you wish to view them by category or component of Windows, go to
the left pane of Event Viewer and browse down to the log file type you wish to view. For example to view all
User Account Control-related logs, go to Applications and Services Logs>Microsoft>Windows>UAC and
click the log file(s) under it to see the details.

Some important things to note in general about event logs:
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* To troubleshoot an issue, focus on Critical events to start with, followed by Errors. Warning and
Information events are more useful mainly for performance optimization.

= Look at how recent the event was. It may be that it occurred a while ago and is no longer occurring, so it
may be a one-off or could have been resolved through some other action inadvertently. Focus on issues
which occur often and more recently. If the error is very recent, such as during your latest session,
consider what you have done recently that may have triggered it. For example if you started a particular
program or disabled a particular Service.

= Remember that a log of 100 events may be the same issue which has occurred every time you start your
PC. That is, seeing 100 errors just may mean that you had the same error twice a day over the past 50
days, not 100 different errors. You can sort event by the Event ID column, so do so to see how many
unique events there are.

If you want to customize the type of event logs which are presented to you in Event Viewer, click the 'Create
a custom view' link in the right pane, and then specify the types of event levels to be shown and the time
period over which they have been logged among other things. You can then view this custom view by
clicking it under 'Custom Views' folder in the left pane. If you want a graphical representation of more
important events, see the Reliability Monitor functionality below.

You can even configure Vista to actually alert you immediately of a specific Event, via Email if you even
want. Highlight a particular Event - I recommend an Error event which should be less frequent - and then in
the right pane you can select 'Attach Task to this Event'. In the Wizard which opens you can specify in the
Action section to 'Send an email' or 'Display a message' and then fill in the details as to the specific email
address you want it sent to, or the message which appears. In this way any events you consider significant
can come to your attention immediately.

Ultimately the Event Viewer is generally more suited to advanced troubleshooting, not for beginners.
However it has a wealth of information which can help you refine where a problem is occurring if you take
some time to go through it. Fortunately Vista does extract what it believes to be performance issues or errors
worthy of attention and shows you more details automatically, so even relatively novice users can have
some idea of what is causing a slowdown or problem. There are several other automated methods of
determining problems in Vista which are much easier for everyone to understand and use and they are
detailed below.

B RELIABILITY AND PERFORMANCE MONITOR

The Reliability and Performance Monitor can be accessed in a number of ways, either through the
Performance Information and Tools>Advanced Tools area by clicking the 'Open Reliability and Performance
Monitor' link, or by going to Start>Search Box and typing "perfmon" (without quotes) and pressing Enter.
You can also access just the Resource Usage section of this utility by clicking the 'Resource Monitor' button
under the Performance tab of Task Manager. The Reliability and Performance Monitor is an important new
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tool for monitoring and measuring system performance in Vista, and can again be used to troubleshoot
problems as well as improve performance.

PERFORMANCE MEASUREMENT

One of the ways to determine how to improve your performance is to monitor your system resources and
determine firstly if any programs are using too many resources when they shouldn't be; and secondly to
observe and see just what type of resources your more resource-hungry applications and games need. This
can help identify any bottlenecks.

To begin monitoring resource usage, open the Reliability and Performance Monitor, on the main Resource
Overview screen you will see four graphs which immediately commence displaying CPU, Hard Drive,
Network and Memory (RAM) usage. You can leave monitor open as you undertake a task or start a program
to see its impact on the four areas of resource usage. Clicking on any graph will open the relevant sub-
component underneath the graph area, displaying the details of specific programs or processes and how
much of that particular resource they are consuming at the moment. You may even like to briefly run a game
or strenuous application and see which resources are pushed to their limits.

However as the name suggests, Resource Overview is just a real-time overview of system resource usage. If
you want to actually conduct a proper performance analysis over time, you will need to click the
Performance Monitor item in the left pane, which opens up a large single graph. You can now add
components for this graph to map over time by clicking the green '+' button at the top, or right-clicking on
the graph itself and selecting 'Add Counters'. For example to add a counter measuring hard drive usage,
double-click on the Logical Disk item in the list, then select the specific variable you wish to measure (e.g.
Disk Write Bytes/Sec) and click the Add button. You can add as many components as you like, though
obviously it is wise to limit this to make the graph readable. Click OK when done.

The graph will now update to start mapping all the variables you've added, and you can see in the legend at
the bottom of the graph the components being mapped, the color for each component and you can tick or
untick particular ones if you wish to temporarily show or hide them. Remember that since the Y (vertical)
axis scale is fixed, some components will not display in any meaningful way when using a common scale.
However you can change the type of data display used in two ways:

* The simple method involves clicking the graph button at the top and selecting either Histogram or
Report view which may be much more meaningful - or you can press CTRL+G to cycle display types.

*  The more detailed method involves right-clicking on the graph and selecting Properties. Then under the
Graph tab you can adjust the vertical scale manually by entering a maximum and minimum, and under
the View box you can select Histogram or Report view instead as well. Under the Appearance and
General tabs you can also further customize the display appearance and sample rate as well, and
importantly you can set the duration for the graph (default is 100 seconds).

Data Collector Sets can be created to allow you to schedule performance monitoring. To begin this process,
right-click on the 'Performance Monitor' item in the left pane and select New>Data Collector Set. This will
open the Create New Data Collector Set Wizard. Follow the prompts to define where the set will be held
(typically under the \perflogs directory). You can start the collection straight away and to stop it, right-click
on the name of the new Collector Set you've created in the left pane and select Stop. To view the results at
any time, go to where the log is stored and double-click on it to open it in the Performance Monitor, or find it
under the Reports>User Defined area in the left pane of Performance Monitor. To schedule performance
monitoring using a Data Collector Set, right-click on it and select Properties. Then under the Schedule tab
click the Add button and you can set the time and day the task will begin, and over what period of time it
will occur.
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TROUBLESHOOTING

While you can use the Performance Monitor as above to assist in troubleshooting and diagnosing a
performance problem, to quickly identify individual issues affecting your system's stability, you can use the
Reliability Monitor found under the left pane of the Reliability and Performance Monitor window. The main
feature of the Reliability Monitor is a System Stability chart which attempts to graph just how stable your
system is over time. The closer you are to 10 on System Stability Index scale of 0 - 10, the more stable your
system is deemed to be. Note that the reliability monitor begins graphing your system in the first 24 hours
after you install Vista - use the scroll bar at the bottom to view the full length of the graph.

At the bottom of the graph you can see Errors (red Xs), Warnings (yellow exclamations) or Information
(white Is) events in the five categories of Software (Un)installs, Application Failures, Hardware Failures,
Windows Failures and Miscellaneous Failures. Click on any event and at the bottom of the screen you will
see the details of the particular process, program or hardware component that is related to the issue.

This is a useful method of quickly seeing at what periods your system is at its least stable, and the types of
issues which maybe cause it.

The Reliability and Performance Monitor generally requires a bit more effort to use, but rewards those who
are patient and who compile appropriate logs with valuable information on the types of things which may
be causing system issues or performance bottlenecks.

B TASK MANAGER

The Windows Task Manager is a key Windows utility that allows you to view real-time information about
which applications, processes and services are running on your system, as well as a range of performance

and system information. There are several ways of accessing Task Manager, some quicker than others:

* Press CIRL+ALT+DEL together and then select 'Start Task Manager.

*  Go to Start>Search Box and type "taskmgr" (without quotes) and press Enter.
* Right-click on the Taskbar and select the 'Task Manager' item.

*  Press CTRL+SHIFT+ESC to bring up Task Manager.

By default Task Manager only shows the running processes for your particular User Account. If you want to
see all processes, including System and Network processes, click the 'Show processes from all users' button
under the Processes tab. This will provide the most detailed view of what is running on your PC at the
moment, and is always the recommended view.

Task Manager has a range of performance and troubleshooting uses, we look at the main ones below:

PERFORMANCE MEASUREMENT

To use Task Manager for performance monitoring, the place to start is under the Performance tab, which
similar to the Performance Monitor Resource Overview section (see above) has graphs which display CPU
and Memory usage in real time. The 'CPU Usage History' graph(s) at the top show the percentage of CPU
used for each core on your CPU; so for dual core CPUs there will be two graphs, for quad core CPUs four
graphs, and if the CPU has HyperThreading enabled, then there will be one graph for each 'virtual' core as
well. Note that if you only want one graph for all CPUs, go to the View menu and select CPU History>'One
graph, All CPUs'. Under the View menu you can also tick the 'Show Kernel Times' to display the amount of
CPU resources used by the Kernel (core Vista software) as a red line.

Next to the graphs, the CPU Usage scale shows actual percentage of total CPU resources used. It is
important to understand that the total CPU usage figure is an average of the combination of all CPU cores,
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so if you have a dual core CPU with both cores working at around 50% each for example, the total CPU
usage shown is 50%, which is the average, not the sum of the two CPUs.

CPU usage should be relatively low during idle periods (i.e. 1- 10% at most), though remember that your
system may launch a CPU-intensive task such as the Search Indexer when idle, so if the CPU usage is high
go to the Processes tab, click the CPU column to sort processes in order of highest to lowest CPU usage, and
see what is taking up CPU time aside from 'System Idle Process'. See Troubleshooting further below.

The area below the CPU graphs show the amount of memory (RAM) being used by the system at present for
all your running processes. It is not however the total amount of RAM used by the system, as the system also
uses RAM for caching by SuperFetch. Next to this figure is the graphed history of memory usage. To see the
actual details of the way memory is being used by Vista at the moment, the text tells the full story, as
covered below:

Physical Memory (MB)

= Total - Total amount of physical RAM installed in your system.

* Cached - Amount of RAM recently used by the system for holding a range of data for quick access,
typically related to SuperFetch.

*  Free - Unused RAM; not cached nor in use by any process.

Kernel Memory (MB)

* Total - Total amount of memory used by the Kernel (the core software of Vista) on your system.
* Paged - How much of the total is in virtual (paged) memory.
* Non-Paged - How much of the total is in physical RAM.

The important thing to understand here is that when SuperFetch is enabled, Vista actively attempts to put as
much data as it can into the system memory in the form of cached data. It doesn't matter how many
programs, services or processes are currently running; that only affects the main Memory Usage figure
shown on the graph. The Cached figure shows the true story of what SuperFetch is doing, and that is to
cache as much information in RAM as possible in anticipation of its usage, and this in turn should make
Windows more responsive. This is why the Free figure under Physical Memory is usually very low,
sometimes even 0. The rationale behind this is that any truly free RAM is wasted - if it holds no information,
it does nothing to assist in speeding up the system, and thus serves no purpose.

As soon as you run a relatively memory-intensive program, SuperFetch will give up this cache almost
instantly. For example while keeping Task Manager open on this pane, run a Blend test in Prime95 (see the
Prime95 section further below) and you will see the Cached figure suddenly drop to almost nothing as all of
it goes towards the main Memory Usage figure shown in the Memory graph. Then when you exit the
program, SuperFetch will begin steadily recaching information again and you will notice drive activity while
it does this. See the SuperFetch section of the Memory Optimization chapter for more details.

Under the System area to the right you can see the following components:

* Handles - The number of unique object identifiers in use by processes.

*  Threads - The number of objects or processes running within larger processes or programs.

*  Processes - The number of individual processes running (as listed under the Processes tab).

*  Up Time - The number of minutes since the PC was last started.

= Page File - The amount of virtual memory in use (on the left), and the sum of system RAM + virtual
memory (on the right) - see the Memory Optimization chapter.
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If you click the 'Resource Monitor' button it will take you to the Resource Overview screen of the Reliability
and Performance Monitor - see the section further above for more details.

Once you've had a look at the Performance tab, go to the Processes tab and while this is mostly useful for
troubleshooting - as covered below - there is still some useful performance-relevant information here. For
example you can go to the Applications tab, right-click on a program and click 'Go to Process' to see
precisely which main process is running for that application. You can then see how much CPU it is using
under the CPU column (shown as a % of total CPU resources), and the amount of memory it is currently
using under the 'Memory (Private Working Set)' column. If you want to see the most resource-intensive
processes, click on the CPU or Memory column header to sort it such that the processes are sorted with the
highest usage ones shown at the top. You can also see their associated Service(s) by right-clicking on a
process and selecting 'Go to Service'. See the Services chapter for more details.

In fact under the Processes tab you can specify a range of information to be shown. Go to the View menu
and choose the 'Select Columns' item. You will be presented with a list of details you can display for
processes as separate columns, and you can tick those you wish to show. For example if you want to see the
hard drive usage statistics for running processes, tick the 'IO Read Bytes' to see how many bytes of data each
process has read from the hard drive this session.

TROUBLESHOOTING

The most common use for Task Manager is typically to allow a user to close a problematic program/process.
Whenever a program stops responding or you can't close it any other way, open Task Manager and under
the Applications or Processes tab you can highlight the offending task or process and select 'End Task' or
‘End Process'. Given Vista's new methods of isolating the core of the operating system (the Kernel) from
being corrupted, this method is much less necessary, since by default Vista will prevent the entire system
from becoming unstable, detecting a frozen or non-responsive application or process and after a short period
will terminate it automatically or present you with a list of options as to how to proceed. You can still
terminate a program or process manually with Task Manager if you don't want to wait for Vista to detect its
state, but it is not absolutely necessary now.

Many of the performance-related uses for Task Manager further above can also assist in troubleshooting
program problems as well. For example if your CPU usage is consistently at or close to 100%, then you can
investigate under the Processes tab to see which particular process is using so much resources. Make sure
though that you are viewing processes for all users in Task Manager (see further above) otherwise this
exercise can be pointless. In some cases a program can become caught in a loop or have some other kind of
error which causes it to try to use all CPU resources. You can manually end the process causing problems,
restart the program and see if it happens again - if so then the program bears further investigation. Some
programs require or specifically attempt to use full CPU resources, such as games or intensive benchmarking
programs. Even some background Windows tasks such as the Search Indexer can use full CPU, but because
of the way Vista prioritizes CPU and I/O resources (see the Hard Drive Optimization chapter), no
background task should use large amounts of CPU resources when Vista detects that you are trying to
undertake another task which requires those resources.

If your system is consistently showing signs of being sluggish and/or you see a lot of drive activity, check the
memory usage figures under the Processes tab. The Memory (Private Working Set) column shows
specifically the amount of memory in use by a process which cannot be shared by other processes. Bear in
mind that as mentioned further above you can also place additional columns in the Processes tab, so go to
View>Select Columns and chose some more metrics which may reveal system issues. In particular the other
Memory-related columns are described below:

*  Memory (Working Set) - The sum of Memory (Private Working Set) + memory which can be shared.
*  Memory (Peak Working Set) - The maximum amount of Memory (Working Set) used by the process.
*  Memory (Working Set Delta) - The change in Memory (Working Set) used by the process.
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*  Memory (Commit Size) - The amount of virtual memory that is reserved for use by a process.

* Memory (Paged Pool) - The amount of committed virtual memory for a process that can be written
(paged) to the hard disk.

* Memory (Non-paged Pool) - The amount of committed virtual memory for a process that can't be paged
out to disk.

The descriptions for all the Task Manager columns can be seen in this Microsoft Article.

One very useful column is the Tmage Path Name' column which you can enable under the Processes tab.
When displayed, it shows the exact file locations for every running process, so for example if you believe the
process is related to malware, you will be able to see precisely where its file is hidden or which program it
relates to.

Another useful new column you can add is Virtualization, which displays whether file and registry
virtualization has been enabled for the process - see the User Account Control section of the PC Security
chapter for details.

For the svchost.exe (Service Host) processes or any other process you believe is related to a Windows service,
right-click on it and select 'Go to Service(s)' and the relevant service(s) will be highlighted under the Services
tab of Task Manager. If the process is not related to a service, no service will be highlighted. Conversely you
can right-click on a service under the Services tab and click 'Go to Process' to see its relevant process under
the Processes tab highlighted. This is particularly useful when determining service resource usage.

If you can't resolve a process-related issue yourself, then you can create a special file which contains
debugging information for use by a technical support person. Right-click on the relevant process you believe
to be problematic or suspicious and select 'Create Dump File'. A .DMP file with the name of the process will
be created under your \Users\[username]\ AppData\Local\ Temp\ directory. While you can't open this file
and view its contents normally, you can use the Windows Debugging Tools to view and troubleshoot the
contents, or allow someone with more expertise to do so for you.

At any time if you wish to view or manually adjust the CPU priority with which a process runs, you can
right-click on it and select 'Set Priority’. Each process has a level of priority as to how much CPU time it is
allowed when multiple applications are running together. This is described in more detail under the Hard
Drive Optimization chapter. You can force a particular process to have higher (or lower) priority if you wish
to either experiment to see if a particular process is the source of resource-based problems (like stuttering),
or if you want to guarantee that a particular process gets top priority when multitasking. Right-click on the
process and select 'Set Priority' then select the relevant level.

If you wish to permanently apply this priority change to a particular program, so that it automatically occurs
each time the program starts, go to the programs' launch icon, right-click on it and select Properties. In the
Target box enter the following text in front of the text already there, making sure there is one blank space
between /high and the existing text:

%windir% \ system32\ cmd.exe /c start " /high

Note that manually changing process priorities can destabilize the system, and furthermore major programs
such as games will already get the highest priority for resource usage. If altering the priority helps improve
performance then this means you should focus on removing a range of background programs - see the
Startup Programs chapter. Forcing priority is not the appropriate way to resolve this issue in the long term.

MULTI-CORE CPUS

Some desktop PCs contain a CPU with two or more cores - that is, a single CPU which is actually made up of
two (or more) separate CPU chips. Furthermore some Intel CPUs have a technology called HyperThreading
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which in effect emulates two physical cores on each single core of a CPU. For a program to truly take
advantage of both cores on a CPU, it needs to be multi-threaded. That means several program 'threads' will
run in parallel, with each thread assigned to a particular core to handle. Alternatively, multiple separate
programs can be run together much more smoothly on a dual core system, as each program can be run on a
separate core. However many programs and games are still not multithreaded, and hence show no real
benefits when run individually on a dual core system. In fact some programs exhibit problems, such as
stuttering, skipping or incorrect speeds when run on a multi-core CPU.

To use Task Manager to troubleshoot multi-core CPU related problems you can manually force the main
process for a program to temporarily run on only one specified CPU core. Do this as follows:

* Launch the program in question, and as soon as it appears to be loading, or immediately after it has
loaded up, open the Task Manager.

* Under the Processes tab, find the game/program’s main process; if necessary go to the Applications tab,
right-click on the program, select 'Go to Process'.

* Right-click on the relevant process and select 'Set Affinity".

= In the box which appears, untick 'CPU 1' (and any other available CPUs), so that only 'CPU 0' is ticked. If
you're troubleshooting problems you suspect on one particular core, you can do the opposite - disable all
cores except CPU 1 (or CPU 2 or CPU 3 etc.). The aim is to restrict the program to run on only one core.

The program is now forced to run on only one CPU core, which should resolve any problems if they were
genuinely related to the multi-core setup. If this works, or if you have problems attempting to change
affinity this way, there is a way of permanently forcing the affinity change on a program each time it loads.
Before undertaking it, be aware that it modifies the executable file to which it is applied, so backup the file
first before using this method:

1. Download the file imagecfg.exe from this page (mirrors: here and here) and put it into your
\ Windows\ System32 directory. The file is safe to use, as it is a Windows NT system file.

2. Identify the problematic program's main executable. To do this go to the program's launch icon, right-
click on it, select Properties and highlight and copy the text in the Target box.

3. Make a backup copy of this executable first and put it somewhere safe.

Open an Administrator Command Prompt - see the Vista Usage Notes chapter.

5. In the command prompt window type: imagecfg -a Ox1 followed by the text you copied from step 1 above
(right-click in the command prompt box and select Paste) then press Enter. Make sure to put quote
marks around the path if it's not already there. E.g.:

b

imagecfg -a 0x1 "c:/program files/RegCleaner/RegCleanr.exe"”

6. Windows will now only allow that program to see and use the specified CPU core each time it is
launched by using that particular executable.

If you are having problems with imagecfg - as some online games may identify a modified executable as a
cheat for example, you can use this SetAffinity program instead. Download and extract the contents to an
empty folder, and move the madCHook.dll file to your \Windows\System32 directory. Now run the
setaffinity.exe file and a small wrench icon will appear in your Notification Area. Clicking on this will bring
up the interface where you can select to run a game with only one CPU core, either temporarily or
permanently.

For all other intents and purposes a multi-core CPU-based system will behave the same way as a single core
system. You should only use the steps above if you run into a problems with a particular program which
you believe is associated solely with multi-core CPU usage.
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As you can see, the Task Manager has multiple functions as detailed above. Familiarizing yourself with its
various uses will help give you a good idea of what is happening on your system at any time, both for
troubleshooting and general performance and maintenance purposes. For example, regularly checking active
processes and memory usage will give you early warning of things such as malware infections, since they
often cannot be hidden from the Task Manager's Processes list or memory usage statistics.

PROCESS EXPLORER

If you want an advanced form of Task Manager which provides even more details about processes and has
multiple options for performance analysis and troubleshooting, you can download Process Explorer. When
launched, Process Explorer look similar to Task Manager, however aside from the same sort of functionality
as Task Manager covered above, you can also see much more information about a process by double-clicking
on it. In the box which opens, there are various tabs which provide valuable information specific to the
process. For example under the Performance Graph tab you can see resource usage graphs for the process;
under the Performance tab is a range of data which is neatly summarized to give a good overview of

resource usage, and under the Image tab you can details about the file itself, including the ability to verify if
a file is a Microsoft system file. Process Explorer is a valuable tool to add to your system and is safe to use.

B SYSTEM HEALTH REPORT

One of Vista's built-in diagnostic routines is the System Health Report, which is actually a preset Data
Collector Set that runs using Performance Monitor, and provides user-friendly output. To access System
Health Report, go to Control Panel>Performance Information and Tools>Advanced Tools and click the
'Generate a system health report' link, or go to Start>Search Box and type "perfmon /report” (without quotes)
and press Enter.

As soon as it launches, the System Health Report starts gathering information for 60 seconds. When
complete, the report highlights any Errors, Warnings or Critical issues at the top of the report, with details of
possible methods for rectifying them. Note that some errors and warnings are completely normal; for
example if you have purposely disabled a hardware device on your system, or disabled some of Vista's
security features, the report will highlight these. Ideally you should run several System Health Reports,
firstly under normal (relatively idle) conditions, and then subsequently if you wish to troubleshoot a
particular application or game, launch the report then launch the relevant program and exit it after a minute
to see what the System Health Report says.

Under the Basic System Checks section of the report, you can see the areas in which there may be potential
issues, though again these are usually highlighted in the section above, so you can browse them for more
detailed information. The Resource Overview section shows the status of system resources during the 60-
second period the report was run, and is not indicative of your general system resource usage. This is why
it's useful to run a System Health Report several times under various system conditions, so you can better
see what type of bottlenecks your system may be facing under particular circumstances.

You can see detailed information under the various categories at the bottom of the report by clicking the
small triangle at the far right of a particular category, or you can jump directly to specific areas of the report
by left-clicking once on the report icon in the middle of any of the category toolbars, then choosing the sub-
category link to investigate.

You can save each report by going to the File menu and selecting 'Save As'. The report is saved in .HTML
format and can be viewed in your browser. Since this is a system snapshot, as mentioned it is recommended
to run multiple reports under various circumstances and then view the results and compare to see if there
are common issues with a particular resource, or specific errors which occur under certain circumstances.
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B NETWORK DIAGNOSTICS TOOL

The Network Diagnostic Tool is designed to help troubleshoot network and Internet connection-related
problems. To access it, go to Control Panel>Network and Sharing Center and click the 'Diagnose and repair’
link in the left pane. The tool will launch and do an automatic scan of your connection to see if there are any
connectivity problems. If a problem is found Windows will then either automatically resolve it, or present
you with options or advice on how to fix the issue. More complex are generally not solvable this way, but for
simple connectivity issues you should first run this tool.

You can also see a graphical representation of your network connection setup in the Network and Sharing
Center, and if there are any problems it will be displayed in the diagram.

B MEMORY DIAGNOSTICS TOOL

The Windows Memory Diagnostic Tool is another built-in Vista diagnostic that is usually triggered when
Vista detects that a problem may be caused by your physical memory (RAM) chips. It is similar to the
MemTest86 utility covered further below, and needs to run at startup because that is the optimal time when
your RAM is free of any operating system or other software components residing in it. You can also opt to
manually run the tool at any time if you suspect memory-related problems with your RAM or CPU memory
caches, by going to Control Panel>Administrative Tools and selecting the Memory Diagnostics Tools there,
or by going to Start>Search Box and typing "memory" (without quotes) and pressing Enter.

The tool will run at the next reboot, doing a series of tests to determine whether your memory subset is
faulty. You can choose which tests it runs if you wish by pressing F1 as soon as the tool starts, and selecting
from the following options, pressing TAB to move between option categories:

* Test mix - Select the type of test you want to run, whether Basic, Standard or Extended. Standard is
recommended to begin with, and Extended is recommended if you want to do more strenuous testing of
your RAM but is very lengthy.

= Cache - Select whether to have the CPU caches Enabled, Disabled or Default (depends on the test). I
recommend having the cache Enabled to start with, then Disable it if you wish to isolate whether it is a
RAM-related error, or a CPU cache-related error.

* Pass count - The number of times you want to repeat the test, with 0 being infinite. I recommend 2
passes to start with, more if you really want to stress test your memory.

Press F10 to confirm your choices and start the test, progress will be shown both for each test and the overall
progress for all tests. This may take some time to complete depending on the options you've chosen. If you
suspect a memory-related problem, the longer and more strenuous the testing, the better (e.g. 2-3 hours of
testing). This will bring out any latent instabilities in your RAM or CPU caches. You will be told if an error is
found, and what it may be related to, however if your memory subset is clear of problems then no issues
should occur. If errors are found you can try the following:

* Reduce or remove any overclocking on your motherboard, RAM or CPU, then rerun the tests. If the
problems don't occur then clearly the issue is with your components being pushed too far by
overclocking. See the Overclocking chapter.

* Rerun the tests with only one stick of RAM. Vista may even tell you which particular memory stick is
faulty, so remove it and rerun the tests.

* Increase cooling in your case and make sure to remove any clutter or dust around your CPU and RAM
in particular, and anything blocking the free flow of air into and out of your case. If running in a hotter
environment you may need additional case cooling. See the Cooling section under the BIOS & Hardware
Management chapter for more details.
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Windows Memory Diagnostic Tool while thorough can't detect all memory-related errors, so see the other
tools you can use further below in this chapter. If it does detect a problem however it is very likely that your
RAM is faulty, and if ignored will lead to data corruption and more problems.

B PROBLEM REPORTS AND SOLUTIONS

Microsoft now consolidates program error reports in a central location under the Problem Reports and
Solutions automated utility, found under Control Panel, or by going to Start>Search Box and typing
"problem" (without quotes) and pressing Enter. On the main screen of Problem Reports and Solutions you
will see the last known solutions to the problems identified on your system - clicking each link gives you
more details. To view a list of the individual problems Windows has detected on your system, click the
‘View problem history' link in the left pane, and each problem or error is listed under the relevant program
which has triggered it. You can double-click on a specific problem to see the technical details of it.

When Windows detects an error, the way it checks for a solution is by sending a report to Microsoft,
containing your Product ID, and a minidump file (in the format Mini[date].dmp) which includes exception
information, system information, a list of all the modules that are currently loaded and their version
information, and a list of all the threads that are currently running.

To change this behavior, click the 'Change Settings' link and select 'Ask me to check if a problem occurs', and
then click the 'Advanced Settings' link below this and choose whether to turn on problem reporting for all
programs (recommended), whether you wish to change settings for any other users on the system (best set to
‘Allow each user to choose settings'), and whether to 'Automatically send more information if it is needed to
help solve problems' (recommended). Click the Add button if you wish to exempt particular programs from
having their problems reported this way, in case you are worried about privacy issues for example.

Having viewed your problem history, if you want to manually check to see if there are any solutions to your
problems, click the 'Check for new solutions' link in the left pane, and after a while you will see on the main
screen if any solutions or further information is available. Click the links shown to either resolve the issue, or
to find out more about it. If prompted to provide additional information I recommend that you allow this,
however the choice is yours. By submitting errors and additional information to Microsoft, this allows them
to compile a better database of the types of issues which occur, what sort of circumstances trigger them, and
hence how best to release fixes for them.

This method of checking for and resolving problems is by no means complete, nor will you solve all
problems this way, but it provides a relatively easy to understand interface for viewing and attempting to
resolve program and Windows-related problems. Most of the time you will have to do further investigation
on your own to work out the source of a problem. Even if you find no solution, at least Microsoft will be
aware of this problem and if a valid bug or error, can work to resolve it in a patch or update.

B WINDOWS ERRORS

Regardless of how many automated tools and diagnostics Windows Vista contains, you may still experience
a range of error messages or problems which cannot easily be resolved. Some problems are caused by faulty
hardware or adverse conditions (e.g. overheating), or by incompatible software or problematic drivers, and
these are virtually impossible for Vista to self-diagnose. However you can investigate these issues further
yourself to work out what the problem may be related to.

For most major errors you will receive a Blue Screen of Death error, often listing an error message and an
error code. By default Vista is set to automatically reboot when it experiences a serious error, so you will
have to go to Control Panel>System>Advanced System Settings, or go to Start>Search Box and type
"systempropertiesadvanced" (without quotes) and press Enter. Then under the Advanced tab, click the
Settings button under the 'Startup and Recovery' section, and untick the 'Automatically restart' box. Now
when a major error occurs your system will freeze and show details of the error, and I recommend you make
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a note of the exact error message and any error number(s) provided. If the problem you're experiencing
doesn't have a specific error message or number, then note down the application or procedure involved
when you triggered the error.

Then using this information search through the following official Microsoft resources for solutions:

Microsoft Knowledgebase

Microsoft TechNet

Microsoft Windows Vista Solution Center
Microsoft Events & Errors Message Center

In most cases you will find a good lead which will help you narrow down the particular component(s) to
which this error may relate, especially in conjunction with the tools covered throughout the rest of this
chapter. If nothing is found in the resources above, searching in Google using the error number or exact
error phrase also provides excellent leads for seeing who else has experienced this problem and the things
they have done to resolve it. Most any problem can be resolve rapidly if researched this way.
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B THIRD PARTY TOOLS

Although Vista contains a range of performance measurement and diagnostic tools, there are several major
third party tools which you should also download and use if you want to undertake proper performance
measurement and diagnostics. Each of these tools focuses on a particular area of the system, such as your
graphics performance, or diagnosing memory related problems, so it is wise to use a combination of them
and not rely on any particular one or two programs. Below are more details of each programs:

3DMARK

3DMark is a popular and reasonably accurate 3D graphics benchmarking utility that has been around for
several years. The latest version primarily utilizes your graphics card and to a lesser extent the CPU, with
the memory subset a player as well. 3DMark results will give you a good indication of 3D gaming
performance on your machine, and broadly speaking the higher your results the faster the performance of
recent games on your system. In very general terms if one system scores higher in the same version of
3DMark than another, then it should be better for gaming.

To use the free version of 3DMark start the program and click the 'Run 3DMark' button. You will see a series
of tests running. These use various graphical techniques, some of which may not be supported by your
graphics card, and some of which are only available in the purchased version of the benchmark. At the end
of the run the benchmark will present a final score. You can then use this score to compare with other people
who have run the benchmark and this will tell you whether your system is relatively faster or slower, and if
compared with others who have virtually the same system specifications, it will tell you whether you have
room to improve on your particular system. Note however that some systems with the same specifications
may be heavily overclocked just to get a high 3DMark score and not particularly stable for day-to-day use.

One method of comparing results with others is to simply find an appropriate forum and post your results
for comparison and discussion. A more reliable method is to use 3DMark's Online Result Browser (ORB) to
compare results with others who have posted their 3DMarks. Using the ORB means you have a better chance
of finding a precise match for your system specs since the ORB has many thousands of users. To enter the
ORB at any time, click the 'Options' button under the Results section of the main 3DMark screen and then
click the 'Online ResultBrowser' button. Keep in mind that 3DMark is a DX9-based benchmark, and does not
test DX10-related functionality at all. Also remember that the scores from the previous versions of 3DMark
are definitely non-comparable.
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RTHDRIBL

RTHDribl (Real Time High Dynamic Range Image-Based Lighting) is actually a DirectX9 tech demo and not
specifically designed as a benchmark or stress tester as such. You must have a graphics card with Pixel
Shader 2.0 support or higher to run it - if you can run Vista Aero you can run this tool. It does not have a
series of tests to run, so simply start up the program and observe your framerates (top left corner). You can
turn off the text shown on the screen at any time by pressing F1 and F3. You can also cycle through a range
of object shown (Press O), the materials used on their surfaces (Press M), and the backgrounds used (Press
L). You can change the display resolution or increase the size of the program's window, either of which will
increase the load on your graphics card.

To use it as a stress tester, go to the File menu and select 'Config Display'. In the Direct3D Settings screen
which opens, click the 'Fullscreen' option, then select a higher resolution such as 1280x1024 or above. If you
really want to stress your graphics card, select the highest resolution available. You don't need to alter any of
the other options on this screen unless you know what you're doing. Click Ok and the changes will be
implemented. Now start the Auto Demo mode by pressing F5 (or Demo>'Enter Planet Demo') and let the
program run for a while and any graphics instabilities will soon become apparent through crashes, artifacts
or glitches. You can also manually rotate the objects, change them, their materials and background
environments often to put further stress on the graphics card.

GAME BENCHMARKS

The most useful form of graphical benchmarking is through the use of the benchmarking features in many
3D games. This is considered 'real world' benchmarking, since for most intents and purposes modern PC
games are the most system intensive - and system-wide - benchmarks you can use. Many of the more recent
games such as Half Life 2, Quake 4, Prey and F.E.A.R. contain built-in benchmarking utilities. For more
details of these benchmarking functions, as well as how to configure these games for optimal performance,
see this list of my Game Tweak Guides. If you want an automated utility to run the benchmarks for you,
then you can download a range of free game benchmarking utilities at HardwareOC Benchmarks. Note that
they have been given explicit permission to use TweakGuides.com game guide text and descriptions in their

utilities by me.

Even if you can't find an automated or built-in benchmarking feature for a game, simply select the most
strenuous game you have - i.e. the one with the most graphical detail, best artificial intelligence and physics,
and preferably the most recent - and use the FRAPS utility to measure performance over a set period of time.
You can assign a key which starts and stops the benchmarking process in FRAPS, or you can tell FRAPS to
stop benchmarking automatically after a period of time. You can specify the benchmarking stats to save,
such as minimum, maximum and average frames per second.

To use any strenuous game as a stress tester, play it continuously for a sustained period of time at very high
settings, such as one or two hours. If the game crashes at any point then this likely a good indication that
your system is not completely stable.

PCMARK

PCMark is a general benchmarking utility from the makers of 3DMark that has been around for several
years, and although not as reputable or as widely used as 3DMark, provides a reasonably good benchmark
of your computer's general performance, not just in 3D gaming. It runs a series of tests based on such things
as file encoding, disk reads/writes and basic graphics display. To use PCMark run the program and click the
‘Run PCMark' button on the main screen. After several tests it arrives at a score you can compare with others
online, or again on the ORB. Note that PCMark results are recorded separately from 3DMark results and are
not comparable.

so1psouer(] 29 JUSWDINSEIA SDUBWLIONIS ]

Copyright © 2007 Koroush Ghazi 238


http://www.daionet.gr.jp/~masa/rthdribl/index.html
http://www.tweakguides.com/Games.html
http://www.hocbench.com/
http://www.fraps.com/
http://www.futuremark.com/download/

O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

SANDRA

Sandra is discussed under the System Specifications chapter, however it also contains a range of modules
designed to test certain components of your system, such as the CPU, RAM, or various drives. The free
version of Sandra is limited in the particular modules you can access and hence the tests you can run,
however there are sufficient benchmarks in the free version for you to use it as a decent system
benchmarking tool.

To see the modules of Sandra which have benchmarking functionality, click the Benchmarks tab and you
will see modules such as the 'Processor Arithmetic', 'Cache and Memory' and 'Physical Disks'. To run a
benchmark, open the appropriate module and press F5 or click the blue 'opposing arrows' (Refresh) icon at
the bottom of the module. This will begin a benchmarking run, after which you will eventually see the
results displayed at the top of the module. You might want to record the score(s) somewhere. You can put
the benchmarking results in context by looking at the reference figures provided beneath it. You can also
change the reference data to reflect a variety of hardware to compare against. Note that for the File System
Benchmark, by default it does not use the Windows File Cache, and this can give quite low results. To enable
the file cache, and hence see the real-world results of Windows memory management tweaking on your
Windows system, click on the Options button at the bottom left of the File System Benchmark module,
untick the 'Bypass Windows File Cache' option, click OK then run the benchmark.

Sandra also has a role as a diagnostic tool. To use it as a stress tester of specific components on your system,
use the relevant modules mentioned under the Benchmarking tab. However instead of simply running them
once, if you want to stress test the relevant component simply refresh the benchmark repeatedly (by pressing
F5) whenever it completes each run. Alternatively, if you want to stress all your components in turn
automatically, Sandra has a 'Burn-in Computer' module under the Tools tab which will undertake more
thorough stress testing of your machine. Start the wizard, tick the components you want to continually stress
test, set the number of times for them to loop, make sure to tick the 'Monitor your computer's health' and
‘Terminate on overheat/failure' options to be safe, and then commence the stress testing.

PRIME95

Prime95 is a small mathematics program which will effectively stress test your CPU and memory. Once
you've installed the application, to run the actual stress test run Prime95.exe and choose the Just Stress
Testing' button. Next, under the Options menu select 'Torture Test' to start stress testing. Select the test type
based on the particular components you want to focus on testing:

*  Small FFTs - Select if you want to primarily test your CPU.
* In-place Large FFTs - Select if you want to test your CPU for stability under high heat and voltage usage.
* Blend - Select if you want a more general 'real word' test which tests both the CPU and plenty of RAM .

Once you click OK the testing will begin. If the program aborts with an error, you will be notified. If at any
point you want to stop the test, go to the Test menu and select Stop. Make sure you read the document
Stress.txt that comes with the program as it will explain more about CPU stress testing and how Prime95
helps uncover instability. The program recommends running the torture test for between 6 - 24 hours,
however a PC that is unstable will usually crash much sooner than that, often within a few minutes of
running the test. In general if your PC lasts for over 2 continuous hours under the Prime95 torture test it
proves that the CPU and memory subset are quite stable.

SUPER PI

Super PI is a small utility similar to Prime95, in that it stress tests your CPU and memory subset by
calculating the mathematical number PI to a certain number of places. Download the program and run the
super_pi_mod.exe file. Click the Calculate menu item at the top, and select the number of places to calculate PI
to, ranking from 16 thousand (16k) to 32 million (32M) places - the larger the number of places, the longer it
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will take. In general for a speed test of your CPU, select the 1M option and once the calculation is done, note
the time in seconds taken for the final loop (e.g. 38.562s). You can then compare this figure to other people to
see how fast your CPU is. If you want to stress test your CPU, run the full 32M calculation which will take
longer, and hence is a better stress test of your CPU. Once again you can also compare the time taken to
complete this with other users.

Note: Both Prime95 and Super PI only run on one core of a multi-core CPU by default. To stress test both
cores of a dual core CPU for example, you should open up one instance each of Prime95 and SuperPI
together, then run them both and both CPU cores will be stressed.

MEMTEST

MemTest is a Windows-based memory test for all systems and will help in stress testing your RAM to detect
any errors. Memory-related errors are one of the primary causes of system instability and data
corruption/errors, so a RAM tester is a necessity. To use MemTest simply launch the program, and I
recommend manually entering the amount of RAM you wish to test - e.g. enter 512 to test 512MB of RAM,
1024 for 1GB of RAM and 2048 to test 2GB of RAM. Click the 'Start Testing' button to begin RAM testing and
allow the test to run until it has reached 100%. Ideally you should run the test for at least an hour or more, or
even overnight if you want to test for total system stability. If any errors whatsoever are found then you
have unstable memory which can lead to many types of system problems.

MEMTESTS86

Memtest86 is another good memory test and is better than MemTest in that it tests your memory before
Windows loads into memory, similar to the way the Windows Memory Diagnostic Tool tests your memory.
This is a much more accurate way to test your RAM and memory subset free of any memory spaces taken up
by the operating system. To use MemTest86 download the latest zip file and extract the contents. Run the
Install.bat file from the archive and enter a blank 1.44MB floppy as prompted. To run Memtest86, leave the
floppy in the drive and reboot your system - it will run from the floppy and test your RAM. Note that some
motherboard BIOSes come with MemTest86 built-in, so check your BIOS for this option and run it from
there, especially if you don't have a floppy drive to use for this procedure. If you can't find this option on
your motherboard either, then just use the Windows Memory Diagnostic Tool, as it is tests your RAM in a
similar manner to Memtest86.

That covers the main performance measurement and diagnostic tools you can use to troubleshooting and
optimize your system. There are many other programs which can be used for this purpose, but the ones
above should be the most reliable and the most easy to use under Vista. There are no tools which
automatically diagnose and fix all your problems. Many tools will claim this to be the case, but believe me
when I say none actually exists. The causes of PC problems are often very complex and interrelated, and can
be a combination of hardware or BIOS problems combined with incorrect settings or driver problems. It
requires some effort to properly diagnose a PC problem, but using the tools and methods above combined
with some research can usually find you the solution quite quickly if you genuinely want to solve an issue.
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CLEANING WINDOWS

As you use your system in day-to-day activities, a vast range of temporary, backup and unnecessary files can
build up on your hard drive. Most temporary files are automatically deleted whenever you close an
application, or whenever you shut down Windows. Unfortunately some of them aren't, and over time they
can build up, taking up a lot of disk space and generally making a mess in your directories. The main reason
to clean Windows is to free up additional drive space, reduce clutter and possibly prevent file version
conflicts. This chapter looks at the tools and methods required to safely clean Windows.

B Disk CLEANUP

The built-in Disk Cleanup utility provides the ability to automatically find and remove a range of
unnecessary files. To access the Disk Cleanup utility go to your Start>Programs>Accessories>System Tools
menu, or go to Start>Search Box and type "cleanup" (without quotes) and press Enter. You will be asked
whether you want to clean up just your own files, or files from all users on this computer. If there are other
users on this machine, I recommend considering the impact on them. Cleaning up some components such as
Temporary Internet Files, Error Reports or older Restore Points could adversely impact them, but of course
at no point will personal files or folders be removed.

To remove unnecessary Windows files at any time, under the Disk Cleanup utility you can select any of the
following components. Note that some of these items may not appear if they have nothing to clean.
Furthermore, for some of these options you can click the 'View Files' button to see precisely what files will be
affected:

Downloaded Program Files: Ticking this item removes all the files held under \ Windows\ Downloaded Program
Files directory, usually small ActiveX and Java programs which you may have downloaded while browsing
certain web pages. This option does not delete any other files you have downloaded anywhere else on your
system. This setting is best left unticked, especially if you visit trusted pages which need these program files.

Temporary Internet Files: Ticking this item clears your Internet Explorer browser cache, held under
Users\ [username]\ AppData\ Local \ Microsoft \ Windows \ Temporary Internet Files. It does not affect the browser
cache of your other browsers. In general this is best left unticked as constantly clearing your browser cache
can slow down browsing on IE - only clear the cache periodically (See Internet Explorer chapter).

Hibernation File Cleaner: Ticking this option has two important effects. Firstly it removes the system file
Hiberfil.sys found under your base hard drive directory. This file is for the Hibernation feature covered under
the Power Options section of the Control Panel chapter. It is a large file, equal in size to your system RAM,
so removing it can save quite a bit of drive space. However if you use the Hibernation or Hybrid Sleep
feature you should not tick this item, as the file needs to stay. Secondly, by removing this file you also
disable access to the Hibernation feature, which can only be regained by following the instructions in this
Microsoft Article. Therefore only tick this option if you do not current use, and do not wish to use

Hibernation or Hybrid Sleep. If the option doesn't appear it means you don't have this file on your system.

Offline Webpages: Ticking this item clears any offline web pages stored under the \ Windows\ Offline Web Pages
directory. This item is fine to tick unless you wish to keep these pages.

Recycle Bin: Ticking this item removes all the files and folders currently in the Recycle Bin. Tick this item only
if you're sure that you no longer need any of them.

System error memory dump files: Ticking this item removes all memory dump files, such as Memory.dmp
usually found under your \ Windows directory. These dump files can help when reporting an error - see the
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Performance Measurement & Diagnostics chapter. If you aren't having any problems or don't need to
troubleshoot your system, you can delete these.

System error minidump files: Similar to the above option, ticking this item removes all minidump files, for
example Mini020407-01.dmp, found under the \ Windows\ Minidump directory among other places. Only tick
if you don't have any system issues.

Temporary Files: Ticking this item removes any temporary files created by programs. These files are usually
cleaned out by the program itself, but this does not happen at times due to a bad shutdown or program
crash. This item should be ticked.

Thumbnails: Ticking this item removes the cached thumbnails which Vista creates for viewing files, folders
and particularly pictures in Icon or Tile view. In general you should not tick this item unless you have most
of your folders set for Details or List view instead. Deleting thumbnails only increases the time it takes for
Vista to regenerate thumbnails for folders which use this view.

Per user archived Windows Error Reports
Per user queued Windows Error Reports
System archived Windows Error Reports
System queued Windows Error Reports

The four options above refer to error reports generated by Vista and covered under the Performance
Measurement & Diagnostics chapter. If your system is free of errors or problems, then you can safely remove
these. Otherwise they may be useful for troubleshooting so don't remove them.

More options: Under this tab you will be able to access the Programs and Features area of Vista by clicking the
first 'Clean up' button. See the Programs and Features section under the Control Panel chapter for more
details. The second option here is more important, as clicking the 'Clean up' button under the 'System
Restore and Shadow Copies' area will bring up a prompt asking you if you wish to Delete all of your System
Restore points except for the most recent, also removing any older Shadow Copies as part of this process.
These are covered in more detail under the Backup & Recovery chapter. If your system is performing
without any problems and you also don't wish to restore any recent Previous Versions then it is usually fine
to click this option, as older Restore Points can often take up a fair bit of disk space.

ADVANCED DISK CLEANUP

There is a more advanced form of disk cleanup which provides a few additional options you can select for
cleanup along with the original options covered above. To activate it, you must type the following in a
Command Prompt or at the Start>Search Box:

Cleanmgr /sageset:1

The number after the sageset switch can be anything from 0 to 65535, it doesn't matter - it's simply the
specific place in the Registry that your options will be saved. Note further that you cannot specify a drive or
user to clean files for, this applies to all drives and partitions, so use cautiously if you have other users on the
machine. The following additional options will be available using this advanced method:

Debug Dump Files: Ticking this option removes any general .DMP files which are usually not needed unless
you are trying to troubleshoot a problem.

Old Chkdsk Files: If you have run the Chkdsk command or any automated recovery method in Windows
Recovery Environment then it may have found portions of damaged or lost files which it has saved with the
.CHK extension in your base directory. Unless you are still in the process of recovering these files, they are
safe to delete.
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Previous Windows installation(s): If Vista found any files or folders which were not compatible when doing an
Upgrade over a previous version of Windows, it will store them in a series of folders called Windows.old. You
can view their contents to see if there's anything you want to keep.

Setup Log Files: Ticking this option removes any log files created during Windows installation. Not normally
needed, best removed if your system is not showing any problems.

Temporary Windows installation files: Ticking this option removes a range of temporary installation files
created during Windows installation. These files can be removed without any problems.

Files discarded by Windows Upgrade: During an Upgrade install of Vista, any non-system files which Vista
cannot move across, it will keep them backed up just in case. If none of your personal files are missing after
an Upgrade install, you can tick this option.

Once you have selected the relevant options, click OK. Nothing will be deleted just yet - your settings are
saved and you can now run advanced Disk Cleanup with these options at any time by typing the following
in a Command Prompt or in Start>Search Box:

Cleanmgr /sagerun:1

Press Enter and the cleanup process will begin immediately. Note that the number after sagerun must match
the number used in the sageset switch further above for the same options to execute. In general this
advanced method need not be used very often; once after you have installed Windows and then periodically
is sufficient. The regular Disk Cleanup method further above is safer and more configurable, making sure it
doesn't have inadvertent impacts on other users or other drives on your system.

B RECYCLE BIN

The Recycle Bin provides a storage area for deleted files and acts as an additional layer of protection against
permanently deleting files on your system. To access the Recycle Bin configuration options, right-click on the
Recycle Bin icon on your Windows Desktop and select Properties. Note, if you can't see the Recycle Bin
anywhere on the Desktop, see further below.

Custom Size: This option sets the maximum amount of drive space allocated to the Recycle Bin should it need
it. Highlight the logical drive you wish to set the space for, and then enter an amount in MegaBytes (MB),
with the minimum amount being 1MB. I strongly recommend allocating a decent amount of space here, at
least as large as the largest files you are likely to delete (e.g. 2000MB which is roughly 2GB). If the Recycle
Bin is not large enough for a file you're deleting, it will be permanently deleted instead, so don't skimp on
the Recycle Bin size.

Do not move files to the Recycle Bin: If this option is ticked, all files will be deleted permanently instead of
being moved to the Recycle Bin first. I strongly recommend against ticking this option, as the Recycle Bin
gives an added level of protection against accidental deletion of important files. If you wish to permanently
delete individual files at any time, simply hold down the SHIFT button at the same time as pressing Delete
or choosing the Delete option to bypass the Recycle Bin.

Display delete confirmation dialog: If ticked, every time you choose to delete a file, you will be asked if you
wish to continue. As long as you have the Recycle Bin enabled, then I recommend unticking this option as it
is an unnecessary annoyance.

Note that no file is actually permanently deleted when it is deleted 'permanently' from your drive. It is
simply marked for deletion and hidden by the file system, but it can be overwritten at any time. For details
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of how to recover a file which has been 'permanently’ deleted from Windows or the Recycle Bin, see the
Backup & Recovery chapter.

You can choose whether to show or remove the Recycle Bin icon on your Desktop by right-clicking on an
empty spot on your Desktop, selecting Personalize, then clicking the 'Change desktop icons' link in the left
pane. Here you can tick or untick the Recycle Bin' item to show or hide this component on the Desktop. If
you want to change the icon used for the Recycle Bin, highlight its (full) and (empty) icons here and clicking
the 'Change icon' box, then select a new icon to use, or click Browse to find and select additional icons aside
from the system default icons.

B CCLEANER

CCleaner is a free utility which can automatically find and remove a wide variety of essentially useless files
from your system. CCleaner automates a task that you can perform manually to some extent (see further
below), but which takes longer to do by hand; CCleaner finds and removes a range of files with common
extensions identifying them as unnecessary files (e.g. .TMP, .BAK, .OLD) and also files which reside in
known temporary or rubbish folders. It is not foolproof, however if used with a bit of caution it is usually
quite safe in removing only unnecessary files.

Run the program and first click on the Options button and adjust the following settings:

1. Under the Settings section, untick all available boxes as none are vital to running CCleaner correctly.
Under the Cookies section, in the left pane are a list of cookies CCleaner will automatically delete if the
Cookies option is ticked under Internet Explorer and/or Firefox on the main CCleaner screen. Select
which cookies you would like to keep by highlighting it in the list and moving it using the '->' arrow to
the 'Cookies to keep' list. If you're not going to delete any cookies then ignore this area.

3. Under the Custom section you can add particular files or folders which you would like CCleaner to
delete. This can be useful if a particular program keeps creating specific unnecessary folders which
CCleaner wouldn't normally pick up as rubbish, but be very careful what you add here.

4. Under the Advanced section I suggest unticking everything except 'Only delete files in Windows Temp
folders older than 48 hours' which should be ticked for maximum safety, along with the 'Show prompt
to backup registry issues'.

5. If you're not sure if you're running the latest version of CCleaner at any time, click the 'Check for
updates now' link at the bottom right corner to see if a newer version of CCleaner is available. It is
recommended that you always use the latest version for maximum safety and compatibility.

To start the cleaning process, first make sure you close all open applications to prevent conflicts if CCleaner
tries to delete actively used files. Then open CCleaner and under the Cleaner>Windows tab make sure to
untick anything which you don’t want deleted. For example, you may want to keep your Internet Explorer
history or browser cache (Temporary Internet Files). Note that you should only tick the options under the
Advanced list at the bottom if you know what you are doing, otherwise they are all best left unticked as
removing them can lose a lot of your customizations in Vista. Importantly, don't tick the 'Old Prefetch data’
item if you use SuperFetch as this will remove SuperFetch optimizations and work against the benefits it
provides - see the Memory Optimization chapter for details.

Next, under the Cleaner>Applications tab CCleaner lists all your installed applications which it can help
clean up. Once again, make sure you untick anything you wish to keep. Most of the cleaning CCleaner will
be doing for these applications is to remove the Most Recently Used (MRU) list, but you may lose some
customizations you want to keep, so if in doubt do not tick an item.

Once you have all the relevant options ticked, don't run the cleaner just yet. Click the Analyze button and
after a while CCleaner will come up with a list of files it wants to delete. At this stage nothing has been
deleted yet, so scroll through the list and make sure no files that you wish to keep are listed. If you have any
doubts, or want some of these files kept, go back to the Windows and/or Application tabs and untick any
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areas you don't want CCleaner to clean and click Analyze again. Once you're happy to continue click the
‘Run Cleaner' button to permanently remove the listed files.

Finally, the Issues function in CCleaner attempts to find redundant Registry and File system entries. To start
with, tick all the options available and then click the 'Scan for Issues' button. A whole range of "issues" may
be found, however I recommend caution when using this section of CCleaner. Make a backup of the Registry
first if in doubt - see the Backup & Recovery chapter.

B MANUAL CLEANING

Below is the basic manual method for cleaning out the more obvious redundant files in your system. If you
don't trust an automated cleaner or just want to be certain you delete all unnecessary files, follow these steps:

1. Close all open applications and games as some of these may have created temporary files that cannot be
deleted because they are in use. Restart your system just to be certain.

2. Make sure you empty your Recycle Bin. Also ensure that the option to move files to the Recycle Bin is
enabled. This will provide protection against accidentally deleting a necessary file in the next few steps.

3.  Open Windows Explorer and navigate to the following directories on the hard drive where you have
installed Windows. Delete any files or subdirectories beneath them, but not the directories themselves:

\ Temp

\ Windows\ Temp

\ProgramData\ Temp

\ Users\ [username]\ AppData\ Local\ Temp

4. There are troubleshooting and diagnostics files and directories which you should only delete if you
genuinely feel you currently have no major issues on your system:

* .DMP files under \ Windows and \ Windows\ Minidump (e.g. Memory.DMP)
*  The directories under \perflogs\ System \ Diagnostics

5. Finding files with extensions that identify them as redundant. Go to Start>Search, select Advanced
Search and enter the following text then make sure to tick the 'Include non-indexed...' box. In each case
you can usually delete all incidences of files without a problem:

*BAK
* TMP
*OLD

6. Delete any files you are sure are not needed anymore, such as older versions of downloaded driver
packages, setup files from downloaded programs, log files and so on.

7. Note, if any files cannot be deleted because they are in use by Windows, reboot your system and go into
Safe Mode (See the Backup & Recovery chapter). From there you should be able to delete any file.
Usually however if a file is in use it is a good indication the file is needed and best not deleted unless
you are certain it's unnecessary.

As noted further above in the CCleaner section, do not regularly clean out the contents of the
\ Windows\ Prefetch folder if you use the SuperFetch feature. This resets SuperFetch and reduces its
effectiveness. Only delete the contents of this folder if troubleshooting or you dramatically change your
usage patterns.

That covers the bulk of unnecessary files on your system. Importantly do not empty your Recycle Bin just yet
- reboot your system and use it normally for a few days just to be sure the files you have deleted are
genuinely no longer needed. In general I recommend using the automated methods further above for regular
Windows cleaning, but you can supplement them with manual cleaning every once in a while.
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REGULAR MAINTENANCE

Keeping Windows Vista and your PC in optimal working order requires regular system maintenance. Any
operating system will degrade over time if not properly maintained, so you must arrive at some regular
method of undertaking such maintenance using the tools and methods in this guide. It also cannot be done
on a rigid schedule; it depends on your usage patterns, how often you install patches and updates, install
new software and move files around, etc.

Below is a list of the actual things I regularly do to maintain my PC, the rough order they are done in, and
the frequency with which I do them. Although you may consider some steps or frequency of actions overkill,
I've found that by doing these procedures at least once a week I not only keep Windows as fresh as the day it
was installed, I also weed out any undetected malware or unnecessary programs, keep my drive space
optimal and also quickly get wind of any data corruption issues before they ruin my data.

This is only an example, and you will need to customize it to suit your particular circumstances, but it is a
good starting point for the average PC user.

STEP 1 - SCAN FOR MALICIOUS SOFTWARE

Action: Update malware scanners then run a full manual scan on each one.
Frequency: Once a week at least. Scan individual suspicious files such as new downloads or saved
attachments as often as required.

See the PC Security chapter for details.

STEP 2 - CHECK FOR NEW STARTUP PROGRAMS & SERVICES

Action: Use MSConfig to quickly check under the Startup and Services tabs for any newly installed startup
programs or non-Microsoft services. Identify any new ones and disable unnecessary ones as required.
Frequency: Once a week at least. Also after each new program or game install.

See the Startup Programs and Services chapters for details.

STEP 3 - CLEAN WINDOWS

Action: Run the Disk Cleanup utility, then CCleaner. Do a manual clean out of remaining unnecessary files.
Only empty the Recycle Bin if certain no important files will be removed, otherwise leave it for the moment.
Frequency: Once a week at least. Also after any major program or game installs.

See the Cleaning Windows chapter for details.

STEP 4 - CLEAN & COMPACT THE REGISTRY

Action: Use RegSupreme to run a thorough clean of the Registry, then use NTRegOpt to compact it.
Frequency: Once a week.

See the Windows Registry chapter for details.

STEP 5 - RUN A DISK CHECK

Action: Use the Disk Check utility to do a full disk scan/repair of the hard drive.
Frequency: Once a week, or done automatically when using a third-party defragmenter (see Step 6 below).

See the Hard Drive Optimization chapter for details.
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STEP 6 - DEFRAGMENT THE DRIVE(S)

Action: Use a disk defragmenter - either the default Windows Disk Defragmenter or a commercial package
like Diskeeper - to run a full defragmentation of the hard drive.

Frequency: Once a week at least. Importantly also after every major program or game install/uninstall, or any
manual game or Windows patching.

See Hard Drive Optimization chapter for details.

STEP 7 - BACKUP IMPORTANT FILES

Action: Create a System Restore point. Backup the Registry using Erunt. Do a full manual backup of
important files and folders to CD/DVD. Also backup extremely important files again to ISP webspace via
FTP as an added precaution.

Frequency: Once a week at least. If working on something extremely important, backup every couple of days
both to ensure it's not lost, and also to have several versions in case current version is corrupted or
accidentally deleted.

See the Backup & Recovery chapter for details.

SCHEDULED MAINTENANCE

Given Windows Vista has good scheduling functionality, you can automate many of these tasks to
commence while you are asleep or away from your PC, by using Task Scheduler if the program itself has no
scheduling features - see the Task Scheduler section of the Control Panel chapter. This is particularly useful
for more long disk-intensive tedious tasks such as scanning for malware or backup up drive contents.

Please note that unfortunately there are no automated maintenance programs which can do proper PC
maintenance for you. Though many tools many claim they can do this, there are several important steps
which require active decision making and irregular frequency of application. There is no magic wand which
will clean and optimize your machine for you. At best most will simply remove unnecessary files or registry
entries; nothing genuinely thorough or useful.

Just as a human mechanic is required to actually inspect, tune and maintain a motor vehicle, rather than any
totally automated process, so too PC requires that you be aware of how things work and to actually think
and act based on particular circumstances to keep both the hardware and the software running optimally.
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That brings The TweakGuides Tweaking Companion for Windows Vista to a close. I hope you've found the
information in this guide valuable as a reference source. As I say at the end of all my guides: Until next time,

take care!

Cheers,

Koroush Ghazi

B VERSION HISTORY

The table below shows all the major revisions made to this guide since first released.

‘ Version ‘ Release Date

‘ Pages Revised

1.00

1 March 2007

Nil - First Release.

[End of Guide]
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